
WHAT'S NEW IN Global Mapper v16.0 

 Significant New Features 

o Dramatically sped up many operations by making use of multiple cores. The 

following operations are now much faster in most cases: 

Contour Generation 

View Shed Calculation 

Gridding of 3D vector features 

Search by Attributes/Name 

Creation of area features from equal colors/elevation/slopes 

[LIDAR MODULE ONLY] Automatic classification of Lidar ground 

points (20X as fast or more) 

[LIDAR MODULE ONLY] Initial display of height-above-ground color 

for Lidar point clouds 

Reprojection of layers covering a large area of the world 

o [LIDAR MODULE ONLY] Added option to automatically classify building and 

high vegetation (i.e. tree) points from a raw Lidar point cloud. This is a very 

powerful option on the Lidar toolbar (and via the LIDAR_CLASSIFY script 

command) that, combined with the existing (and much-improved) option to 

automatically classify Lidar ground points, allows automated classification of 

over 90% of ground, building, and high vegetation points from a raw Lidar point 

cloud. 

o [LIDAR MODULE ONLY] Added option to automatically extract building 

outlines from classified Lidar point clouds. This is a very useful option on the 

Lidar toolbar that, combined with the automatic classification and manual cleanup 

tools, can allow very efficient extraction of 3D building outlines from Lidar point 

clouds. 

o [LIDAR MODULE ONLY] Added option to automatically extract tree 

points/areas from classified Lidar point clouds. This is a very useful option on the 

Lidar toolbar that, combined with the automatic classification and manual cleanup 

tools, can allow very efficient extraction of tree points (with crown height and 

width attributes) as well as approximate tree coverage areas from Lidar point 

clouds. 

o  [LIDAR MODULE ONLY] Added options to filter Lidar points by 

class/elevation/color/scan-angle/source-ID/etc. when exporting, gridding, and 

selecting from point clouds. 

o Added option to plan and record a 3D fly-through as a video file. New toolbar 

buttons on the 3D dialog allow setting up and recording a high-definition 3D fly-

through. 

o Support rendering textures on 3D polygons in the 3D view. This allows for the 

creation of photo-realistic 3D model views when loading 3D data that has texture 

images included. There is a drop-down on the 3D toolbar to select the Skybox 

background for the 3D display. 

o Added a Graph and Chart Manager under the Analysis menu to allow creating 

graphs and charts from loaded data. The following type of operations are 

supported: 

Bar graph, histogram, line chart, or bar chart from any attribute field in 



loaded vector layers. 

Histograms for gridded terrain layers (i.e. DEMs) 

You can save the graph to a BMP file and place it on the map as a fixed 

screen position layer. 

Graph definitions are saved in the workspace file for easy saving and 

sharing. 

o Added option to export selected layers with new right-click option in Control 

Center. This finally lets you easily export just one or more layers without having 

to disable the others, export, and then re-enable them. 

o Added built-in streaming online ASTER GDEM v2 worldwide terrain data set at 

higher resolution (just over 30 meters) and from a much faster/more reliable 

server than the previous streaming ASTER GDEM v1 data set. 

o Removed GEM module. All functionality that was present with the GEM add-on 

module is now part of the base package. 

o Added new GeoCalc toolbar to access Blue Marble’s Geographic Calculator 

coordinate transformation library if you have that installed. The new toolbar has 

buttons to enable/disable GeoCalc projections and settings and also a dedicated 

button to launch the Geographic Calculator. 

o Fixed security issue with MAPI.DLL. Secunia Advisory SA 51510/CVE-2013-

0727. 

 New Supported Formats 

o Support Numerous New 3D Model Formats: 

Collada: *.dae 

PLY (Stanford Polygon Library) : *.ply 

Blender : *.blend 

OBJ (Wavefront): *.obj 

3DS (3DS Max): *.3ds 

STL (StereoLithography) : *.stl 

o Added support for MrSID MG4 format image and Lidar files. 

o Added support for loading RDTED (terrain data in CADRG/RPF format) files. 

o Added support for exporting Vertical Mapper Classified (clutter) Grid GRC Files. 

o Added support for loading LCV Land Cover Files. 

o Added support for ZMap+ Fault Polygon Files. 

 Lidar Changes 

o [LIDAR MODULE ONLY] Added option to automatically classify building and 

high vegetation (i.e. tree) points from a raw Lidar point cloud. This is a very 

powerful option on the Lidar toolbar (and via the LIDAR_CLASSIFY script 

command) that, combined with the existing (and much-improved) option to 

automatically classify Lidar ground points, allows automated classification of 

over 90% of ground, building, and high vegetation points from a raw Lidar point 

cloud. 

o [LIDAR MODULE ONLY] Added option to automatically extract building 

outlines from classified Lidar point clouds. This is a very useful option on the 

Lidar toolbar that, combined with the automatic classification and manual cleanup 

tools, can allow very efficient extraction of 3D building outlines from Lidar point 



clouds. This option is available on the Lidar toolbar and in a script via the 

LIDAR_EXTRACT command. 

o [LIDAR MODULE ONLY] Added option to automatically extract tree 

points/areas from classified Lidar point clouds. This is a very useful option on the 

Lidar toolbar that, combined with the automatic classification and manual cleanup 

tools, can allow very efficient extraction of tree points (with crown height and 

width attributes) as well as approximate tree coverage areas from Lidar point 

clouds. This option is available on the Lidar toolbar and in a script via the 

LIDAR_EXTRACT command. 

o  [LIDAR MODULE ONLY] Dramatically improved automatic classification of 

ground points. The following improvements have been made: 

Improved classification to filter out likely buildings and trees before 

finding nearly certain ground points. This fixes the common issue of the 

top of flat buildings being classified as ground points. There are 

parameters controlling this on the ground classify dialog. 

Tremendously sped up automatic classification of ground points. The 

operation can be 20 times faster or even more on machines with a large 

number of cores. 

Added option to ground classify dialog to filter the Lidar points that are 

considered as possible ground. You can manually filter the points by 

elevation, color, scan angle, etc. 

Allow performing a ground-point automatic classification just on selected 

Lidar points. 

o  [LIDAR MODULE ONLY] Added option to Lidar LAS/LAZ export to filter the 

export so that only points that are within a given elevation range, near any one of 

a list of colors, within a list of allowed classes, within a scan angle range, and/or 

within a list of point source IDs are exported. 

o [LIDAR MODULE ONLY] Added option when gridding Lidar point clouds to 

filter what points are considered in the grid. You can use that to grid only points 

that are within a given elevation range, near any one of a list of colors, within a 

list of allowed classes, within a scan angle range, and/or within a list of point 

source IDs are exported. For example you might use this to quickly create a 

ground grid from a Lidar point cloud. 

o [LIDAR MODULE ONLY] Added option to grid Lidar intensity values rather 

than elevations when doing a bin-based grid of Lidar point clouds. The intensity 

grid will default to a grayscale rendering, like an aerial image, but can be 

customized to use any shader. The option is a new Grid Type selection on the grid 

options dialog. You can also do this from a script by adding 

GRID_TYPE=INTENSITY to the GENERATE_ELEV_GRID command. 

o [LIDAR MODULE ONLY] Added option to grid Lidar height above ground 

values rather than elevations when doing a bin-based grid of Lidar point clouds. 

The option is a new Grid Type selection on the grid options dialog. You can also 

do this from a script by adding GRID_TYPE=HEIGHT_ABOVE_GROUND to 

the GENERATE_ELEV_GRID command. 

o  [LIDAR MODULE ONLY] Enhanced option to filter the selected Lidar points in 

the Digitizer Tool to also allow filtering the selection by classification, point 



source ID, and scan angle range. 

o [LIDAR MODULE ONLY] Greatly improved filling of gaps when doing binned 

gridding of Lidar point clouds. The filled gaps should now be much smoother and 

also calculate more quickly. 

o [LIDAR MODULE ONLY] Sped up display of height-above-ground color for 

Lidar point clouds on multi-core machines. 

o Dramatically sped up searches on point clouds. 

o [LIDAR MODULE ONLY] Added support for coloring Lidar point clouds by the 

difference in height between the first and last return of a multiple return pulse. 

This is useful for visualizing things like potential tree heights or non-penetrable 

objects like buildings. 

o Sped up the display of point clouds with a very large number of points (i.e. 10’s 

of millions) of points, particularly when zoomed in on a small section of the point 

cloud. 

o  [LIDAR MODULE ONLY] Made path profiles through Lidar points in a map 

catalog show those Lidar points 

o Added new built-in point type for Railroad ASPRS class 10 (Lidar, Railroad). 

o Added support for coloring points by the point index in the point cloud. This 

allows visualizing the spatial arrangement of the points in the source file. 

o Updated display of min/max Scan Angle on the Statistics dialog for Lidar point 

clouds to show the min/max values in degrees rather than the raw scaled values. 

o [LIDAR MODULE ONLY] Made Feature Info dialog and status bar display 

modifications to elevations from Alter Elevation Values tab of Options dialog for 

point cloud layer. 

o [LIDAR MODULE ONLY] Made the elevation legend display with height colors 

for a ‘height above ground’ rendering of a point cloud. 

o Updated creation of point clouds from elevation grid cell centers to create the 

points in the full native units of the layer and not a more precise unit like 

centimeters. 

o  [LIDAR MODULE ONLY] Fixed coloring of Lidar path profile as height-above-

ground if the main map view is not also using the same draw mode. 

o Fixed bug in v15.1.6-15.2.1 with Lidar classification filter on the Lidar load 

dialog not being remembered. 

o Fixed bug in v15.2.0-v15.2.1 with binned gridding of Lidar data sometimes not 

creating a layer. 

 3D Viewer Changes 

o Added option to plan and record a 3D fly-through as a video file. New toolbar 

buttons on the 3D dialog allow setting up and recording a high-definition 3D fly-

through. To create a 3D fly-through, you first define a fly-through path from a 

line feature. You can define the camera location and direction for every point 

along the path, preview the fly-through frame-by-frame or as a single stream, and 

save the results to an AVI video file with different resolution and frame rates. 

o Support rendering textures on 3D polygons in the 3D view. This allows for the 

creation of photo-realistic 3D model views when loading 3D data that has texture 

images included. There is a drop-down on the 3D toolbar to select the Skybox 



background for the 3D display. 

o Added real-time display of main map display cursor location in the 3D view. You 

can enable display of a vertical line in the 3D view that shows where your cursor 

is positioned in the main map view as you move it around. 

o Added support for drawing the current GPS location and recorded track in the 3D 

viewer. There on options on the 3D View Options dialog to control the display of 

the GPS icon. 

o Made 3D points with rotated symbols draw at the appropriate location in space 

and with the specified rotation relative to the plane of the surface. This allows for 

things like floating arrows pointing in different directions. 

o Added option on toolbar to control whether or not the 2D and 3D map views are 

linked. By default they are linked so updated in either one also updates the other. 

If you disable the linking then you can separately pan and zoom the 2D and 3D 

view windows. 

o Added option to display skybox. Add a realistic background to your 3D views. 

o Added display of onscreen notifications as 3D viewer settings change. This will 

show text about changes to the water height, walk mode height, vertical 

exaggeration, etc. as text in a corner of the 3D window for some period of time 

(default is 10 seconds). You can configure the display of these notifications on the 

3D view options dialog. 

o Added support for specifying an Altitude mode of Depth Below Sea Level for 

vector features (either for an entire layer or for individual features). If this is set 

the elevation for the feature will be treated as a negative value for display in the 

3D view. 

o Fixed 3D zoom with mouse option which was broken in v15.2.0-v15.2.1. 

 Path Profile/Line of Sight Function Changes 

o Made crossing 3D lines shown in the path profile view display at the interpolated 

elevation at the cross point and not the elevation at the start of the intersecting line 

segment. 

o [LIDAR MODULE ONLY] Added right-click option on main map when the Path 

Profile Tool is active but nothing is drawn to set the corridor width for a Lidar 

path profile . 

o Fixed bug in v15.2.0 with path profile dynamically drawn line not being correct 

for long lines. 

o Fixed problem with areas that the path profile crosses not being displayed if there 

are no line features loaded. 

 Analysis Function Changes 

o Added support for conditional expressions in the Raster Calculator. This allows 

things like performing different operations on band/elevation values depending on 

how they relate to other values. For example, you could have a formula like ‘IF ( 

B1 > B2, B1 - B2, 0 )’. This would cause the resulting value to be B1 - B2 if B1 > 

B2, and 0 otherwise. 

o  Improved creation of watershed, water rise, and view shed coverage areas to 

more rarely create self-intersecting (invalid) areas. 

o Updated creation of view shed coverage areas with a transmission angle to create 



a 3D area with the height of each vertex being the height of the transmission at the 

vertex distance. This allows for a nice 3D display of the transmission beam. 

o Made volume calculations accurate regardless of what projection you are 

currently using for display. Previously the volume could be inaccurate if using a 

distorted projection for the location, like Geographic far from the equator. 

o Improved pile volume calculation by sampling the terrain at more locations 

around the pile area boundary to form the “base” surface rather than only 

sampling at the vertex locations. This helps a lot for pile boundaries with only a 

few vertices and also lowers the effect a single poorly-placed vertex can have. 

o Improved pile volume calculation when the pile boundary has some vertices 

outside of the terrain surface. Before that could cause large spikes in volume as 

those vertices were treated as 0. Now they are just ignored. It is still best to have 

all vertices on the terrain surface though. 

o Updated contour generation to create lines mark as absolute height and contour 

areas with extrusion disabled to improve the default 3D view. 

o Added better progress reporting to watershed operation and allow cancel when 

finding flow to/from points, lines, and areas. 

o When creating Voronoi diagram, extend lines to clip boundary. 

o Fixed long-standing error gridding 3D vector layers with lines used as constraints 

for some data sets. 

o Fixed problem with points with elevations of -9999 or below not gridding. 

o Fixed error about not enough 3D points being available to grid when trying to grid 

1 or 2 3D triangle (TIN) features. 

o Fixed problem with styling for drainage areas created from watershed calculation. 

They were displaying with a single color rather than random colors in v15.2. 

 Digitizer Tool Changes 

o Added option to range ring creation to create radial areas (as opposed to radial 

lines) so that you can easily create pie wedges at a fixed radius. 

o Added an option to create a point feature at the centroid/average of a group of 

selected point features. This is under the Advanced Feature Creation right-click 

menu when you have more than one point feature selected. 

o Updated option to count features in selected area to be able to count lines that are 

partially inside the area rather than just those that are completely inside the area. 

o Updated add of coordinate attributes for line and area features to add a BOUNDS 

attribute with the bounding box. 

o Updated creation of line features from selected islands/holes in areas to assign the 

parent area attributes to the new lines and also add an ISLAND=Y attribute. 

o Updated creation of regular grid of features to all creating point features at the 

grid cell centers. 

o Added support for resampling selected line features at a fixed percentage of the 

length rather than a fixed distance along the line. 

o When create points from the vertices of selected features, add the feature name as 

an AREA_NAME or LINE_NAME attribute to the created points. 

o Added right-click menu for layer selection box on feature edit dialog to allow 

controlling whether the group name for a layer is pre-pended or appended to the 



layer name. 

o Made enclosed area and length/perimeter for rectangular or circular areas and 

lines be displayed in the status bar as the features are drawn with the Digitizer 

Tool. 

o Added Insert Vertex option to top-level right-click menu of Digitizer Tool when 

vertex display is enabled. 

o Fixed issue in v15.2.0-v15.2.6 with new area features added to a layer loaded 

from a file being lost if you save to a workspace and then load that workspace 

back in. 

o Fixed error in v15.2.0-v15.2.5 creating buffers on one side of the boundary of a 

closed line feature. 

o Fixed bug in v15.2.0 with rectangular buffers/range rings around point features 

being huge. 

o Fixed bug in v15.2.0-v15.2.1 with multiple combined range rings not drawing 

properly. 

o Fixed bug where the elevation values will change units when combining 3D lines. 

o Fixed crash in v15.2.0-v15.2.8 when doing many Digitizer Tool operation (like 

creating a line) when grid lines are displayed. 

 Scripting Changes 

o Added ability to calculate pile volumes using the new CALC_VOLUMES 

command. 

o Added support for setting the area, line, and point display for a layer from a 

.gm_layer_style file with the AREA_STYLE_NAME, LINE_STYLE_NAME, 

and POINT_STYLE_NAME parameters for the 

IMPORT/SET_LAYER_OPTIONS command. 

o Added support for providing a MAP_ORDER of MOVE_FRONT, 

MOVE_FRONT_GROUP, MOVE_END, or MOVE_END_GROUP to the 

SORT_LAYERS script command. You can also filter what layer group to sort by 

adding a LAYER_GROUP parameter. This allows re-ordering individual layers 

however you need. 

o [LIDAR MODULE ONLY] Support automatically classifying building and high 

vegetation (tree) points using the LIDAR_CLASSIFY script command.  

o [LIDAR MODULE ONLY] Support automatically extracting building outlines 

and tree points/outlines from classified Lidar point clouds using the 

LIDAR_EXTRACT script command.  

o [LIDAR MODULE ONLY] Support filtering exports to Lidar LAS/LAZ files by 

point attributes like elevation, scan angle, classification, color, etc. with the 

EXPORT_VECTOR and GENERATE_ELEV_GRID commands using new 

parameters LIDAR_FILTER, LIDAR_COLOR_FILTER, 

LIDAR_COLOR_DIST, LIDAR_SCAN_ANGLE_RANGE, 

LIDAR_ELEV_RANGE, and LIDAR_SOURCE_ID_LIST. 

o Updated the COMPARE_STR parameter for the EDIT_VECTOR command to 

support more comparison operators than = and !=, including <, <=, >, and >=. 

o Support including the group name in the FILENAME parameter for commands 

like SET_LAYER_OPTIONS. You can add <sub> in the filename filter to 



specify a group separator. 

o Added support for finding and fixing invalid polygons/area geometries by adding 

FIX_INVALID=YES to the EDIT_VECTOR command. 

o Added support for creating point features spaced along line/area features using the 

EDIT_VECTOR script command. The 

CREATE_POINTS_ALONG_FEATURES attributes allows you to specify the 

spacing of the points in meters. 

o Added built-in %TIMESTAMP%, %DATE%, and %TIME% variables so you 

can easily add the current date and time to things like log messages with the 

LOG_MESSAGE command. 

o Added option to specify what elevation value is the no-data (void) elevation by 

adding VOID_ELEV to the IMPORT_ASCII script command. 

o Made GEN_PRJ_FILE and GEN_AUX_XML_FILE parameter work for 

EXPORT_ELEVATION script command. 

o Display filename being imported or exported in progress for script/workspace. 

o Show progress for IMPORT_DIR_TREE command and allow cancel of process. 

o Added support for defining a map layout from a .gm_layout file with the 

MAP_LAYOUT command. 

o Added support for defining a layer style from a .gm_layer_style file with the 

DEFINE_LAYER_STYLE command. 

o Added option to require one or more attributes to have equal values when copying 

attributes between features with the COPY_ATTRS command. Add 

EQUAL_ATTR parameters for each attribute that must be equal. 

o Support disabling showing warnings when no layers are unloaded with the 

UNLOAD_LAYER script command by adding SHOW_WARNINGS=NO to the 

command. 

o Fixed bug with failure to write workspace when calling SAVE_WORKSPACE to 

the same .gmw file multiple times within a script. 

o Made UNLOAD_LAYER work with hidden layers. Broken since v15.2.0. 

o Allow providing a default value for DEFINE_VAR when getting the variable 

value from a feature attribute. 

 Projection/Datum Changes 

o Added support for providing a default projection to use when starting the 

application or unloading everything. If you define a projection in a startup.prj file 

in either the install folder or the User Settings file list on Help->About, that 

projection will be automatically selected at application start or when you unload 

everything. 

o Sped up change of projection for layers covering a large part of the earth on 

multi-core systems. 

o Added built-in AMG (Australian Map Grid) projection so the correct projection 

name could be used for AGD66/AGD84-based projections (rather than MGA). 

o Improved display of Transverse Mercator-based projections far from the central 

meridian. 

o Added built-in Mars MOLA Sphere datum so that newer Mars data can 

automatically load with the correct ellipsoid model. 



o Added built-in Batavia (Indonesia) and NAD83 (NSRS2007), NAD83 

(NSRS2011), NAD83 (PA11), and NAD83 (MA11) datums and EPSG codes. 

Note the special NAD83 datums are currently treated as coincident with base 

NAD83. The new codes are to allow maintaining the correct metadata. 

o Added built-in Clarke 1866 Ellipsoid and Clarke 1880 Ellipsoid datums to make it 

easier to position older small scale maps that only specify an ellipsoid but no 

datum. 

o When using GeoCalc integration mode, added button to the Projection tab of the 

Configuration dialog to allow reloading the GeoCalc XML DataSource without 

needing to restart. 

o Fixed fetch of projection information from ESRI .aux.xml files in some cases. 

o Improved storage and retrieval of Minnesota County Datum projections with 

custom county datums from GeoTIFF headers. 

o Made State Plane projections with NAD83 HARN datums store the EPSG code 

correctly to GeoTIFF and Lidar LAS/LAZ files. 

o Improved compatibility of GeoTIFF files using the Web Mercator projection in 

Esri products. 

o Fixed shift in RSO Malaysia projections in v15.2.1-v15.2.5. 

 Online Source Changes 

o Added built-in streaming online ASTER GDEM v2 worldwide terrain data set at 

higher resolution (just over 30 meters) and from a much faster/more reliable 

server than the previous streaming ASTER GDEM v1 data set. 

o Added built-in link for NSF OpenTopography online source which catalogs freely 

available Lidar data worldwide. 

o Updated NAIP source to new server URL and made workspaces that reference the 

old NAIP URL automatically update to point to the new server. 

o Fixed crash in v15.2.0-v15.2.2 when trying to remove a user WMS source. 

 Format Specific Changes 

o Made layer selection for PDF import be a tree control to match how Acrobat 

displays the layers and make it easier to enable/disable entire groups of layers. 

o Added option to Shapefile export to include the sides and bottom of extruded 3D 

areas as additional 3D area features in the export. 

o Improved loading of multi-part 3D areas with Z values. There were problems with 

things like the sides of buildings being treated as islands/holes in the top. 

o Added recognition of additional types from OSM XML files as the proper Global 

Mapper type. 

o Improved import of building areas from OSM XML files. They should all come in 

as areas now and also will be marked to extrude and treat heights as relative to 

ground. 

o Additional improvements to Wasp .map export to prevent cross-point errors in 

Wasp. 

o Added support for specifying what Z value is treated as the no-data (void) value 

when loading ASCII files with the 3rd coordinate value treated as the Z (elevation) 

value. This allows no-data values other than the default of -999999.0. 

o Added option to control whether -useserver or -netecm is used in the command 



line when exporting MrSID files and using a cartridge license server on the 

network. 

o Update MrSID exports to embed the WKT projection string in the SID file header 

if the projection/datum could not be fully stored in the GeoTIFF tags in the 

header. This allows for projections to be stored that aren’t fully describable in 

GeoTIFF tags. 

o Updated GML import to remove the prefixes from attribute names, like ‘slip:’. All 

prefixes are removed except for osgb: and gml: if they won’t result in duplicate 

attribute names. 

o Fixed problem with toc.xml files for ECRG format files being overwritten by a 

Global Mapper map catalog when closing the layer. 

o Added option in Advanced section of General tab of Configuration dialog to 

control whether or not to use geometry columns when importing from MS SQL 

Server databases. 

o Made date fields in DBF/Shapefiles be formatted using the current system local 

date settings rather than always MM/DD/YYYY. 

o Added support for using PRJ files for DWGs. 

o Improved export of imagery from a map catalog (GMC) draped on top of terrain 

for 3D PDF export. It will now maintain the full resolution of the data in the map 

catalog. 

o Made 3D PDFs export XY units as meters to match the vertical units so the 

elevations aren’t exaggerated due to unit inconsistencies. 

o Updated KML/KMZ export so that if a KML folder attribute (default of 

KML_FOLDER) exists but is empty, the feature will be exported at the top level 

rather than inside a default folder. 

o Sped up load of large GeoTIFF DEM files that have an .aux.xml file with the 

valid min/max elevation range. 

o Fixed handling of attributes for generic ASCII text files when breaking new 

features on the change in the value in a particular column. Before the first line of 

attributes from the next feature could be added to a feature. In addition attributes 

with different values were added as separate attributes rather than combined in 

one. 

o Support file versions up to 1155 for CADRG exports when exporting through the 

user interface. Previously anything over 33 was not allowed. 

o Loading a workspace with data loaded from a spatial database now automatically 

selects the database table rather than prompting user. 

o Automatically decode Equirectangular projections and more Mars datums from 

PDS format files. 

o Fixed bug in v15.2.0-v15.2.3 with manual rectification of TIFF files with the File-

>Rectify Imagery menu command not doing anything. 

o Fixed problems in BSB export with position fields in v15.2.0-v15.2.2. 

o Fixed problems loading some BAG files, such as those from the Canadian 

Hydrographic Service. 

o Fixed grayscale BMP export to create an 8-bit BMP file rather than 24-bit with 

gray colors. 



o Fixed issue with images from ECRG files loaded from a .zip file not displaying. 

o Fixed crash in RasterOverlay.cpp when enabling contrast adjustment for ECRG 

files. 

o Fixed bug in v15.2.0-v15.2.1 with layer attribute not saving to MapInfo and 

Shapefile exports when the option is selected. 

o Fixed bug in v15.2.0-v15.2.1 with invalid symbol/icon size error with some 

KML/KMZ files. 

o Fixed bug in v15.2.0-v15.2.2 with incorrect rotation of point symbols from 

KML/KMZ files. 

o Fixed placement of line feature labels when exporting to KML/KMZ and the 

current projection is not already Geographic/WGS84. 

o Fixed bug in v15.2.0-v15.2.1 with alignment of multi-line text labels in PDF 

export. 

o Fixed problem with toc.xml files for ECRG format files being overwritten by a 

Global Mapper map catalog when closing the layer. This was supposed to be 

fixed in v15.2.0 but wasn’t really fixed until v15.2.4. 

o Fixed text size issue with opaque backgrounds for PDF export. 

o Fixed rendering issues with some PDF files, particular that use transparency. 

o Fixed issue with some layers not being listed for PDF import so you couldn’t turn 

them off. 

o Fixed export of vector layers set to use the UTF-8 text encoding to PDF. 

o Only show a single error message for all invalid areas encountered during 3D 

PDF export rather than an error message for each invalid area. 

o Fixed issues loading some XTF files with bad pings. 

o Make TIFF orientation other than top-left work for elevation GeoTIFF files. 

o Fixed crash with some high bit-depth Erdas Imagine files with void values. 

o Fixed issue with the units coming in as US Feet rather than International Feet for 

ECW files that use a .aux.xml file for specifying the projection when that 

.aux.xml specifies international feet. 

o Support automatic decoding of RGF93 datum from ECW files. 

o Fixed problem with LDEM (Lunar DEM) PDS files coming in as Sinusoidal 

projection instead of Equirectangular. 

 Rendering/Style Changes 

o Sped up the display of data layers with a very large number of features, 

particularly when zoomed in on the data. 

o Added option to draw labels with an opaque (filled) background of a custom color 

rather than always using the current view background color. The new option is on 

the font selection dialog. 

o Added option to add just minimum, maximum, and average attributes when using 

the ‘Init from Values’ button for attribute-based styling for a layer. This allows 

easily setting up a color range without initializing to all values for a range of 

numerical attributes. 

o Further speed-up when rendering raster layers cropped to polygons, particular 

when cropped to polygons with large numbers of vertices. 

o Added loaded view shed layers to the map legend when displayed with the color 



for each listed along with the view shed layer name. 

o Fixed crash zooming to view in Google Earth in v15.2.0-v15.2.1. 

o Fixed problem with dialogs not remembering what they were resized to in 

v15.2.0-v15.2.2. 

o Fixed problem with option to hide area labels that are not completely contained 

within the areas in v15.2.4. 

o Fixed bug with attributes not showing in Quiver Plot dialog opened from Point 

Styles tab of Options dialog for layer in v15.2.0-v15.2.4. 

o Fixed issue with elevation legend showing coloring for wrong range when the 

topmost layer uses a custom layer shader that is also the same as the shared 

shader. 

o Fixed issue with custom vector symbols scaled to a fixed height in meters not 

always drawing. 

 Made the Configuration, Options, and Metadata dialogs be resizable. 

 Allow canceling a long search on the search dialog. 

 Support saving a workspace when no data is loaded, allowing the save of just the 

projection and map layout settings in a workspace. 

 Added support for forcing a filename passed on the command line (including .gmw) to be 

run in an existing instance of GM if possible rather than starting a new instance. Just add 

-existing to the command line. If you load a workspace in an existing instance, you can 

also add -no_prompt to the command line to indicate that the “unload all” prompt at the 

beginning is skipped and the workspace should just be loaded on top of the already 

loaded data. 

 When calculating attributes using a numeric operation, like addition, subtraction, or 

division, treat monetary values with a $ at the front of the attribute as numbers. 

 Added new Tree point type. 

 Support using a feature display label or layer name for an elevation attribute. 

 When splitting a layer by attributes and the description of the layer has been customized, 

make the new layer names use the customized layer name and not the original one. 

 Fixed modification of elevation units on vector options dialog. This was broken in 

v15.2.0-v15.2.1. 

 Fixed odd selection behavior in the Control Center when clicking on the + or - next to a 

group of layers. Previously any existing selection would be maintained and the new 

group also selected, rather than the previous selection being reset. 

 Fixed installation problems on XP 64-bit in v15.2.0-v15.2.1. 

 Fixed crash stopping GPS tracking when playing back a NMEA log file in real time. 

 Fixed rare issue with custom settings, like custom shaders or datums, not reading on 

application start if you start multiple instances at nearly the same time. 

 Fix error about parsing GMSettings.xml on systems with no internet connection. 

 Fixed placement of main Global Mapper window when the placement of multiple 

monitors is changed. In some cases before it could start up off screen. 

 Fixed issue with right-click option to move selected layers after another layer in the 

Control Center not working if the layer to move after was before the layer to move in the 

list. 

 Fixed lockup when closing all layers with grid lines displayed. 



 Fixed issue with *.TMP files sticking around in temp folder after crashes. 

 Fixed issue with lockup closing all layers with a grid layer displayed. 

 

WHAT'S NEW IN Global Mapper v15.2 

 Significant New Features 

o Added option to File menu of 3D Path Profile/Line of Sight dialog to save the 

rendered path profile to any supported vector export format, including PDF files 

o Added option to Display Options menu of 3D Path Profile/Line of Sight dialog to 

display any area and line features that cross the path. 

o Improved buffer area creation. You can now create rectangular/squared buffers, 

buffers on just one side of selected line features, and buffers with variable width 

from start to end. 

o Added option to create a Quiver Plot from attributes of point features to easily 

create directed, scaled arrows (or other symbols). With this option you can select 

U and V vector attributes or Magnitude and Rotation attributes as well as a 

symbol to get rotated and scaled symbols (typically arrows) from the attributes of 

point features. The Quiver Plot functionality is available on the Point Styles tab of 

the Options dialog for a point layer as well as from the Attribute or Create Point 

Features right-click submenu of the Digitizer Tool. 

o Added support for displaying and exporting text in multiple languages. The 

following changes resulted: 

Each vector layer’s options dialog now includes a Code Page/Language 

setting where you can select which character set the display labels and 

attributes for the layer user. This includes UTF-8.  

Display labels will be displayed on-screen using that character set 

information. The text is converted from the selected code page/language to 

Unicode for display, so any text language can be displayed regardless of 

system language. 

File formats that specify a character set, including Shapefile/DBF, 

KML/KMZ, GML, OSM XML, and GPX, will automatically set the 

proper code page for a layer when loaded. 

Searching and editing of labels and attributes will use the current system 

language setting, so you can for example edit Korean language attributes if 

your Windows language is set to Korean. 

Exports to formats that support character set information, like 

Shapefile/DBF, KML/KMZ, OSM XML, and GPX will convert text from 

the original layer text language/code page to the selected output language 

or the character set for that format. 

o Made toolbars remember their location between runs. Finally you can re-organize 

your toolbars and have their location be remembered when you close and re-open 

Global Mapper. 

o Added support for specifying the altitude mode for vector features/layers. This 

allows specifying whether 3D vector features have heights relative to ground or 

absolute heights relative to sea level. You can set the altitude mode individually 

for features when editing them or for an entire vector layer at a time on the 

Options dialog for the layer. The altitude mode is used in the 3D viewer to place 



the features. If unspecified the 3D View setting for relative/absolute is used. The 

altitude mode is set automatically when reading KML/KMZ files. The altitude 

mode is also used during view shed calculations with vector obstructions and 

when displaying a path profile for a 3D line feature. 

o Added conditional processing via new commands IF/ELSE_IF/ELSE/END_IF. 

This allows conditional execution of groups of commands based on some variable 

value. The variables could have been passed on the command line or the user 

prompted to enter one. 

o Added support for multiple levels of grouping layers in the Control Center. You 

can now specify group names with <sep> embedded in them to provide multiple 

levels of grouping. 

o Greatly sped up rendering of some layers when reprojected, particularly online 

sources that use Web Mercator when displayed in Geographic or 

Mercator/WGS84. 

o Fixed Security Vulnerability in NCSECW.dll (CVE-2010-3599). 

o Fixed OpenSSL Heartbleed vulnerability. This only affected the PostgreSQL 

support. 

 New Supported Formats 

o Added support for many more 3D models from Collada DAE files. 

o Updated XTF (eXtended Triton Format) import to create mosaic from sidescan 

sonar data. 

o Added support for additional HDF5 elevation grid data formats. 

o Added support for loading AVS UCD format with 3D TIN features. 

o Added support for exporting loaded 3D areas and terrain layers to ASCII AVS 

UCD files. 

o Added support for playing back Hypack RAW files as NMEA GPS log files to 

extract the line information. 

o Added support for exporting line and polygon data to Kongsberg SIS plan format 

files. 

o Added support for exporting point data to Lowrance SonarLog (SLG) CSV files. 

 Lidar Changes 

o [LIDAR MODULE ONLY] Added support transforming the coordinates of Lidar 

point clouds, including graphically rectifying them, providing a transform (shift, 

rotate, and scale), and doing a file-based coordinate-to-coordinate transformation, 

including via .gm_xform file. Previously the only transformation available for 

Lidar point clouds was reprojection. 

o [LIDAR MODULE ONLY] Added option to filter selection of Lidar points to 

only those selected points within a certain elevation range or near certain colors. 

This provides a very easy way to select things like points of a certain color or just 

high points in a region. This option is under the Advanced Selection right-click 

sub-menu of the Digitizer Tool when Lidar points are selected. 

o [LIDAR MODULE ONLY] Added support for auto-classifying ground points in 

Lidar points clouds in a script using new LIDAR_CLASSIFY command. 

o [LIDAR MODULE ONLY] Fixed bug with creating of grid using binned grid 

methods to Feet elevation units creating a grid that says meters when the values 



are in fact feet. 

o Made cut/copy/paste work for points in a Lidar point cloud. 

o [LIDAR MODULE ONLY] Use squared off buffers rather than rounded buffers 

when getting a path profile through a Lidar point cloud. 

o [LIDAR MODULE ONLY] Use a larger palette of colors when coloring by point 

source ID so you don’t get duplicate colors when more than 5 point source IDs 

are present. 

o Added support for disabling the write of the projection to an exported LAS/LAZ 

file header in a script by adding NO_PROJ_HEADER=YES to the 

EXPORT_VECTOR command. 

o Added option to keep the original file offset/scale when exporting to Lidar 

LAS/LAZ files. This is useful if you have some kind of requirement to keep the 

original offset/scale in the header rather than having an optimal offset/scale 

calculated. 

o Added support for providing a specific offset and scale to use when exporting 

Lidar LAS files rather than using the default calculated one with a new option on 

the Lidar export dialog or by adding a HEADER_OFFSET and 

HEADER_SCALE parameters to the EXPORT _VECTOR script command. 

o Allow cropping to a selected area when specifying the bounds to import from a 

Lidar point cloud. This will currently just limit the points to the bounds of the 

selected areas and not actually crop to the areas. 

o Made Lidar point cloud data export to spatial databases, like Esri File 

Geodatabases (GDB). They will export as normal 3D point features. 

o Made the GPS_TIME attribute for Lidar points be more intelligent about how 

many decimal digits are shown rather than always just showing a 10th of a second 

precision. The number of digits is now based on the smallest time slice 

encountered. 

o Allow searching on the RETURN_NUM attribute in the search vector dialog. 

o Improved display of Lidar point clouds with intensities over 255. 

o [LIDAR MODULE ONLY] Added option under View->Toolbars menu to turn 

the Lidar toolbar on and off. 

o Added option to specify the Flight Date to store in the LAS/LAZ file header when 

exporting. 

o Changed FLIGHT_TIME metadata value for Lidar files to FLIGHT_DATE. 

o Fixed bug with editing the elevation value of multiple selected Lidar points with 

the elevation of some being set to an incorrect value or not changed at all. 

o Fixed bug with the color not being maintained from a provided Lidar point cloud 

if exporting and also checking raster layers, such as through a script 

EXPORT_VECTOR. 

o Fixed problems loading Leica PTS files with extra blank lines at the end. 

o Fixed issue with elevation legend range not updating when you delete Lidar 

points or change their elevation. 

 Path Profile/Line of Sight Function Changes 

o Added option to File menu of 3D Path Profile/Line of Sight dialog to save the 

rendered path profile to any supported vector export format, including PDF files. 



This is very handy for making documents including the path profile since it will 

scale cleanly. 

o Added option under Display Options menu of 3D Path Profile/Line of Sight 

dialog to display any lines and areas that intersect the path. With this option 

enabled you see a vertical line showing exactly where any of the other lines/areas 

on the map intersect the 3D path. If the intersecting lines have their own 

elevations they are shown at that elevation. Otherwise they are shown at the path 

elevation. 

o Added right-click menu to Path Profile Tool with option to show the last drawn 

path profile if you’ve closed the dialog it was one. This is useful for bring the path 

profile dialog back up for the last drawn profile if you needed to change some 

stuff and go back to it. 

o Updated right-click option to set the color for separate lines draw for each terrain 

layer to allow specifying the style to use as well so you can draw a layer’s terrain 

values using any line style you want rather than just a single-pixel wide dashed 

line. 

o Added option to Display Options menu on the Path Profile dialog to control 

whether or not portions of the path that don’t cross loaded terrain are filled by 

interpolating the valid elevations on either side of the gap or filled with the 

minimum valid value along the path. 

o Added option to right-click menu on path profile dialog to control whether or not 

the start and stop coordinates are drawn on the profile. 

o Move path label to the top center of the path profile when saving the profile and 

showing the path label. It had been at the bottom left of the profile. 

o When creating min/max (extrema) points along a path profile, make the new point 

labels be in the selected elevation units for the path and include the elevation unit 

label. 

o Updated the saving of a XYZ file from the path profile dialog to save the path 

from each terrain surface as separate 3D lines if you have the option enabled to 

display a separate line for each surface and there were multiple surfaces under the 

path. 

o Updated the saving of a CSV file from the path profile dialog to save the 

elevation from each terrain surface as separate column if you have the option 

enabled to display a separate line for each surface and there were multiple 

surfaces under the path. 

o Updated the 3D Path Profile Path Details to include the Path Length (length along 

path) and the ground (3D) length for the Total Climbing and Total Descending 

segments.  

o Updated line of sight dialog prompt for which elevation layer to base ground-

relative tower heights on to only show once per path profile dialog instance so if 

you want to check different heights you don’t have to keep re-selecting the base 

elevation layers. 

o Added option on the dialog to set up the profile sample count/spacing to always 

keep all original vertices of the line the path profile is being shown for. This 

option allows you to specify a custom sample spacing but still ensure the original 

line path is exactly followed. 



o Made CSV export from path profile start the distances at the specified base 

distance. 

o Made right-click in the path profile when Lidar points are selected clear the Lidar 

selection rather than showing the context menu. This provides an easy way to 

clear the selection. 

o Added more distance units to the path profile spacing options and also made the 

units selection be remembered between runs. 

o Fixed display of  Total Climbing and Total Descending in 3D Path Profile details 

when elevation values are displayed in feet rather than meters. 

 Analysis Function Changes 

o Added new Analysis menu command to Count Overlapping Layers. This is useful 

for a number of things, in particular counting how many view shed layers overlap 

at any particular location. 

o Automatically mark any closed contour lines that are simplified into a stick (i.e. 

first and last point the same with one other unique point) as deleted. 

o Added option to specify the size of the allowed elevation or slope change when 

simplifying 3D lines. 

o Allow calculation of volumes within areas at a fixed height relative to the ground 

surface at each vertex rather than only at a fixed height relative to sea level. 

o Updated option to Measure Volume Between Surfaces for selected areas to add 

the calculated volume values to the areas as attributes. 

o Changed roughness for oceans to 0.0003 in built-in roughness tables from 0.03 as 

that is more in agreement with common usage. 

o Automatically skip loaded terrain layers that are outside a custom elevation range 

for contour generation to speed up the operation in some cases. 

o Updated reported Total Volume for area/pile volumes to be the cut volume minus 

the fill volume rather than adding them together. 

o Updated Combine/Compare Terrain Layers dialog to only show a single list of 

layers to select from for those operations that work on multiple layers in a single 

list, like Add, Average, Maximum, Minimum, and the new Count Layers. 

o Added new Combine/Compare Terrain Layers option to count layers with valid 

samples. This option will create a grid with the count of valid overlapping layers 

at each location. 

o Added new Combine/Compare Terrain Layers option to keep the first layer value 

only if the second layer value is invalid. This is used to cut one or more terrain 

layers from a terrain layer. 

o Added option to view shed calculation when using a range of angles and a height 

to check to allow specifying whether the height to check is relative to sea level or 

ground. 

o When generated contours from terrain, automatically apply the default attribute 

list for iso-height areas to any created contour areas. 

o When generated contours and marking closed contours less than some length as 

deleted also mark contour areas as deleted that don’t meet the length 

requirements. 

o Improved accuracy of volume results when the current projection is highly 



distorted in the area of interest, like if Mercator is selected and you are not near 

the equator. 

o Made the maximum depression fill depth setting be remembered between runs of 

the watershed and find ridge lines tools. 

o Fixed bug with pile/area volume reports being incorrect for pile bases that are 

sloped. A single elevation was being chosen. 

o Fixed bug in v15.1.0/v15.1.1 with the saving of the TIN layer when generating a 

grid from vector layers not working. 

o Fixed bug in v15.1.0-v15.1.4 with flattening of areas during gridding where the 

area edges are shared with others of different heights not actually making the 

areas flat even though they have a single elevation. 

o Fixed problem with creation of equal-value areas from feather-blended terrain 

layers not using the feather-blended values. 

o Fixed bug with colorization of contour area features when contours are created in 

feet and unit labels are not appended. 

o Fixed bug with contour generation with areas generated not obeying a custom 

elevation range and generating a contour outside the range. 

o Fixed problem with creation of roughness areas (and equal-value areas) that 

caused some sections to erroneously be marked as islands/holes in other larger 

areas that they were not actually inside of. This could also result in cross-point 

errors when exporting to Wasp .map files. 

o Fixed bug with label of contour lines in feet being wrong if you based the 

contours on the minimum specified elevation rather than even contour intervals. 

 Digitizer Tool Changes 

o Added support for creating buffer areas around line features with variable width 

from start to end. You can specify different start and end buffer distances to get a 

buffer that tapers from one end of a line to another. This is useful for things like 

creating slowly widening areas from stream lines from a watershed analysis. 

o Added support for created squared-off feature buffers rather than just rounded 

ones. No longer create separate rectangular buffer areas about line and area 

feature segments. Result is now a single buffer area with squared rather than 

round edges. 

o Added options for creating buffers on just the right or left side of line features. 

o Added option to create a Quiver Plot from attributes of point features to easily 

create directed, scaled arrows (or other symbols). With this option you can select 

U and V vector attributes or Magnitude and Rotation attributes as well as a 

symbol to get rotated and scaled symbols (typically arrows) from the attributes of 

point features. The Quiver Plot functionality is available on the Point Styles tab of 

the Options dialog for a point layer as well as from the Attribute or Create Point 

Features right-click submenu of the Digitizer Tool. 

o Added option to create randomly-spaced points within selected area features. This 

option allows you to specify how many points to create inside selected areas and a 

minimum spacing. This is useful for determining random sample locations for 

scientific tests, among other things. 

o Added new Feature Creation Options item under right-click Options menu for 



setting up the automatic creation of features (i.e. no Feature Edit dialog) and the 

handling of default attribute lists. You can now set up area, line, and point 

features so that when you digitize a new feature it is automatically created and 

initialized with the settings of the last digitized feature of the same type rather 

than having to confirm the settings on the feature edit dialog for each feature. 

o Added prompt for maximum allowed separation when connecting selected points 

into lines. This option allows you to connect larger collections of points that form 

separate lines rather than just joining them into one long line. Any points further 

apart than the specified maximum distance will be connected as part of a new 

line. 

o Added option to drag the map to scale features on the rotate/scale features dialog. 

Also added new options to the Move/Reshape right-click menu and Favorites 

toolbar to select drag to rotate and drag to so you can quickly get into drag 

rotate/scale mode. 

o Added option to create a separate coverage area (concave hull) for each selected 

area/line feature. This is useful is you have a collection of irregular area features 

(like automatically generated building outlines) and you want to create a more 

smoothed boundary for each. 

o Updated creation of lines connecting points to nearest line to also add an attribute 

(both to the point and the connecting line) with the distance along the line to the 

nearest point. This is useful for finding chainage and offset. 

o Updated selection of features with selected areas to also operate within selected 

closed line features. This means that you no longer have to convert closed lines to 

areas to be able to select features within them. 

o When you have multiple picture points selected the option to place the picture 

points now allows you to draw a box in which to tile the pictures. They will then 

automatically tile inside that box based on the size of the highest aspect selected 

associated image. 

o Fixed subtracting/adding islands of areas that have vertices on the edge of the 

“parent” area so you don’t get an island added that touches the parent instead an 

actual subtract operation that removes the polygon from the parent shape. 

o Added option to snap to the nearest raster layer pixel center when digitizing. This 

new snapping option can be enabled under the right-click Options menu. When 

enabled, digitized points will snap to the center of raster/image layer pixels if 

nothing else is available to snap to and the click location is inside a raster layer. 

o When creating/editing individual features, make the layer selection box include 

the group name for the layer the feature is in if it is grouped. Also prepend an 

asterisk to any layer names that are hidden or non-selectable so they are sorted 

together. 

o Added option when moving lines to the nearest point to also insert vertices in the 

line at the point locations. 

o Updated option to select all lines within selected area features to also select any 

vertices within that area if vertices are displayed for selected features. 

o Added new option to select any line features that are outside of selected area 

features and leave any inside the area de-selected. 

o When creating a regular grid of features, allow using special values %left%, 



%top%, %right%, and %bottom% for the numeric start value for the rows and 

columns. Those special values will be replaced with the corresponding edge of the 

grid cell bounding box. This allows you to easily get grid cell coordinates as the 

names of the grid cells. 

o Added new option when copying attributes from areas to areas to require that at 

least half of an area be covered by another area before using it to assign attributes. 

o Added option when measuring the volume of multiple selected areas to calculate a 

break-even volume for all selected areas, either as a whole or separately for each 

area. 

o Added option when calculating elevation statistics for selected area features to 

also create point features at the locations of the minimum and maximum 

elevations within the areas. 

o Updated option to create a regular grid of features to have separate Grid 

Placement options for filling a specified rectangle by providing the cell counts 

and calculating the cell width and height needed to fill with those counts or vice-

versa. 

o Added support for editing the description of features. When you edit a selected 

feature you can now choose whether or not is uses a custom description and also 

edit that description. 

o When creating points at the end points of grid lines when creating a Regular Grid 

and the spacing is in degrees, use the Position Display Format setting to format 

the coordinates. So you can get DMS or DM formatting. 

o Made calculation of elevation/slope statistics for selected line features, also 

include the average elevation along the line as an AVG_ELEV attribute. 

o Added option to add attributes for the pixel coordinates of point features in a 

raster layer when point features are selected and there is raster data available at 

the point location. 

o Added option to create point features at the min/max elevation locations along 

selected line features when calculating elevation statistics along lines like you 

could with areas. 

o Added option when applying terrain elevations to selected area and line features 

to only apply the terrain elevations to selected vertices rather than the entire 

features. 

o Made 3-point rectangle area/line draw support snapping to horizontal/vertical 

locations. 

o Greatly sped up operations that select or create a large number of features, 

especially point features. 

o Improved option to reduce the vertex count of selected areas. It will now chop at 

more intelligent locations to result in less areas. Also allows reducing all the way 

down to 3 vertices each without locking up. 

o Added new Advanced Selection option to select any line or area features that 

intersect or touch a selected line feature. 

o Made fixed width line features draw at that fixed width when selected rather than 

at just the width of the ‘Selected Line’ style. 

o When editing a feature and assigning it to a newly created layer, make the new 



layer have the same elevation units as the layer the original feature was in. 

o When selecting a new location for a point or vertex, add an option to select the 

point location from a map. 

o Added support for automatically fixing invalid polygons where the child/island is 

on the parent. 

o Added option when creating distance/bearing/COGO lines to specify that the 

bearing provided is relative to the bearing of the last line segment rather than an 

absolute bearing. 

o Added ‘Add/Update Feature Measure Attributes’ option to right-click 

Analysis/Measurement submenu in Digitizer Tool when multiple features are 

selected. This is in addition to the Attribute/Style submenu where it already is 

present. 

o Fixed bug in v15.1.0-v15.1.2 that cause area buffers to be wrong in many cases 

when the current projection is not Geographic. 

o Fixed bug existing since at least v14 that caused any new islands/holes added to 

area features loaded from a file to be assigned to the wrong area when you save a 

workspace with the modifications and reload it. This fix will also try and fix the 

island assignment when you load an old workspace with this mis-assignment. 

o Fixed bug in v15.1.0 that prevented selection of area features inside other areas. 

o Fixed bug in resampling a line or creating perpendicular lines along a line at a 

fixed number of spaces if you didn’t want to keep the original vertices. 

o Fixed EXTEND line functionality that was broken in v15.1. 

o Fixed crash cropping loaded point/Lidar features to a selected area and assigning 

the cropped results to a new layer. 

o Fixed bug in 15.1 causing a lockup when creating point features from selected 

line and area features. Also added progress bar so you can cancel the operation if 

it is taking a while. 

o Fixed bug in v15.1.5 that caused crash when applying elevations from terrain to 

selected point features when one or more of the points already had an elevation 

value. 

o Fixed bug with cropping points to an area and placing the results in a new layer 

just deleting the points in the area and not creating new ones. 

o Fixed buffering of areas with islands/holes to also buffer the hole in the parent 

area rather than dropping the hole. 

o Made per-vertex elevation lists correctly convert units when moving 3D features 

from layers in one elevation unit to layers with a different elevation unit. 

o Fixed bug causing a lockup when creating area features from selected 3D line 

features when some of the lines had consecutive points with the same XY location 

but differing Z values. 

 Scripting Changes 

o Added conditional processing via new commands IF/ELSE_IF/ELSE/END_IF. 

This allows conditional execution of groups of commands based on some variable 

value. The variables could have been passed on the command line or the user 

prompted to enter one. 

o Added support for exporting web-format tiles (Google Maps, Bing Maps, OSM, 



TMS, MBTiles, RMaps) using a new EXPORT_WEB script command. 

o Added support for updating the style of loaded features by providing style 

attributes with a new STYLE_ATTR parameter for the EDIT_VECTOR 

command. This allows you to easily update the style of matching features based 

on whatever criteria that you want, and to just update the pieces of the style that 

you want, like just the color or style. 

o Added support for working on layers that are selected in the Control Center when 

running a script in the context of the map main view. Just specify the filename as 

‘SELECTED LAYERS’ and the command will operate on any layers selected in 

the Control Center. 

o [LIDAR MODULE ONLY] Added support for auto-classifying ground points in 

Lidar points clouds in a script using new LIDAR_CLASSIFY command. 

o Added SET_OPT script command for setting general options. Currently it 

supports setting the Position Display Format and turning the display of areas, 

lines, points, and labels on and off. 

o Added new SAVE_WORKSPACE script command to allow saving a workspace 

from a script. 

o Added support for copying/moving matching features to a new layer using the 

EDIT_VECTOR command. You can use new COPY_TO_NEW_LAYER, 

MOVE_TO_NEW_LAYER, NEW_LAYER_NAME, and NEW_LAYER_PROJ 

parameters to control the operation. 

o Added support for creating tapered buffers around line features with the 

EDIT_VECTOR script command by adding BUFFER_DIST_END or 

BUFFER_ATTR_END parameters to existing buffer parameters. 

o Added QUERY_LAYER_METADATA script command to allow defining a 

variable based on some metadata value of a loaded layer. You can also do the 

same now with the DEFINE_VAR command using the METADATA_LAYER 

and METADATA_ATTR parameters. 

o Added support for referencing already loaded layers with the 

POLYGON_CROP_FILE and FEATHER_BLEND_POLY_FILE parameters. 

Just specify the name of the loaded layer (or ‘User Created Features’). 

o Added EXPORT_ANY script command for automatically selecting from 

EXPORT_ELEVATION, EXPORT_PACKAGE, EXPORT_PDF, 

EXPORT_RASTER, and EXPORT_VECTOR based on the provided TYPE 

parameter. 

o Added new parameter to RUN_COMMAND to allow the result of the specified 

program to be stored in a variable.  The new parameter is 

CAPTURE_RESULT=<var_name>, where <var_name> is the name of a script 

variable. 

o Added support for providing CODE_PAGE parameter to EXPORT_VECTOR for 

Shapefile export to get exported results in difference code pages (languages). 

o Added support for using a POLYGON_CROP_FILE with the 

GENERATE_ELEV_GRID script command. 

o Added option to keep the original layer and features around rather than closing 

them when using the SPLIT_LAYER script command. Just add 



CLOSE_ORIG_LAYER=NO to the script command to keep them open. 

o Added support for keeping all duplicates when using the JOIN_TABLE command 

by adding more supported values for the ALLOW_DUPLICATES parameter. 

o Added option to chop up areas to remove islands by adding 

REMOVE_ISLANDS=YES to an EDIT_VECTOR script command. 

o Added option to split matching line features at the nearest location to point 

features from a layer using a new POINT_LAYER_TO_SPLIT_AGAINST 

parameter for the EDIT_VECTOR command. 

o Added support for duplicating features with multiple values in a single attribute 

when using SPLIT_LAYER. You can now add a SPLIT_ATTR_SEP parameter 

with a value indicating a separator character. If the split attribute has multiple 

values, like PROPERTY_NAME=”A,B,C” with SPLIT_ATTR_SEP=”COMMA” 

you wouldget 3 copies of the feature, one in layer A, another in layer B, and 

another in layer C. 

o Added support to specify the type for an EXPORT script command as 

FIRST_LOADED or LAST_LOADED to export the same type as an already 

loaded layer. 

o Updated SET_OVERLAY_OPTIONS script command to only update any options 

that are actually provided for the layer rather than resetting many (like 

GROUP_NAME) to the default if not provided. 

o Allow specifying multiple FLOW_TO_POS parameters to a 

GENERATE_WATERSHED script command so you can analyze the flow to 

multiple points at once. 

o Added option to create point features from each vertex of matching area and line 

features by adding CREATE_VERTEX_POINTS=YES to an EDIT_VECTOR 

script command. 

o Added support for specifying the Lidar class filter using the 

LIDAR_TYPE_FILTER command with the LIDAR_FILTER parameter. 

o Added support for specifying a Lidar class filter with the LIDAR_FILTER 

parameter for IMPORT and IMPORT_ARCHIVE script commands. 

o Allow leaving off SHAPE_TYPE for EXPORT_VECTOR if only one type 

(areas, lines, or points) of features are loaded. The SHAPE_TYPE will be auto-

selected in that case. 

o Added support for getting the folder string that the current file in a 

DIR_LOOP_START loop is relative to the original search folder. This is inserted 

using %RECURSE_FOLDER%. 

o Added support for specifying a mask of commonly used formats (all, elevation, 

raster, or vector) in the FILENAME_MASKS parameter for the 

DIR_LOOP_START command. 

o Added support for excluding some filenames from a DIR_LOOP_START by 

adding FILENAME_MASKS_EXCLUDE to skip files that match the 

FILENAME_MASKS that you don’t want. 

o Fixed handling of FILENAME_MASKS=”..” for DIR_LOOP_START so that 

without recursing you get one record for each sub-folder and not just a single 

record for the specified folder itself. 



o Added support for extracting a piece of a filename value by adding 

FILENAME_PIECE to the DEFINE_VAR script command specifying which 

piece to extract from the value (i.e. DIR, FNAME_WO_EXT, FNAME, 

PARENT_DIR). 

o Added support for automatically feathering to the coverage polygon of a layer by 

adding FEATHER_BLEND_POLY=COVERAGE to the IMPORT (or 

SET_LAYER_OPTIONS) command. This will calculate the coverage polygon 

for the layer and feather to that rather than requiring you to already have that 

computed. 

o Added support for generating an index file for tiled KML/KMZ exports by adding 

KML_GEN_INDEX_FILE=YES to the EXPORT_VECTOR command. 

o If you pass a script on the command line to Global Mapper and no license can be 

acquired, just show a single message and exit rather than bringing up the full 

application. 

o Added support for disabling the write of the projection to an exported LAS/LAZ 

file header in a script by adding NO_PROJ_HEADER=YES to the 

EXPORT_VECTOR command. 

o Added support for providing a specific offset and scale to use when exporting 

Lidar LAS files rather than using the default calculated one by adding 

HEADER_OFFSET and HEADER_SCALE parameters to the EXPORT 

_VECTOR script command. 

o Added support for sorting multiple attribute values when copying from areas to 

points or lines. Use MULTI_AREA=ALL_SORT with the COPY_ATTRS script 

command to do this. 

o Added support for creating polygonal coverages and bounding boxes in the 

current projection with the GENERATE_LAYER_BOUNDS command using a 

new BOUNDS_TYPE parameter. You can add a MAX_VERTEX_COUNT 

parameter to specify the maximum number of vertices to include in the polygonal 

coverage. 

o Added support for exporting to OSM XML files with EXPORT_VECTOR 

command. 

o Added support for disabling export of <ele>, <desc>, <sym>, and <time> for 

GPX exports from a script. 

o Made EXPORT_RASTER script command work when only Lidar point clouds 

are loaded. 

o Added support for ignoring attributes when exporting OSM XML files by adding 

ATTR_TO_DELETE parameters to the EXPORT_VECTOR command with the 

attributes to ignore. 

o Fixed problem with GENERATE_ELEV_GRID script command showing error if 

the only loaded vector data was in the User Created Features layer. 

o Improved duplicate finding with SUBSET_IS_DUP=YES and 

MARK_DUPLICATES=YES or DELETE_DUPLICATES=YES with the 

EDIT_VECTOR command to allow some fuzziness when matching lines that 

shared end points but slightly different along the path and also to fix some 

incorrect duplicate marking. 



o Fixed export of rendered vector data to CADRG/CIB files with the 

EXPORT_RASTER script command. It wasn’t saving the rendered vector data 

when INC_VECTOR_DATA=YES was added as it should. 

o Fixed generation of contours in feet with GENERATE_CONTOURS when 

specifying a MIN_ELEV and MAX_ELEV. Those values should now be 

interpreted as feet when generating contours in feet. 

o Added support for some common incorrect values for the TYPE parameter for 

commands, like LIDAR_LAZ, LAS, LAZ, and KMZ. They will now work as 

aliases for the intended type. 

 Projection/Datum Changes 

o Support automatically getting projections from SRS strings like SR-ORG:7044 

(where 7044 is the projection code). This also works with the ‘Init from EPSG’ 

button on the projection dialog. 

o Support automatically getting projection from SRS strings like 

urn:adv:crs:ETRS89_UTM33. 

o Made projection files and EPSG codes that match to Swedish Grid and MGA 

zones that also match a UTM zone use the country-specific projection name. 

o Changed unit name ‘Chains (Sears)’ to ‘Chains (Sears/Gunter)’ to reflect common 

usage. 

o Fixed saving of interplanetary datums to workspace files. 

o Fixed read/write of GeoTIFF files using the Hotine Oblique Mercator Azimuth 

Natural Origin projection, like Alaska State Plane Zone 1. 

o Made GeoTIFF export with Polyconic projection write out the 

ProjNatOriginLatGeoKey for the origin latitude in addition to writing it to the 

ProjCenterLatGeoKey. 

o Recognize Web Mercator projections from GeoTIFF files created by Esri 

products where it is stored in the GTCitationGeoKey. 

o Automatically detect GeoPDF files that are clearly not in Canada but specify a 

Canadian datum code (like NAS-E) and make them generic NAD27 rather than 

NAD27 (Canada). 

o Improved precision of the Mercator (Navionics Special) projection. 

o Improved scale bar display for Mercator projection. It will now much more 

closely match the great circle distance even when far from the equator. 

o Added support for L2CAN83 projection code from EPSG and ERS files. 

o Increased precision of lat/lon projection parameters stored in workspace files. 

Now they will be saved to 1/100,000th of an arc second, or about 0.3mm  on the 

ground as compared to about 3cm precision before. False easting/northing values 

are now stored to the nearest 0.1mm instead of 1mm. 

 Online Source Changes 

o Added support for multiple levels of grouping of online layers. You can add ‘-->’ 

to the group name when adding a layer to specify a sub-level. 

o Allow quickly adding an entire layer tree from a WMS source. If you select a 

layer with child layer, like the top-level source, then you are prompted to 

separately add the child layers as their own source. If you select to do this you 

will get a sub-group under each selected group with the specified source name as 



the sub-group name, then each child layer under the main layer is added under 

that sub-group. 

o Added NLCD 2011 (National Land Cover Database 2011) built-in online source. 

o Added new AVIATION CHARTS group that has some streaming VFR/IFR 

charts for North America. 

o Added NOAA Digital Coast source for terrain and Lidar data along US coastlines. 

o Added new OpenStreetMap.org Vector Map Download source under Worldwide 

Data group to take you directly to download of OpenStreetMap data for your area 

of interest. 

o Added Maine (MEGIS) sources under U.S. Data->Maine group. 

o Updated OSM and TMS web format exports to include option to export directly 

to GMG (Global Mapper Grid) terrain tiles and also specify the tile size to use. 

o Updated OSM/TMS/Google Maps exports to automatically create a 

.gm_source_def.xml file that you can use to add the source as an online source 

using the ‘Add Sources from File’ button on the online download dialog. 

o Added option to specify the Resampling Method to use when rendering 

downloaded source right on the online dialog. This defaults to bicubic resampling 

to significantly improve the clarity of some sources at some zoom levels. 

o Added support for adding streaming TMS (tiled) online sources that are tiled to 

World Mercator (Mercator with WGS84 datum) instead of Web Mercator. 

o Added support for splitting Bing Maps exports up into a separate folder for each 

zoom level and row (each image name is still the full quad name) to avoid slow 

exports due to having a huge number of files in a single folder. 

o When adding a custom tile source (OSM/TMS/Google Maps) there is now a 

button to select a local folder as the base. Selecting that automatically sets up the 

Base URL with the <file:///> prefix. 

o Added support for custom tiled sources with only a single zoom level so there is 

just a %x and %y but no %z in the custom tile filename definition. 

o Sped up access to local file-based tile sources by directly accessing the tiles in 

their specified location rather than copying to our local cache. 

o Added support for WCS sources that use wcs: prefixes in their tags. 

o Added support for customizing the user agent string provided with web requests. 

Add a registry string value named ‘WebUserAgent’ in 

‘HKEY_CURRENT_USER\Software\Global Mapper’ to have that used rather 

than the automatically generated user agent string. 

o Added support for loading WFS services that don’t specify a bounding box for the 

data in the WFS capabilities XML document. 

 Format Specific Changes 

o Added option to Shapefile export to allow selecting the code page/language to 

export. All exported attributes and other text will be converted from the specified 

language for the layer to the selected output language. If you export to UTF-8 a 

.cpg file is also created with the export specifying that the text is encoded with 

UTF-8. 

o Greatly sped up handling of Shapefiles with large numbers of attributes, both for 

initial display and search. 



o Improved 3D PDF and U3D export performance. 

o Allow use of any available attribute value for naming layers in PDF export rather 

than limiting to just the feature description or source filename as before. Includes 

addition of LAYER_ATTR to EXPORT_PDF script command. 

o Made Korean and Japanese text export properly to PDF files. 

o Added option to 3D PDF export to control whether Lidar points are saved as short 

colored lines or points, noting that Acrobat reader cannot currently display the 

colored 3D points. 

o Updated KML/KMZ export of 3D area features with a specific extrusion height in 

a 3D_EX_HT attribute to automatically add the faces necessary to create a 

floating 3D volume rather than just extruding the area to the ground. This is 

useful to create 3D airspaces or other floating volumes. 

o Updated PostGIS, Spatialite, and MySql databases to properly convert text 

to/from UTF-8 now that we have code page/language support. 

o Added option to load BMP, JPG, PNG, and TIFF images with no geo-position 

information directly as Picture Points, similar to a JPG with EXIF information. 

You get to select the location to place the image on the map. You can also provide 

a PICTURE_POS with an IMPORT command in a script to load a file as a picture 

point via script. 

o Updated KML import to keep the ‘extrude’, ‘tesselate’, and ‘altitudeMode’ 

attributes for area and line features. The ‘extrude’ attribute is used in the 3D 

display to control the extrusion of 3D areas to the ground. The ‘altitudeMode’ 

attribute is used to specify whether elevations are relative to ground or absolute in 

the 3D view. 

o Added advanced option to KML/KMZ raster export to use transparent PNG 

images for any exports with transparent pixels when the JPG format is chosen for 

the export. This allows you to use the best compressed JPG images whenever 

possible and only switching to PNG for transparency when absolutely necessary. 

o Added option to KML/KMZ vector export to quickly add available attribute 

values to the custom HTML description text. 

o Made area transparency and border line styles work for some KML/KMZ files 

that they weren’t used for before. 

o Fixed lockup loading some KML/KMZ files that referenced custom icon images. 

o Allow cropping to a selected area when exporting a vector KML/KMZ file. 

o Added support for rotated symbols in KML/KMZ files. 

o Made the option to import DGN cells as points work for DGN v8 files. Previously 

it only worked for DGN v7 files. 

o Added option to write out ECEF coordinates when exporting to CSV and Simple 

ASCII Text format. 

o Added option to specify Security Classification and added an advanced option to 

write out empty frame files for CADRG/CIB export. 

o Added option to specify the maximum number of colors to use for a CADRG/CIB 

export. This allows you to reduce the number of significant colors considered to 

possibly enhance the presence of small features using colors not found in the rest 

of the map. 



o Fixed CADRG/CIB export with vector data that had poor results in areas of 

partial vector coverage. 

o Added option to select the Security Classification character for DTED exports. 

o Automatically recognize the elevation for spot heights and contour lines from 

OSGB GML files. 

o Load <node> entities from OSM XML files if they have any non-default 

attributes and not just a recognized OSM type. 

o Updated OSM XML exports to remember the last used automatically assigned 

node and way IDs so that subsequent exports will have unique ID ranges. 

o Remove quotes automatically from attribute values in generic ASCII text file 

import. 

o Add Tiling tab to CSV export to allow gridding into tiles. 

o Updated GMG export to default to using lossless compression. Also made that 

setting be remembered between runs. 

o Added many more recognized names for GRIB format weather products. 

o Made batch conversion from Arc Binary Grid files uses folder name for new file 

name rather than w001001 since all Arc Binary Grid files use the same filename. 

o Added option to export the Y/Latitude coordinate before the X/Longitude 

coordinate when batch converting to Simple ASCII Text, XYZ Grid, and XY 

Color files. 

o Updated OSM XML export to always write out a ‘version’ attribute for each 

<node>  and <way> element written out. A value of version=’1’ is used if no 

version field already existed. 

o Added support for automatically getting position and projection from Diva GIS 

.grd files. 

o Added MBTiles and RMaps exports to the File->Export Raster Data menu. 

Previously they were only on the File->Export Web Format menu. 

o Improved handling of Hydra clutter (.Z1C) files. 

o Fixed problems running out of memory when exporting to web formats (Google 

Maps, Bing Maps, etc.) and cropping to areas that are separated by great distances 

so the entire tile set would be millions of tiles if not cropped to the selected areas. 

o Added option to web format exports (Google Maps/Bing Maps/OSM/TMS/etc.) 

to allow specifying a custom tile naming scheme, including with hexadecimal-

formatted rows and columns using %x_hex and %y_hex in the names. 

o Updated web exports (Google Maps/Bing Maps) where JPG is used for most tiles 

and PNG for any transparent tiles to save the forced PNG tiles with a .jpg 

extension so that the generated HTML will still display everything. 

o Updated web exports (OSM/TMS/Google/Bing) to discard any edge tiles that 

have less than one half pixel of overlap with the output rectangle. 

o Updated Geographix CDF import/export to support rotated labels and 

automatically place line labels along the line at an appropriate location. 

o Added additional producer codes for CADRG/CIB exports. 

o Added option to DWG export to control whether or not 2D lines with a single 

elevation (like contour lines) are saved as 3D lines or 2D lines with an elevation. 

o Added support for LogASCII well files with the lat/lon stored in a FL1 field. 



o Defer errors encountered while reading from MrSID files during export until the 

end of the export. The problem areas will be filled with the background color or 

black. 

o Updated Garmin JNX export to include the Product ID everywhere it is needed in 

the output file so that BaseCamp can activate it properly. 

o Allow selecting a band marked as an alpha channel as a data band for MrSID and 

JPEG2000 images. This allows doing multi-spectral analysis on files that 

incorrectly mark a data band as an alpha channel. 

o Added option to control whether or not elevation attributes are included when 

batch converting to MapInfo MIF/MID and TAB/MAP files. 

o Added support for wildcard characters (‘*’ and ‘?’) in the PDF layer names in the 

LOAD_FLAGS of the IMPORT command. 

o Create BSB file alongside KAP when exporting to the BSB chart format. In 

scripts you can disable this by adding CREATE_BSB_FILE=NO to the 

EXPORT_RASTER command. 

o Fixed problems displaying some BSB charts. 

o Fixed loading of binary DXF files. 

o Fixed rendering of some SPLINE entities from DXF and OCAD files. Advanced 

users can customize how many points are used to stroke a spline curve with a 

given number of control points by creating a DWORD value in the registry named 

‘SplineCurveMult’ at ‘HKEY_CURRENT_USER\Software\GlobalMapper’ with 

the number to multiply the control point count by to get the final vertex count. 

The default value is 8, so a spline with 4 control points will have 32 vertices. 

o Added support loading ELLIPSE entities from DXF and DWG files. 

o Made text exported to DXF files maintain its color. 

o Made any .THF file be recognized for use with a ASRP/ADRG format file. 

o Fixed loading of text from OCAD files. Only half of the text was loading in some 

cases. 

o Fixed problem where original elevation as read from a 3D point Shapefile won’t 

go away even if you edit the attributes. 

o Updated PDF export of labeled area features to ensure the area label is included in 

the PDF if the area is cropped. The label location will be moved to a central 

location in the cropped area. 

o Fixed alignment and font issues, especially with rotated text, for PDF export. 

o Added support for more vector features from EMF files, like Bezier curves and 

complex paths. 

o Fixed problem with areas in 3D Shapefiles not loading if the only have 2 unique 

points if elevations are ignored but 3 (or more) if Z values are considered. 

o Automatically load additional models in DGN files if the active model is empty. 

o Fixed crash loading some rare YCbCr-encoded TIFF files in 64-bit builds. 

o Fixed problem with striped and background line and area border styles not 

exporting properly to PDF files. 

o Fixed bug with vector-based symbols, like many Geology symbols, not exporting 

to PDF files. 

o Fixed problems loading some CityGML files. 



o Fixed inconsistent scaling of vector exports to CADRG depending on the bounds 

of the loaded data and not the bounds of the export. 

o Fixed problem with elevation TIFF files with overview layers not displaying 

properly when the elevations are not stored in meters. 

o Fixed orientation and position of imported CPS3 grid files. 

o Fixed error loading some Erdas Imagine IMG files. 

o Fixed problem in v15.1 when exporting to MS SQL Server database with float 

field. 

o Fixed display of EXIF JPG files in map catalogs in v15.1. 

o Fixed error at end of loading large Surfer Grid ASCII files. 

o Fixed problems with large (over about 42,676) values in elevation GeoTIFF files 

with unsigned 16-bit samples drawing as invalid/voids. 

o Fixed saving of Albers Conic projections to MapInfo files. 

o Fixed crash loading some corrupt/incomplete LAZ files. 

o Fixed issue with point elevation units changing to meters if the Elevation 

Display/Export Units setting was set to ‘Native Layer Units’ on the Vertical 

Options tab of the Configuration dialog when exporting to formats like CSV. 

o Fixed crash in OSM XML export when one or more lines contains a RouteParam 

value with more than 12 fields. 

o Fixed vertical shift in output XY Color files when using a resolution that is an odd 

integer. 

o Fixed slow load of some Arc Binary Grids in v15.1. 

 Rendering/Style Changes 

o Added option to create a Quiver Plot from attributes of point features to easily 

create directed, scaled arrows (or other symbols). With this option you can select 

U and V vector attributes or Magnitude and Rotation attributes as well as a 

symbol to get rotated and scaled symbols (typically arrows) from the attributes of 

point features. The Quiver Plot functionality is available on the Point Styles tab of 

the Options dialog for a point layer as well as from the Attribute or Create Point 

Features right-click submenu of the Digitizer Tool. 

o Added new option to Vertical Options tab of the Configuration dialog to set up 

hill shading using multiple different light directions. This allows you to create a 

shaded elevation map that is less dependent on the light direction (azimuth) that 

you set up. 

o Added support for using attribute-based styles based on the description and type 

of features on the Styles tabs of the Options dialog for a vector layer. 

o Dramatically sped up feather blending of raster/terrain layers when feathering to 

complex polygon boundaries with a large number of vertices. 

o Made generated lat/lon grid lines with the Position Display Format set to DMS or 

DM trim any zeroes off of the end of the formatted coordinates so you don’t get 

unnecessary precision. 

o Made 3D view display the currently rendered data on a flat surface if no terrain 

data is available. 

o Added option to 3D view options dialog to control whether or not 3D vector 

features are drawn both in space and reflected on the terrain surface. By default 



they are also drawn on the terrain surface as they show in the top-down view. 

Now you can turn that off so they only show in space if you want. 

o Added support for displaying a North Arrow in the 3D View. Use the ‘C’ shortcut 

key to turn it on and off. 

o Added option to turn hill shading on and off for individual terrain layers rather 

than sharing the global hill shading option. 

o Added option to right-click menu in Swipe Tool to swipe the image that was 

right-clicked on. This helps you easily swipe away an image you want without 

knowing its name. 

o Made option to zoom to a selected layers be the first item in the right-click menu 

for a layer in the Control Center. 

o Made any custom shaders in use be saved in workspace files (DEFINE_SHADER 

command) so that if you use the workspace on another machine the custom shader 

will be display the same way on the other machine. 

o Updated exports of terrain where the displayed elevation range is based on what is 

in the display to also do the same for what is in the total export. 

o Made last used Map Layout no longer be remembered between sessions by 

default. There is a new checkbox option on the bottom of the Map Layout dialog 

if you do want it to be remembered like before, otherwise it will still save to 

workspaces as usual, but you will get a default map layout whenever starting a 

new session. The distance and elevation scale enable/disable state will be 

remembered regardless. 

o Greatly sped up cropping raster/elevation layers to complex polygon features 

from the Cropping tab of the Options dialog for the layers. 

o Add option to Info Tips configuration to allow displaying the elevation/color from 

all layers under the cursor rather than just the top-most layer. 

o Added Preview to the Custom Shader dialog so you can easily visualize what the 

custom shader colors will look like. 

o Made box minimum/maximum resamplers work for slope values (before they just 

provided the average). 

o When creating new area, line, and point types from the Styles tabs of the 

Configuration dialog, default the style to what is selected in the type list. 

o Support selecting point styles based on a point type wherever you can select a 

point symbol to use. This allows you to set up a point type with the symbol you 

want and then select by that type name rather than re-defining the point style 

somewhere else. 

o Greatly improved the appearance of the Geology - Arrow symbols when scaled or 

rotated. They are now vector symbols internally so they are clean no matter the 

scaling or rotation. 

o Added option to specify that line styles should render with flat “endcaps” rather 

than rounded as normal. There is a new checkbox option on all line styles dialog 

allowing you to specify that lines more than a single pixel wide should draw with 

a flat end. 

o Made default attribute list dialog for feature types be resizable. 

o When adding area/line/point types from a cGPSMapper RGNType.txt file from a 



Styles tab of the Configuration dialog, automatically assign the feature style from 

any existing GM type that the MP type code was mapped to. 

o Added option on Palette tab of Options dialog for palette-based layers to switch to 

a grayscale palette. This allows easily setting up a palette image for extraction of 

the raw palette indices rather than colors in a new palette on export to a grayscale 

format. 

o When rendering line direction arrows for line features with a label centered on the 

line, draw the direction arrow to the end of the line rather than under the label. 

o Fixed bug causing new copies of custom symbols to be created in the custom 

symbol folder with an increasing numeric prefix every time you start Global 

Mapper. 

o Fixed bug in 64-bit version when specifying a fixed height in meters for custom 

shape symbols that caused those symbols to not select in a symbol selection box. 

o Fixed slowness when changing the background color in v15.1.5-v15.1.6. 

o Fixed problem in v15.1.5-v15.1.7 with the hill shading setting being disabled 

whenever making a change on the Shader Options tab of the Configuration dialog. 

o Fixed display of 3D line features in the 3D view when they are set to use a 

different elevation unit than the elevation display units on the Vertical Options tab 

of the Configuration dialog. 

 Added new button on Search dialog to only ‘Search Selected Features’. This option will 

cause the search to only consider features that are currently selected with the Digitizer 

Tool. 

 Add checkbox option to Search dialog to make features selected in the Digitizer Tool 

automatically be selected in the Search dialog and vice-versa. 

 Made the results in the Search dialog be sorted in a case insensitive manner if the box to  

do a case sensitive search is not checked. 

 Added the ability (finally!) to edit the description of features using the feature edit dialog, 

the CALC ATTR option from the Control Center or the EDIT_VECTOR script 

command. 

 Made relative paths on UNC (network) paths work from workspaces and map catalogs so 

that you can now move workspaces around and share them from different locations even 

when referencing UNC paths (those that start with \\). 

 Updated the option to view the current view in Google Earth to have the option to include 

any selected features. 

 Add support for copying entire vector layers to the clipboard by selecting them in the 

Control Center and pressing Ctrl+C. You can then paste them to a new layer or instance 

of Global Mapper by using Ctrl+V. 

 Added prompt when loading a non-georeferenced BMP, GIF,  JPG, PNG, or TIFF file to 

have an option to load as a picture point instead of manually rectifying or faking position. 

You can then select the point to place the image on the map. 

 Made coverage bounding boxes created for cropped raster layers follow the bounds of the 

crop area rather than the bounds of the uncropped file. 

 Improved the default ‘Recent File Types’ filter to always include some very commonly 

used formats, like .tif, .shp, .kml. .las, .etc. 

 Fixed clipping of 3D lines to interpolate new Z values along clipped segments. 



 Added support for using a special attribute value of  <Feature Layer Group Name> in any 

place that an attribute can be selected for an operation. This will be the name of the group 

of layers that the feature is in. 

 Added new options when duplicate records are encountered when joining records to a 

loaded file. Now in addition to aborting the join or keeping the last match, you can keep 

all matches either by appending to the same attribute value or by creating new attributes 

with a numeric suffix. 

 When selecting a feature with the Feature Info tool that has an attribute value with a URL 

or a link to a file, you will now be prompted for an action to take automatically for that 

link, including opening the file/URL in the associated Windows shell application or 

browser or loading the file into Global Mapper. This provides more straight-forward 

access to some of the existing functionality that was on the right-click menus for the 

Feature Info dialog. That functionality is still there as well. 

 When selecting a feature with the Feature Info tool, automatically open any path 

specified in an OPEN_LINK attribute with the associated Windows application. Also 

support additional formats from the LINK attribute, including PDF, DOC, and Excel 

spreadsheet files. 

 Added new option on the Vector Display tab of the Configuration dialog to hide the 

display of style attributes on the Feature Info and Search dialogs. 

 When exporting to tiles using the Tiling tab on export, allow using special values %left%, 

%top%, %right%, and %bottom% for the numeric start value for the rows and columns. 

Those special values will be replaced with the corresponding edge of the tile cell 

bounding box. This allows you to easily get output filenames with the tile cell 

coordinates embedded in them. 

 Made further significant speed up to exports cropped to areas when you are cropped to 

multiple area features. The more areas you cropped to at once the faster it is now as 

compared to before. 

 Made the last used Tool be remembered between runs so if you use the Zoom, Pan, or 

Measure Tool that tool will automatically be selected when you start Global Mapper the 

next time. 

 Updated layer metadata to include 8 new entries, the longitude and latitude for each 

corner of the map bounding box in the current map projection datum. 

 Allow adding the ‘Open Sample Data’ option from the quick start buttons shown when 

you first open Global Mapper to the Favorites drop-down list on the toolbar so you can 

use it when you already have other data loaded. 

 Updated the batch geo-coder to recognize PROVINCE and POSTAL CODE as column 

names from a CSV/text file being geo-coded. 

 Made exports cropped to an area when keeping pixels if any part is in the crop area 

handle any type of intersection of the crop area with a pixel and not just those where the 

pixel center or any corner point is included. 

 If snapping an export to the nearest layer pixel boundary and cropping to an area, make 

sure that at least the entire area coverage is kept so we don’t lose anything on bottom or 

right if we snap up and/or to the left. 

 Made named views be immediately shared to other running instances of Global Mapper 

rather than requiring an instance to be closed then the other instance re-opened to make 

them available. 



 Fixed lockup saving GPS tracklog in some cases. 

 When initializing a new custom shader from an existing file (like a Surfer CLR file), 

initialize the shader name to the filename if the shader name is still the default. 

 Fixed rendering of ‘Solid with Black Edges’ line style when a fixed width in meters is 

used for the line. 

 Fixed problem with un-grouping a layer in the Control Center in the middle of a group 

also un-grouping the later layers in the same group. 

 Fixed problem with some windows showing off-screen when you go from a multiple 

monitor setup to a single monitor. In particular this was an issue with the Control Center. 

 Fixed display of nested progress dialogs on multi-monitor displays. 

 Fixed problem with ‘Select All’ (from everything or just in layer) not select islands/holes 

in parent areas so that subsequent operations don’t always do anything with those 

islands/holes. 

 Fixed bug with some edges of manually specific crop boundaries being lost when loaded 

from a workspace in v15.1.7-v15.1.8. 

 

WHAT'S NEW IN Global Mapper v15.1 

 Significant New Features 

o Added support for loading data from and exporting data to MS SQL Server 

Spatial databases. The spatial database import and export dialogs now have an 

option for MS SQL Server. 

o Updated the Raster Calculator to support calculations from elevation grid layers. 

You can now apply any custom formula to loaded terrain layers to create a new 

terrain layer. The layer may actually be a grid of other non-elevation values, like 

NDVI values, etc., so this opens up an entirely new set of analysis possibilities. 

o Dramatically sped up raster/elevation exports cropped to complex area features. 

For very complex areas (i.e. hundreds or thousands of vertices) the exports may 

be 10x as fast or even better! 

o Added built-in links several online sources, including all NASA GIBS (Global 

Imagery Browse) sources, Landsat8 imagery and Lidar data from the USGS 

EarthExplorer web site, and GlobCover ESA2009 Land Cover data. 

o Added Attribute Setup tab to Shapefile export to allow customizing exported 

attribute types and lengths. 

o Added option to generate contour lines directly from 3D TIN areas. This allows 

you to exactly maintain breaklines or other 3D features when you have a 3D TIN 

including those, such as you might save from the gridding process. There is a new 

Analysis menu command for generating contours from TIN areas. 

o Added option to 3D Path Profile to display the path from each terrain layer 

separately. This allows easily comparing the surface of multiple loaded terrain 

layers along a path. The new option is under the Display Options menu on the 

Path Profile dialog. 

o Added support for writing Adobe ISO 32000 Extensions to PDF and 3D PDF 

export. These are the Adobe-standard for geo-spatial PDF files. The PDF export 

options include a checkbox option to specify that this type of placement 

information should be saved. 



o Added new Recent File Types filter in the File->Open dialog to track commonly 

used file types. As you open files those you use the most often will be added to 

that filter. It will start with the contents of the Commonly Used Formats filter, but 

will adapt over time as you use the software. 

 New Supported Formats 

o Added support for loading data from and exporting data to MS SQL Server 

Spatial databases. The spatial database import and export dialogs now have an 

option for MS SQL Server. 

o Added support for loading generic MS Access (MDB) files with point data. You 

are prompted for the fields to get the coordinate data from. This works for things 

like GPSeismic files. Note that because there is not a 64-bit MS Access driver 

generally available you have to use the 32-bit Global Mapper to load these files. 

o [LIDAR MODULE ONLY] Added support for loading Leica PTS point cloud 

files. 

o Added support for loading new GvLF Lidar database format (.gvl). 

o Added support for exporting 3D terrain and features to U3D files. 

o Added support for loading ECRG (Enhanced Compressed Raster Graphics) 

toc.xml files. 

o Added support for loading new ECW v3 format. 

o Added support for loading Field Survey XML files from Trimble devices. 

o Added support for loading GML files from the Finnish Land Survey. 

o Added support for loading Kongsberg SIS plan format files. 

o Added support for loading text file listing location and bounding box of OSM tile 

images in format of filename and 4 bounding box columns in lat/lon. 

 Lidar Changes 

o [LIDAR MODULE ONLY] Added additional selection option on path profile 

dialog with Lidar points shown to select by drawing a polygon. 

o [LIDAR MODULE ONLY] Added support for loading Leica PTS point cloud 

files. 

o [LIDAR MODULE ONLY] Added option when batch converting to Lidar 

LAS/LAZ files to apply color from loaded imagery. 

o [LIDAR MODULE ONLY] Made searching by HEIGHT_ABOVE_GROUND 

attribute possible in vector search dialog. 

o Added built-in links to online Lidar data from the USGS and other US agencies 

under new Lidar group in online source dialog. The USGS National Lidar Dataset 

is linked to via EarthExplorer. The bounds you specify will automatically be sent 

to the EarthExplorer site for easy download. 

o Made batch converting Lidar point clouds with RGB colors to new LAS/LAZ 

files automatically include the colors in the output files. 

o Updated Digitizer Tool option to count points inside selected area features to 

count Lidar point cloud points. 

o Added option to render Lidar points by the point source ID. In addition the point 

source ID is available as a SOURCE_ID attribute and can be searched on and you 

can choose to load just a particular source ID when loading Lidar files. 

o  [LIDAR MODULE ONLY] Allow adding favorites toolbar option to set any 



Lidar classification from 0-20 so you can add 1 click (or keyboard shortcut) 

access to reclassify selected Lidar points to any classification that you need. 

o [LIDAR MODULE ONLY] Added option to automatic classification of ground 

points to reset any pre-existing ground points to unclassified for the operation. 

This is useful if you want to re-run the operation with different parameters and 

start from scratch. 

o Correct Lidar point classifications between 10 and 17 to match ASPRS definitions 

(for example 10 is Rail, not Bridge, and Bridge is 17). Also added classification 

code 18 for High Noise points. 

o  [LIDAR MODULE ONLY] Fixed binned gridding of Lidar data after load from 

Analysis menu to obey a bin spacing provided in current projection units rather 

than as a multiple of native point spacing. 

o [LIDAR MODULE ONLY] Improved automatic classification of ground points 

for multi-return data by only considering the last return of each pulse. 

o Allow export of Lidar point clouds to PLS-CADD format files. 

o Fixed error when discarding points outside of some range (in standard deviations) 

from the mean on load. 

o Fixed error saving workspace with modifications to a Lidar point cloud if all 

Lidar classifications in the point cloud are turned off on the Lidar Configuration 

dialog. 

o Fixed color of Lidar points on map legend to reflect custom Lidar colors from the 

Lidar Configuration tab. 

 Analysis Function Changes 

o Added option to generate contour lines directly from 3D TIN areas. This allows 

you to exactly maintain breaklines or other 3D features when you have a 3D TIN 

including those, such as you might save from the gridding process. There is a new 

Analysis menu command for generating contours from TIN areas. 

o Added option to 3D Path Profile to display the path from each terrain layer 

separately. This allows easily comparing the surface of multiple loaded terrain 

layers along a path. The new option is under the Display Options menu on the 

Path Profile dialog. You can also right-click on the profile itself when this option 

is enabled and select a new option to specify what color to use for each terrain 

layer line. 

o Added option to get the min/max/avg elevation in a corridor around a defined 

path for 3D path profile display and line-of-sight analysis. There are new menu 

commands under the Path Setup menu on the 3D Path Profile dialog for defining 

an elevation corridor. You can specify the corridor width and specify whether to 

use the minimum, maximum, or average elevation encountered along lines 

perpendicular to each sample location. 

o Added option to save a 3D Path Profile to a DXF file directly from the File menu 

on the Path Profile dialog. 

o Updated the Raster Calculator to support calculations from elevation grid layers. 

You can now apply any custom formula to loaded terrain layers to create a new 

terrain layer. The layer may actually be a grid of other non-elevation values, like 

NDVI values, etc., so this opens up an entirely new set of analysis possibilities. 



o Added built-in Raster Calculator formula for NBR (Normalized Burn Ratio). 

o Added built-in NDVI shader for displaying calculated NDVI data grid data in a 

nice manner. If you select a NDVI formula then the display will default to the 

NDVI shader. 

o Added new Analysis menu command to ‘Create Layer Statistics Report’. This 

allows you to analyze loaded vector layers and generate a report of feature counts 

and attributes. This provides the functionality of the GENERATE_REPORT 

script command in the user interface. You can also get this by right-clicking on a 

layer in the Control Center and selecting to display layer statistics. 

o Added option to the Line of Sight dialog so that you can specify the from or to 

elevations are relative to a selected layer rather than just ground or sea level. This 

allows you to specify transmission relative to an actual ground layer while 

including things like clutter or obstruction layers on top for the line of sight, like 

perhaps a tower extending above trees that act as obstructions. 

o Added option when finding ridge lines to only find ridge lines above some 

minimum elevation. 

o Added option to Generate Contours dialog to discard any closed contour line 

segments below some minimum length threshold in meters. This makes it easy to 

discard any very short little contours that commonly crop up in very detailed data 

sets, like those derived from Lidar. 

o Added Resampling method selector on the Generate Contours dialog for selecting 

which resampling method to use when sampling terrain layers during contour 

generation. 

o Fixed problem with the Pile Volume calculations results not being consistent with 

the results if you add elevations from the terrain to the area vertices then calculate 

against that. 

o Fixed problem with high bit-depth images created with the Raster Calculator not 

displaying properly if the calculated values are larger than 255. 

o Fixed problem with tiny unconnected line segments sometimes being created as 

part of contour generation. 

o Fixed path profile when sampled at a fixed distance interval to not include the 

non-endpoint vertices that aren’t at an exact distance multiple. 

o Fixed problem with inconsistent path profile/line-of-sight results depending on 

your zoom level when creating the path profile. 

o Fixed crash when doing a path profile where no elevations are available on the 

path. 

 Digitizer Tool Changes 

o Added polygon selection mode in the Digitizer Tool. You can enable this under 

the Advanced Selection submenu, then you can draw a polygon by left clicking to 

define a region to select features in. 

o Added option to create point features at grid line intersections when creating a 

regular grid of features. This new option on the Create Regular Grid dialog allows 

you to get a point feature named for the grid cell it anchors created automatically 

at each grid cell intersection. 

o Added option to create ellipses with a defined major and minor axis length and 



rotation with the Create Range Ring option. 

o Added option to select all point/Lidar features within some distance of selected 

line features. The option is under the Advanced Selection right-click submenu 

when you have one or more line features selected. 

o Added option when applying elevations to selected vector features from loaded 

terrain layers to add the terrain elevations to any existing elevations (i.e. make the 

elevations relative) rather than just overwriting any existing elevation values with 

the terrain elevations. 

o Added option to copy attributes from point to lines features with the Copy 

Attributes option in the Digitizer Tool. 

o Added option when copying attributes between feature types to handle when more 

than one “from” feature is in or near the “to” feature. 

o Updated the option to show a path profile for a selected line feature to allow 

showing the path profile dialog for up to 8 selected lines at once. Each selected 

line will get its own dialog. 

o [GEM Module Only] Added a new checkbox option to the 'Create Flattened Site 

Pad Plan' dialog to specify that the new flattened terrain should be inside the 

selected area(s) rather than outside. This means that the new terrain will smoothly 

transition from the heights at the edge of the area to the terrain surface inside the 

area. 

o Updated the regular grid creation so you can now choose to either anchor it to the 

top-left point like before or specify to fill a box. If you choose to put the grid in a 

box, you select the box you want and just the number of rows/columns or the cell 

width/height, then the other value is calculated from the box. 

o Added option when creating coverage polygons for features (and layers) to 

control how “smooth” the resulting polygon is relative to the data. 

o Added options when creating points from area centroids to control whether or not 

the points are moved inside the areas if the centroid is outside the area (the 

default) and also whether only a single centroid per group is created if you have 

grouped areas. 

o When creating points at line intersections, include the attributes of the intersecting 

lines as attributes of the new intersection points. The attribute names will be 

prefixed with LINE1 or LINE2 depending on which line they came from. 

o When creating points at the centroids of selected area features, make sure the 

point doesn’t end up inside an island of the area. 

o When you move a vertex of a 3D line to a location that snaps to a 3D feature, the 

Z value of the vertex is now updated to the Z value of the snapped location. 

o Made creating multiple new area features from lines in separate operations default 

the layer to the last selected layer for the new areas rather than always defaulting 

back to the User Created Features layer. 

o Fixed problem with the Z values assigned to area vertices being divided by 100 

when you snapped to existing 3D points/vertices. 

 Scripting Changes 

o Added support for adding vector features from inside a script by using a new 

DEFINE_TEXT_FILE command which allows embedded text descriptions of 



features right in the script and then loading with IMPORT_ASCII. 

o Added new Favorites toolbar option to ‘Run Last Script from Run Script 

Command.’ This option will run the last script that you ran via the File->Run 

Script command. 

o Added support for generating contours from 3D TIN areas by adding 

GEN_FROM_TIN_AREAS=YES to the GENERATE_CONTOURS script 

command. 

o Added new LOG_MESSAGE command to allow writing any string (including 

variable values) to the current script log. 

o Added support for copying attributes from point to line features using the 

COPY_ATTRS script command. 

o Added support for controlling the copying of attributes from areas to points when 

there are multiple areas containing a point with a new MULTI_AREA parameter 

for COPY_ATTRS. 

o Added support for controlling the copying of attributes from areas to lines when 

there are multiple areas containing a line with a new MULTI_AREA parameter 

for COPY_ATTRS. 

o Allow overriding the palette interpretation of a layer in the IMPORT or 

SET_LAYER_OPTIONS script commands by adding a PALETTE_NAME 

parameter with the filename of a palette file to use. 

o Added support for wildcard matches in type names in EDIT_VECTOR compare 

strings rather than requiring an exact match or a match on all types. 

o Added support for replacing new-line character sequences using the 

EDIT_VECTOR command. Just use \n in the from or to side of an 

ATTR_REPLACE_STR parameter. 

o Added support for cropping layers to a polygon boundary specified in layer pixel 

coordinates rather than layer native coordinates. Do this by defining the pixel 

boundary with a DEFINE_SHAPE command and adding 

CLIP_COLLAR_POLY_PIXEL=YES to the IMPORT command. 

o Added support for specifying a producer code and security classification for 

DTED exports using EXPORT_ELEVATION. New DTED_PRODUCER_CODE 

and DTED_SECURITY_CLASS parameters are now available. 

o [LIDAR MODULE ONLY] Support using bin-based gridding with 

GENERATE_ELEV_GRID script command via GRID_ALG and 

GRID_BIN_SIZE parameters. 

o Added option to create area skeleton lines using the EDIT_VECTOR command. 

Add CREATE_SKELETON_LINES=YES to the command to create them. 

o Updated creation of buffers with the EDIT_VECTOR command to support 

putting the buffer distance units right in the BUFFER_DIST parameter. Also 

made units of MILES work, they were treated as meters before. 

o Updated match on loaded layer filenames and descriptions with wildcards to do a 

case-insensitive search of loaded layers. 

o Added support for appending results of EXPORT_METADATA to existing text 

file by adding APPEND_TO_FILE=YES to the command. You can also add a 

custom header line with a new HEADER parameter and add an extra blank line 



with ADD_BLANK_LINE=YES. 

o Added option to SPLIT_LAYER script command to make the description for the 

new layers just the attribute value instead of also including the original 

description. Add LAYER_DESC_ATTR_ONLY=YES to enable this. 

o Added SCALE_XY_AS_TENTHS and SCALE_Z_AS_TENTHS parameters for 

the EXPORT_VECTOR command when exporting to SEGP1. They provide the 

same options that the interface has when exporting SEGP1 files. 

o Made PRECISION parameter for EXPORT_VECTOR script command also work 

for SVG exports. 

o Added support for customizing the color format used for 

GENERATE_EQUAL_VAL_AREAS command with new ATTR_FORMAT 

parameter. 

o Allow specifying colors as raw integers or hex representation like “#RRGGBB”. 

o Made GEN_TAB_FILE work when exporting to ECW or JPEG2000 files with 

EXPORT_RASTER command. 

o Made DEFINE_VAR prompts shown when running a script in batch mode from a 

command line if no default value is provided or the prompt is for a directory or 

file. 

o Fixed save of world file from EXPORT_ELEVATION script command to specify 

correct spacing and corner. 

o Made Run Script dialog title bar show the filename of the script that is loaded. 

o Allow using letters for PRODUCER_CODE for CADRG/CIB exports with 

EXPORT_RASTER. 

o Added support for adding USE_CENTER_COORDS for ARCASCIIGRID export 

with EXPORT_ELEVATION script command. 

o Added support for importing text files with a per-vertex time column using the 

IMPORT_ASCII command with a custom COORD_ORDER parameter 

describing where the time column is located. 

o Added support for a new PIXEL_SIZE_MAX parameter for EXPORT_RASTER 

and EXPORT_ELEVATION commands where you can specify the maximum 

pixel dimensions to use. Either width or height may be shrunk to maintain sample 

spacing. 

o Added support for specifying slope values in percent rather than degrees when 

defining a shader via the DEFINE_SHADER script command. Add 

SLOPES_PERCENT=YES to command to indicate the slopes are in percent. 

 Projection/Datum Changes 

o Made custom datum definitions save into Global Mapper file formats, like .gmw, 

.gmp, and .gmg. This allows you to load a file or workspace saved with a custom 

datum on another machine and have that datum automatically added to the new 

machine. 

o Made unrecognized ellipsoids in WKT PRJ files automatically be added as a 

custom ellipsoid. 

o Added option to set the current view/export projection from a WKT projection 

string stored in a feature attribute. Now if you have a feature attribute whose 

value is a projection string (like from a PRJ file), you can right-click on that 



attribute in the Feature Info dialog and set the current view/export projection 

based on the attribute value. 

o Updated Equirectangular projection to match Esri products when using datums 

based on an ellipsoid. Note this will make any saved Equirectangular data from 

GM prior to v15.0.4 not match the results of anything after v15.0.4. This is a 

rarely used projection though. 

o Improved handling of "Local" projections with rotations to and from WKT PRJ 

files to match Esri. 

o Added built-in Naparima 1955 datum. 

o Added support for additional EPSG codes. 

o Updated datum shift file for ED50 (Spain/Portugal) to new file from 2009. 

o Fixed Transverse Mercator transformation with negative northing values and 

displaying in a projection system with a datum based on a sphere rather than an 

ellipsoid. 

 Online Source Changes 

o Added built-in links to all NASA GIBS (Global Imagery Browse) sources. This 

includes daily imagery from the AQUA, MODIS, and TERRA satellites among 

many others. There is an entire NASA GIBS group in the online download dialog 

that provides quick access to all of the sources. 

o Added built-in links to Landsat8 downloads from USGS Earth Explorer. The 

Landsat8 data is not available as a streaming source, so the new source just takes 

you to the web site. 

o Added built-in links to online Lidar data from the USGS and other US agencies 

under new Lidar group in online source dialog. The USGS National Lidar Dataset 

is linked to via EarthExplorer. The bounds you specify will automatically be sent 

to the EarthExplorer site for easy download. 

o Added built-in GlobCover Land Cover ESA 2009 source. This source provides 

land cover data for the entire world. A built-in roughness tab for calculating 

roughness grids from the ESA 2009 data is also included. 

o Added prompt for dimension values for streaming WMTS sources that have 

customizable variables, like a time/date for NASA GIBS sources so you can pull 

down imagery from whatever date you need. 

o Fixed problems with using WMS sources set to not draw with tiles and also using 

the option to limit the zoom level range they display at. The data was still 

downloading even at zoom scales it wasn’t requested. 

o Fixed error using WMS sources with a negative “resx” or “resy” tag value in the 

layer definition. 

o Improved status reporting when sources are down so that you can get additional 

information about what is going on with a data source without having to contact 

technical support. 

o Added new 'Export: Online Sources Use Same Scale Logic as Draw' option to 

Advanced section of General tab of Configuration dialog so that the zoom scale 

selection logic works the same for online layers when exporting and drawing. If 

unchecked draws will skew more towards the lower resolution layer (when scale 

is between 2 zoom scales on the online server) while exports will pick up the 



more detailed layer sooner. If checked then both exports and draws use the draw 

behavior. 

 Format Specific Changes 

o Added support for Adobe ISO 32000 Geospatial Extensions to PDF and 3D PDF 

export. 

o  [GEM Module Only] Improved loading of IHS Well (297/298) files so that 

directional surveys for each well come in as separate lines and you can better 

visualize the entire well path in the 3D viewer. 

o Added Attribute Setup tab to Shapefile export to allow customizing exported 

attribute types and lengths. 

o You can now load KML files that reference local imagery (<GroundOverlay> 

tags) and those will load like a map catalog with the bounds of each image shown 

until you zoom in. 

o Added support for positioning rotated images from KML files that use the 

gx:LatLonQuad tag of a <GroundOverlay> to provide the corner coordinates. 

o Re-enabled support for loading KML files that are marked as UTF-8 but have 

improperly encoded characters internally. 

o Fixed Wasp Map export problems with cross-point and other others due to 

overlapping or touching roughness areas. 

o Added support for loading Parcels from LandXML files. 

o Further rendering improvements for complex DXF/DWG files, including fixing 

problems with lines that are too wide and better support for multi-line text. 

o Made DWG exports of 2D line features create 2D polylines rather than 3D 

polylines. 

o Improved quality of CADRG exports when vector data is included in the export. 

o Updated Geographix CDF import to add attributes for PLSS and Texas Land  

Survey System attributes in ‘B’ records. 

o Updated Geographix CDF export to include PLSS survey information in export 

‘B’ records for survey section areas. 

o When exporting to Platte River .dat files, don’t add .0 to township and range 

values. 

o Added additional layer Metadata reporting for ASRP, CADRG, CIB, DTED, and 

ECRG format data. 

o Improved display of imagery with 32-bit floating point samples. 

o Updated BSB export to add dimmed palettes for dusk and night display. 

o Added option to specify elevation digits of precision and resampling method 

when exporting to XYZ Grid files. 

o Added option when exporting vector KML/KMZ files to control whether or not 

picture points (i.e. points with externally linked images, like a JPEG with an EXIF 

position) are embedded directly in the KMZ or are just linked to the local file on 

disk. 

o Support loading of attribute/value pairs from <description> tags in KML files 

where an HTML table is used with a single row of attribute names and another 

row of attribute values. 

o Fixed load of 3D area features from KML/KMZ files (only a single elevation used 



before). 

o Added option to use WKT formatting and includes area and line features when 

batch converting to CSV format files. 

o Added display of additional metadata values for NITF format files. 

o Updated Wasp Map export to include both roughness and elevation for area 

features with both. 

o Allow loading NetCDF files directly from .grd.gz files. 

o Made export of background lines (i.e. thick road backgrounds, striped lines, etc) 

work to PDF files. 

o Added option when batch converting from PDF format files to control whether or 

not PDF layers that are hidden by default are included in the exported results or 

not. 

o Added support for loading NetCDF files with 32-bit integer samples for the grid. 

o Added support for GRIB files from NOAA with Polar Stereographic projections 

and with longitudes from 0-360. 

o Fixed inversion of some PDF files positioned with Adobe 32000 position data. 

o Fixed export of 3D vector data to 3D PDF files so that all elevations are converted 

to meters so they are consistent with the terrain. 

o Fixed error loading some S-57/S-63 data sets. 

o Made the DGN import option to import cells as points work for DGN v7 files. 

Does not currently work for newer DGN files. 

o Fixed problem with fixed width area border styles not saving to GMW and GMP 

files. 

o Fixed error saving a workspace with modified ASCII text files that contained 

areas. 

o Fixed display of 32-bit TIFF grayscale imagery with invalid values of -

2147483647. 

o Remove extra blank line after header lines when exporting to SEGP1 format. 

o Fixed problem with PRJ file not being found automatically for SHP files on a 

network drive that has case-sensitive filenames. 

o Fixed error reading OTF feature template file. 

o Fixed problem with attributes coming in wrong for text files with WKT 

coordinates in the first column. 

 Rendering/Style Changes 

o Added support for rotated multi-line text. 

o Added new line styles for double lines with lines on the outside path but not the 

middle. 

o Added support for specifying a background color and width for any line style to 

allow drawing a solid line of any color behind any line style. 

o Added new line styles for rendering lines based on elevation. This will use the 

current elevation shader to colorize each line segment based on the average 

elevation of the segment. This is useful for GPS tracklogs and other 3D lines, like 

contours. There is also a special GPS menu option to enable this for track lines 

which is just a shortcut to set the track line style to use elevation shading. You can 

also render the GPS vessel itself in a color from the current elevation. 



o Added the ability to specify flat end caps for line styles. 

o Updated Swipe Tool to allow swiping multiple layers rather than just a single one. 

Useful if you have a group of layers that you want to swipe on and off rather than 

just a single one. 

o Made Map Layout text display on top of any fixed screen ‘always on top’ layers, 

rather than under them. This allows you to easily place labels on top of things like 

custom logos and legends. 

o If you edit the style for multiple selected attribute-based styles on a Styles tab of 

the Options dialog for a vector layer and you change the color, the color will now 

apply to all selected styles. If you don’t change the color the original color will be 

kept, allowing you to change the style of multiple values without making them 

use the same color. 

o Fixed loading of Surfer ASCII Grid files that use tabs rather than spaces in file 

header. 

 Updated the Feature Info Tips display setup under the View menu to allow providing a 

custom formatting string, similar to how you set up custom label display. 

 Updated display of nearest feature elevation in status bar to be in current Elevation 

Display/Export Units rather than always native layer units. 

 Fixed problem with drag-and-drop not working from Windows Explorer on machines 

with Windows UAC enabled. 

 Made metadata display for layers in the Map Catalog Options dialog actually load the 

layer and show the full metadata rather than just general metadata. 

 Added * after workspace name in title bar if the workspace has un-saved modifications. 

 Added new right-click option for layers in the Control Center to control whether or not 

export is allowed from the layer. This is stored in workspace files as well. 

 Added new Position Display Format option to show lat/lon values as just plain decimal 

with no degree symbol or hemisphere indicator. You can select this in the Position 

Display Format setting on the General tab of the Configuration dialog. 

 Added optional tracking and reporting of errors encountered and commands and formats 

used so that we can better concentrate our development efforts on the most commonly 

used functions and also fix bugs even faster. You can disable tracking under the Help 

menu. No identifying information or mapping data itself is included with the reporting, 

only statistics about what is being used and any errors. 

 Made the statistics displayed when right-clicking on a numeric column in the Search 

dialog and selecting to display stats show the sum of the values in addition to the other 

stats. 

 Updated check-in of borrowed license to automatically check license back out normally 

from the license server rather than requiring you to re-register against the license server. 

 Made the ‘borrow until’ date show on the Help->About dialog if using a borrowed 

license from a network license server. 

 Improved automatic adding of commonly used commands to the Favorites toolbar to add 

more commands used in the Digitizer Tool. 

 Made the ‘Shift Layers’ option in the Control Center remember the last offset units and 

values. 

 Fixed problem with custom vector point symbols from DXF files being vertically flipped. 



 Fixed favorite option to move selected vertices to work if only a single vertex is selected. 

 Fixed problems with favorite shortcuts using special characters like commas. 

 Made GPS NMEA data log dialog resizable. 

 Fixed slowdown replaying a recorded GPS NMEA log in real-time. The display was very 

unresponsive. 

 Fixed problem with GPS menu option to keep the vessel on screen being disabled. 

 Fixed problem with some settings, like custom styles and custom datums, not saving and 

being available in the next session if some Global Mapper SDK-based applications had 

been run on the machine, such as SonarWiz. 

 Fixed PolygonClipper.cpp error when exporting reprojected data with islands where 

some of the islands of an area cannot be displayed in the export projection. 

 Fixed crash showing metadata for a layer in a map catalog. 

 

WHAT'S NEW IN Global Mapper v15.0 

 Significant New Features 

o Added support for feature extension plugins to Global Mapper. These allow 3rd-

parties and customers to create add-ins to Global Mapper to extend the 

functionality through their own toolbars and/or menu items. The feature 

extensions will have access to all data loaded in the Global Mapper application 

instance through same API used by the Global Mapper SDK. There is an item 

under the Help menu for managing the installation and registration of feature 

extension plugins and add-in modules. There are 2 extensions included with the 

install, a COAST extension allowing cost-analysis of sea level rise simulations, 

and a Map Overview extension to allow adding a separate map window allowing 

easy navigation around the entirety of the loaded data. 

o Added separately licensed Lidar module with advanced Lidar analysis 

functionality. See Lidar Changes section below for details. The licensing is 

handled under a new Help menu option for working with module and feature 

extension licenses. 

o Added Raster Calculator under Analysis menu for performing mathematical 

operations on multi-band imagery to extract different types of information. You 

can use pre-defined formulas, like NDVI and NDWI, or create your own free-

hand formulas using common mathematical operations, like addition, subtraction, 

multiplication, division, and powers, as well as simple operators like absolute 

value, minimum value, and maximum value of 2 values. 

o Added option to adjust the elevation shader colors based on just the elevations in 

the current view. There is a new option on the Vertical Options tab of the 

Configuration dialog to enable this behavior. It allows easily pulling out localized 

elevation differences when you zoom in to an area with small relief changes 

relative to the entirety of the loaded data. 

o Added support for passing variables on the command line to a script. You can 

provide the variable after the script (.gms) filename itself on the command line in 

the form ‘-var_name var_value’. For example, ‘global_mapper.exe 

“c:\my_path\my_script.gms” -my_var my_var_value’. 

 New Supported Formats 



o Added support for importing and exporting 3D PDF files. Underlying data format 

in PDF 3D Annotations may be U3D or PRC. We do not support the less common 

PRC format at this time. 

o [LIDAR MODULE ONLY] Added support for loading E57 Lidar files. 

o Added support for CMIP5 HDF5 data sets with sea surface temperatures. 

o Added support for loading text files with the coordinates stored as ECEF (Earth-

Centered Earth-Fixed) coordinates. The Coordinate Format drop-down on the 

ASCII Text Import dialog has an option to specify that the coordinates are ECEF. 

o Added support for GCP (control-point) files with the pixel coordinates specified 

as a percentage value rather than an absolute pixel coordinate. So if you have text 

placement files with just the corner coordinates you can easily add 0% or 100% 

for the X and Y pixel coordinates of each corner to get a good placement. 

o Added support for loading ANUGA Rainfall and Greenland Terrain NetCDF 

format files. 

 Lidar Changes 

o Added a new premium Lidar add-on module with advanced Lidar analysis tools. 

You can activate the Lidar module license under the new Help menu command 

for managing modules and feature extensions. 

o [LIDAR MODULE ONLY] Added new  binning methods for gridding Lidar 

point clouds. You can now create a regular grid from the minimum, maximum, or 

average value in individual “buckets”. This method is extremely fast compared to 

the normal triangulation-based approach. You can select which method to use on 

the dialog that appears when importing Lidar data. 

o [LIDAR MODULE ONLY] Added support for displaying and editing the 

classification of Lidar points in the path profile tool. You can control the corridor 

width and select displayed Lidar points in the path and reclassify them or delete 

them. Any Lidar points that are displayed are also considering for line-of-sight 

operations. 

o [LIDAR MODULE ONLY] Added support for applying colors from loaded 

imagery layers to loaded Lidar point clouds directly in memory. This allows 

easily creating a fully colorized Lidar data set without having to export to a new 

LAS/LAZ file first. 

o [LIDAR MODULE ONLY] Added support for automatically identifying and 

classifying ground-shot points from unclassified Lidar point clouds. 

o [LIDAR MODULE ONLY] Added support for drawing points from a point cloud 

as a ‘height above ground’. This will determine a ground elevation for all 

locations under the point cloud (using classified ground and water points if 

available) and then display the height relative to that. The new draw mode is 

available on the Lidar draw mode drop-downs. 

o [LIDAR MODULE ONLY] Added support for exporting elevations to LAS/LAZ 

points from a point cloud as a ‘height above ground’. There is a new checkbox 

option on the LAS/LAZ export dialog allowing you to specify that the saved Z 

values should be heights above ground rather than the normal elevation. You can 

also script export of height above ground by adding 

SAVE_HEIGHTS_ABOVE_GROUND to the EXPORT_VECTOR command for 



LAS/LAZ export. 

o Added new Lidar tab to Configuration dialog for easily filtering Lidar data by 

classification and return type. 

o [LIDAR MODULE ONLY] Added support for saving Lidar statistics from a 

script. If you add ADD_LIDAR_STATS=YES to an EXPORT_METADATA 

script command you get all of the information from the Statistics tab of the 

Metadata dialog dumped to the file. 

o [LIDAR MODULE ONLY] Added Alter Elevation Values tab to Lidar options 

dialog to allow offset, scale, and  range restriction of Lidar point cloud data. This 

is the same as the Alter Elevation Values tab available for gridded elevation 

layers. 

o Faster drawing of large Lidar point clouds by using multiple cores/processors. 

o Much faster drawing of reprojected Lidar point clouds when zoomed out so the 

point cloud takes up only a tiny part of the screen. 

o Added new option on Lidar Options dialog to control the brightness when 

coloring by intensity. 

o Added support for new ASPRS classifications 40-45 from Topo-Bathy Profile for 

bathymetric points. 

o Support exporting Lidar point cloud data to DGN and PDF files. 

o Improved the reported density figure (points per square meter) on the metadata 

dialog for Lidar point clouds. Now the point cloud is chopped up into a grid and 

the count of points in each piece of the grid is used to calculate more localized 

densities, then those are analyzed to get a good representative density that skews 

towards the denser parts of the cloud. This is especially improved for point clouds 

with large areas of no data as those no longer bring down the calculated density. 

o Fixed bug editing Lidar points from some Lidar files, particularly ASCII Text or 

MrSID Lidar, LAS/LAZ editing was not affected. 

o Fixed bug that caused RGB colors to not display for point clouds with less than 

512 points. 

o Fixed bug that would cause the scan angle to be reported incorrectly for some 

points in very rare cases. 

o Fixed crash loading LAS/LAZ files with an invalid (but non-zero) date in the 

header. 

o Fixed bug with elevation values being multiplied by 100 when exporting part of a 

point cloud to a GMP file with the export elevation units set to Statute. 

o Fixed bug with the displayed elevation range not updating when changing the 

elevation units for a loaded Lidar layer. 

 Analysis Function Changes 

o Improved path profile/line of sight paths that cross areas of no known elevation so 

that the path is smoothly interpolated between the surrounding valid elevations 

rather than showing 0 for invalid locations. 

o Fixed problem with very large view shed calculations and very small clearance at 

the view shed center that resulted in a strange pattern of blocked samples in the 

outer parts of the view shed. 

o Fixed problems with the creation of polygon coverage for area and line layers that 



could cause the coverage to cross through some long straight segments. 

o Allow editing the parameters and recalculating multiple view shed layers at once 

from the Control Center. Previously you could only edit and recalculate a single 

view shed layer at a time. 

o Added display of the total elevation increase and decrease along a path on the 3D 

path profile details. 

o Fixed crash in path profile when creating a new point feature along the profile and 

assigning it to a new layer rather than an existing one. 

o Added checkbox option to view shed calculation to control whether or not to treat 

invalid/missing elevations as ocean (height of zero). 

o Fixed issue in v14.2 with odd island creation in view shed coverage and equal 

area coverage creation. 

o Fixed issue in v14.2 with pressing cancel on view shed options dialog causing the 

Control Center to stop updating properly. 

o Added option when creating roughness areas from a land cover layer to control 

whether or not invalid areas are automatically chopped up. 

o Fixed problem calculating roughness grids from land cover layers that have had 

color modifications, like translucency, contrast, etc. applied. 

 Digitizer Tool Changes 

o Added option to automatically download and/or load files/web links associated 

with an attribute of selected features. This is a very powerful feature allowing you 

to easily download files associated with features (like coverage areas) from online 

server or load from local disk. This option is on the right-click Attribute submenu 

when one or more features is selected. 

o Added option to add curve/arc segments when creating distance/bearing/COGO 

lines. The arc parameters (like chord length, radius, and bearing) are providing as 

part of the COGO string for a segment. 

o Added option to create numbered points along a distance/bearing/COGO line. The 

points start at a specified number and increase by 1 for each vertex. 

o Added option to copy attributes from  line features to area features. 

o Added option to create radial lines at some fixed angle interval when creating a 

range ring. 

o Updated option to crop selected areas to a selected line to allow cropping areas to 

multiple selected lines at once. 

o When creating new areas or lines by clicking on existing 3D features, only require 

half of the clicked locations to have valid elevations before creating a new 3D 

feature. Any vertices with unknown elevations will be filled in from the adjacent 

elevation values. 

o Added new option under Crop/Combine/Split submenu to chop up selected area 

features until they have less than some vertex count. 

o Add new right-click options under the Vertex menu to move the vertex selection 

to the next or previous vertex. This is available when a single vertex is selected in 

a line or area. 

o Made the measure attributes for areas in a group of areas include a 

GROUP_AREA attribute that is the combined enclosed area of all areas in the 



grouping. 

o Added option when creating buffer areas from 3D areas and lines to add a Z offset 

to the buffer areas so you can stack them. 

o Updated option to add coordinate attributes to selected features to also work for 

line features. The start and end point coordinates will be saved in START_X, 

START_Y, END_X, and END_Y attributes. 

o When calculating elevation statistics for selected lines, add a LENGTH_3D 

attribute for the length of the line along the surface. Also prompt if any 3D lines 

are encountered to see if the existing per-vertex elevations should be used or if 

samples along the line path from the terrain should be used. 

o Added option to customize the drawing style used when creating range rings. 

o Fixed bug that would cause areas that failed to combine with errors to be marked 

as deleted rather than  kept unmodified. 

o Allow reversing the vertices for a single selected area (previously only worked for 

lines or if multiple areas were selected). 

o Fixed problem with every 32nd vertex not showing vertex editing commands in 

right-click menu. 

 Scripting Changes 

o Added support for passing variables on the command line to a script. You can 

provide the variable after the script (.gms) filename itself on the command line in 

the form ‘-var_name var_value’. For example, ‘global_mapper.exe 

“c:\my_path\my_script.gms” -my_var my_var_value’. 

o [LIDAR MODULE ONLY] Added support for saving Lidar statistics from a 

script. If you add ADD_LIDAR_STATS=YES to an EXPORT_METADATA 

script command you get all of the information from the Statistics tab of the 

Metadata dialog dumped to the file. 

o Added new DEFINE_VAR_TABLE command to allow providing a table of 

variable values with key names to allow easily creating generic scripts with tables 

of things like state names and abbreviations associated with a numeric code, etc. 

o Added support for creating buffers around features using the EDIT_VECTOR 

command. There are new BUFFER_DIST and other attributes (see the scripting 

reference for details). 

o Updated behavior of VAR_LOOP_START so that if you provide an end value 

less than the start and explicitly provide a positive VAR_STEP, the loop is just 

skipped rather than the step direction being automatically reversed. This allows 

you to use the VAR_LOOP_START as an ‘IF’ statement to conditionally execute 

a block of commands. 

o Updated COPY_ATTRS command to allow copying from areas to areas. 

o Added support for replacing text strings within feature attribute values using the 

EDIT_VECTOR script command and a new ATTR_REPLACE_STR parameter. 

This allows you to replace one text string with another in a particular attribute 

value (or feature label) for all features matching a search query. 

o Added support for extracting more pieces of the path to the current file inside a 

DIR_LOOP_START...DIR_LOOP_END. You can now use %PARENT_DIR1% 

to get the grand-parent folder, %PARENT_DIR2% to get the super-grand-parent, 



etc. 

o Added support for including %SPLIT_ATTR% in the EXPORT_VECTOR 

command when splitting by attribute so that you can use the split attribute value 

in the export filename path. 

o Added support for deleting all attributes except a list of allowed attributes with 

EDIT_VECTOR. You can provide one or more ATTR_TO_KEEP parameters to 

specify which attribute s to keep. 

o Added support for specifying the export row and column order for XYZ grids 

exported with EXPORT_ELEVATION using new EXPORT_ROW_MAJOR, 

REVERSE_COLS, and REVERSE_ROWS parameters. 

o Updated cropping to polygons during export to support any special attribute name 

for POLYGON_CROP_NAME_ATTR and 

POLYGON_CROP_FOLDER_ATTR. The previous <Area Display Label> and 

<Area Source Filename> still work but are deprecated in favor of the standard 

names, like <Feature Name>. 

o Added support for including a filename  suffix when cropping an export to a list 

of polygons. Add a POLYGON_CROP_FILENAME_SUFFIX to specify text to 

include after the attribute value but before the file extension in the output 

filename. 

o Added support for controlling whether or not areas with the same filename 

attribute are combined when doing a POLYGON_CROP_USE_EACH operation. 

Now POLYGON_CROP_COMBINE_DUPS handles this. 

o Added ALLOW_COMMA_DECIMAL parameter to EXPORT_VECTOR 

command for Shapefiles to control whether or not a comma can be treated as a 

decimal when detecting floating point fields. 

o Added support for exporting area and line features to CSV files with 

EXPORT_VECTOR by adding POINTS_ONLY=NO as a parameter. 

o Support providing a custom  precision and no-data value for Arc ASCII Grid 

exports with the EXPORT_ELEVATION command using VOID_ELEV and 

PRECISION parameters. 

o Made cancelling an individual grid cell export for EXPORT_ELEVATION or 

EXPORT_VECTOR cancel the entire script immediately list it already does for 

EXPORT_RASTER. 

o Added support for supplying the flight date for an exported Lidar LAS/LAZ file 

with a FLIGHT_DATE parameter for an EXPORT_VECTOR or 

EXPORT_ELEVATION script command. 

o Added support for KEEP_ZERO_AT_ZERO parameter for 

GENERATE_WATERSHED command to allow disabling the option to keep zero 

(ocean) elevations at 0 height for flow modeling. 

o Added support for specifying the projection to use for a POLYGON_CROP_FILE 

using a new POLYGON_CROP_FILE_PROJ parameter. 

o Added support for marking lines that are a subset of another line as a duplicate 

when using MARK_DUPLICATES=YES or DELETE_DUPLICATES=YES 

with the EDIT_VECTOR command. Just add SUBSET_IS_DUP=YES to 

command. 



o Improved behavior of FORCE_EXIT command so it doesn’t cause a different 

exception to be thrown. Now it cleanly exits the application. Also if the 

application does crash for some other reason 1 should be returned as the return 

code rather than  0. 

o Added option to ignore islands/holes in areas when using 

CONVERT_AREAS_TO_LINES=YES with the EDIT_VECTOR command. 

Now also add IGNORE_ISLANDS=YES to only create lines from the parent area 

boundary. 

o Updated JOIN_TABLE command to accept FILE_DELIM=SPACE or 

FILE_DELIM=TAB. 

o Made MIN_ELEV and MAX_ELEV for GENERATE_CONTOURS command 

be interpreted in the ELEV_UNITS specified rather than always meters. 

 Projection/Datum Changes 

o Updated Alberta 10TM projection to have separate “zones” for Resource and 

Forestry versions of projection. 

o Added new EPSG codes for Indiana State Plane zones using US Feet (codes 2965 

and 2966 replacing deprecated codes 2244 and 2245). 

o Fixed problem loading Nautical Miles units from WKT PRJ files. 

o Added better error message when we can’t load a WKT PRJ file due to an 

unrecognized datum, ellipsoid, or unit string. 

 Online Source Changes 

o Included OpenSeaMaps data as a built-in online source. This provides sea-marks 

(buoys, etc.) as an overlay layer to draw on top of an already loaded layer, like 

base OpenStreetMaps data or an imagery layer. 

o Fixed issue with some WMS sources not listing all available projections that are 

defined in the capabilities document if said document didn’t also list a bounding 

box for that projection. 

o Fixed issues with tiled (OSM/TMS/Google Maps) sources with a ? followed by 

extra parameters in the base URL not saving properly to workspace files. 

 Format Specific Changes 

o Updatd DXF/DWG import to set the default view to the extents specified in the 

file rather than just showing everything. This eliminates the default view of a 

bunch of extra stuff and not the core data. 

o Added additional options to DWG/DXF export for choosing what information 

about a feature to create the layer name from  (i.e. description/type, name, layer 

name, etc.). 

o Greatly improved display of text loaded from DWG/DXF files, including getting 

font names and proper alignment in many cases. 

o Fixed problems with some extruded features being improperly positioned when 

reading from DXF/DWG files. This is a very old problem that is finally fixed! 

o Made 3D Tin Face areas loaded from DXF/DWG files use the brush style for the 

type from the Area Styles tab of the Configuration dialog rather than always 

filling the TIN areas. 

o Dramatically improved the rendering and load of CityGML files. 

o Improved  handling of non-English text in Shapefiles/DBF. Text will 



automatically be converted based on the language specified in the DBF file. 

Support for UTF-8 decoding specified in a .cpg file along with the .shp file is also 

supported. 

o Added support for specifying the output format (MG2, MG3, or MG4) and the 

network cartridge server location 

o Updated PDF export to have options to control where the header and footer 

strings are placed relative to the margins. You can now place them in the center or 

edges of the margins or directly on the map. 

o Make sticky notes in PDF files import as text point features. 

o Improved placement of text next to point symbols in exported PDF files. 

o Updated DGN export to write point features out as 0-dimensional line features 

rather than create shared cells for each point. 

o Added options to XYZ Grid export to allow exporting from the bottom-to-top or 

right-to-left rather than the default order. 

o Added registry option to specify the precision for XYZ Grid elevation exports. If 

you add a DWORD key in ‘HKEY_CURRENT_USER\Software\Global Mapper’ 

with a name of ‘ASCIIGridExportPrecision’ and a value of 0 or higher, that value 

is how many digits of precision to include after the decimal for the output Z 

values. 

o When loading GeoTIFF files with an Esri .aux.xml and the option is selected to 

prefer world files over built-in coordinate information, use the .aux.xml 

positioning before all else if the .aux.xml has both a projection and control points. 

o Updated generic ASCII text import where attributes from coordinate lines are 

kept and lines are broken based on the change in some field to add the break 

attribute to the attribute list for the line feature. 

o Added option to KML/KMZ vector export to control whether or not filled area 

features with no border are chopped up automatically into smaller pieces to avoid 

issues displaying them in Google Earth. 

o Added additional attribute and style decoding from CityGML files. 

o Updated BSB exports from a single layer with an automatic crop boundary to 

save that in the exported KAP file’s PLY entries rather than the full export bounds 

to allow seamless viewing in other applications. 

o Updated CADRG and CIB exports to wrap the a.toc file in a NITF header to make 

it readable by more applications. 

o Fixed errors reading some ASRP data sets with incorrect data in the header file. 

o Added built-in area fill colors for OSGB VectorMap Local GML files. 

o Made area groups be supported for import from and export to CSV files with 

WKT coordinate strings and MULTIPOLYGON objects. 

o Added option to Shapefile export to allow discarding any attributes for which all 

values are empty. 

o Fixed problems reading some Shapefiles over 2GB in size. 

o Made the RGB color at the cursor location display in the status bar for ECW, 

JPEG2000, and MrSID image files. 

o Updated Shapefile export  to replace degree characters with spaces since some 

versions of Arc can’t handle degree symbols in DBF files. 



o Added option to Shapefile export to control whether or not ELEVATION 

attributes are written out for features with a single elevation value. 

o Added option to Shapefile export to control whether or not a comma can be used 

for a decimal when detecting the type of fields. 

o Fixed problem with extra comma  in the Projection Setup field for Ozi .map files 

written out for some projections (like Transverse Mercator). 

o Added option to generate PRJ files when exporting to most terrain formats, 

including Arc ASCII Grid and XYZ Grid. 

o Allow loading files from .tar.gz archives that are larger than 2GB in size. 

o Added support for Swedish RIK files with transparency and also made the 

SWEREF99 projection read correctly from newer RIK files. 

o Fixed export of ECW file with New York East State Plane zone storing as New 

Jersey zone (they are identical definitions so the coordinates are the same 

anyway). 

o Updated Erdas Imagine IMG files to automatically obey any no-data values 

specified in the header, both for terrain grid and imagery files. 

o Fixed handling of attributes with double-quotes from PLS-CADD XYZ files. 

o Improved support for <ExtendedData> tags with attributes in KML/KMZ files. 

o Fixed encoding of non-ASCII folder names in KML/KMZ files. 

o Fixed problem with the latitude of origin not writing out to MapInfo files for 

Hotine Oblique Mercator-based projections, like Swiss Grid. 

o Updated GPX import to automatically assign the symbols for waypoints if the 

<sym> tag matches a point symbol name in Global Mapper. If not the <sym> tag 

value is saved as an attribute and will be kept on export to a new GPX file. 

o Fixed export of labels with the background marked as filled rather than 

transparent to PDF files. Now (if not rotated) the background will be blanked out 

in the PDF as well. 

o Added new option on OSM/TMS/Google Maps/Bing Maps export dialog to only 

export tiles that are fully covered by the export bounds. This advanced option 

makes it easier to update just part of an earlier large web tile export. 

o Automatically decode datums from GeogCitationKey in GeoTIFF files if 

provided there but not in datum code. 

o Fixed error loading some HTF format files. 

o Fixed bug in export of area Shapefiles that could cause some islands/holes to turn 

into parents in the exported file. 

o Fixed problems with some area features not loading from DGN files if they are 

incorrectly marked as ‘holes’. 

o Fixed errors loading some workspace files over 2GB in size. 

o Fixed export to 3D vector files pulling elevations from Erdas IMG files with 

overviews or online layers to pull from an appropriate layer automatically (most 

detailed for IMG files) rather than pulling from current drawn layer. 

 Renamed ‘Gridding’ tab to ‘Tiling’ to make the intent clearer, especially when used in 

conjunction with other operations that refer to ‘grids’. 

 When cropping loaded layers to multiple selected area files, allow using just the most 

overlapped area from the selected areas to crop rather than all. When cropping a map 



catalog to multiple areas this is automatically done for each map in the catalog 

individually. This allows easily cropping to a custom grid of coverages all at once. 

 When placing your mouse near 3D features, the elevation of the feature (or closest 

location on 3D areas/lines) will be displayed on the status bar after the feature 

description. 

 Added new ‘Show All’ button to Search dialog allowing you to easily reset the search 

back to all searchable features. 

 Updated search on attributes != (not equal) to a text value to include results that don’t 

include the attribute at all. 

 Added option to display slope percent grades on the Elevation Legend if using a slope 

shader. Enable this by right-clicking on the elevation legend if a slope-based shader is 

active and checking the option to display slopes as percent grade. 

 Added option when creating custom elevation shaders to repeat the colors for anything 

outside the specified range rather than clamping them. 

 Updated Style tabs of Options dialog for vector layers to allow manually entering an 

attribute name to base the styles on rather than  selecting from a list. This allows selecting 

an attribute style for map catalogs where the attribute list isn’t known up front. 

 Add display of the coordinates of each vertex in the current view/export projection on the 

Feature Vertices dialog for area/line features if the feature is reprojected. 

 Made Control Center position and size be remembered in workspace (.gmw) files. If you 

have the Control Center displayed when you save a workspace, the next time you load 

that workspace the Control Center will automatically be displayed at the location it was 

when you initially saved the workspace. 

 Updated the Feature Info dialog to show the combined area of all grouped areas next to 

the group area count. 

 Added a new menu command on the Options->Rectification Method submenu on the 

rectification dialog to control whether or not an explicitly selected method of Polynomial 

will switch to a 2nd-degree polynomial at 6 points or not. 

 Added option in 3D view to control the step size used by the water up/down toolbar 

buttons. 

 Updated the Full View (Home) button to ignore any hidden layers when zooming to the 

full view. 

 Added support for customizing the 3D view rotation angle based on pressing the ‘4’ or 

‘6’ key. If you add a string value 

‘HKEY_CURRENT_USER\Software\GlobalMapper\3D_KeyRotateAngle’ with the 

number of degrees to rotate with each key press that will be used rather than the default. 

 Allowed zooming to 1:1 resolution for multiple selected layers from the right-click menu 

on the Control Center. Previously it only worked if a single raster or elevation layer was 

selected. 

 Fixed multi-band export fill value for no-data values. Should be 0 or the gray value of the 

background color, but was set to last valid encountered value in v14.2 

 Added display of current loaded and selected  layer count on the title bar of the Control 

Center. 

 Updated option to create polygonal coverages for selected layers from the Control Center 

to work for map catalog layers as well. Rather than just creating bounding box areas for 



each map in the catalog it will now load and create coverage polygons for each map. 

 Play a sound when lengthy operations (i.e. 5 minutes or longer) complete. This provides a 

way to notice a long operation  is done without switching back to the program. 

 Fixed bug with extra period being inserted in some filenames on export when you don’t 

explicitly enter the extension to use. 

 Added support for connecting to GPS devices at 300, 1200, and 2400 baud. 

 Smoothed out some sharp edges in vector data when transforming with a coordinate 

transformation file with more than 4 control points. 

 Fixed batch conversions to multi-band imagery formats when the ‘Use Other Source Files 

as Filler’ option is checked. 

 Added support for new text alignments that align text with the baseline of text rather than 

the middle of text. This is not automatically used when loading DXF/DWG files that 

specify that alignment. 

 Fixed problems with creation of coverage areas for some data sets. 

 

WHAT'S NEW IN Global Mapper v14.2 

 

 Significant New Features 

o Updated option to Measure Volume Between Surfaces to support measuring the 

volume difference within multiple selected area features and generating a report 

of the volume difference within each area and the total difference. 

o Added option when measuring the volume of one or more area features (either 

with the Digitizer Tool or drawn with the Measure Tool) to measure the cut and 

fill volume of the area relative to how the edges of the area feature cut the terrain 

surface. This provides a very easy mechanism to measure the volume or one or 

more piles of material simply by drawing/selecting an area around them. 

o Added new EXTEND function allowing extending one or more line features to a 

previously selected line feature. To use this, first select the line feature to extend 

to, then right-click and choose the Move/Reshape submenu command to select the 

“extend to” feature. Then select the line feature(s) to extend to that line, then 

right-click and select the Move/Reshape menu command to extend the selected 

lines. 

o Added new right-click option to the ‘Search Vector Data’ dialog to allow 

calculating and displaying the statistics for a numeric column in a result set. This 

allows you to easily see the minimum, maximum, average, and standard deviation 

of the numeric values for all of the selected attribute for the result set. 

 Lidar Improvements 

o Allow searching on elevation values for Lidar points (missing in v14.1.0). 

o Added option to color Lidar point clouds by the return number to easily visualize 

where you have multiple returns (often vegetation). 

o Added quality slider to the Lidar display options tab of the Options dialog for 

point cloud layers allowing control of display quality (i.e. what fraction of points 

are drawn) vs. display speed. 

o Added option when loading Lidar files to specify how often to sample points 

when using preview mode. 



o Added option when loading Lidar files to automatically mark any points outside 

some number of standard deviations from the mean as deleted. This allows easily 

getting rid of outlier/noise points. 

o Added option to Lidar load options dialog to load the elevation values as depth, 

resulting in negative elevations. 

o Improved load as ASCII (like .xyzi) files to allow selecting the Lidar 

classification to assign to the points. 

o Updated creation of points from the grid cell centers of a loaded terrain layer to 

create a point cloud rather than a series of full point features, resulting in vastly 

less memory usage and much greater performance. 

o Added report of point density (samples per square meter) to the metadata report 

for Lidar point cloud layers. 

o Sped up the initial display of the search dialog when searching on Lidar point 

cloud data. 

o Updated batch conversion of Lidar LAS/LAZ files to GMP (Global Mapper 

Package) files to allow storing as point clouds or grids since GMP files can store 

the data either way. 

o Added support for exporting point clouds to DXF and DWG format files. 

o Fixed issue in v14.1.0 loading some LAS files with lat/lon XY coordinates. 

o Fixed issue in v14.1 with incorrectly positioned points in some ASCII files loaded 

as point clouds. 

o Allowed Lidar point cloud export to MapInfo MIF/MID and TAB/MAP files and 

also allowed batch converting Lidar point clouds to Shapefiles. 

o Made colorizing Lidar point clouds using the EXPORT_VECTOR script 

command work properly with online imagery sources. 

o Fixed issue in v14.1 with exports to new LAS/LAZ files dropping the GPS time 

from input files if exporting to LAS v1.2 or earlier. 

 Global Energy Mapper Only Features 

o Added PILE VOLUMES command in the Digitizer Tool to allow quickly 

measuring the volumes of area features/piles when there is terrain loaded with the 

piles in the surface. 

 New Supported Formats 

o Added support for loading Natural Resources Canada (NRCAN)  BYN geoid 

offset grid files. 

o Added support for loading text files with a pen up/down column with values of 1 

for pen down. There is a new checkbox option for this on the ASCII import 

dialog. 

o Added support for loading DECC wind speed text files for the UK. 

 Analysis Function Changes 

o Added support for combining/comparing terrain layers with more than one 

selected layer in each of the sets of terrain layers. 

o Updated water rise calculation to find flow to any elevations <= to the specified 

fixed elevation rather than only exactly equal elevations. 

o Updated watershed, ridge line, and water rise calculations to have option to 

specify the resampling method for each layer rather than defaulting to resample if 



any reprojection or pixel mis-alignment occurs to avoid changing values. 

o Sped up gridding of 3D area features that are already in a TIN. Also fixed crash 

doing this in some cases. 

o Re-arranged watershed options dialog to fit on lower resolution screens. 

o Allow calculating density grids from the centroids of area features. 

o Made watershed, roughness grid, and equal-value areas always be valid when 

created (i.e. no self-intersecting pieces). 

 Digitizer Tool Changes 

o Added new EXTEND function allowing extending one or more line features to a 

previously selected line feature. To use this, first select the line feature to extend 

to, then right-click and choose the Move/Reshape submenu command to select the 

“extend to” feature. Then select the line feature(s) to extend to that line, then 

right-click and select the Move/Reshape menu command to extend the selected 

lines. 

o Replaced options for copying attributes between individual features types with a 

generic ‘Copy Attributes Between Features’ option. This displays a dialog that 

allows you to select which types of selected/loaded features to copy attributes 

between and exactly which attributes to copy. 

o Added options to group multiple polygons into a single multi-part polygon and 

also to un-group polygons. These options are under the Advanced Feature 

Creation submenu. All areas in a multi-part group must be in the same layer and 

have the same attributes, style, and type. Editing any area in a group will edit all 

areas in the group. These areas will stay grouped as a multi-part polygon when 

exporting to Shapefiles. You can select all areas that are part of a group under the 

Advanced Selections submenu. You can also see all of the areas in a group with 

the Feature Info tool. 

o Added tool to find and fix invalid (i.e. self-intersecting) area features among 

selected areas. 

o Added the option to specify an allowed distance threshold when connecting lines 

into areas so that you can create areas from lines that don’t exactly match at their 

end points, but are within some specified distance. 

o Allow inserting of vertices at intersections of area features. Previously the vertex 

insert only worked for line features. 

o Added option to select all area and island features below a certain size threshold. 

This allows easily finding small areas/islands for removal. 

o Updated Concave Hull creation to work for area and line features. 

o Updated subtracting of lines from multiple area features when using the Crop 

Loaded Features to Selected Area(s) option to generate the correct results if the 

line crosses multiple area features. 

o Fixed error about invalid polygons when creating buffers for some features. 

o Added new items to Options submenu to control whether or not snapping is only 

to point features or vertices of line/area features. 

o Fixed scaling of features in a different projection than the current view projection 

when not also rotating them. 

o Fixed issue with duplicate lines being created when creating area skeleton lines. 



o Fixed issue with point attributes not copying properly to Voronoi/Theissen 

polygons. 

o When digitizing, allow snapping to the first point of a line or area feature that is 

being digitized. 

o Updated combine of line features to prefer the choice of line to connect to that 

maintains the original direction of both lines if possible over an option that 

requires a reversal. 

o Updated the addition of per-vertex elevations to selected features to always pull 

from the most detailed layer of loaded grid sources and never overview layers. 

o Restored option to select only those areas whose centroid is within a selected area. 

o Allow splitting a line into separate features when multiple vertices are selected. 

o Added support for providing bearings as mils6400 for distance/bearing/COGO 

lines and for offsetting features by a fixed distance and bearing. 

o Fixed bug in v14.1 that caused splitting an area against a selected line to only 

keep half of it. 

o When combining lines that don’t connect within the specified distance threshold, 

if a single end point of each line is selected, combine between those 2 end points 

rather than at the shortest connection. 

o Fixed bug in v14.1 when selecting areas in other areas by centroid only that 

caused areas whose centroid is outside the area to not be selected. 

o Fixed bug in v14.1 when finding the intersection of 2 areas that caused all of the 

pieces to not be kept when specifying that you want to keep the parts outside of 

the crop area as well. 

 Scripting Changes 

o Added COPY_ATTRS script command to allow copying attributes between 

different types of features using a script. 

o Updated GENERATE_REPORT to allow specifying multiple REPORT_ATTR 

parameters to group the results by multiple attributes. This allows you to do things 

like find the total area and line length by layer and feature type or name. 

o Added support for forcing the filename created with EXPORT_VECTOR to only 

contain lower-case letters by adding MAKE_FNAME_LOWER=YES. 

o Added support for forcing the filename created with EXPORT_VECTOR to only 

contain lower-case letters by adding MAKE_FNAME_LOWER=YES. 

o Updated GENERATE_REPORT to support generating based on any recognized 

attribute type, like <Feature Layer Name>, <Feature Type>, etc. Also added Lidar 

point counts to the generated report. 

o Added support for generating coverage areas (concave hulls) for layers by adding 

a CREATE_COVERAGE_AREAS=YES parameter to the EDIT_VECTOR 

script command. 

o Added support for using a Yes/No, Yes/No/Cancel, or Ok box when prompting 

with DEFINE_VAR. Use PROMPT=YES_NO or 

PROMPT=YES_NO_CANCEL or PROMPT=OK. 

o Added support for adding coordinate attributes (X and Y) to point features using 

EDIT_VECTOR with ADD_COORD_ATTRS=YES. 

o Added support for discarding all closed contour lines less than some length when 



using the GENERATE_CONTOURS script command by adding a 

MIN_CONTOUR_LEN parameter with the minimum length to keep in meters. 

o Added support for specifying the major and minor contour intervals in a script 

using MAJOR_MULT and MINOR_MULT parameters for the 

GENERATE_CONTOURS script command. 

o Added support for creating areas from lines that don’t exactly connect at end 

points. The new MAX_DIST parameter for the COMBINE_LINES command 

allows specifying the maximum allowed distance between end points in meters. 

o Updated GENERATE_LAYER_BOUNDS to allow providing a FILENAME 

parameter to specify that you only want to add the bounds for a particular layer. 

o Added support for defining a variable with DEFINE_VAR that is set from the 

first non-empty value of an attribute of the features in a loaded layer. Use 

VALUE_ATTR rather than VALUE for the value and optionally use FILENAME 

to specify which layer to check. 

o Added support for forcing the filename created with EXPORT_VECTOR to only 

contain lower-case letters by adding MAKE_FNAME_LOWER=YES. 

o Fix bug in v14.1.0/1 with EDIT_VECTOR not returning any results if no 

COMPARE_STR parameters are provided. 

o Add support for generating NITF files with D for ICORDS rather than G. Use 

NITF_USE_DECIMAL=YES to enable. 

o Added support for generating .ers header files along with raster image exports by 

adding GEN_ERS_FILE=YES to EXPORT_RASTER script commands. 

o Made FILL_GAPS option work for multi-band exports with EXPORT_RASTER 

command. 

o Added time stamp to ‘Script Processing COMPLETED’ message recorded when a 

script finishes so you can track the start and stop time of a script from a log file. 

o Added option to disable the write of projection information to ECW/JPEG2000 

files by adding NO_PROJ_HEADER=YES to the EXPORT_RASTER command. 

o Added support for saving long labels (over 31 characters) to DXF files when 

exporting using EXPORT_VECTOR by adding ALLOW_LONG_LABELS=YES 

to the command. 

 Projection/Datum Changes 

o Added built-in Qatar 1974, RT38, and RT38 (Stockholm) datums. 

o Updated great circle paths to be calculated along the geodesic for the ellipsoidal 

model defined by the current datum using the Vincenty formulas rather than using 

a spherical earth model. This makes the great circle path more accurately the 

shortest path on the surface, although for navigation purposes the differences are 

usually negligible. 

o Added NTv2 grid shift file for MGI Austria datum conversions to make them 

more accurate. 

o Added German Legal Metre as a built-in unit. 

o Corrected European Datum 1979 to use International 1909/1924 ellipsoid (it had 

been set to International 1967). 

o Corrected Indian (Nepal) [Kalianpur 1975] datum to use the new Everest 1830 

(1975 Adjustment) ellipsoid rather than Everest 1856. 



o Corrected Schwarzeck datum to use new Bessel Namibia (GLM) ellipsoid rather 

than the base Bessel 1841. 

o Corrected Hong Kong 1963 datum to use Clarke 1858 ellipsoid rather than 

International 1909/1924. 

o Corrected Indian 1954 datum to use Everest 1830 (1936 adjustment) ellipsoid. 

o Corrected EPSG code assigned to Reykjavik 1900 datum. 

o Updated SAD69 datum to prefer EPSG code 6618 as the old code 6291 is 

deprecated. 

o Updated save of WKT PRJ files based on NAD83 or NAD27 datums to use 

GeogCS name expected by Esri products. Also store UTM ProjCS as Esri expects 

for those datums. 

o Made projections using Yards and Indian Yards save to WKT PRJ files. 

o Updated handling of Web Mercator projections (Mercator with WGS84 Auxiliary 

Sphere/Google Maps datum) to be stored how Esri products expect in both WKT 

PRJ format and GeoTIFF headers. 

 Online Source Changes 

o Added support for loading data from INSPIRE WMS servers (commonly used in 

Europe) which are based on WMS 1.3.0. 

o Only show one error message when trying to access a WMS source that is offline 

rather than several messages. 

o Fixed problems loading from some WFS sources. 

 Format Specific Changes 

o Added support for creating a map catalog (GMC) from selected area features with 

an attribute that contains a URL of an associated file for each area. When you 

zoom in far enough that the map is needed, it is downloaded from the URL and 

then loaded automatically. This allows you to have a single map catalog reference 

a huge online database of data. 

o Updated CSV export to have option to specify the digits of precision, allow use of 

spaces or semi-colons as separators, write the ELEV field first, and to allow using 

commas for decimals rather than periods (i.e. European style). 

o Add progress reporting for load of XML-based formats, like KML, GML, GMC, 

OSM XML, including the ability to cancel the load. 

o Updated the GeoPDF import to have a 'Use for All' option when importing PDF 

files with layers. If you check that all PDF files in that load operation will disable 

the same layers automatically without showing the prompt. The next load 

operation won't automatically select them, but will uncheck those layers by 

default and show the layer dialog. 

o Added support for loading more PDF files directly from .zip files. 

o Added advanced support for overriding the DPI that PDF files are loaded at so 

you can achieve better display on some systems. You can now create a DWORD 

value in the registry at ‘HKEY_CURRENT_USER\Software\GlobalMapper’ 

named ‘PDF_RENDER_DPI’ with the value set to want you use for the DPI. For 

example, try 1200 for a very high resolution render. Note this will take more 

memory and load more slowly and might fail and use a lower resolution anyway. 

o Fixed issue with raster PDF exports being less sharp than the originals. 



o Fixed issue with PDF export of translucent filled areas with holes/islands also 

making the border of the area translucent. 

o Fixed issue with CIB exports that caused them to get significantly darker and also 

to be slightly mis-aligned with where standard CIB tiles should be. 

o Updated CADRG exports to map type with ‘Various’ for scale to save the actual 

scale entered in the exported files rather than just saving ‘Various’. 

o Improved handling of workspaces with very large embedded layers. 

o When loading multiple workspace (.gmw) files at a time, if you choose to skip 

unloading all layers for one workspace in the load operation, the rest will 

automatically be skipped. 

o Added check for corrupted workspaces when saving a new workspace. This offers 

some protection against bad disk sectors or incomplete writes over a network that 

can result in lost data. 

o Updated Zoomify format exports to keep empty tiles. 

o Added support for loading elevation values from attributes/text files that use 

commas for a decimal separator rather than a period. 

o Fixed issues loading Erdas Imagine .img files with signed 8-bit values. 

o Updated GeoTIFF export of Web Mercator projections to store an ESRI PE String 

in the PCS Citation so that Esri products can recognize the projection. 

o Corrected placement of GeoTIFF files with negative X or Y pixel scale factors. 

o Fixed issue from v14.0 with not being able to hide some NITF image layers. 

o Fixed problem with missing tiles when exporting CADRG files from some map 

catalogs. 

o Updated to support 64-bit feature IDs in OSM XML imports and exports. 

o Greatly sped up the display of some rotated BSB charts. 

o Updated SPS import to keep point depth and water depth as separate 

DEPTH_PNT and DEPTH_WTR attributes if both are present. 

o Added support for loading NetCDF files with time-dependent variables. 

o Added support for adding generic text files (like XYZ) to map catalogs. 

o Updated OSM XML import to automatically try to find a connecting path for 

areas formed from relation tags when the specified lines (ways) don’t connect. 

o Added support for ASTER L1A HDF files with 14 bands of data. Also added all 

layer metadata to HDF files. 

o Made .jpf be recognized extension for JPEG2000 files. 

o Added option when batch converting to JPEG2000 and ECW format files to 

control whether or not the projection/datum information is stored in the header. 

o Added option to ‘Create Uncompressed Files’ when batch converting to Erdas 

Imagine files image or elevation files and to ‘Create Overview Layers’ for 

elevation Erdas files. 

o Updated KML/KMZ export to fix an issue with the name of area features showing 

up in the balloon text box when you specify a custom HTML description. 

o Updated KML/KMZ export to not export area and line label points when the 

feature has labeling disabled in the main view. 

o Reorganized the vector KML/KMZ export dialog so that it will fit on smaller 

screens. 



o Automatically chop up large vector areas (> 1024 vertices) when exporting to 

KML/KMZ to ensure they always render properly in Google Earth. 

o Allow cropping to selected area features when exporting DVG and SVG format 

files. 

o Fixed issues with banded shadows when zoomed out on some large Erdas 

Imagine elevation files with multiple overview layers. 

o Fixed issue with overview layers not being used for some RGB Erdas Imagine 

IMG files, resulting in very slow display of very large RGB IMG files. 

o Added option to save a text metadata file with some image format exports. This is 

the same text metadata format that you can save when doing a screen capture. 

o Made elevation units selected for vector layers loaded from ASCII text files stick. 

o Allow raster/elevation export plugin DLLs to modify the projection, bounds, or 

pixel dimensions of an export by modifying the values in the EP_ExportStarted_t 

structure passed to EP_ExportEvent function with new EP_Event_PrepareExport 

event sent before any others. 

o Sped up display of Shapefile export options dialog when large map catalogs of 

vector data are loaded. 

 Updated Favorites toolbar to sort the manually added and automatically added items and 

to sort them alphabetically rather than by usage to make them easier to find. 

 When providing custom attribute-based line styling with interpolation between numeric 

values, make the specified line widths interpolate between values as well. 

 Added new option to the Advanced section of the General tab of the Configuration dialog 

to snap raster/elevation export bounds to the nearest multiple of the specified pixel size. 

So if you check this and export with 0.5m resolution pixels, the output will start on an 

even 0.5m multiple boundary. 

 Added option to 3D view options dialog to turn off the terrain surface display. This can 

be useful if you want to have a terrain surface available for adding relative offsets to 3D 

vector features, but you don’t want to display the surface. 

 Made area crop operations more tolerant of self-intersecting and other invalid polygons. 

 Added option to load files directly from a URL in an attribute value from the Feature Info 

dialog. Just right-click on the attribute value with the URL to the file to load. Global 

Mapper will then download it and load it as a new layer. 

 Allow for print header and footers containing ampersand characters. Before they were 

turned into underscores unless you used a double-ampersand. 

 Updated vector search dialog to do a better job of sizing columns based on the data. 

 Updated vector search to only search on those layers in a map catalog that are already 

loaded. This prevents lockups searching on map catalogs where only some of the maps 

are loaded. 

 Fixed creation of equal value areas with a list of colors to match to and an allowed color 

fuzziness. Previously only the exact colors were matched and the fuzziness ignored. 

 Updated save of GPS waypoints to add attributes for fix type, PDOP, and number of 

satellites. 

 Fixed decoding of GPS waypoints from a NMEA stream with $GPWPL sentences. 

 Updated batch convert to Shapefile to use lower-case extension for all generated files 

rather than upper case. 



 Ignore per-vertex elevation lists for area and line features that contain all 0 values if a 

non-zero elevation attribute is present. 

 Updated Ctrl+L shortcut key to copy the current GPS position to the clipboard if a GPS 

device is currently being tracked. 

 Updated save of GCP files from image rectification dialog to save the latitude and 

longitude of each point at the end of each line. 

 Fixed crash at startup if you had installed from a USGS dlgv32 Pro installer and had an 

expiring trial license installed. 

 When loading multiple un-referenced images, added ‘Yes to All’ and ‘No to All’ options 

for controlling whether to rectify or fake position information for all images that are 

selected. 

 Added right-click option on the Vertices dialog to allow creating point features from each 

selected vertex. 

 Update Vertices dialog to re-center the map on a selected vertex when it is off screen. 

 Add warning to multi-band exports if any high bit depth bands would be truncated to 

lower values without any adjustment. Also updated 16-bit values being converted to 8-bit 

values be shifted rather than truncated for non-color bands. 

 Increased allowed number of grid lines when specifying a custom grid spacing, 

particularly in 64-bit builds. 

 Made bounding boxes created from map catalog layers include attributes for the bounds 

of the map. 

 Fixed gridding of elevation exports when providing an overlap so that it uses the correct 

spacing for the export when applying the overlap. 

 Updated creation of equal value areas to use the border style of whatever area type is 

selected for the new areas. This allows you to turn off the borders. 

 Fixed display of bearings relative to Magnetic North rather than True North. They were 

shifted the wrong direction based on the magnetic declination at the location. 

 Made custom shortcut keys work when ALT is one of the keys specified with the 

shortcut. 

 

WHAT'S NEW IN Global Mapper v14.1 

 

 Significant New Features 

o Numerous improvements for working with Lidar data. See special subsection 

detailing changes below. 

o Added support for licensing using USB dongles, allowing you to freely move 

single user licenses between any number of machines. 

o Added new Analysis menu option to compute the areas covered when you raise 

the water level of selected areas or a fixed elevation by some height. This is useful 

for modeling the rise of a flood plain by some height or by modeling sea level 

rise. 

o Added option to Analysis menu to allow calculation of Voronoi/Theissen 

polygons for loaded point features. 

o Updated download of online imagery to have an option to control whether or not 

the source is cropped just to the specified bounds or if panning around the data set 



is allowed. 

o Renamed Terrain Analysis menu to Analysis to reflect the addition of several new 

analysis functions that apply to non-terrain data. Also added some existing 

analysis functions here, like the ability to create elevation grids from loaded 3D 

vector data. 

o Added new option to View Menu to enable the display of ‘Info Tips’ at the cursor 

location. This will display a popup window at the cursor location with 

information about the feature and/or map under the cursor. 

o Updated Help menu command to Release/Remove licenses for node-locked 

licenses to automatically communicate with the license server if possible to 

further simplify the process of moving node-locked licenses to a new machine. 

 Lidar Improvements 

o Dramatic increase in the size of point clouds that can be loaded. You can now 

load point clouds with hundreds of millions or even billions of points. 

o Dramatic increase in the speed of displaying large point clouds both in the main 

map view and the 3D view, especially when zoomed out. 

o Improvement in the appearance of point clouds when you zoom in on them. Now 

the individual points will get larger when zoomed in on them to make them easier 

to see. 

o Additional display options for point clouds, including the ability to render the 

intensity values as grayscale images, coloring by the Lidar classification, and 

coloring by the point elevation or RGB color if present. 

o Option to limit import of Lidar files based on the return type (i.e. first return, last 

return, first of many, last of many, etc.). 

o Special storage of Lidar points in Global Mapper Package files. They will now 

store extremely compactly in GMP files, typically several times smaller than the 

uncompressed LAS format. Lidar point clouds stored in GMP files will also load 

extremely quickly. 

o Added display of a large number of statistics for loaded Lidar point cloud layers, 

including a breakdown of the return counts by classification, return type, etc. The 

statistics are displayed on the Metadata dialog for a Lidar layer which you can 

display from the Control Center. 

o Updated editing of Lidar point features to have special edit dialogs for the 

attributes that apply to Lidar point data. 

o Added option to load Generic ASCII Text files as Lidar point clouds, providing 

much improved handling and reduced memory requirements for XYZ and XYZI 

files. 

o Added new built-in point types “LIDAR, Low Point (Noise)” and “LIDAR, 

Overlap” so those types can have their style customized and be turned on and off 

for filtering. 

o Added options to both load and save Lidar point classifications with values 

between 32 and 255 to LAS 1.2 and earlier fields, even though it violates the LAS 

specification. Some applications, like Terrascan, violate the specification to store 

classes 32-255. This option allows you to use them with software that doesn’t 

support LAS 1.4 (which supports 256 classifications) yet. 



 Global Energy Mapper Only Features 

o Added option to Digitizer Tool to easily subdivide an existing area into 4 separate 

areas, like sectioning an area. Useful for parcel maps. 

o Updated option to create a flattened site plan to allow smoothly transitioning to 

the existing heights of selected 3D areas, so you can create a site plan to a non-

level surface. 

o Added new right-click option to Advanced Feature Creation submenu of the 

Digitizer Tool when one or more points are selected to create whisker lines 

emanating from the selected points. Whisker lines are often used to estimate some 

sort of coverage from selected points to see if a point in a seismic survey covers 

what is needed. 

o Greatly sped up the display of the SpatialOnDemand sources. 

o Added a number of new built-in Oil & Gas point types/symbols and also 

improved the appearance of the previous ones. 

 New Supported Formats 

o Introduced a new OTF (Objective Terrain Format) reader available for an 

additional license fee. OTF is a special multi-function format used in war 

simulation that contains a variety of attribute and surface feature information 

useful for military work. The new OTF extension is available for licensing under 

the Help menu. 

o Added support for loading GeoMedia MDB database files. 

o Added support for importing and exporting DWG 2013 files. 

o Added support for exporting MapBox MBTiles and RMaps SQLite  files for use 

on mobile devices, like many Android apps. 

o Added support for exporting ASRP 1.1 files (only 1.2 was supported previously). 

o Added support for loading JPGIS (Japanese DEM) XML files. 

o Added support for loading ZMap+ Isomap Line/Contour files like KINGDOM 

uses. 

o Support for correctly handling signed 16-bit and 32-bit integer band values for 

imagery formats, like TIFF, BIL, BSQ, Erdas Imagine, etc. 

o Added support for loading vector data from PCI Geomatics .pix files. 

o Added support for loading GeoTIFF images with an 8-bit palette and 8-bit alpha 

channel that are stored separately. 

o Made Zoomify exports create hotspots.xml file for use in Zoomify GeoViewer. 

o Added support for rotated Geosoft Grid files. 

 Digitizer Tool Changes 

o Added new option to Advanced Feature Creation submenu to create a coverage 

area (concave hull) for loaded or selected point features. This allows you to easily 

get the coverage for an irregularly shaped grouping of points, like in a Lidar data 

set. 

o Added new option to create square areas of a fixed area on the ground in the 

Create Area/Polygon Feature submenu. This will show the area square as part of 

the cursor until you place it. You are prompted to enter the area on the ground 

each square template should cover. 

o Added new option to Advanced Feature Creation submenu to create a line 



skeleton from area features. 

o Added new option when a picture point (like JPEG with EXIF data) is selected 

allowing you to place the picture on the map. You can use this to draw a box 

where you want the image drawn on the map and it will be placed there. 

o Updated option to combine line features to prompt for an allowed threshold 

between the lines, allowing connecting lines that don’t quite exactly connect. 

o When combining selected line features, add option to choose exactly which 

attributes are required to match. 

o Updated combine of area to work properly when some of the areas have 

islands/holes. Also added a progress bar to the operation when there are lots of 

areas being combined. 

o Updated combine of 3D area features to keep the per-vertex elevations of the 

original areas. 

o Added new items under Options submenu to allow easily control whether areas, 

lines, and points are selectable. 

o Updated the option to crop any loaded features to selected areas to have an option 

to cut away what is inside the selected areas rather than what is outside of them. 

o Updated the option to crop any loaded features to selected areas to crop features 

properly to areas with islands/holes in them. 

o Added option to set the text color for any selected features with labels to the right-

click Attribute/Style menu. 

o Added option to specify a simplification threshold for elevations for simplifying 

selected area/line features. To do so, simply provide a space and the Z threshold 

in meters after the normal threshold, like ‘2 10’ to simplify to 2 meters 

horizontally and 10 meters vertically. 

o Added option to control whether or not original vertices are kept when resampling 

selecting area/line features at some fixed distance interval. If you uncheck it you 

will just have the vertices at the new spacing. 

o Updated the resampling of area/line features to use the ellipsoidal distance along 

segments rather than the grid distance so that long segments are split at the correct 

distance. 

o Made the option to Move selected features always be on the top-level right-click 

menu. 

o Updated to add a DIST_FROM_LINE attribute to the points when creating lines 

connecting selected points to the nearest lines. 

o Updated the option to create a single vertex list from areas with islands to have an 

option to split the area into smaller pieces until no islands are needed rather than 

connecting the islands with invisible lines that create invalid areas. Also added the 

option to the Crop/Combine/Split submenu. 

o Greatly improved the speed of the “select areas in other areas” option when doing 

the partial overlap allowed check. Also removed the “centroid” check option as it 

is not needed with the partial check now being just as fast. 

o Added new option to right-click Analysis menu to force selected 3D line features 

(typically streams) to flow downhill. This will modify the elevation values for 

vertices that don’t obey the downhill rule and potentially reverse the direction of  



a line. 

o When creating points at the vertices of selected area/line features, add a 

VTX_NUM attribute to the created points with the vertex index from the original 

feature. 

o When creating points at the vertices of selected area/line features and one or more 

vertices are selected, prompt the user for whether or not to only create new points 

at the selected vertices. 

o Added option to remove the per-vertex elevation lists for 3D area and line 

features. This is typically used when you have features that have erroneous 

elevation lists of all 0. 

o Fixed selection of lines that are completely within an area with lines that start on 

the area boundary and leave it but remain inside the bounding box of the area 

being selected. 

o Allow cancelling the process of selecting points that are within selected area 

bounds. 

o Fixed the resampling and/or splitting of line features at a single fixed distance. 

o Fixed problems with many different buffer creation operations. 

o Sped up the creation of very small buffers by reducing the number of vertices 

used to trace the curve at the ends for buffers less than 10 meters in  

o Added progress dialog that can be cancelled when creating buffer areas from 

features with lots of vertices. 

o Corrected the placement of points at the centroids of selected areas. 

 Scripting Changes 

o Added DEFINE_SHADER for adding custom shaders via a script. 

o Added support for OR searches rather than just AND when using the 

EDIT_VECTOR script command to perform operations on some features and 

multiple COMPARE_STR search parameters are provided. Add 

COMPARE_OP=ANY to use an OR search rather than AND. 

o Added support for EQUAL_COLORS parameter for 

GENERATE_EQUAL_VAL_AREAS script command to specify a specific list of 

colors to generate equal value areas for. 

o Added support for providing PRECISION attribute when exporting a 

SIMPLE_ASCII format with the EXPORT_VECTOR script command. 

o Added option to create new point features at the label position (i.e. centroid) of 

area features by added CREATE_LABEL_POINTS to the EDIT_VECTOR 

command. 

o Added support for exporting ECEF coordinates when exporting to XYZ grid files 

using EXPORT_ELEVATION by adding EXPORT_ECEF=YES to your 

command. 

o Added support for exporting Measure Shapefiles with EXPORT_VECTOR by 

adding EXPORT_MEASURES=YES to the parameter list. 

o Updated SKIP_UNLOAD_ALL parameter for EMBED_SCRIPT command to 

skip the first UNLOAD_LAYER or first UNLOAD_ALL command in case you 

are embedding a call to a custom script that just unloads a single layer instead of 

all of them. 



o Added support for disabling the display of warning message when loading a 

workspace/script by adding SHOW_WARNINGS=NO to the 

GLOBAL_MAPPER_SCRIPT header line. 

o Added support for setting the color to use for the Daylight Shader using a 

DAYLIGHT_SHADER_COLOR parameter for the SET_VERT_DISP_OPTS 

command. 

o Made table join operations not case sensitive by default and added support for 

specifying that they should be case sensitive by adding CASE_SENSITIVE=YES 

to the JOIN_TABLE script command. 

o Added support for ignoring whitespace during table join operations. Add 

IGNORE_WHITESPACE=YES to JOIN_TABLE script command to ignore 

whitespace. 

o Added support for controlling whether or not to ignore duplicate entries when 

doing a JOIN_TABLE command using a new ALLOW_DUPLICATES 

parameter. 

o Added support for specifying Lidar point cloud draw styles using 

LIDAR_DRAW_MODE and LIDAR_POINT_SIZE parameters for IMPORT 

command. 

o Added support for adding USE_8BIT_CLASSES=YES to EXPORT_VECTOR 

command when exporting Lidar LAS 1.1/1.2 files to export full 8-bit classes 

despite the limitations of the format. 

o Added support for saving the flow accumulation grid when using the 

GENERATE_WATERSHED script command by adding 

SHOW_FLOW_ACCUM=YES as a parameter. 

 Online Source Changes 

o Fixed major bug with lockups when viewing the NED 1/3rd arc second and SRTM 

terrain data sources that are hosted on globalmapper.com. 

o Updated download of online imagery to have an option to control whether or not 

the source is cropped just to the specified bounds or if panning around the data set 

is allowed. The default is now to make the entire data set available for panning 

and zooming. 

o Default WMS sources to no longer use tiles for display by default which speeds 

up access dramatically in many cases. 

o Added option to add all of the layers from a single WMS source by selecting the 

top-level layer entry. This worked before by combining all layers into a single 

entry. Now you have the option to do that or to create a separate layer for each 

one. 

o Dramatically sped up downloads from WMS/WMTS servers that are missing data 

at some zoom levels. 

o Added support for local tile OSM/TMS/Google Maps sources with file:// URLs. 

o Removed the built-in Nexrad US radar imagery source that was no longer 

working and replaced it with a new US radar imagery source and 2 worldwide 

cloud-cover (both visible and infrared) sources. 

o Added support for adding sources from the custom tile sets at 

<http://wms.jpl.nasa.gov> (the same source used for the Landsat and ASTER 



GDEM sources in Global Mapper). This includes things like the daily MODIS 

and AQUA data sets. 

o Fixed issue with the new option to not download WMS sources as tiles for display 

not working if the path to your temp folder was too long. Also fixed crash when 

this option is checked. 

o Fixed issues loading data from some WFS servers. 

o Fixed display of clickable feature information using the Feature Info tool when 

using WMS sources that support that. This was broken in v14.0. 

 Projection/Datum Changes 

o Added automatic recognition of most GeoTIFF files with incorrect false 

easting/northing values due to Esri products doing an incorrect unit conversion 

when creating non-meters GeoTIFF files with a custom projection. Those files 

will now position as desired despite the incorrect information in the header. 

o Added support for a new getLayerProjectionStr function to the raster/elevation 

plugin API. This allows you to fetch a WKT projection string or EPSG code for 

the layer and use that for the projection. 

o Added built-in Poland 2000 grid system based on ETRS89. 

o Added support for additional zones for the Gauss Krueger 3-degree-zone 

projection and removed Germany from the name as it now covers much more of 

the world. 

o Added new STM1987 (DNAG) datum for use with Geological Maps of North 

America. 

o Added NTv2 grid shift file for Croatia HDKS Grid datum. 

o Corrected Origin Latitude and False Northing for Gauss Krueger Argentina 

definitions. 

o Corrected the Carthage datum to use the Clarke 1880 (IGN) ellipsoid rather than 

Clarke 1880. 

o Improved accuracy of distance calculations when one or both of the line endpoints 

is within a few meters of the North or South Pole. 

 Added Cropping tab to Options dialog for elevation layers so you can directly crop 

elevation layers without having to export first. 

 Significantly sped up exports cropped to area features in many cases. 

 Added support for editing the type and labeling options for vector layers in a map 

catalog. 

 Added option to specify the number of digits of precision to include when exporting to 

Simple ASCII Text files so that you can override the defaults. 

 Added support for scaling any point symbol added on the Point Styles tab of the Options 

dialog for a layer, including interpolating the scale factor for attribute-based styles with 

the same symbol when based on numeric attribute values. 

 Allow double-clicking on a control point in any of the map displays on the image 

rectification dialog to select that control point in the list at the bottom of the dialog. 

 Allow selecting multiple control points at once on the image rectification dialog. 

 Made the default attribute lists for each type be saved to .gm_style files so they can easily 

be transferred to other systems. 

 Updated the CALC ATTR option in the Control Center to allow calculating multiple new 



attributes without having to re-open the dialog. 

 Added support for adding a DRAW_ORDER attribute to area features to control the draw 

order. This can be directly in the feature attribute list or in the default attribute list for the 

type. Valid values are 1 to 128. 

 Added support for bringing in measures from point and line Shapefiles using PolyLineM, 

PointM, or MultiPointM shape types. For PolyLineM the measures come in as the per-

vertex “elevation” values. 

 Updated Shapefile export to support exporting per-vertex “elevation” values as Measure 

values rather than Z values. For example to export PolyLineM rather than PolyLineZ. 

 Added option to spatial database exports to split into separate tables by the layer name. 

 Updated Wasp .map export to automatically shrink areas with a single roughness value to 

avoid touching adjacent areas so that the roughness can be applied just inside the area 

with a small buffer between the areas to make Wasp happy. In addition any areas with 

holes/islands will be split up to so that no holes are necessary to avoid overlap. 

 Added option to turn the display of labels on and off for a layer on the Options dialog for 

the layer. 

 Updated vector exports to allow cropping to multiple areas at once and also to area 

features with islands/holes in them. 

 Improved display of smoothed features, in particular streams from watershed generation 

and contour lines. 

 Fixed bug in v14.0.3 release with much larger depressions being filled than necessary in 

watershed and in particular ridge line calculation. 

 Added new built-in ‘Text’ point type. 

 Allow shared contrast adjustment to be used on map catalogs to allow easily applying the 

same contrast adjustment to large collections of images without having to directly load 

them. 

 Added option to control whether or not style attributes are included when batch 

converting to Simple ASCII Text files. 

 Made custom symbols file only be written out if any new custom symbols were added or 

removed, making it much easier to share user data folders between multiple users. 

 Updated PDF export to allow automatically calculating a round-number scale to save to 

by checking to print to scale and entering a value of 0. You can also include the 

calculated scale in the header or footer by using the text %SCALE% in the header and/or 

footer definition. 

 Updated Measure Tool so that option to use extra precision for measurements also 

applies to the display of bearing values, so you can make them more precise. 

 Added option to ignore EXIF information when loading JPG images and just load them 

as normal top-down images. This option in in the Advanced section of the General tab of 

the Configuration dialog. 

 Fixed issue in v14.0 release with ESRI File Geodatabases not opening if you didn’t have 

an ESRI license on the machine. 

 Fixed issue in v14.0 release with KMZ files exported for Garmin devices using the GPS 

menu command not working on the Garmin devices or when loaded back in Global 

Mapper. 

 Added recognition of Wasp Resource Grid Files (.rsf) that are missing the header line. 



 Made the image type (i.e. RGB, grayscale, multi-band) for JPEG2000 and ECW exports 

be remembered between exports. 

 Added support for loading more attributes from CityGML files. 

 Fixed problems loading GML files with gml:surfaceMember elements with 2D features 

in them. 

 Updated GPS heading display to always be a positive number (range 0-360). 

 Added new options on the GPS menu to control the units that the speed is displayed in. 

 Warn users when printing or exporting to scale with a view/export projection selected 

that does not have a consistent scale throughout the map, like Geographic or Mercator. 

 Added right-click option to path profile dialog to allow turning off the display of the 3D 

path of the line feature the profile was created from (if shown for a selected line). 

 Made Lidar load options only be remembered within a single group of files being loaded 

if you check the box to use for all Lidar operations. That way you get the options again 

for the next set and the filter rectangle can also be remembered. 

 Fixed problem in some v14 builds with view sheds not rendering properly. 

 Fixed flicker of Control Center when working with map catalogs and large lists of layers. 

 Fixed problems exporting non-English text to OSM XML files. 

 Fixed problem with tiles that don’t intersect a provided export crop area being discarded 

during a web export even if you uncheck the option to skip empty tiles. 

 Fixed problem that prevented allowing a port number to be specified for PostGIS 

databases. 

 Fixed issue with changes to the default font for custom feature types being lost if no other 

changes to custom types are made during that session of Global Mapper. 

 Fixed parsing of projection parameters from some BAG files. 

 Fixed problems with ordering of frame files in a.toc files for CADRG exports in the 

Southern Hemisphere. 

 Fixed issue with changes to spatial databases layers not being saved out to workspace 

files. 

 When doing an elevation export cropped to an area feature, treat the area bounds as the 

bounds of the visual extents of the export rather than the grid cell center as you would 

specify if manually providing bounds. 

 Fixed issue with mouse wheel zooming not working for some free-rotating mouse 

wheels. 

 Fixed issue with a non-default grid spacing provided while loading a generic ASCII text 

file as an elevation grid not being saved to workspace files. 

 Added option to General tab of the Configuration dialog to control whether or not unit 

labels (like ‘m’ or ‘ft’) are appended to projected grid line labels. 

 Made the view background color be saved to workspace files. 

 Prompt to save the workspace when unloading everything or closing Global Mapper if 

the projection, background color, or any map layout options changed. 

 Fixed problems loading MapInfo files with non-Western characters in the filename. 

 Updated raster exports from a map catalog to snap the export to a pixel boundary of the 

layers in the map catalog if the option is checked to snap exports to a pixel boundary if 

possible. 

 Fixed problem with overview layers from GeoTIFF files being ignored when loading the 



GeoTIFF from a workspace file or map catalog. 

 Fixed colors for ASRP exports and allowed numbers in the data set name. 

 Fixed bounding box coordinate order in TRANSH01.THF file exported for ASRP exports 

and also added bounding polygons for QAL and SOU files written for that export. 

 Added ‘Avg Speed’ column to Feature Vertices dialog for line features with per-vertex 

time stamps to show the average speed to the end of a given segment. 

 Allow deleting vertices on the Feature Vertices dialog by pressing the Delete key. 

 Made non-default resampling option for BIL elevation exports actually work. It was 

always being ignored and the default resampling used. 

 Fixed problems loading some RIK3 format files. 

 Sped up web exports cropped to complex areas when skipping empty tiles and the actual 

data files cover only a small part of the crop area. 

 Fixed problem loading SHP files over 2GB in size. 

 Make sure that the display label for area features with islands doesn’t show the label in 

one of the islands. 

 Added option to export area features as track lines when exporting GPX files. 

 

WHAT'S NEW IN Global Mapper v14.0 

 

 Significant New Features 

o Added support for spatial databases (see list below) for both import and export. 

ESRI ArcSDE (requires ESRI license on machine and 32-bit only) 

ESRI File Geodatabase (includes raster and grid and all versions of file 

geodatabses, requires ESRI license on machine and 32-bit only) 

ESRI Personal Geodatabase (requires ESRI license on machine and 32-bit 

only) 

MySQL Spatial 

Oracle Spatial 

PostGIS/PostgreSQL 

SpatiaLite/SQLite 

o Added new Terrain Analysis menu and moved functionality like contour 

generation, combine terrains, and watershed there from the File menu. 

o Added option to calculate the volume between 2 terrain surfaces on the new 

Terrain Analysis menu. 

o Added option to find ridge lines on loaded terrain data on the new Terrain 

Analysis menu. 

o Added new Favorites toolbar that provides easy access to frequently used 

Digitizer/Edit Tool options. The new toolbar automatically tracks which features 

you commonly uses and makes some of those available. You can also customize it 

and choose which options to always make available. The currently selected 

favorite can be run by pressing a button or using the Ctrl+Enter shortcut key. You 

can also setup custom keyboard shortcuts for any favorite item. 

o Reorganized Digitizer Tool right-click menu, greatly reducing the size of the 

popup menu and making it much easier to find items. 

o Updated the Quick Start buttons displayed at startup, removing the Find Data 



Online option and replacing the Manage Loaded Data (Control Center) button 

with one to Open Sample Data that is included with the installer. The new button 

also still opens the Control Center. 

o Added support for adding WFS (Web Feature Services) online data sources for 

dynamically loading online vector data sources. 

o Added support for adding WMTS (tiled WMS) online data sources. 

o Improved display of online sources at some display scales and also use less 

imagery for some DigitalGlobe exports. 

o Added button on DigitalGlobe client ID specification dialog to allow easily 

estimating how much premium DigitalGlobe imagery that you would need to 

purchase for a particular export size and resolution. Also show coverage for each 

DigitalGlobe source as you highlight it in the source list. 

o Update search dialog to allow selecting a specific set of layers to search in. 

 Global Energy Mapper Only Features 

o Added option to Digitizer Tool to create a flattened site plan that smoothly 

transitions a set of areas into the surrounding terrain with an allowed slope and 

optional benches/terraces. This tool can also calculate the optimal flatten height 

such that the cut and fill volumes are approximately equal (i.e. no haul in or out of 

dirt required). 

o Added option to rotate a shape feature to calculate an optimal rotation angle for 

selected area/closed line features such that the combined cut-and-fill volume for 

the features is minimized at a calculated break-even height. This is a powerful 

feature for finding the optimal orientation and cut height for a pad site to 

minimize the total amount of dirt that needs moved. 

o Added a new group of online data sources (with limited usage for free) from 

Spatial Energy (www.spatialenergy.com <http://www.spatialenergy.com>). This 

includes Bing Maps data, among several other sources. 

o Added option to Digitizer Tool to easily subdivide an existing area into 4 separate 

areas, like sectioning an area. Useful for parcel maps. 

 New Supported Formats 

o Added support for exporting loaded data to CADRG/CIB format data sets. 

o Added support for exporting loaded data to ASRP format data sets. 

o Added support for importing and exporting Garmin JNX format data sets. This 

allows much larger data sets (like imagery) to be exported to compatible Garmin 

devices which already have a Garmin BirdsEye subscription than the officially 

supported KMZ format. This option is part of the existing GPS menu item to send 

raster maps to a Garmin device and also as part of the list of raster formats from 

the File->Export->Raster menu command. 

o Added support for exporting loaded terrain data to binary STL format data sets. 

o Added support for generating OziExplorer .map positioning files for most raster 

exports and when batch converting to most formats (new in v14.0.1 release). 

o Added support for loading OpenAir Airspace text files. 

o Added support for exporting loaded line data to ZMap+ IsoMap Line Text files. 

o Added support for loading NMF (ArcGIS Explorer map) format files. 

o Added support for loading Cosmo-SkyMed SCS Radar Data in HDF5 Format. 



o Added support for additional bands of VIIRS data in HDF5 Format. 

o Added support for loading Cogent3D .imagery, .line, .point, and .poly files. 

o Added support for loading generic text files with MGRS coordinates. 

o Added support for exporting loaded contour line data to the AnuDEM contour 

.gen format. 

o Added new export options for RAW and ERS (ERMapper) Grid formats. These 

were previously possible using the BIL export, now there are just explicit options 

to get the proper extension and options by default. 

o Added support for text format files, like Arc ASCII Grid Files, larger than 4GB in 

size. 

o Added support for LogASCII v2.0 Files (only v3.0 were supported before). 

Change in v14.0.1. 

o Added support for elevation GeoTIFF files with 64-bit double-precision samples. 

 Digitizer Tool Changes 

o Added new Favorites toolbar that provides easy access to frequently used 

Digitizer/Edit Tool options. The new toolbar automatically tracks which features 

you commonly uses and makes some of those available. You can also customize it 

and choose which options to always make available. The currently selected 

favorite can be run by pressing a button or using the Ctrl+Enter shortcut key. You 

can also setup custom keyboard shortcuts for any favorite item. 

o Reorganized Digitizer Tool right-click menu, greatly reducing the size of the 

popup menu and making it much easier to find items. 

o Updated the toolbar buttons for creating new features to be active even if the 

Digitizer/Edit Tool is not active. If you select one of those options the tool will 

automatically activate. 

o When using the File->Unload All menu command, reset the tool to the Zoom 

Tool if the Digitizer Tool is active so that the projection can also be reset and 

avoid confusion when the next file is loaded. 

o Added option when rotating and scaling features to use the mouse to interactively 

rotate the features rather than specifying a specific rotation angle. 

o Added option to create a series of new line spaced along selected line/area 

features that are perpendicular to the selected feature. 

o Added option to assign attributes to selected point features from loaded line 

features. 

o Updated the option to assign address attributes to selected point features to also 

add an ADDR_SIDE attribute with which side of the line the point is on. 

o Updated options to assign attributes between features to choose which attribute(s) 

to copy. 

o Updated Undo option (Ctrl+Z) to allow un-doing the last deletion of one or more 

features (new in v14.0.1). 

o Added option when selecting all areas that connect to a selected area to select 

only those immediately connected or those that can be reached with any connect 

path. 

o Updated option to crop a selected area to a selected line to allow cropping 

multiple selected areas to the line. 



o Added option for creating more than 1 point offset from an existing point (new in 

v14.0.1). 

o Added support for adding elevation statistics to selected point features (in 

addition to lines and areas which are already supported) using the Digitizer Tool. 

This includes adding SLOPE and SLOPE_DIR attributes, as well as 

ELEVATION, from the loaded terrain. 

o Updated calculation of elevation statistics for area features to calculate the 3D 

surface area and store it as a SURFACE_AREA_3D attribute for each area. 

o Fixed issue in v13.2 with slow performance (i.e. apparent lockup) trying to snap 

in the vicinity of area and line features with an extremely high (i.e. tens of 

thousands or more) number of vertices. 

o Updated joining of lines with per-vertex timestamps (like tracklogs) to keep the 

per-vertex timestamps. 

o Added new View menu command to zoom to the features selected with the 

Digitizer Tool. 

o When creating range rings around multiple selected point features and choosing 

the option to combine the results, immediately combine the results rather than 

waiting until a subsequent operation with the combine checkbox not checked. 

o Updated options to select areas in other areas or to apply attributes to areas from 

other areas to allow just doing those that partially overlap and whose centroid is 

within a selected area. 

o Updated the feature measure dialog to highlight the feature selected in the dialog 

on the map. 

o Add a TIMESTAMP (as well as ELEVATION and DEPTH if applicable) 

attributes by default to points created with the Quick Point Creator feature from 

the position of a connected GPS device. 

o Fixed change in orientation of line and area features when editing the segment 

lengths when the bearings are being reported relative to magnetic north. 

 Scripting Changes 

o Added support for numeric and character looping in scripts using new 

VAR_LOOP_START and VAR_LOOP_END commands. This allows you to step 

through some range of numbers or characters in a script, including simple loop 

counters or numbers like coordinates. 

o Added support for looping over loaded layers in scripts using new 

LAYER_LOOP_START and LAYER_LOOP_END commands. This allows you 

to step through any loaded layers to perform operations based on some current 

layer. 

o Added new CALC_ATTR script command to allow calculating new or updating 

existing attribute values in a script, including numeric calculations between an 

attribute an another attribute or a fixed value and appending or prepending text to 

existing attributes. 

o Added new EDIT_MAP_CATALOG script command to allow creating new map 

catalogs and adding and removing maps from existing map catalogs from inside a 

script. 

o Added new SET_LAYER_OPTIONS script command to allow setting the display 



options of a loaded layer without having to unload the layer and re-import it. 

o Added new COPY_LAYER_FILES script command to allow copying the base 

files for one or more loaded layers to a new location on disk (new in v14.0.1 

release). 

o Allow use of the SHAPE_TYPE parameter to filter which types of objects (i.e. 

areas, lines, and/or points) are considered for the EXPORT_VECTOR and 

EDIT_VECTOR commands. 

o Added support for TRANSFORM_FILENAME parameter for IMPORT 

command in script to provide a coordinate-to-coordinate (rather than pixel-to-

coordinate like the GCP_FILENAME parameter) when loading a layer. 

o Added support for generating OziExplorer .map files for EXPORT_RASTER 

command. Use GEN_OZI_MAP_FILE=YES to enable this behavior (new in 

v14.0.1). 

o Added support for specifying the SPATIAL_RES parameter for export commands 

as percent values rather than raw numbers, to easily allow adjusting native 

resolutions. 

o Fixed issue with folders being created for each possible output when gridding 

even if no files end up being created there. 

o Added option to mark duplicate features with a DUPLICATE=Y attribute by 

adding MARK_DUPLICATES=YES to the EDIT_VECTOR command rather 

than just marking them as deleted. You can specify IGNORE_ATTRS=YES to 

only match on geometry and not also attributes, but now specify 

DUPLICATE_ATTR parameters to indicate some attributes that do need to be 

identical. 

o Allowed use of POLYGON_CROP_FOLDER_ATTR without also using 

POLYGON_CROP_NAME_ATTR to insert a folder into an output filename 

path. 

o Updated SET_LOG_FILE command to add a version string and timestamp to the 

log file. 

o Added new GRID_TYPE_PIXEL_SIZE_MAX parameter for 

EXPORT_RASTER and EXPORT_ELEVATION script commands to allow 

specifying that gridding should be done to a maximum pixel size, but then the 

actual pixel size shrank to get same-sized tiles that exactly cover the  specified 

export bounds rather than making the last row and column of tiles possible go past 

the edge. 

o Added support for providing a coordinate offset and scale (COORD_OFFSET and 

COORD_SCALE parameters) when exporting Lidar LAS files with the 

EXPORT_VECTOR command. 

o Fixed issue with the EXPORT_RASTER command when running a script from a 

command prompt whereby if you only had vector data loaded it wouldn’t be 

found. 

o Fixed COMBINE_TERRAIN script command to by one pixel larger in size to 

better maintain the sample spacing. 

o Fixed JOIN_LAYER command to work with formats other than Shapefiles. 

o Added option (TIFF_NO_GTIFF_HEADER) to disable writing out a GeoTIFF 



header when exporting a TIFF file. 

o Add option to prepend a blank line to the start of empty files being appended to 

with the GENERATE_PATH_PROFILE script command by adding an 

ADD_BLANK_LINE=YES parameter. 

o Updated DIR_LOOP_START to allow specifying .. (two dots) as the 

FILENAME_MASK parameter for just looping over directories without needing 

to specify a file inside the folders. 

 Online Source Changes 

o Added support for adding WFS (Web Feature Services) online data sources for 

dynamically loading online vector data sources. 

o Added support for adding WMTS (tiled WMS) online data sources. 

o Improved display of online sources at some display scales and also use less 

imagery for some DigitalGlobe exports. 

o Added button on DigitalGlobe client ID specification dialog to allow easily 

estimating how much premium DigitalGlobe imagery that you would need to 

purchase for a particular export size and resolution. Also show coverage for each 

DigitalGlobe source as you highlight it in the source list. 

o Added new SRTM terrain source hosted on globalmapper.com that is more 

reliable and much faster than the previous source hosted on a NASA/JPL server. 

The old source is still available with the text ‘Backup Source’ at the beginning of 

the source name just in case the new source is ever not available for any reason. 

o Added support for merging WMS sources comprised of multiple layers into a 

single download if the WMS server supports it. This is useful for vector data 

available as different layers. 

o Added drop-down lists to explicitly select the projection and file format to use 

when creating new WMS/WMTS sources so that you don’t have to provide it as 

part of the service name anymore if you want something other than the default. 

o Added support for adding custom tile-based sources that use quadtree naming 

(like Bing Maps). You just specify a custom URL string and use %quad for the 

quadtree name placeholder rather than %x, %y, and %z. 

o Added option for custom WMS sources to draw using a single download per 

screen draw rather than using tiles. This is useful for sources that add watermarks 

to each download from the WMS server.  This option is available by right-

clicking on a WMS source in the source list. 

o Updated TMS web export to generate a tileset XML file rather than an HTML 

file. 

o Updated TMS web export to generate a tileset XML file rather than an HTML 

file. 

o Added option to skip existing tiles for WorldWind Export, allowing you to split a 

large export among multiple running instances of Global Mapper. 

o Fixed default display projection when loading the entire world of DigitalGlobe 

imagery. It was coming in for viewing as a UTM projection centered on the prime 

meridian if nothing else was loaded, which was not good for viewing much of the 

world. 

o Made the WMS/WCS source selection dialog resizable. 



o Moved the File menu option to load an ECW file from the Web to the online 

imagery download dialog as a new button. 

o Added support for WMS sources that go from 0-360 rather than -180 to +180. 

 Projection/Datum Changes 

o Added Norwegian Transverse Mercator (NTM) zoned projection as a built-in 

projection. 

o Added ED50 (Malta) and Sphere Radius 6378137 m as built in datums. 

o Renamed Quebec MTM projection to MTM (Eastern Canada) to reflect that the 

projection is used for more than just Quebec. 

o Updated Hotine Oblique Mercator/RSO projections that use Azimuth Point 

parameter to save to PRJ files as ‘Longitude_of_Center’ rather than 

‘Central_Meridian’ so that Esri products will recognize it. 

o Use TOWGS84 parameters in a WKT PRJ file to select an appropriate datum 

specialization for datums like ED50 that have lots of transformation parameters 

available. 

o Use TOWGS84 parameters in a WKT PRJ file to select an appropriate datum 

specialization for datums like ED50 that have lots of transformation parameters 

available. 

o Updated New Israeli Datum transformation parameters based on official values 

from Israeli authorities. 

o Added support for using a default.prj file in the App Data folder (see Help-

>About dialog to set) in addition to the .exe file path. 

 Updating pasting of features to show a dialog allowing you to control what layer the 

features on the clipboard are pasted to. You can now either paste to the original layer (if 

still loaded), always create a new layer, paste to the User Created Features layer, or select 

a loaded layer to paste to. There is also an option on the Edit menu to control whether or 

not the paste options dialog is displayed or if the last selected option is used. 

 Reorganized the File menu to reduce its size, including moving the export commands to a 

popup menu and grouping some other related functionality together, in addition to 

moving spatial analysis functions like contour generation and combining terrain to their 

own menu. 

 Added option for displaying the bearing of line and area segments on the map on the 

Vector Display tab of the Configuration dialog. 

 Added option to calculate the areas that drain to and from selected line features when 

performing a watershed analysis. 

 Added option to watershed calculation to discard any stream stub segments (i.e. short 

segments at start of flow path) below a certain length threshold. 

 Updated watershed calculation to make the streams 3D lines and ensure that the stream 

elevation always flow 100% downhill, even through depressions. 

 Updated watershed calculation to save an input flow attribute (IN_FLOW) for each 

stream and also renamed the MAX_FLOW attribute to OUT_FLOW. 

 Updated map catalog dialog to have a checkbox next to each map so you can disable 

maps without removing them from the map catalog (added 14.0.1 release). 

 Added new custom Half Pie and Half Pie (Empty) point symbols that allow for custom 

sizes and colors for the same shape of symbol. 



 Allow overwriting loaded Shapefiles with large DBF files. Previously you would get an 

error if trying to overwrite them if they were currently loaded due to the DBF file being 

held open. 

 Added option to specify a bounding box to load when loading Lidar point cloud data. 

Useful for limiting your load to just a small region for very large Lidar files. 

 Added option to GPS menu to draw a ring around the vessel location of a user-specified 

radius. 

 Updated build of map legend based on an attribute of vector features to also check the 

default attribute list for the feature type, allowing you to assign alternate names for a 

feature type (like different language for built-in types). 

 Added new right-click option to the 3D path profile dialog to create a 3D line feature 

from the active sub-path. 

 Made the Path Details dialog displayed from a 3D path profile dialog modeless so you 

can interact with the path with the details shown and also show details of multiple paths if 

you have multiple profile dialogs open. 

 Include RETURN_NUM as attribute for Lidar point cloud points (v14.0.1 change). 

 Made Help menu command to Release/Remove licenses work for node-locked licenses, 

providing a mechanism to move licenses more easily. 

 Updated exports to KML/KMZ when using a Mars or Moon datum to stick with that 

datum to facilitate using the data in Google Mars or Google Moon. 

 Updated image rectification dialog to make the mouse wheel work for zooming when in 

the reference image view if the mouse is in there rather than just always zooming the 

zoom map view. 

 Added Heading (always instead of just when time available) and Total Length columns to 

Feature Vertices dialog showing the length along to the line to each vertex. 

 Updated font selection dialogs for things like the distance scale and elevation legend to 

allow selecting any color and not just one of a few common colors. 

 Added option when saving search results to the clipboard as text to save them to a file if 

they are too large to all fit on the clipboard. 

 Added new volume measure units (acre-feet, acre-inches, barrels, and barrels of oil). 

 Made geocoding addresses from a file use Country and Postcode fields. The address 

search will also be tried without the postal code if the results are poor as for some reason 

the search will sometimes work better without the postal code than with it. 

 Added option when batch geocoding addresses to copy any addresses that no match at all 

could be found for to the clipboard. 

 Added option to hide layers that are inside the selected area features to the right-click 

menu in the Control Center (previously just an option to hide layers outside selected 

layers existed). 

 Updated Control Center to move the selection to the layer below (or above if none below) 

the item(s) being deleted rather than moving it to the first layer in the list. 

 Fixed rare incorrect coloring of some PDF files in the 64-bit version. 

 Made holding down the Ctrl key when resizing the main map window maintain the same 

resolution rather than keeping the same bounds and changing resolution. 

 Greatly improved performance when exporting from online sources that occasionally 

return invalid image files. 



 Added option to clone existing attribute styles on the Styles tabs of the Options dialog by 

right-clicking on an item and selecting the appropriate command that pops up. This 

allows easily using an existing style for a new attribute value. 

 Fixed some issues with SOSI export and added OBJTYPE to every feature exported to 

SOSI file. 

 Updated ZMap Grid ASCII Export to use 5 columns of elevation rather than 3. 

 Restored dynamic behavior of water level slider on 3D view options dialog. 

 Fixed issue in v13.2 release with prompt for type of unknown files no longer being 

shown when using the File->Open Data File menu command. 

 Fixed issue with map layout items disappearing when you cancel a KML/KMZ export. 

 Fixed issue with small custom shape symbols being larger than specified when viewed in 

Google Earth after exporting to KML/KMZ. 

 Improved recovery from errors due to setting 3D view texture and/or terrain size larger 

than your video card can handle. 

 Added support for creating equal-value areas from map catalogs. 

 Fixed problems drawing some symbols from IoGas .gas files. 

 Corrected slope attribute value display to show degrees rather than radians for equal 

value area creation on a slope grid. 

 Added support for GDAL “no data value” tag (42113) when reading and writing 

elevation GeoTIFF files. 

 Added option to generic ASCII text import to create areas from closed line features if no 

CLOSED attribute is specified for the feature. 

 Fixed error loading high bit depth NITF files with embedded JPEG2000 images in v13.2. 

 Sped up rendering of ECW, MrSID, and JPEG2000 images when zoomed out a bit on 

them. They are no longer automatically interpolated to improve appearance as it’s not 

needed for multi-level formats like those. 

 Updated row and column grid naming to allow starting on strings of more than one letters 

(like BY). 

 Fixed issue with Control Center being impossible to find if you somehow drag it off the 

screen since the position is now remembered. 

 Limit field length and allowed characters in exported DBF files (such as with Shapefile 

export) to 254 characters as ESRI products can’t handle the full supported 255 character 

length and also can’t handle any special characters in DBF field names. 

 Fixed issue with “Never Anti-Alias Pixels” option in batch conversion not being obeyed 

if the automatic export resampling option is enabled (the default) on the General tab of 

the Configuration dialog. 

 Fixed problems with cropping to selected areas during batch conversion and also gridding 

vector data, like Simple ASCII Text or Lidar files, as part of the conversion. 

 Fixed issues with some .ntf files being recognized as NTF Grid files rather than NITF 

files and not loading. 

 Corrected tiny (about 1 parts in 6 million) over-reporting of calculated area values. 

 Corrected flight date written to Lidar LAS files to be days of year rather than days in 

month so it won’t always be in January. 

 Display FLIGHT_DATE for Lidar LAS files in the metadata dialog for the layer. 

 Fixed issues in v13.2 that could cause some buffer areas to be created with spikes back to 



the original feature being buffered. 

 Added keyboard access to GPS menu items Save Tracklog (Alt+G then S) and Mark 

Waypoint from Average Position (Alt+G then A). 

 Updated SPS format load to auto-detect the format version if no header was provided so 

that the attributes can be decoded properly from SPS v2.x files. 

 Corrected cell type written to ERS files exported along with  floating point BIL elevation 

files. 

 Updated raster KML/KMZ export so that if you have the box checked on the Gridding 

tab to create separate folders for each row that your KML/KMZ super-overlay export will 

create separate folders for the zoom levels and rows of tiles to avoid sticking huge 

numbers of files in a single folder for very large exports. 

 Added Ctrl+Shift+S as shortcut for Save Workspace As. 

 Corrected reporting of minimum clearance location for line of sight and also storage of 

line of sight to a KML file to save the great circle path it was calculated with rather than 

the straight line path. These can be significantly different for very long line of sight paths. 

 Added metadata about layers that were combined and the combine operation used to new 

elevation layers formed by combining terrain layers. You can see these values on the 

Metadata dialog for the combined layer. 

 Improved handling of loading multiple unknown file types at once by remembering the 

type selected if prompted. Also made MSI Planet files load regardless of filename. 

 Allow exporting grid lines to a raster file even if nothing else is loaded. 

 Made sea level display as blue in the Global Shader. 

 Added support for loading JP2 files with no embedded position information but with an 

accompanying .aux.xml file with position information. 

 Made the vector type filter dialog for the Map Layout dialog resizable and have right-

click options on each type list for clearing or setting all types. 

 Added option to GPX export to include all feature attributes and not just those officially 

supported in the GPX format. 

 Support additional GML flavors, like new OSGB INSPIRE maps. 

 Improved loading of LandXML files, including adding support for loading contour lines. 

 Added support for using index.txt (and other index files from MSI Planet) to position 

most image formats, like BMP. 

 Fixed issue from v13.2 loading NITF files with embedded high-bit-depth JPEG2000 

images. 

 Significantly sped up the drawing speed of some NITF files with embedded JPEG2000 

images. 

 Allow setting up attribute-based styling that matches against a blank value. 

 When loading KML files, obey any designated <HotSpot> and <scale> for custom icon 

symbols. 

 Added option to the Advanced Section of the General tab of the Configuration dialog to 

disable copying error message text to the clipboard automatically. Use this if you have 

issues with error text wiping out text you were copying on the clipboard when an error 

pops up in a Global Mapper process. 

 Updated import of color fields from generic text files to support some common color 

names, like RED, BLUE, GREEN, etc. in addition to specific RGB colors. 



 Added buttons on the screen capture dialog allowing you to easily increase or decrease 

the capture size by a multiple of the default size. 

 Drastically sped up exports of multiple terrain layers to new GeoTIFF elevation files. 

 Fixed issue in v13.2 and later with pan arrows not showing at edges of map display in 

image rectifier on some touch-screen systems (Fix in v14.0.1). 

 Added new right-click option on vector search dialog to minimize the size of each 

column (added in v14.0.1). 

 

WHAT'S NEW IN Global Mapper v13.2 

 

 Significant New Features 

o Updated DigitalGlobe premium imagery with access to new DigitalGlobe servers 

with faster access to more up-to-date and higher resolution imagery in most 

locations. 

o Added support for specifying custom paper sizes for geospatial PDF export. 

o Added MapQuest OpenAerial Worldwide Imagery as built-in source. 

o Load many geospatial PDF files at higher resolution. 

o Added option to most raster/elevation exports to control the resampling used 

during export right on the export dialog. 

o Added built-in access to geologic map datasets for most of the world using the 

File->Download Online Imagery/Data menu command. 

o Added new build-in USA Topo Maps source (replacing the msrmaps.com USGS 

DRG source which is no longer offered by Microsoft as of May 1, 2012). 

o Make WMS sources with a specified legend image (like some of the Geologic 

Maps just added) automatically show that legend image as a separate layer. 

o Added option when setting up the zoom scale display of loaded maps or map 

catalogs to display maps within a range of percentages rather than just always 

over a certain percent. 

o Add support for randomizing colors assigned when initializing attribute-based 

styling from existing attribute values on the Style tabs of the Options dialog for a 

layer. 

o Updated Global Mapper Package export dialog to replace Terraserver-

USA/MSRMaps.com export resolution option with one that works for any online 

layer, allowing you to export online layers to GMP files is a much more 

convenient manner. 

o Added support for loading DigitalGlobe imagery from their WCS server. 

 New Supported Formats 

o Added support for loading LogASCII Standard wellbore log format. 

o Added support for exporting loaded vector data to SOSI (Norwegian) format files. 

o Added support for loading PCI Geomatics PIX imagery format files. 

o Added support for additional GRIB2 format data sets, such as weather products. 

o Added support for NDVI (Normalized Difference Vegetation Index) data in 

HDF5 format. 

o Added support for VIIRS data in HDF5 format. 

o Added support for exporting loaded data to PCX image files. 



o Added support for loading waypoints from EasyGPS .loc format files. 

o Added support for initializing custom shaders from Hypack HCF files. 

o Added option to export multi-band imagery to XY Color Text files. 

 Projection/Datum Changes 

o Add built-in support for TWD67 (Taiwan) and Wisconsin County (Marathon) 

datums. 

o Improved accuracy of OSGB36 datum transformation in offshore areas where the 

grid shift file is inaccurate. In order to still provide a way to explicitly use the 

NTv2 grid shift or choose the 7-parameter transformations, the existing Ordnance 

Survey 1936 datum was renamed OSGB36 (Best Transform) and 2 new 

specializations, OSGB36 (Grid Shift) and OSGB36 (7-Parameter) were added so 

that uses that need a particular transformation can choose the one that they need. 

o Improved accuracy of nautical miles as units of measure. The conversion factor 

was inexact. 

o Made NAD27 datum specializations (like NAD27 Mexico) use the proper 

explicity datum code when exporting to MapInfo files rather than the generic 

NAD27 datum code. 

o Allow providing a rotation angle for Polyconic projections. 

o Added support for automatically adding custom datum definitions from GeoTIFF 

files using the GeogTOWGS84GeoKey tag. 

o Improved accuracy of State Plane Alaska Zone 1 projection conversions. 

o Corrected display of Robinson projection with non-zero central meridian. 

 Digitizer Tool Changes 

o Updated snapping when drawing new features to automatically snap to the 

intersections of line and area features, even if they don’t have a vertex at the 

intersection. 

o If grid lines are displayed, make snapping snap to them by default. You can 

disable snapping to grid lines on the Vector Display tab of the Configuration 

dialog. 

o Updated combine area operation to allow selecting which attributes have to be the 

same between features in order to combine them. 

o Allow creating distance/bearing/COGO lines from multiple selected points, 

allowing easy creation of lines offset some distance/bearing from a collection of 

start points. 

o Updated option to resample selected lines to have an option to split the lines into 

new lines at the newly created vertex locations, thus allowing you to easily split a 

line into fixed length pieces. 

o Allow deleting multiple attributes at a time when editing more than one feature at 

a time. Now when you select the Delete button on the edit dialog you get a list 

allowing you to select which attributes to delete, with the one selected on the 

main dialog the only one checked by default. 

o Allow cancelling the creation of lines from multiple area features by selecting 

Cancel on the feature options dialog that appears. 

o Added support for old-style shortcut keys for copy/paste, so now Ctrl-Insert/Shift-

Insert work for copy/paste in addition to Ctrl-C/Ctrl-V. 



o Added option to Edit menu to control whether or not we automatically enter move 

mode when pasting features from the clipboard. 

o Added new option to add style attributes to selected features to right-click menu. 

o Added new option to right-click Advanced Feature Creation submenu to create a 

new point feature offset a given distance/bearing from an existing selected point 

feature. 

o Updated option to add attributes to areas from points in that area to append values 

of attribute already exist to the new value for the area (comma-separated) rather 

than just using the first value encountered. 

o When drawing new features by snapping to existing 3D line or area features, use 

the elevation from the snapped-to feature even if not snapping to a vertex. 

o Corrected issues with the bearings and orientations of arc areas and line features, 

including making manually drawn arcs use projection-independent bearings by 

default rather than Cartesian bearings. 

 Scripting Changes 

o Added new JOIN_TABLE command to allow joining an attribute table to a 

loaded layer. 

o Added support for overriding the default resampling done during export by 

explicitly providing a SAMPLING_METHOD parameter with the sampling 

method to use. 

o Added support for exporting NITF format files using the EXPORT_ELEVATION 

and EXPORT_RASTER script commands. 

o Made the SIMPLIFICATION option for the EDIT_VECTOR script command 

also simplify area features. 

o Added option to include style attributes when exporting to Shapefile using the 

EXPORT_VECTOR script command by adding an INC_STYLE_ATTRS=YES 

parameter. 

o Updated DEFINE_VAR command to support having a REPLACE_STR 

parameter to replace some part of the variable value with some other text. This is 

useful inside of directory loops for replacing some part of an existing variable 

with some other text string. 

o Made advanced option to snap export to pixel boundary if possible also be applied 

when exporting from a script. 

o If grid lines are enabled make them export from a script using the EXPORT_PDF 

and EXPORT_VECTOR commands unless you specify 

SAVE_GRID_LINES=NO as a parameter. 

o Allow export to scale for PDF export using EXPORT_SCALE parameter for 

EXPORT_PDF command. 

o Added advanced option for ECW export using EXPORT_RASTER to allow 

embedding the 4th color band of input layers as the alpha channel value. Add 

USE_BAND4_AS_ALPHA=YES parameter to enable this functionality. 

o Fixed export of fixed screen position layers (like watermarks) to work even if the 

layer hasn’t already been rendered or exported. 

 Added right-click option on feature vertices dialog to allow providing offset and scale 

factors for selected elevation values. 



 Fixed problems using some ECW files. 

 Added option to add a title to the elevation legend. 

 Added option to customize the elevation range shown on the elevation legend (new 

option when you right-click on the elevation legend). 

 Added option to disable map layout text items without deleting them. The Map Layout 

dialog now has checkboxes next to each text item. 

 Update north arrow controls in Map Layout to be a checkbox to turn on and off rather 

than using the special ‘No Symbol’ selection to control this. 

 Added option to Shapefile export to include style attributes (like the area, line, or point 

draw style and the label font) when exporting. 

 Added new option to buffer creation to just create rectangles the given buffer distance 

from each segment of an area or line feature rather than creating a single buffer for the 

entire feature with curved edges and ends. 

 Updated path profile dialog with a line of sight to allow drawing multiple Fresnel zones 

and also drawing a line at each transmitter location from the terrain surface to the 

transmission height. 

 Added new option to contour generation to create the contour lines as the terrain passes 

to the contour height from above it rather than using the default of creating it when the 

terrain goes from the contour height to lower elevations. 

 Added right-click menu option to map catalog dialog to allow zooming the view to the 

selected maps. 

 Updated finding of equal-value areas for a terrain layer to use slope values if you 

currently have a slope shader enabled for the layer rather than elevation values. 

 Updated Styles tabs of the Options dialog for a layer to allow selecting multiple values 

for attribute-based styles at once for deleting or changing the style for. 

 Allow cropping to a selected area when exporting to MapInfo MIF/MID or TAB/MAP 

files. 

 Added support for reading KML attributes from <SimpleData> tags. 

 Added support for reading and writing KML <TimeStamp> tags. 

 Fixed long-standing issues loading many types of JPEG2000 files, particularly large 

NAIP imagery files that used to lock up or render very slowly. 

 Updated setting of group name from Control Center to have a drop-down list with the 

other existing groups to allow easily selecting an existing group. 

 Updated batch rectify export operation to ensure that each output image maintains the full 

resolution of the input image, even if it has to be expanded to account for rotation. 

 Added new right-click option on the map catalog dialog to allow sorting the maps by 

resolution. 

 When showing a 3D path profile from a named line feature, display the name of the line 

on the dialog title, on the path profile itself when saving to a BMP, and also in the path 

details. 

 Updated Lidar LAS exports so that updates to the CLASS and INTENSITY attributes for 

points being exported are used rather than the original values from the file. 

 Corrected auto-assignment of Lidar point types for classes 10 and up, including adding a 

new Lidar Bridge and Road point types. 

 When splitting layers by numeric attributes in the Control Center, sort the new layers 



numerically rather than alphabetically. 

 Made commas and semi-colons be the first checked for delimiters when doing an auto-

detect of delimiter on import of generic ASCII text files. 

 Update PDF layer and page selection dialogs to be resizable and have their size 

remembered. 

 Updated S-57 import so that if you have customized the style to use for Isobath areas that 

style is used rather than an auto-assigned solid shade of blue based on depth. 

 Made layer description in the Control Center include the count of deleted features. 

 Updated 3D view options dialog to have OK, Apply, Cancel, and Help buttons rather 

than updating the view immediately as you are changing values. This prevents 

inadvertent changes and very slow editing of values with large data sets loaded. 

 Fixed problem in v13.1 release with reading latitude from $GPRMC sentences formatted 

as DDMM.MMMM on a connected GPS device or from a NMEA text file. 

 Fixed bug exporting LASzip (LAZ) files from 13.1 release that caused them to only be 

readable in v13.1. 

 Fixed issue in 13.1 with labels not showing until you change the labeling option on the 

Options dialog for the layer in the Control Center after saving and reloading a workspace 

when not using attribute-based labels. 

 Made Arc ASCII Grid exports write no-data value as -9999.0 rather than just -9999 so 

that ESRI products don’t treat the grid as an integer grid rather than a floating point grid. 

 Made text file/CSV import not replace \n text in filenames or URLs with a newline 

character. 

 Added support for loading UKOOA P/190 files that do not conform to the format 

specification. 

 Fixed issue with v13 upgrade license being prompted for every time that you run in 

v13.1. 

 Use font rotation and placement information from OSGB MasterMap GML files. 

 Fixed problem with custom OSM/TMS/Google Maps tile URLs with variables in them 

and also ampersand (&) characters not working due to the ampersands being converted to 

their escape sequence (%26). 

 Fixed number of zoom levels used for custom OSM/TMS/Google Maps sources. The 

custom sources were only going to one less zoom level than specified (i.e. if you 

specified to go to zoom level 18 it would only go to 17). Note to get the correct zoom 

level behavior you would need to re-add your source. 

 Fixed issues drawing scaled semi-transparent custom symbols or printing them. The 

semi-transparent areas would not render properly. 

 Corrected MAX_FLOW and DRAIN_AREA calculations for streams in watershed 

calculation. They were showing values for anything flowing to the end point of a stream 

rather than just what could flow along that stream. 

 Made walk mode height stick on 3D view options dialog and also be remembered 

between runs. 

 Allow cancel of DTED file load. 

 Fixed searching on addresses with accent characters. 

 Fixed problem in v13.1 with some JPEG2000 files coming in with a Geographic 

projection but units of meters, so it can’t be reprojected. 



 Allowed larger embedded grid layers to be saved to workspace files without errors. 

 Changed alternate Cut shortcut key to be Shift+Delete rather than Ctrl+Shift+Insert as 

that is what it is historically. Ctrl+X still works as before. 

 Fixed issues loading from WMS sources where the GetMap URL includes a question 

mark. 

 Fixed crash in 13.1.2 when performing a cut-and-fill volume calculation over a range of 

elevation values. 

 Fixed issue in v13.1 with Global Mapper Grid exports with large no-data areas filling 

those areas with 0 when zoomed out. 

 Fixed issue in v13.1 with layer selection not working for all PDF files. 

 Fixed more issues loading DGN files with curves as part of the outer boundary of an area 

shape. 

 Fixed issue with exporting 3D area and line features with elevation units other than 

meters to vector Lidar LAS files. The elevation units were not converting correctly. 

 Fixed issue with the MapMart Data Discovery Tool from the online source not working 

on 64-bit Windows. 

 Updated XY Color Text export to store pixel center rather than pixel corner coordinates. 

 Added prompt to cancel entire load process when one of multiple selected files fails to 

load. 

 Updated E00 import to include the level for annotations as an E00_TEXT_L attribute for 

the point feature created for the annotation. 

 Make Control Center remember position between runs in addition to size. 

 Fixed issue in v13.1 with the length of attribute names and values being limited when 

adding or editing them. 

 Don’t show warnings about every empty E00 file encountered when loading more than 

one file at a time. 

 Fixed vertical flip of BMP exports with vector/map layout items included from v13.1. 

 Fixed issue in PDF export with Map Layout margins overriding PDF export margins and 

sometimes obscuring other map layout layers, like custom text. 

 Updated grid line export to PDF files to only show those grid lines appropriate for the 

export resolution rather than always exporting all grid lines. 

 Updated PDF export using the source filename/layer description for the PDF layer name 

to prepend the group name assigned to the parent layer for a feature to the layer name in 

the PDF file. 

 Added option to Gridding tab of export dialogs to control whether or not the row/column 

name is pre-filled with ‘A’ characters to make them all the same length. 

 Made batch convert from Lidar LAS to new Lidar LAS point files keep the LAS version 

the same in the header of the new files even if the files didn’t need to be as high of a 

version as they were. 

 Fixed error in v13.1 when loading some types of files with non-English letters in the 

filename. 

 Remember the quality, target compression, and simplification settings for each batch 

conversion operation 

 Made option to skip files with unknown projections during batch conversion also skip 

those with no known position information at all rather than using a default location. 



 Fixed error in v13.1 that caused no data to be loaded from Lidar LAS/LAZ when saving 

to a workspace and reloading or placing in a map catalog. 

 Fixed bug in v13.1 where the DPI was not being saved for GeoTIFF exports. 

 Fixed error about not being able to create file when doing a gridded export and creating 

folders for each row (or column if reversed). 

 Updated feature vertex dialog to spread vertex elevations just between the 2 selected 

vertices rather than between beginning and end if 2 non-adjacent vertices are selected. 

 Fixed loading of accented characters from UTF-8 encoded GNIS text files. 

 Sped up the creation of equal value areas from gridded layers in some cases, particularly 

with very complex shapes being generated as the result. 

 Fixed issue with the scale bar being incorrect on some raster exports. 

 Fixed error loading some Arc ASCII Grid (GRIDASCII) files from v13.1. 

 Fixed problem where rectifying an image when you have a map catalog of vector layers 

loaded causes all layers in the map catalog to be loaded for display in the reference view. 

 Made main Global Mapper window remember its location between runs on multi-monitor 

systems when closed on secondary monitor rather than coming back up on main display 

screen. 

 Made KML/KMZ files which contain NetworkLink elements referencing KMZ files 

automatically download and load those KMZ files. Previously only linked KML files 

would work. 

 Fixed issue when exporting Shapefiles from features with different attribute sets with 

multiple attributes over 10 characters in length with the first 10 characters being the 

same. 

 Added option to DXF export to control whether line features with just a single elevation 

(like contours) are written out as full 3D lines or just lines with elevation. In v13.1 the 

behavior had been changed to always write them as full 3D lines, this allows you to get 

the earlier behavior if needed. 

 Added Check All and Clear All buttons to many dialogs with a list of things that can be 

selected. 

 Added support for specifying an override of the rectification method inside a GCP file 

with a line of format Method=method_name, like Method=Polynomial, or 

Method=Affine. 

 Added option when creating new line types or editing existing custom types to have those 

lines drawn as “fat” lines, like roads are, when you zoom in on them. 

 Made the feature info dialog remember its location on screen. 

 Fixed issues adding WMS sources with a ? at the end of the URL. 

 

WHAT'S NEW IN Global Mapper v13.1 

 

 Significant New Features 

o Added new network licensing option with borrow feature and concurrent seat 

access. 

o Added support for geospatial PDF import/export to 64-bit builds. 

o Added ability to select which layer(s) to load from a geospatial PDF file. 

o Added ability to load multi-page geospatial PDF files with geo-positioning 



information. 

o Significantly sped up depression filling step when generating watersheds/drainage 

areas. 

o Added new built-in Topo Maps category to File->Download Online Imagery/Data 

menu command and added new Brazilian Topo Map source to the list. 

o Added built-in access to land cover datasets, like NLCD for the US and CORINE 

for Europe, using the File->Download Online Imagery/Data menu command. 

o Added support for generating roughness grids from land cover layers by right-

clicking on a land cover raster or grid layer in the Control Center and selecting the 

option to generating roughness. Currently the CORINE land cover and MODIS 

VCF are supported as input data types. 

o Added support for defining feature labels based on a custom free-form string that 

can include multiple attribute values. 

o Added support for defining feature labels based on a custom free-form string that 

can include multiple attribute values. 

o Made feature labels that are based on attribute values automatically update when 

those attribute values change. 

o Added option to allow cropping any loaded features to one or more selected area 

features to the right-click menu of the Digitizer/Edit. 

o Added display of the length of each segment when displaying the vertex list for a 

feature with the Feature Info or Digitizer/Edit tool and also allow for editing the 

length. Also make the selected segment be highlighted on-screen. 

o Added option to Digitizer Tool to allow editing the length of clicked area and line 

segments. With this mode selected, clicking on a line or area segment brings up a 

dialog allowing you to edit the length of the segment and the feature is reshaped 

accordingly. 

o Added option to Vector Display tab of the Configuration dialog to allow 

displaying the length of line segments on the map. 

o Made attribute editing remember any attribute names and associated values that 

have previously been entered and provide a drop-down list of those values for 

easy selection. 

o Added support for custom slope shaders. There is now a checkbox option on the 

custom shader dialog allowing you to specify the values are slopes in degrees. 

This allows you to easily colorize loaded terrain based on the slope of the terrain. 

o Added support for adding new OSM, TMS, and Google Maps tiled sources using 

a custom URL naming scheme. You can now provide URLs with %x, %y, and 

%z variables in them to have the tile URL setup however the source requires. 

 New Supported Formats 

o Added support for loading some LandXML files. 

o Added support for loading and exporting LASzip (compressed Lidar) files. 

o Added support for loading and exporting Lidar LAS 1.4 files. 

o Added support for loading .las.gz (gzipped-Lidar LAS) files. 

o Added support for loading IHS 297/298 Well Data point files. 

o Added support for loading and exporting GeoJSON files. 

o Added support for Digital Bathymetric Database Variable Resolution (DBDB-V) 



files in HDF5 format. 

o Added support for loading Pathfinder AVHRR (Sea Surface Temperature) files. 

o Added support for loading CORTAD (Coral Reef Temperature Anomaly) data in 

HDF5 format. 

o Added support for loading TRMM Precipitation Grid files from NASA. 

o Added support for exporting area and line features to CSV files using WKT 

coordinate formatting. 

o Added support for loading WAsP Resource Grid (.wrg/.rsf) files. 

o Added support for loading IGF DIS terrain grids. 

o Added support for loading INM 3TX terrain grids. 

o Added support for loading Micropath 3CD terrain grids. 

o Added support for exporting BIL terrain files as part of WorldWind export to 

generate new terrain data sets for use in WorldWind. 

o Added support for exporting area features to SMT Kingdom Polygon files. 

o Added support for loading GML files directly from .gz archives. 

o Added support for loading QGIS and CLR palettes. 

o Added support for exporting data to multi-band and high bit-depth NITF files. 

o Added support for exporting terrain data to NITF format files. 

 Projection/Datum Changes 

o Added built-in Minnesota County datum with pre-built zones for each special 

Minnesota projection. 

o Added built-in 3TM (Alberta), Croatia (TM), Gauss Krueger (Croatia), Trinidad 

Grid, and Universal Polar Stereographic North and South Zone projections. 

o Added Krasovsky 1940 Ellipsoid, NAD27 (Michigan) [for Lambert Michigan 

State Plane zones only], Potsdam 1983, Tete (Mozambique) and VN-2000 

(Vietnam) datums. 

o Added Clarke 1866 (Michigan) as built-in ellipsoid. 

o Added Kilometers, Chains (Benoit), and Chains (Sears) as built-in units. 

o Improved storage and retrieval of datums with non-Greenwich meridians from 

WKT-format PRJ files. 

o Added option to generate ESRI .aux.xml projection files for most raster exports 

and when batch converting. 

o Made false easting/northing work for Bonne projection. 

o Made ‘South American 1969’ datum automatically use SAD 1969 (Brazil) 

specialization if the location being converted is in Brazil. 

o Updated American Samoa 1962 datum conversion to use NADCON conversion 

tables for the best possible accuracy. 

o Fixed problems parsing degree projection attributes from GeoPDF files that aren't 

just straight decimal numbers (i.e. ’69 W’ rather than ‘-69’). 

o Allowed Equidistant Conic B projections to be saved to WKT PRJ files. 

o Fixed problems in v13.00 release with Old Israeli Datum, MGI Croatia-Serbia, 

MGI Slovenia, Kertau 1948 (Malaysia), and S-42 (Azerbijan/Georgia) datums. 

o Corrected Bursa-Wolfe transformation parameters provided as part of a 

TOWGS84 part of a PRJ file. The rotation angles had been reversed for small 



rotation angles. 

o Fixed extraction of projection information from ESRI .aux.xml files. 

o Fixed issue with very large (i.e. over 20,000,000 meters magnitude or so) false 

easting or northing values in MapInfo files. 

o Made the elevation units for vector files default to the units of provided projection 

if the elevation units are not explicitly specified. 

o Fixed problem using Stereo70 projection with a datum other than S-42 (Pulkovo 

1942). 

 Digitizer Tool Changes 

o Added option to allow cropping any loaded features to one or more selected area 

features to the right-click menu of the Digitizer/Edit. 

o Added display of the length of each segment when displaying the vertex list for a 

feature with the Feature Info or Digitizer/Edit tool and also allow for editing the 

length. Also make the selected segment be highlighted on-screen. 

o Added option to Digitizer Tool to allow editing the length of clicked area and line 

segments. With this mode selected, clicking on a line or area segment brings up a 

dialog allowing you to edit the length of the segment and the feature is reshaped 

accordingly. 

o Added option to Digitizer Tool to copy selected attributes from selected areas to 

any areas contained (partially or fully) within selected areas. Useful for applying 

things like land-use attributes to smaller areas. 

o Made attribute editing remember any attribute names and associated values that 

have previously been entered and provide a drop-down list of those values for 

easy selection. 

o Added new buttons to the Digitizer Toolbar for setting the new vertex draw mode 

to right-angle mode, orthographic (horizontal or perpendicular to screen) mode, 

and also to undo the last placed vertex. 

o Made snapping work when moving a single area or line feature if any of the 

selected vertices of the feature being moved (or any of the vertices if no vertices 

are explicitly selected) is close enough to snap to a vertex of another existing line 

or area feature. 

o When drawing new area or line features with both the right-angle to last segment 

and orthographic draw modes enabled, the vertex will also snap to align to the 

first placed vertex of the feature to make it easy to draw things with straight 

edges, like buildings. 

o Automatically enter Move Mode when pasting new features for easy moving of 

the newly pasted features. 

o When moving features, stay in Move Mode rather than switching back to default 

mode if on a Tablet PC device. 

o Allow display of multiple path profile/line of sight dialogs from selected lines. 

Also made those dialogs created with the Digitizer/Edit Tool be modeless so you 

can zoom and pan around the map while they are open. 

o Updated distance/bearing/COGO line entry so that if you have the 

distance/bearing/COGO dialog up and you click on the map while in the default 

distance/bearing mode, the distance and bearing from the last point to where you 



clicked is pre-filled for easy editing. 

o Added option to select area features that contain the selected point feature(s) to 

the Advanced Selection submenu of the Digitizer Tool when points are selected. 

o Added option when right-clicking on a map from a map catalog with the 

Digitizer/Edit Tool active to remove that map from the map catalog. 

o Updated projection of point along a distance and bearing to use more accurate 

Vincenty formula so that distances should match exactly. 

o Added option when creating buffer areas to specify the buffer distance via an 

attribute of the feature and to also specify the area type to assign to the new buffer 

areas. 

o Added dot at location of first vertex to be created for an area or line feature so you 

can see where it will snap to. 

o Dramatically sped up the creation of buffers around very complex shapes in some 

cases. 

o Fixed issue creating buffer areas when the current view datum is different than the 

native datum for the feature being buffered. 

o Made Cancel button actually work when cancelling the creation of multiple buffer 

areas around selected area and line features with the Digitizer Tool. 

o Updated creation of regular grid cropped to area to include cells where the center 

isn’t inside the crop area if the option on the Advanced section of the General tab 

of the Configuration dialog is checked to keep pixels if any part is in the crop 

area. 

o When connecting points into line features and all of those points have elevations 

and/or timestamps, add per-vertex elevations and/or time-stamps to the new line. 

o Update Distance/Bearing/COGO dialog to support COGO text files with tabs and 

also to support files where only some lines are recognized COGO distance entries. 

o Prompt users for the units for distances in distance/bearing COGO files that don't 

explicitly provide units. 

o Updated the calculation of area and line elevation statistics to include the position 

of the minimum and maximum elevation found within the area as separate X and 

Y attributes rather than a combined coordinate pair for each to make it easier to 

load back in as points. 

o Allowed calculation of elevation statistics for 3D lines even if no terrain data is 

loaded. 

o Added option to create points at the intersection of line features when 

finding/splitting lines at intersections using the Digitizer Tool. 

o Added keyboard shortcut so holding down ‘J’ when selecting multiple vertices 

with the Digitizer Tool automatically puts you in ‘join’ mode. 

o Add an ENCLOSED_AREA attribute to closed lines when adding measure 

attributes. 

 Scripting Changes 

o Allowed for interactive user provision of variable values using the PROMPT and 

PROMPT_TEXT parameters for the DEFINE_VAR script command. This allows 

you to run scripts that take user input! 

o Parameters that expect A value of YES or NO to enable or disable functionality 



can be enabled with just the parameter name. So rather than saying 

FLAG_PARAM_NAME=YES you can just say FLAG_PARAM_NAME to get 

the same behavior. 

o Updated COMBINE_LINES script command to allow 

CREATE_AREAS_FROM_LINES=YES to be specified for combining lines to 

areas from a script. 

o Added support for specifying bounds for many commands with an ADDRESS 

and RADIUS field. 

o Added support for BSB export with EXPORT_RASTER script command. 

o Updated EDIT_VECTOR command to allow special names like <Feature Name> 

or <Index in Layer> on right-side of ATTR_VAL parameter. 

o Updated EDIT_VECTOR command to allow COMPARE_STR to use != for 

comparison in addition to =. 

o Updated EDIT_VECTOR command to allow comparisons to be done numerically 

by adding a COMPARE_NUM=YES parameter to the command. 

o Added support for wildcards in FILENAME parameter to IMPORT_ARCHIVE 

command. 

o Fixed bug from v13.00 that caused POLYGON_CROP_BBOX_ONLY parameter 

for EXPORT_RASTER command not work. 

o Added support for exporting XY_COLOR format files using the 

EXPORT_RASTER script command. 

o Made variable replacement work inside DEFINE_MAP_LAYOUT sections. 

o Added support for PTS_AT_INTERSECTIONS parameter for EDIT_VECTOR 

script command to allow creating points at line intersections. 

o Added support for providing text values for many TIFF/GeoTIFF tags when using 

the EXPORT_ELEVATION and EXPORT_RASTER script commands with the 

GEOTIFF type. Supported parameters are TIFF_COPYRIGHT, 

TIFF_IMAGE_DESC, TIFF_DOC_NAME, TIFF_PCS_CITATION, 

TIFF_DATETIME, and TIFF_GTCITATION. 

o Added INC_COLOR parameter to EXPORT_VECTOR script command to 

specify that colorized LAS should be created. 

o Added option to generate ESRI .aux.xml projection files from export commands 

by adding GEN_AUX_XML_FILE=YES to the command. 

o Added support for ignoring the attributes lists of features when comparing them to 

see if they are duplicates with EDIT_VECTOR by adding 

IGNORE_ATTRS=YES to the command. 

o Added option to save a depression-filled DEM from a 

GENERATE_WATERSHED command to a GMG file by providing a 

FILLED_DEM_FILENAME parameter. 

 Fixed checkered export from some online sources, like 1 arc second NED and SRTM. 

 Added new right-click option to Swipe Tool to maintain the swipe after releasing the left 

mouse button. Then the swipe will be maintained for any exports. 

 Added support for using Epanechnikov kernel when calculating density grids. 

 Updated density grid generation to be volume-preserving. 

 Added options to density grid generation to specify how many sample cells will be in 



each radius and what area units to report using. 

 Added ‘Automatic’ option for DPI on PDF export. This will automatically use a DPI that 

causes the full resolution of the most detailed raster layer involved in the export to be 

maintained if possible. 

 Updated 3D viewer so that arrow keys and page up/down will pan and zoom the map in 

non-walk mode and the numeric keypad ‘8’ and ‘2’ keys will control the tilt. Also 

holding down Shift with the arrow keys and page up/down will get faster movement. 

 Improved automatic placement of point labels when they cannot be placed to the top right 

of points without colliding with another label. Now more locations than just the bottom 

left will be checked to see if they fit there. 

 Added support for tracking multiple GPS devices using $PCDLI (InStar GPS) NMEA 

sentences and SubSea $GID and $HID NMEA sentences. 

 Added option to add time stamp attributes to features when creating/editing them. 

 Allow much larger view shed calculations as the tables for calculation can spill to disk 

rather than having to be in memory. 

 Added option to view shed calculation to save the signal strength after free space path 

loss at each visible location to a separate grid layer that can then be operated on like any 

other grid layer. 

 Added progress reporting to view shed calculation when applying vector obstructions. 

 Updated view shed calculation to automatically replace no data areas with zero elevation 

so that you can easily calculate view sheds over ocean tiles. 

 Allowed for the same text label for point and area features to be displayed multiple times 

in the same area of the screen so long as they don’t overlap. 

 Sped up calculation of contrast adjustment statistics for some very large images. 

 Prevent display of ‘Map Data Not Available’ tiles when working with online data sources 

like ‘World Imagery’ that don’t contain data at all zoom levels at all locations. 

 Added option when batch converting to MapInfo formats to control whether or not 

NAME attributes are added. 

 Added support for automatically using a .gcp control point file accompanying an image 

file to rectify the image when loading it. 

 Added option to control whether or not sub-folders are searched when loading all files 

from a directory tree. 

 Made the load of some palette-based raster formats (like TIFF files) look for more 

descriptive palette files in the same folder as the TIFF file to improve the text display on 

the status bar. 

 Added option to Global Mapper Package exports of vector features with associated image 

files (like points from EXIF JPG file) to actually embed the associated images inside the 

package file for easy transport. 

 Updated S-57 to support inland waterways types. 

 Added support for some curved arc segments from ESRI File Geodatabase (GDB) data. 

 Improved support for TextString rectangles from ESRI File Geodatabase (GDB) files. 

Now they just come in as text. 

 Added advanced options for specifying the minor and major contour interval when 

generating contours. Previously you had to use the ContourInterval_Minor and 

ContourInterval_Major registry keys to do this (this also still works). 



 Updated DXF and DWG exports to have new labeling option to include labels in same 

layer as area and line features that they come from rather than generic 

FEATURE_LABELS layer. 

 Updated export of area and line features with a single elevation value to still create 3D 

features in exported DXF files. 

 Made road icons scale based on the symbol scaling factor specified when exporting PDF 

files. 

 Added option to Vector Display tab of the Configuration dialog to make the mode for 

drawing new area and line segments at right angles (perpendicular) to the previous 

segment on by default. You then turn off with the ‘R’ key. 

 Added new command to external control API command (GM_Ctrl_DeletePoint) to allow 

deleting existing point features that were added with GM_Ctrl_AddPoint. 

 Added option to automatically split Garmin Raster Map exports into separate KMZ files 

if the result won’t fit in a single KMZ that Garmin units can make full use of. 

 Updated Measure Tool to add new options on right-click menu to always use the larger 

unit (like km for metric or miles for statute) and also to round the measured value to the 

nearest whole number. 

 Added option when exporting vector data to KML files to control whether or not lines 

with per-vertex times are exported as ‘Replay Tracks’. 

 Updated elevation grid generation to allow a grid tightness threshold down to 0.5 grid 

spacings to allow getting a grid that exactly covers a regularly gridded set of input data. 

 Added option to control whether or not tile organization is used for exported JPEG2000 

files. 

 Improved support for NLCD (National Land Cover Database) files by automatically 

detecting the palette for those files and making the land cover type name be added to the 

palette for display in the status bar as you move the cursor around the map. 

 Made calculated density grids be saved to workspaces. 

 Added button to map catalog dialog allowing the removal of files that can’t be found. 

 Added option to Lidar LAS export to specify the File Source ID and Global Encoding 

values in the header. 

 Added option to Lidar LAS export to specify which vertical CS/datum to store in the 

header. 

 Made the bounds specified on an Export Bounds or other bounding box tab be displayed 

on the map as it is updated if possible. 

 Fixed crash calculating cut-and-fill volumes with the Measure Tool over a range of 

heights. 

 Added option to ‘Prepend as Text’ when calculating new attribute values. 

 When prepending or appending text to attributes from the calculate attribute option of the 

Control Center, don’t automatically provide an extra space character. 

 Fixed problem with coloring of point clouds from Lidar files from v13.00 release. 

 Updated the web format exports to treat an export PNG or JPG file where all pixels end 

up as background pixels as "empty" so they should not be exported if the ‘Skip Empty 

Tiles’ option is checked. 

 Fixed issue with ‘Show Labels for Lines of This Type’ setting not always working on the 

Line Styles tab of the Configuration dialog. 



 Fixed issue with sample spacing being incorrect for raster and elevation exports when 

gridding an export to selected areas and multiple areas resulting in the same output 

filename. 

 Fixed loading of some online sources, like World Imagery and World Topo Maps, from 

workspace files. 

 Made the last filename setting (i.e. use source filename or use quad filename/description) 

used be remembered when batch converting. 

 Fixed inconsistency with ‘User Created Features’ layer still being displayed as ‘User 

Created and Modified Features’ in some locations. 

 Fixed rare issue with some parts of double-precision Surfer Grid files not displaying. 

 Updated reporting of Metadata for vector layers to separately report how many deleted 

and non-deleted area, line, and point features there are. 

 Updated Control Center display to include the feature count next to each vector layer. 

 Fixed font assignment when splitting up features based on an attribute from the Control 

Center. 

 Updated creation of gridded surfaces by flattening areas to always use the flat area with 

the largest elevation at a given location if multiple areas are present at that location. 

 Added new built-in ‘Course Line’ line type to control how GPS course lines are 

displayed if that option is enabled. 

 Added support for exporting BSB maps natively with the Transverse Mercator projection. 

 Added option to allow long labels when batch converting to DXF files. 

 Fixed crash showing path profile/line of sight details when a Fresnel zone frequency is 

applied. 

 Made Lidar LAS files correctly write v1.2 in the header if color values are present rather 

than v1.1. 

 Fixed problems finding geospatial information from some Erdas .img files. 

 Updated LAS export with color values stored for each point to store colors in upper 8 bits 

of color values rather than lower 8 bits as some applications expect them that way. 

 Updated LAS export with color values from LAS point clouds that had the color data to 

allow transferring that color data over to the new file. 

 Added option when creating equal-value areas from palette-based raster layers to specify 

whether to always save the palette index/name or the full RGB value. 

 Fixed problems doing hyper-spectral multi-band exports with more than 16 bands or so. 

 Made option to snap to nearest input layer pixel on export work for gridded elevation 

exports in addition to raster exports. 

 Made very small (i.e. less than 1.0E-6) elevation scale factors store properly in 

workspace files. 

 Fixed problems loading some slightly corrupt .zip files. 

 Don’t add extra space above or below path profile to buffer when explicitly setting a 

minimum or maximum height to display. 

 Made option in Digitizer Tool to find points within some distance of another point save 

the results to a CSV file. 

 Made path profile be available for 3D lines from the Digitizer Tool even if no terrain data 

is loaded. 

 Drastically reduced memory requirements for online data sources when a very large 



bounds (like all data) is used and you reproject and zoom way in. 

 Made the default File->Open Data File folder be shared with the File->Load Workspace 

menu command. 

 Drastically sped up display of Map Layout dialog and Styles tabs of vector options 

dialogs when very large numbers of features are loaded from Lidar layers. 

 Dramatically sped up the load of some GML format files. 

 Added progress reporting to MapInfo MIF/MID and TAB/MAP exports. 

 Don't prompt for fake position or rectification for image files (like JPG) loaded from an 

archive file (like a .zip) if other files are present in the archive file. 

 Removed the ‘Close’ button from the Overlay Control Center as it was unnecessary and 

the dialog Red X suffices. 

 Updated web exports with the ‘Fill to Tile Bounds’ option checked to export all layers to 

the full bounds of the tiles from the lowest zoom level so that you don’t get different 

coverages at different zoom levels. 

 Fixed problems rendering overlapping point symbols in 3D view. 

 Updated SegY importer to use the same settings for each SegY file involved in a multi-

load. 

 Fixed some rendering issues with some DGN files, like those with 2D curves. 

 Drastically sped up sub-sampled exports from Erdas Imagine .img files with overview 

layers. 

 Added option to map catalog options dialog to always show the maps in the map catalog. 

This also fixes an error message if you right-clicked on a map catalog in the Control  

Center and set the zoom scales to show at to always, then tried to open the Options dialog 

for the map catalog. 

 Made automatic positioning work for new USGS GeoPDF topo maps. 

 Fixed per-vertex elevation lists being all 0 when loading SEGP1 and UKOOA files. 

 Made embedded picture images exported to KML/KMZ files be referenced as lower-case 

to make them work with Google Earth 6.1 which has a bug dealing with upper-case file 

extensions. 

 Made 3D view dialog remember its last position. 

 Updated S-57 and S-63 ENC imports to list the chart scale as part of the layer description 

and provide all of the chart header information as attributes listed as part of the Metadata 

for the chart. 

 Added checkbox option to regular grid creation dialog to control whether or not to keep a 

grid cell area if any part is in the crop area. 

 Made the settings to turn layers on and off based on map scale also be used during raster 

and elevation grid exports to remove layers based on the scale. 

 Allowed larger web exports to be done before hitting an ‘out of memory’ error. 

 Corrected behavior of 'Always Display All Labels' for point labels that do not use the 

automatic placement setting. 

 Added support for displaying (as metadata) and using the contents of the GEOPSB record 

for NITF files to assign non-WGS84 datums. 

 Made a report be generated and copied to the clipboard when performing a join operation 

from an attribute table to a loaded spatial table. 

 Fixed issues doing join of attribute table from DBF file with numeric fields. 



 Fixed issue with JDEMs with large elevations and added support for directly loading 

gzipped JDEM files. 

 Disabled display of pan cursors at edge of maps on Tablet PC devices. 

 Added option to Arc ASCII Grid export dialog to export center rather than corner 

coordinates. 

 Make feather blending with small feather distances (i.e. under 20 or so) smoother, 

particularly on export. 

 Added right-click popup option to Control Center to invert selection. 

 Update Polish MP export using a template MP file that uses Lowrance type mapping to 

write out Lowrance types to the new MP file. 

 Improved elevation legend on main display and on path profile dialog for very small 

ranges of values, such as when displaying non-elevation data. 

 Added support for specifying a DPI value to store when exporting a BMP file. 

 Fixed problem exporting to OSM XML file that caused extra </node> to be written even 

when <node> element was closed in start. 

 Added support for overriding the default maximum in-memory vector-to-raster export 

size of 8192 to allow splitting into different size tiles if your hardware allows it, like 

maybe a much larger size to avoid issues with labels disappearing when the export is 

split. The new value is a DWORD value named “BigExportTileSize” that should be 

placed in ‘HKEY_CURRENT_USER\Software\Global Mapper’. 

 Added smarter parsing of attribute tables stored as HTML in balloon text and 

descriptions for KML/KMZ files. 

 Fix problems enabling map legends of vector feature types when map catalogs with 

vector data are loaded. 

 Made shortcut keys work when the Control Center window has focus. 

 Made cropping a loaded raster layer to an area feature with islands/holes in it use the 

holes. 

 Allow creating equal-value areas for multiple selected raster or elevation layers at once 

from the Control Center. 

 Prompt user about whether or not to keep join results when there are multiple join table 

records with the same value. 

 

WHAT'S NEW IN Global Mapper v13.00 

 

 Significant New Features 

o Added support for loading ESRI File Geodatabase (GDB) data sets from ArcGIS 

v10 and later. 

o Added support for generating density grids from point features in a loaded layer. 

This density grid can be based on either just a count of the point features or any 

numeric attribute value associated with the points. 

o Added support for joining a file with attributes to the attribute table of an existing 

loaded spatial layer against a common attribute. To do this, right-click on the 

layer in the Control Center and select the new JOIN TABLE option. 

o Added support for calculating/copying new attribute values made by copying an 

existing attribute or performing mathematical operations either between two 



attribute values or an attribute value and some number. To do this, right-click on 

the layer in the Control Center and select the new CALC ATTR option. 

o Added built-in access to premium streaming high-resolution terrain and imagery 

from Intermap using the File->Download Online Imagery/Data menu command. 

o Added option under View menu to zoom to the same location in Google Earth. 

o Added option to transform layer coordinates either by a manually specified 

coordinate transformation or with a control point file when shifting coordinates 

for selected layers from the Control Center in addition to just shifting a fixed 

distance. 

o Added option to crop area features to line features using the Digitizer Tool. 

o Added option to easily draw rotated area and line rectangles using the Digitizer 

Tool through the 3-point draw method. 

o Added new Image Swipe Tool to allow easily swiping away a raster layer to see 

other layers in an interactive manner. 

o Added option to create line features rather than areas when creating a regular grid 

of features using the Digitizer Tool. 

o Added option to create point features at the cell edges when creating a regular 

grid of features using the Digitizer Tool. This can be handy for creating a custom 

grid labeled with the coordinate values at the edges. 

o Added option to create a line feature from selected point features. 

o Added a new option to the Advanced Feature Creation submenu of the Digitizer 

Tool to create lines connecting selected points to selected line features along the 

shortest path between the point and any of the selected lines. 

o Added option to Digitizer Tool to automatically move selected point features to 

the nearest point on selected line features. 

o Updated drawing of area and line features to allow easily drawing new segments 

at right angles to previous segments by holding down the ‘R’ key. 

o Added option to only search on-screen features in the search dialog. 

 New Supported Formats 

o Added support for loading ESRI File Geodatabase (GDB) data sets. 

o Added support for exporting loaded terrain data to SRTM HGT format files. 

o Added support for loading SegY format files. 

o Added support for loading NMGF (Noise Model Grid Format) files. 

o Added support for loading ATLAS BNA (boundary) format files. 

o Added support for exporting loaded data to XY Color text files. 

o Added support for exporting 3D triangle areas to Vulcan 3D TIN (.00t) files. 

o Added support for additional ways of encoding ASTER DEM data in HDF files. 

o Added support for loading NOAA/NGA Geoid binary grid shift files. 

o Added support for additional types of Japanese DEM files in LEM format. 

o Added support for Geosoft Grid files with 8-byte double-precision samples. 

o Added support for batch converting to Garmin-compatible KMZ files. 

 Projection/Datum Changes  

o Corrected NAD83 HPGN/HARN transformations that were messed up in v12.02. 

o Made Washington/Oregon HPGN/HARN transformation actually work. 



o Added support for automatically transforming vector file coordinates using a 

.gm_xform file accompanying the data file describing the transformation. This is 

useful for modeling things like local mine grids. 

o Updated rotation for projections to be applied relative to the false easting/northing 

location rather than the (0,0) point. 

o Added built-in support for Dealul Piscului 1933 (Romania), Le Pouce 1934 

(Mauritius), NAD83 HARN North Carolina, WI County (Chippewa), WI County 

(Taylor), and Xian 1980 datums. 

o Added support for Cape Feet, Centimeters, and Millimeters as linear units. 

o Made British Grid coordinates be displayed in the status bar with the 2 letter grid 

cell designation followed by easting and northing rather than just as decimal 

coordinates. 

o Make NAD83 datums write out as “NAD83” rather than 

“D_North_American_1983” to old format PRJ files to maintain compatibility 

with old ESRI products. 

o Corrected EPSG code for NY West Sate Plane zone to 2262 from 2261. 

o Improved conversion parameters for ED50 (Turkey) datum. 

o Fixed cropping to polygon during EXPORT_RASTER command. 

o Improved accuracy of some State Plane projection conversions that used non-

unity scale factors (increased from 6 to 9 digits of precision used for State Plane 

projection definitions). 

o Made Provisional South American Datum 1956 (PSAD56) export correctly to 

MapInfo files. 

o Fixed New Zealand EPSG codes 27291 and 27292 (the false easting and northing 

values were wrong). 

o Corrected import of scale factor from custom datum transformations specified 

with TOWGS84 in PRJ files. 

o Improved accuracy of Bursa Wolfe datum transformations with large rotation 

angles (i.e. more than a few arc seconds of rotation). 

o Corrected use of wrong datum transformation in some cases when using the non-

specific NAD83 CSRS datum. 

 Scripting Changes 

o Added support for simplifying (reducing) line features with the EDIT_VECTOR 

command using the SIMPLIFICATION parameter. 

o Added support for converting area features to line features with the 

EDIT_VECTOR command using the CONVERT_AREAS_TO_LINES 

parameter. 

o Added support for inserting vertices at line intersections and splitting those lines 

at those intersections with the EDIT_VECTOR command. 

o Added support for assigning unique ID attribute values to matching features for 

an EDIT_VECTOR script command using the UNIQUE_ID_BASE parameter. 

o Made SAVE_SCALE_AND_LEGEND work for EXPORT_PDF command. 

o Added FORCE_RGB parameter to GENERATE_EQUAL_VAL_AREAS script 

command to allow forcing the color attribute to use the full RGB color and not a 

palette index. 



o Added support for EXPORT_HEADER parameter for EXPORT_VECTOR 

command to control whether or not header row is written out for CSV export. 

o Added support for exporting to the InRoads ASCII format using the 

EXPORT_VECTOR command. 

o Added FORCE_EXIT command to allow forcibly closing a running instance of 

Global Mapper from a script. 

o Updated EDIT_VECTOR command to not work on hidden/disabled layers. 

o Added support for limiting the range of contour generation using MIN_ELEV and 

MAX_ELEV parameters for the GENERATE_CONTOURS script command. 

o Allow splitting DTED exports into folders by longitude using the 

EXPORT_ELEVATION command by adding a SPLIT_INTO_FOLDERS=YES 

parameter. 

 Added support for calculating free space path loss during view shed calculation and 

making those areas with less power more translucent. You can also see the remaining 

power at any location on the status bar as you move your cursor over the view shed. 

 Added display of the free space path loss in the path details for a line of sight calculation 

when Fresnel zones are calculated. 

 Updated the KML export to include a <gx:Track> section for lines that have per-vertex 

time stamps associated with them so you can play them back in Google Earth. 

 Added support for supplying radius for range ring generation from selected points 

through a RING_RAD_M attribute which supplies the radius in meters. 

 Updated the Simple ASCII Text export to use DMS or DM format for lat/lon values 

exported to text files if the Position Display Format is configured that way on the General 

tab of the Configuration dialog. 

 Added option to SEGP1 export allowing elevation values to be stored with an implied 

decimal. 

 Updated similar color transparency specification on the Display tab of the Options dialog 

for raster layers to provide a slider to control how similar a color can be to the transparent 

color and still be treated as transparent. This replaces the checkbox option to enable 

similar color transparency so that more control is possible. 

 Updated option to insert vertices at line intersections to allow only splitting where there 

are existing intersections and not inserting new vertices. 

 Added option to Alter Elevations tab of Options dialog for elevation grid layers to allow 

providing a power to apply when adjusting elevation values. 

 Added new option to the Options menu on the Path Profile/Line of Sight dialog to allow 

creating point features at the minimum and maximum elevation locations along the path. 

 Added new ‘Dot - Orange’ built-in symbol. 

 Changed the border color for red and green dots to black from white. 

 Improved grouping of Control Center right-click menu options to make them easier to 

find and also added upper-case one word descriptions to the start of some commonly used 

options to make them easier to spot. 

 Added option to Control Center right-click menu to allow hiding all layers that don’t 

intersect a selected area. 

 Added option to split Shapefile exports based on the description of the layer that each 

feature is in. 



 Added upper-case short descriptions of some commonly used items on the right-click 

menu for the Digitizer Tool. 

 Updated creation of equal value areas to allow color fuzziness up to 256 to allow easily 

getting a polygon for the valid area of the layer. 

 Added Ctrl+Alt+M as shortcut for Measure Volume functionality in Measure Tool and 

Digitizer Tool. 

 Added new Advanced Selection option to the right-click menu in the Digitizer Tool to 

allow easily selecting any area features that are connected to the selected areas. 

 Added new Advanced Selection option to the right-click menu in the Digitizer Tool to 

allow easily selecting any line features that are connected to the selected areas. 

 Fixed problem loading *.NTF files in v12.02. 

 Added support for adding a suffix to the row and column names when creating a regular 

grid of area or line features with the Digitizer Tool. 

 Updated KML/KMZ raster exports to allow specification of JPG quality value. 

 Added 2 new filtering modes for the Combine Terrain operation. You can now choose to 

keep the value from the first elevation layer if the second layer value is greater than or 

less than some other user-specified value. 

 Allow specifying a suffix for the label for points generated from selected area or line 

features (in addition to a prefix which you could already specify). 

 Added option to generate AutoKA PC World Files when batch converting to image 

formats. 

 Added option to use the layer name for a feature as the label for the feature in an 

automatically generated map legend. 

 Added support for coordinates in DDMMSS.S and DDMM.M formats when loading 

from generic ASCII text files. 

 Added real-time display of 16-bit values from high-bit depth TIFF imagery files as you 

move the cursor over the file. 

 Updated adding of measure attributes to 3D line features to include a LENGTH_3D 

attribute with the 3D length of the line if it is different than the 2D length. 

 Fixed export of overview layers to Erdas Imagine .img files from map catalogs. 

 Added display of maximum slope along path to 3D path profile details. 

 Added support for fractional coordinates of form degrees.numerator/denominator. For 

example, to enter W94.125, you could now enter W94.1/8. 

 Fixed fill coloring from some DGN files. 

 Added support for NetCDF files larger than 2GB in size. 

 Fixed problem from v12.00 with drawing elevation Erdas Imagine .img files when 

zoomed out if the files have overview layers. 

 Added option when creating point features spaced at some interval along selected 

area/line features to control whether or not a point is always added at the feature end 

point even if not at an exact multiple of the sampling distance. 

 Added option to not interpolate (resample) when batch converting to a gridded elevation 

format. 

 Fixed problems loading data from WMS servers that list both GET and POST methods 

for accessing the servers (like GeoPortal Poland). 

 Lightened up the outside color of displayed vertices to make them easier to see on dark 



backgrounds. 

 Fixed problem with crashes exporting from online elevation sources. 

 Made the simplification (reduction) of area features not create self-intersecting areas. 

 Made some PDS imagery files that use floating point samples for single band imagery 

(like from NASA’s LRO mission) display properly. 

 Sped up exports to Arc ASCII Grid files from large numbers of input files. 

 Fixed error saving workspaces and Global Mapper Package files when new areas with 

islands have been created in a layer. 

 Made the feature info dialog display the description for a layer from the Control Center 

as the Map Name rather than the original description. 

 Fixed RasterOverlay.cpp error loading some JP2 and ECW files with 16-bits per color 

channel. 

 Improved display of arrows to the ends of lines for thick lines and fixed width lines. 

 Fixed download of WCS data in projections other than lat/lon/WGS84. 

 Added support for NITF imagery using tiled JPEG compression (code M3). 

 Swap the drawing for area and line rectangles to by anchored at the top left by default, 

and switched to center-anchored if the ‘T’ key is pressed. 

 Made most view shed parameters be remembered between runs. 

 Fixed cropping to lat/lon boundary for polar stereographic projections. 

 Fixed bug updating the elevations for selected vertices on the Vertices dialog for a feature 

(previously it was just setting the elevation to the index of the vertex and not the actual 

elevation). 

 Fixed problem with some OSM XML files taking extreme amounts of memory to load. 

 Default to always show digitizer toolbar to prevent redraws when switching to Digitizer 

Tool. You can always turn this off if you want, it just defaults to on now. 

 Reduced memory required to load large Lidar LAS files as point clouds. 

 Updated the calculation of area elevation statistics to include the position of the minimum 

and maximum elevation found within the area. 

 Added support for providing extra parameters in OSM, TMS, and Google Maps tiled 

URLs when adding new sources. 

 Added support for Arc ASCII Grid files with extra line breaks after the header lines. 

 Fixed drawing of striped lines with black edges when printing. 

 Corrected Y flip of SurvCAD grid files. 

 Made 3D lines show through 3D translucent areas in the 3D view. 

 Fixed render issues with some GeoPDF files. 

 Corrected loading of MTEXT entities from DXF files with rotation elements provided. 

 Added support for reading and writing receiver group records in UKOOA P-190 files. 

 Corrected generation of area features for some VPF data sets (i.e. VMAP-1). 

 Added support for loading uncompressed 32-bit tiles from Arc Binary Grid files. 

 Made using Java filenames the default when exporting WorldWind tiles. 

 Added Ctrl+E shortcut to Overlay Control Center providing quick access to edit the 

description of selected layers. 

 Added new option to disable the automatic bilinear interpolation of terrain layers on load 

to the Advanced section of the General tab of the Configuration dialog. 



 Corrected creation of equal-value elevation areas around zero. 

 Fixed issue with duplicate area entries in the map legend sometimes. 

 Fixed bug with some exported SVG files having an extra group close. 

 Fixed export of text labels from points with no symbol to SVG files. 

 Made ‘fill to tile bounds’ option work for OSM and TMS exports. 

 Added progress reporting and cancel support for selecting areas that are included within 

or intersect other areas with the Digitizer Tool. 

 Added support for loading GIF images from KMZ files. 

 Fixed loading of curves from DGN files. 

 Made layer names for inserted BLOCK entities in DXF files be assigned properly. 

 Added new Advanced option to tiled web format exports (i.e. Google Maps, Bing Maps, 

OSM, and TMS) to use PNG files rather than JPG files whenever background pixels are 

encountered during the JPG export. 

 Added new options to Google Maps tiled export to make the custom map be a basemap 

layer rather than an overlay layer and to control whether the zoom, pan, and street view 

controls are added. 

 Fixed use of feet as receiver or transmitter height units for view shed calculation. 

 Added option to save the results of a ‘Find Non-Connected Line Endpoints’ operation to 

a file. 

 Added support for NMEA GPS devices that use $DPGGA position sentences. 

 Added options to DWG and DXF exports to allow exporting labels longer than 31 

characters. 

 Added option to Polish MP export to save out all feature attributes and not just those 

defined by the MP format. 

 Made OSM export use lower-case text for all attribute names. 

 Fixed crash when inserting vertex along closing leg of area feature. 

 Fixed grid line placement when margins are present on Map Layout dialog. 

 Do a little bit smarter address search when no 'ADDRESS' field is found in file to geo-

code but other fields are. 

 Allow specification of new elevation values on feature vertex dialog with comma for 

decimal place rather than period. 

 Added CLOSED_CONTOUR attribute to automatically generated contour lines that are 

closed. 

 Added ELEVATION attribute to automatically generated contours so the elevation is 

available as an attribute as well as the display label. 

 Added support for using LZW or Deflate compression on elevation GeoTIFF files. 

 Added new option to the Advanced section of the General tab of the Configuration dialog 

to disable the prompt to skip loading files that are already loaded. 

 Added new option to the slope direction shader to allow providing an offset angle to 

allow for checking alignment against angles other than cardinal directions. 

 Fixed problems with attribute names with accent characters not working to add display 

labels from in some cases. 

 Fixed error loading NITF files with JPEG2000 encoding over 2GB in size. 

 Improved reading of SHP files with no SHX file. 



 Fixed issue with red box around point location for 'No Symbol' points with text exported 

to KML/KMZ files. 

 Added JPG quality setting to Google Maps/Bing Maps/OSM/TMS export dialog. 

 Updated option for selecting lines within area to allow selecting those lines that are just 

partially in the area in addition to those completely within the area. 

 Allow export of grid lines to Shapefiles even if no other line features are loaded. 

 Added support for extracting feature attribute information from <ExtendedData> section 

of <Placemark> entities in KML/KMZ files. 

 Added option to the Advanced section of the General tab of the Configuration dialog to 

minimize the main window during exports. 

 Made simplification and smoothing operations work on un-selected island areas. 

 Made the aspect ratio always be maintained when saving the 3D view to an image file. 

 Made SVG exports include an “id” values with a unique number for each exported 

feature. 

 Updated GPS menu item for sending custom raster maps to a connected Garmin device to 

have an option to specify the maximum map count. This default to 100, but you can 

increase it for newer units that support more than 100 map tiles. 

 Fixed problem exporting Ozi .ozf images to palette-based formats. 

 Updated JPG2000 export to internally tile the created image to 1024x1024 tiles. 

 Made Lidar points marked as “withheld” be automatically marked as deleted on import. 

 Improved vector search dialog so that moving features to a new layer doesn’t reset the 

sort and column sizes. 

 Added option to default GeoTIFF export to use no compression to the Advanced section 

of the General tab of the Configuration dialog. 

 Added option to the GeoTIFF export dialog to disable the writing of GeoTIFF header 

information to the generated file. This is useful for using things like datum specializations 

that can’t be exactly stored in GeoTIFF files, so you’d rather just use a PRJ file and not 

have anything in the GeoTIFF file. 

 Updated SEGP1 import to default to feet for the elevation units if statute is selected for 

the elevation display/export units on the Vertical Options tab of the Configuration dialog. 

 Added option to the Vector Display tab of the Configuration dialog to set the default 

character set for fonts to allow easily switching default fonts to a non-Western European 

character set. 

 Made export of distance/Z file from path profile dialog work properly when a non-zero 

base distance is specified. 

 

WHAT'S NEW IN Global Mapper v12.02 

 

 Significant New Features 

o Added built-in access to additional online Worldwide Imagery, Street Maps, 

MapQuest OSM Street Maps, and Topo Maps using the File->Download Online 

Imagery/Data menu command. 

o Added new MapMart On Demand premium data source to the File->Download 

Online Imagery/Data menu command. This source provides easy access to the 

large library of data sets that MapMart.com provides. 



o Added support for adding online sources that use the Google Maps tiling scheme, 

like a lot of ArcGIS tile sources and Nearmap imagery from Australia. 

o Added support for loading data from WCS (Web Coverage Service) data sources 

using the File->Download Online Imagery/Data menu command. 

o Updated creation of equal-value areas to allow selected just a single color value to 

create areas for rather than creating equal-value areas for all selected colors. 

o Added new right-click option to Control Center to allow splitting a loaded vector 

layers into new layers based on the feature description, type, name, or any 

attribute value. The new layers will automatically be grouped under the original 

layer name. 

o Added additional built-in line styles, including several new Dash styles with 

different dash sizes and spacing. 

o Updated creation of strike-and-dip points to allow dragging along the strike/dip 

direction when placing the points to automate selection of value. 

 New Supported Formats 

o Added support for loading ioGAS .gas point files. 

o Added support for loading Lowrance USR v4 format files. 

o Added support for exporting point features to Lowrance USR v4 format files. 

 Projection/Datum Changes  

o Added built-in support for NAD83 (CSRS) [Canadian Spatial Reference System] 

datum transformations, with grid shifts initially supported for Alberta, British 

Columbia, New Brunswick, Quebec, and Saskatchewan. 

o Added built-in support for Combani 1950 (Mayotte), CSJ67 (Guyane), ED50 

(TURKEY), Fort Marigot (St. Maarten), Guadeloupe 1948, Martinique 1938, 

RGFG96, RGM04, RGR92, and RGSPM06 datums. 

o Added built-in 10TM (Alberta) and Natural Earth projections. 

o Made Irish Grid coordinates display using grid tile letters and coordinates on the 

status bar rather than just the base eastings and northings. 

o Added support for decoding Transverse Mercator projections from Touratech .cal 

files. 

o Restored Bogota Observatory transformation from before v10 as it is more 

appropriate for all of Colombia. 

o Improved storage of New Zealand Map Grid and New Zealand Transverse 

Mercator parameters in GeoTIFF  and MapInfo files. 

o Corrected ellipsoid used for Kertau 1948 datums from Everest 1830 to Modified 

Everest 1848. 

o Recognize "standard_parallel_1" for true scale latitude parameter for Mercator 

projections from WKT PRJ files. 

o Added support for Links and Clarke Links as a linear unit for projections. 

o Updated the projection selection dialog to display the base projection parameter 

values for State Plane projections. 

o Corrected EPSG codes used for SIRGAS 2000 UTM zones. 

 Scripting Changes 

o Added support for defining variables and associated values using the new 

DEFINE_VAR script command. 



o Added EXPORT_PDF script command to allow exporting PDF files from a 

script. 

o Added GENERATE_EQUAL_VAL_AREAS script command to allow creating 

equal value areas from a script. 

o Added support for copying attribute values in loaded vector data using the 

ATTR_TO_COPY parameter for EDIT_VECTOR script commands. 

o Made the EDIT_VECTOR command work for User Created Feature layers. 

o Added support for exporting ESRI-format .hdr files for BIL export by adding a 

USE_ESRI_HDR=YES parameter to the EXPORT_ELEVATION script 

command. 

o Added support for POLYGON_CROP_FOLDER_ATTR parameter to add an 

attribute name as a folder name when cropping to a list of area from a file. 

o Added support for adding lat/lon columns to CSV exports with an 

ADD_LAT_LON=YES parameter. 

o Added support for adding fading to raster KML/KMZ exports using 

KML_FADE_EXTENT_MIN and KML_FADE_EXTENT_MAX parameters for 

EXPORT_RASTER script command. 

o Added support for specifying quality for JPEG-in-TIFF exports using QUALITY 

parameter. 

o Added support for exporting DTED files with the EXPORT_ELEVATION script 

command. 

o Added support for only exporting vector layers to package files using the 

VECTOR_ONLY parameter for EXPORT_PACKAGE commands. 

 Updated Lidar import to support filtering out any types of returns rather than just keeping 

them all or just ground shot points. 

 Updated PDF export to include clickable hot-spot links for any point features with a 

LINK attribute pointing to a web page or local file. 

 Updated Shapefile export to add option to split the exports based on the feature display 

label or any attribute value (previously you could only split on feature type or 

description). 

 Updated Style tabs of Options dialog for vector layers to allow initializing the attribute-

based styling list with the list of attribute values found in the selected layer(s). 

 Updated cut-and-fill volume analysis for area features to allow specifying a range of 

elevation values to calculate the volumes relative to. When this is done the results for 

each cut level will be displayed in a table. 

 Added option to the Vector Display tab of the Configuration dialog allowing changing 

the default font face name. 

 Reduced memory required for loading PDF files so that more PDF files can be loaded at 

once at higher resolutions. 

 Made cropping of multi-band exports to areas features work properly. 

 Added option to control fading and maximum display level for raster KML/KMZ 

exports. 

 Added advanced option to raster KML/KMZ export to allow separating each layer 

exported into its own ground overlay in the exported file. 

 Added support for <PhotoOverlay> elements from KML files. They will come in as 



Picture point features that show the image when clicked on. 

 Added support for using KML/KMZ files reference via external <NetworkLink> 

elements when loading KML/KMZ files. 

 Added support for using styles referenced via external URLs when loading KML files. 

 Made duplicate vertices be removed from area features when exporting to Shapefiles. 

 Updated equal-value area creation to support cropping to bounds or selected area 

features. 

 Added support for only selecting point features with the Feature Info/Digitizer Tool by 

holding down the ‘P’ key when left clicking, lines by holding down the ‘L’ key when left 

clicking, and areas by holding down the ‘A’ key when left clicking (previously area-only 

selection used the ‘P’ key). 

 Updated option to create a new point feature at a specified location to also allow 

providing an elevation value. 

 Made automatic iconization of road names work for European-style highway names (like 

A, B,and M roads) and also when you change the attribute to use for labeling rather than 

just at load time. 

 Added support for WMS servers that use CRS rather than SRS to specify projections in 

their GetCapabilities document. 

 Fixed poor performance with some TIFF files in the 64-bit version. 

 Updated gridding to area features to allow combining the export results of multiple areas 

that have the same attribute/label being used for naming. 

 Updated WaSP .map import to find areas that are holes/islands in other areas. 

 Fixed 1-pixel shift of data under a translucent layer half of the time due to rounding. 

 Updated to support VPF files with no 'lat' file when loading directly from a 'lht' file, such 

as is common with UVMAP data sets. 

 Fixed issue with built-in Landsat imagery data sources only getting up to 30m resolution 

data rather than better than 15m resolution. This bug has existing since v11.00. 

 Updated map catalog dialog to have a button allowing the modification of style settings 

for vector layers in the map catalog. 

 Fixed crash sometimes trying to find areas enclosed in other areas when partial overlaps 

are being checked for. 

 Fixed issue with X and Y coordinates being swapped when importing GML files with 

lat/lon coordinates. 

 Updated Bing Maps, Google Maps, OSM, and TMS tile exports to have option to force 

PNG files to export as palette-based PNG files rather than automatically switching to 24-

bit RGB PNG files if each tile has more than 256 colors. 

 Made the style ‘Solid with Black Edges’ render correctly with fixed width in meters 

styles. 

 Include quotes around CSV column headers to prevent warnings in Excel for CSV files 

saved from the path profile dialog. 

 Updated import of VPF format data sets (like VMAP, UVMAP, DNC, etc.) to include 

both the decoded attribute descriptions and value descriptions as well as the raw attribute 

names and values. 

 Corrected issues importing and export Z/elevation values with DGN v8 files. 

 Updated equal-value area creation to save the palette index for the color value for palette-



based files rather than the full RGB color. 

 Fixed problems with elevation legend display for very large values (i.e. over 1 million). 

 Prompt user for whether to recurse directories or not when adding a directory of files to a 

map catalog. 

 Remove error about file being open in another application when skipping existing tiles 

and exporting to new TIFF files. 

 Added support for providing view shed transmitter and receiver height values relative to 

sea level rather than ground via selected point attributes named OFFSETA_MSL and 

OFFSETB_MSL. You can also add ‘ft’ to the end of the height values to specify the 

heights in feet rather than meters. 

 Updated Gridding tab for exporting to allow specifying overlap as a number of 

pixels/samples in addition to percent of cell size. 

 Fixed crash when interrupting the draw of some TIFF files (i.e. zooming and/or panning 

fast around the data). 

 Fixed bug with modifications to vector features not being read from workspaces if the 

layer also used custom area, line, or point style setups for the layer. 

 Made areas exported to WaSP .map files always be clockwise in orientation. 

 Added option to CSV export to control whether or not lat/lon coordinate values are 

formatted according to the Position Display Format settings or just use raw numbers. 

 Updated option to create points at elevation grid cell centers in the Control Center to 

allow generating points only for a portion of the selected layer(s). 

 When creating new unclassified features or moving unclassified features to a new layer 

with a default type set, automatically change the type to the default type (area, line, or 

point) for the layer of the feature. 

 Updated Google Maps HTML export to use v3 of the Google Maps API. 

 Updated the area elevation statistics calculation to include the aspect (what direction the 

area faces) if it faces most one cardinal direction. 

 Made Lowrance symbol be remembered when importing a Lowrance USR file and 

exporting to a new USR file. 

 Significantly reduced or removed visual seams between elevation layer tiles in map 

catalogs and from online sources. 

 Fixed issues with area features from some DGN files coming in as lines. 

 Added some support for parsing tables of attributes in KML feature descriptions into 

separate attribute values in Global Mapper. 

 Fixed loading of SEG-P1 files that uses decimal lat/lon coordinates rather than DMS 

coordinates. 

 Fixed loading of some line styles from DGN files. 

 Split raster maps that cross the anti-meridian into 2 separate pieces when batch 

converting to a lat/lon projection, like for KMZ export. 

 Corrected view shed calculation when a range of transmission angles are provided. 

 Fixed problems with some attributes from some DGN files not being properly assigned. 

 Fixed export of HF2/HFZ files with fractional units (like centimeters). 

 Updated feature vertex display dialog to show lat/lon coordinates using the current 

Position Display Format setting rather than always showing decimal degrees. 

 Added right-click menu option to feature vertex dialog allowing you to easily spread the 



elevation values along the vertices of a feature to achieve a constant slope between the 

first and last point. 

 Added right-click menu options to feature vertex dialog allowing you to add per-vertex 

times and editing existing time/speed values for each segment of a line feature. 

 Added support for ENVI DEM files with 32-bit integer samples. 

 Added new right-click option to Download Online Imagery/Data dialog allowing you to 

set the maximum resolution at which to try and download data from a user-added WMS 

source. 

 Added new box minimum resampling methods. 

 Added new 9x9 box average and box max resampling methods. 

 Automatically shrink the font for the sub-path text display on the path profile dialog to 

make sure it fits if it is too large to fit in the default font. 

 Added option to specify stream area threshold for watershed delineation as a ground area 

or a fixed cell count. 

 Added option to save the flow accumulation values for each cell to a grid layer when 

calculating a watershed. 

 Updated watershed generation to add NEXT_STREAM_ID attribute to generated 

watershed areas where the ID of the stream that the stream for the watershed flows into is 

stored to facilitate determining connectivity. 

 Updated watershed generation to add DRAIN_AREA attribute to generated streams to 

show the total area that drains into the stream. 

 Update the label display for built-in dot symbols to be closer to the actual dot. 

 Made numeric values be sorted numerically in vector map legend. 

 Improved text placement for some TEXT entities from DXF files. 

 Added support for SOSI files with multiple unit multiplier specifications. 

 Added support for Architectural paper sizes for PDF export. 

 Corrected rendering of fixed height symbols to PDF files. 

 Fixed elevation values for points created from an elevation grid layer when offset and/or 

scale values are applied to the elevation grid layer. 

 Fixed loading of WKT formatted data from some text files. 

 

WHAT'S NEW IN Global Mapper v12.01 

 

 Significant New Features 

o Added built-in access to 1/3rd arc second (~10m resolution) US NED terrain data 

using the File->Download Online Imagery/Data menu command. 

o Added option to export tiles conforming to the OSM (OpenStreetMaps) and TMS 

(Tile Map Service) standards for tile naming and zoom levels. This is under the 

File->Export Web Formats menu command and very similar to the Google Maps 

or Bing Maps exports. 

o Added support for adding new custom OSM/TMS online tile sources on the File-

>Download Online Imagery/Data dialog. 

o Added support for exporting loaded data to BSB Marine Chart format files. 

o Added ability to improve display of 3D view by selecting the size of the terrain 

and texture layers to use when displaying the 3D view and also interpolating view 



of data draped from main map view. You can increase the terrain and texture sizes 

to get a more detailed (but slower) display. 

o Added option to create area features from equal colors/elevations in any loaded 

raster/elevation layer by right-clicking on it in the Control Center and selecting 

the new option to do so. This is useful for things like extracting vector coverages 

from something like a land use/cover raster image, like NLCD data. 

o Updated watershed analysis to allow finding the drainage areas that drain to a 

selected point as well as to trace the flow leaving selected points. 

o Made custom symbols be embedded within Global Mapper Package (GMP) files 

so those symbols can automatically be used on other installations without having 

to first install those symbols. This makes GMP files even more self-contained for 

transporting data. 

o Added support for automatically adding custom symbols referenced in 

KML/KMZ files. 

o Added support for using overview layers from Erdas Imagine .img files when 

rendering, greatly speeding rendering of very large .img files with overview 

layers. 

o Updated creation of area features from lines with the Digitizer Tool to provide 

options for the combination, including requiring closed areas to be created and 

also only connecting lines that match attribute-wise against the other lines. Also 

added progress reporting for the operation. 

o Added new line drawing styles for a dashed line with arrows pointing to either or 

both ends. 

o Added support for batch converting to mulit-band BIL, BIP, BSQ, and JPEG2000 

formats. 

o Added option to locate the minimum and maximum elevation values in selected 

layers via a new right-click option in the Control Center. 

o Added new option to Measure Tool to display measurement paths and measure 

distances/bearings using rhumb lines in addition to great circle or grid lines. 

o Updated JPEG-in-TIFF export to use YCbCr color encoding to generate 2-3 times 

better compression at the same quality than the previous settings. 

 New Supported Formats 

o Added support for new MrSID MG4 raster files, including support for multi-

spectral MrSID images and MrSID images with an alpha channel for 

transparency. 

o Added support for exporting loaded data to BSB Marine Chart format files. 

o Added support for loading HRE (High Resolution Elevation) data files. 

o Added support for loading ACE2 global elevation data set. 

o Added support for loading WindSim .gws files with terrain and roughness data. 

o Added support for Lowrance SL2 CSV files. 

o Added support for exporting loaded terrain and roughness grid files to WindSim 

.gws format files. 

o Added support for exporting loaded line and point features to Orca XML obstacle 

files. 

o Added support for additional PDS format imagery files, including automatic 



support for positioning polar data from the moon. 

 Projection/Datum Changes  

o Added support for supplying a rotation angle about the origin for some 

projections, like Transverse Mercator and Orthographic, to facilitate setting up 

rotated local grid projections. 

o Added new Swedish Grid (SWEREF99) built-in projection with all SWEREF99 

projections used in Sweden available as zones. 

o Added new built-in Mercator (Navionics Special) and Mercator (Lowrance 

Special) projections to represent the custom Mercator projections used by 

Lowrance and Navionics. 

o Added American Samoa 1962, GDM2000 (Malaysia), Lowrance, and 

Potsdam/DHDN (Ferro Meridian) datums. 

o Corrected storage of central meridian for Polyconic projections in GeoTIFF files. 

o Modified saving of NAD83 and NAD27 datums to WKT PRJ files so that ESRI 

products that are inflexible can recognize them. 

o Made the corrected “standard parallel 1” field be used for the true scale latitude 

for the Equirectangular projection in GeoTIFF files. 

o Added support for decoding LOCAL projections from WKT PRJ files. 

o Added support for loading Laborde projections from WKT PRJ files. 

o Fixed problems with wrong EPSG code being written to GeoTIFF files for State 

Plane projections that use units other than meters. 

o Fixed problems with loading non-standard State Plane projections from PRJ files. 

o Made RSO projections with 0 rotation angles work correctly. 

 Scripting Changes 

o Added new EXPORT_SCALE parameter to EXPORT_RASTER command to 

allow exporting to a particular scale. 

o Added new ATTR_TO_RENAME parameter to EDIT_VECTOR script command 

to allow renaming attributes from a script. 

o Fixed problems with EDIT_VECTOR command not finding any matching results 

if a comparison string is provided without any type assignments. 

o Added EXPORT_SLOPE_PERCENT parameter to EXPORT_ELEVATION 

script command to allow exporting slope values as percent slope rather than 

degrees when exporting Float/Grid files. 

o Added support for exporting BMP files with the EXPORT_RASTER script 

command using a format of BMP. 

o Updated GENERATE_ELEV_GRID command to support additional display 

options like those also supported by the IMPORT command. 

o Added new LABEL_FIELD_FORCE_OVERWRITE parameter for IMPORT 

command to specify that any LABEL_FIELD value should be applied to all 

features even if they already have a display label. 

o Added support for KML_MAX_LOD_PIXELS parameter for 

EXPORT_RASTER command to specify the value to use for the 

<maxLodPixels> tag in generated KML files. 

 Added new box maximum resampling methods for terrain layers to allow resampling 

elevation layers by finding the maximum rather than average value within a box of 



samples. Automatic sub-sampling of elevation layers during export will automatically use 

these rather than box average resamplers. 

 Updated SVG export to include display labels. 

 Drastically sped up calculation of raster statistics for contrast adjustment for JPEG2000 

and ECW format files. 

 Added elevation under cursor (if available) to the current projection coordinate display on 

the status bar. 

 Added option when combining area features with the Digitizer Tool to only combine 

those with compatible attribute values. 

 Updated elevation legend display to only display the range of layers that are on-screen 

and not all loaded layers. 

 Made the last selected projected system for files with an unknown projection be 

remembered between runs. 

 Added new option to default auto-contrast adjustment to a linear min/max stretch rather 

than a standard deviation stretch. The option is in the Advanced Section of the General 

tab of the Configuration dialog. 

 Added new option to disable auto-contrast adjustment on load for high bit depth imagery. 

The option is in the Advanced Section of the General tab of the Configuration dialog. 

 Added new option to create a map catalog from selected layers on the right-click menu of 

the Control Center. 

 Added new option to combine terrain layers using a divide operation. 

 Added support for loading Global Mapper Grid (GMG) files larger than 4GB in size. 

 Added support for rotated ENVI files and raster imagery with ENVI headers, including 

massively multi-spectral ENVI files. 

 Added START_TIME and END_TIME attributes to tracklogs with timestamps imported 

from GPX files. 

 Added option to include MAP_NAME attribute when exporting Shapefiles. The attribute 

will contain the description of the map that the feature originally came from. 

 Added support for loading very large .zip files (Zip64 format) over 2GB in size. 

 Added option when loading very large OpenStreetMap (OSM) XML files to only load 

those features that intersect the current screen view. 

 Added support for generating MCF (uBlox position) files when exporting to most raster 

imagery formats (i.e. PNG, JPG, etc.). 

 Updated GeoTIFF export to allow using Deflate (ZIP) compression as well as specifying 

the quality to use for JPEG-in-TIFF compressed files. 

 Added new option when capturing the screen contents to an image to crop the results to 

the bounds of the loaded map data. 

 Added a new option during watershed generation to save the depression-filled DEM to a 

GMG file so you can use that later for repeat operations and have the depression filling 

already done 

 If water display is enabled on the Vertical Options tab of the Configuration dialog, show 

it on the 3D path profile dialog. 

 Allowed working with the underlying map while the 3D path profile dialog is open. 

 Added support for exporting palette-based BMP files. 

 Updated folder selection dialog to include edit box for manually typing a path. 



 Fixed problems loading ECWP (ECW file from the web) from workspace/script files. 

 Fixed problem with last point going out to full spacing in 3D path profile rather than to 

end of provided path when using a fixed spacing for the elevation samples. 

 Fixed issue with generated watershed stream network not saving to workspace files. 

 Fixed problems loading files larger than 4GB from map catalogs. 

 Fixed problems loading some BigTIFF files larger than 4GB in size. 

 Fixed issue from early v12.00 builds that caused box average resampling to automatically 

be used for some exports where reprojecting and changing units. 

 When creating tight buffers around line and area features with per-vertex elevations, copy 

the elevation from the nearest point on the source feature to the vertex in the buffer area 

so that the buffer area will be a 3D feature as well. 

 Made spacebar work to hide/show selected layers in the Control Center. 

 Fixed placement problems with some DGN files (i.e. those with a non-zero origin) in 

v12.00. 

 Enabled option to crop to the right-and-bottom bounds of grid cells when gridding to a 

fixed ground size. 

 Made area obstructions in view sheds work better when the area feature is small 

compared to the view shed sample spacing. 

 Updated the behavior of the arrow buttons in the Control Center for re-ordering layers to 

skip over entire groups of layers at a time. 

 Added support for serial GPS devices that use 7-bit mode (7N1) rather than the normal 8-

bit (8N1) connection mode. This is for advanced users only. See the User’s Manual 

section on the GPS Setup dialog for details. 

 Updated the "same as source units" elevation unit option when batch converting to the 

GMG format to automatically switch meters to centimeters and feet to centifeet so that 

the full resolution of the vast majority of data sets can be maintained by default while still 

getting excellent compression. 

 Updated batch conversion to use lower-case file extensions for all conversions. 

 When loading geo-positioned PDF files with multiple positioned map frames, make the 

map frame that is the largest portion of the PDF file be treated as the main map frame if 

the users chooses to just load the main one. 

 Added support for loading DTED files that incorrectly store the row for each data record. 

 Made Control Center remember which groups of layers are expanded when new layers 

are added and the list is rebuilt. 

 Made workspaces remember their bounds properly when loading them by double-

clicking in Windows Explorer. 

 Fixed problems from v12.00 exporting 3D area and line features or area features with 

labels to DGN files. 

 Fixed problem with the ‘default to use screen bounds for export’ option not working right 

if you didn’t actually click to the bounds tab of an export or other bounded operation 

option dialog before pressing ok. 

 Sort sources on Download Online Imagery/Data dialog alphabetically within each group. 

 Fixed problems exporting new OpenStreetMap (OSM) XML files with non-HTML 

characters in the name or attributes. 

 Corrected assignment of vertex elevations to selected area and line features when the 



layer didn't use meters for units. 

 Added Help menu link to Shortcut Key List. 

 Fixed incorrect calculation of slope values from some lat/lon elevation grids. 

 Updated new areas created by cutting out another area with the Digitizer Tool be created 

in the same layer as the area being cut rather than the ‘User Created Features’ layer if the 

area layer isn’t being reprojected. 

 Corrected placement of point symbols for 3D points in 3D view. They were shifted one 

symbol height down. 

 Updated watershed calculation for selected points to add the enclosed area of the 

watershed areas for each point to be added as a SHED_AREA attribute to the selected 

point features. 

 Fixed conversion of elevation units to feet when exporting to a new vector format with S-

57/ENC data as the input. 

 Corrected application of contrast adjustment to NITF imagery layers that use embedded 

JPEG2000 files. 

 Made the feature measurement dialog resizable. 

 Fixed problems with some DGN areas being filled that shouldn't be. 

 Made changing the projection for multiple layers at a time using the Projection tab of the 

Options dialog for the layers work for more than the first selected layer. 

 Added advanced option to create world files for each exported tile when doing a 

WorldWind export. 

 Fixed bug in Digitizer/Edit Tool with splitting lines into separate features for each line 

segment that caused not all of the lines to be split. 

 Added support for loading Geosoft LUT and TBL palette files. 

 Fixed issue with main map not redrawing when double-clicking on a file in the file open 

dialog to open it. 

 Apply scale factor to values extracted from NetCDF files that include that, like some 

gravity grid files. 

 Made any vertices selected on the map also be selected initially when opening a vertex 

dialog on that feature from the Feature Info or Digitizer Tools. 

 Fixed problems loading some GRIB format files. 

 Made most GRIB data sets come in as elevation grids rather than rasterized and scaled 

grayscale data. 

 Made “version” attribute be maintained when importing OSM XML data. 

 Made area translucency, fixed width lines, and fixed height symbols be saved properly to 

SVG files. 

 Fixed issue rotating and scaling islands in areas if both the island and the parent area are 

selected. 

 Fixed flicker of map layout elements (like scale bar and elevation legend) when moving 

cursor around path profile. 

 Fixed export of borders for translucent areas to PDF files. 

 Made the margin color selection in the Map Layout dialog be remembered. 

 Updated the rotate/scale dialog to remember the last manually entered position selected to 

rotate about during a single session. 

 Made holes/islands in areas export properly to Lowrance LMC format files. 



 Fixed issue with 2nd rectification dialog appearing when rectifying an image with a map 

catalog of images loaded in the main map view. 

 Added support for decoding gml:Curve elements from GML files. 

 Fixed export of elevation data sets with valid values below -9999.0 to Arc ASCII Grid 

files. 

 Updated the palette dialog to allow editing the color or description for multiple entries at 

a time. 

 Added support for pulling in files via FTP using the IMPORT command in scripts. 

 Allow cancel when loading large PNG files. 

 Added option to Google Maps and Bing Maps (VirtualEarth) exports to fill each exported 

tile to the full bounds rather than cropping to the specified export bounds. 

 Fixed issue with changes to vertices made through the Vertices dialog off of the Feature 

Information dialog being lost if you switch tools or click to select a new feature in the 

Feature Info tool. 

 Fixed Bing Maps (VirtualEarth) export to use proper zoom scale names. 

 Fixed error exporting DGN files with a projected system not using meters as the ground 

units. 

 Fixed rare problem encoding negative elevation values to Global Mapper Grid files. 

 Made water drawn in the 3D view use the water color configured on the Vertical Options 

tab of the Configuration dialog rather than always being blue. 

 Fixed problems with path profiles generated over online elevation sources when the path 

spans more than one screen’s worth of data. 

 Added option to fill small gaps in data when batch converting to raster/image formats (it 

was already there when converting to elevation formats). 

 Added support for providing symbol rotation angles in attribute fields named ANGLE or 

SYM_ANGLE. 

 Fixed problems with missing per-vertex elevation values for some area features from 

DGN files. 

 Fixed bug in v12.00 release that caused contour areas to only cover part of the data set in 

many cases. 

 Updated XYZ Grid export of elevation layers to reduce number of decimal digits saved in 

some cases (such as for integer values). 

 When splitting line features with an “id” attribute at a vertex, clear the “id” attribute on 

all but the first new segment so there won’t be duplicate “id” values. 

 Greatly sped up the load and display of RPF (Raster Product Format) data sets like 

CADRG and CIB. 

 Made BMP exports be done as bottom-up BMP files to make them compatible with more 

applications. 

 

WHAT'S NEW IN Global Mapper v12.00 

 

 Significant New Features 

o Added built-in access to the NAIP color high-resolution imagery for the entire 

United States via the File->Download Online Imagery/Data menu command. 

o Added built-in access to the ASTER GDEM terrain data at 1.5 arc second (~45m) 



resolution for the entire world via the File->Download Online Imagery/Data menu 

command. 

o Added built-in access to premium Parcel data for the entire US via the File-

>Download Online Imagery/Data menu command. 

o Added support for automatically delineating stream networks and watershed areas 

using loaded terrain/DEM data using the File->Generate Watershed menu 

command. 

o Added 'Point Styles' tab to Options dialog for vector layers with point features 

allowing users to setup the styling of points in a layer. Now users can use the 

default type-based styling, apply a single style to all point features in a layer, 

setup an attribute-based styling system that styles the points based on the value of 

an attribute value or the display label, or randomly assign colors to the dot or 

custom symbols for points in a layer. 

o Updated the Download Online Imagery/Data interface to group data sources to 

allow easily finding data sources of a particular type or covering a particular area. 

o Updated the Control Center to support assigning groups to selected layers via the 

right-click menu. Those groups can then be collapsed in the Control Center to 

allow easily selecting, closing, or hiding/showing that group. 

o Added new right-click option to the Digitizer Tool for creating a regular grid of 

areas anchored at some point and of user-specified size, rotation angle, and 

naming. 

o Added ability to export BIL/BIP/BSQ and JPEG2000 raster files with multiple 

bands of data at 8, 16, or 32-bit depth (similar to what was possible before for 

GeoTIFF exports). 

o Added option to use “halo” fonts for text display. Halo fonts display a thin border 

around text of a slightly different color, making the text visible on any 

background. The new Halo style is available on the font selection dialog when 

editing the label font for feature types or individual feature styles. 

o Updated the export interface to replace the long sub-menus with dialogs allowing 

format selection to prevent overflowing the export format lists off of the screen. 

o Updated the map legend display based on vector types to allow labeling each style 

in the legend by the feature type, name, or any attribute value, in addition to the 

feature description which is what was always used before. 

o Added new EDIT_VECTOR script command (replacing the ASSIGN_TYPES 

command) to allow adding/updating feature attributes values and display labels, 

reclassifying features, rotating/scaling/offsetting feature coordinates, connecting 

islands of areas to the main parent, deleting duplicate features, or marking 

features as deleted by searching loaded features for matches against their 

attributes/label values and/or types. 

o Updated PDF export to allow using a separate layer for each raster/elevation file 

exported to a PDF file rather than always combining them into a single layer. 

o Made grid line setup be saved in workspace files and map layout files, so your 

grid spacing setup will be saved separately in each workspace. 

o Allowed adding/updating per-vertex elevations for selected line and area features 

from loaded terrain layers using the Digitizer Tool. 



o Added elevation units selection for loaded vector layers to the main Feature Types 

option tab for the layer (moved from Projection tab), making it much easier to 

find and work with. 

o Added option to area volume measurement to find the cut height at which the cut 

and fill volumes would be approximately equal. 

o Added option to save color values from loaded raster files and select the elevation 

units when exporting new Lidar LAS files from loaded vector data. 

o Added option to log all incoming GPS fixes and NMEA strings to a file on the 

GPS Setup dialog. 

o Added support for initializing view shed calculation parameters for calculations 

from selected points based on attribute values of those points. This allows for 

calculating a number of view sheds at once with different parameters. 

o Added support for automatically rotating geology symbols based on an attribute 

value providing the rotation angle. Currently the attributes DIP_AZI, DIP_DIR, 

STRIKE_AZI or STRIKE_DIR are supported to provide the angle in degrees. 

 New Supported Formats 

o Added support for loading HCRF (Hydrographic Chart Raster Format) files, 

including ARCS (Admiralty Raster Chart Services) charts. 

o Added support for exporting gridded elevation data to JPEG2000 elevation grid 

files. 

o Added support for exporting new DTED3/HRTE3 format files from loaded 

elevation data. DTED level 3 files have a resolution of 0.4 arc seconds, or about 

12 meters per sample. 

o Added support for exporting loaded line data to LMN (Spectra Land Management 

Node) format files. 

o Added support for loading Tobin WCS (Well Coordinate System) files. 

o Added support for loading Carlson SurvCAD Grid files. 

o Added support for exporting loaded line data to Hypack Planned Line (LNW) 

format files. 

 Projection/Datum Changes 

o Added support for automatically adding custom datums from TOWGS84 

parameters in WKT PRJ files. 

o Added option to the Advanced section of the General tab of the Configuration 

dialog to control whether or not generated WKT PRJ files include the datum 

transformation as a TOWGS84 field. 

o Added Hotine Oblique Mercator Azimuth Natural Origin projection to allow 

specifying Hotine projections where the false easting and northing are at the 

natural origin of the system. 

o Added new Hong Kong 1980, MGI (Croatio/Serbia), MGI (Slovenia), and 

NAD83 (ITRF96) datums. 

o Fixed loading of Minnesota State Plane South Feet projection from ECW files. 

o Updated Clarke 1866 Authalic Sphere to behave as the USGS intended (i.e. no 

conversion to WGS84, similar to how Google Maps datum works). 

o Added support for saving almost every datum from Global Mapper into exported 

Erdas Imagine files. 



o Added EPSG codes 2991 and 2992 for Oregon Lambert projection. 

o Updated Winkel Tripel projection to allow modifying the True Scale Latitude. 

o Updated the Interrupted Goode Homolsine projection to support a Central 

Longitude parameter. 

o Added support for zone 10 to Gauss Krueger Germany 3-degree zone projection. 

o Corrected Kansas State Plane North and South NAD83 zone definitions for ECW 

files. 

o Fixed problems parsing some MGRS coordinates with shortened coordinates. 

o Added support for getting Gauss Krueger Germany 3-degree zone projections 

from Touratech TTQV .cal files. 

o Added support for saving projections using arc second and grade units to WKT 

PRJ files. 

o Added support for decoding of Geographic projections using units other than arc 

degrees from WKT PRJ files. 

o Updated scale value for Arizona West State Plane projection to have enough 

digits of precision. 

 Scripting Changes 

o Added new EDIT_VECTOR script command (replacing the ASSIGN_TYPES 

command) to allow adding/updating feature attributes values and display labels, 

reclassifying features, rotating/scaling/offsetting feature coordinates, connecting 

islands of areas to the main parent, deleting duplicate features, or marking 

features as deleted by searching loaded features for matches against their 

attributes/label values and/or types. 

o Added GENERATE_WATERSHED script command to allow performing 

watershed analysis from a script. 

o Added new RUN_COMMAND script command to allow running any application 

from within a Global Mapper script. 

o  Added new COMPRESSION parameter to EXPORT_RASTER command to 

allow specifying the compression to use when exporting GeoTIFF files. This 

deprecates the USE_LZW parameter. 

o Added support for new %PARENT_DIR% wildcard in 

DIR_LOOP_START...DIR_LOOP_END loop in script to allow using the name 

of the parent folder for the current file. 

o Fixed EXPORT_VECTOR script command when splitting against anything other 

than an actual attribute. 

o Added option to KML export using EXPORT_VECTOR command to specify 

which feature attribute to use for the folder name in the generated KML file. The 

new KML_FOLDER_ATTR support specifying what attribute to use for the 

folder name. 

o Updated FILENAME_ATTR_LIST parameter for EXPORT_VECTOR command 

to allow specifying particular attribute values to filter against in addition to just 

splitting by attribute. 

o Updated GENERATE_CONTOURS command to support cropping contours to a 

polygon using the POLYGON_CROP_FILE or POLYGON_CROP_NAME 

parameters. 



o Added support for exporting slope or slope direction values to new Float/Grid 

format files using the EXPORT_ELEVATION command. The new parameters 

are EXPORT_SLOPE and EXPORT_SLOPE_DIR. 

o Made running scripts via the command line return a code of 1 rather than 0 if an 

error occurs while processing the script. 

o Added SKIP_UNLOAD_ALL parameter to EMBED_SCRIPT command to make 

embedding workspace files without unloading everything else possible. 

o Added support for specifying the spatial resolution for operations that take a 

resolution in meters using a new SPATIAL_RES_METERS parameter. 

 Updated digitizing of new line and area features when a point location is snapped to a 

point feature or vertex with an elevation, a 3D line or area is created (assuming every 

vertex location had an elevation) with the elevation values of the clicked points/vertices. 

 Updated path details reported for line-of-sight analysis to include information about the 

location of the minimum LOS clearance, like the location, clearance for Fresnel zone and 

baseline, and elevation of baseline. 

 Added new line style ‘Solid with Arrow Pointing to Both Ends’ to allow easily drawing a 

line feature with arrows pointing at both ends. 

 Added option to restrict the range of considered elevation values when generating 

contour lines from loaded terrain data. 

 Made Download Online Imagery/Data dialog resizable. 

 Allow measuring the combined cut-and-fill volumes of multiple selected areas. 

 Updated the GPS Information display dialog to display the altitude above ground level 

(AGL) if terrain data is loaded at the current GPS location. 

 Added right-click option to the Control Center to allow selecting all onscreen layers. 

 Added right-click option to the Control Center to allow selecting all of the features in 

selected layers with the Digitizer Tool. 

 Added support for configuring the band layout of files within a map catalog. 

 Allow cropping to selected areas when printing. 

 Added option to search by a feature's index in a layer when doing a search. 

 Updated the attribute-based styling for layers to allow wildcards (* and ?) in the attribute 

value strings. 

 Added 'Edit' button to Help->About dialog allowing you to easily change where settings 

files for things like custom datums, ellipsoids, and types/styles are stored. 

 Added new option on the 'Specify Sample Spacing in Other Units' dialog for raster and 

elevation exports to use the sample spacing used for the last export. 

 Added new option to view shed calculation to allow specifying a range of Fresnel zone 

percentage clearances to match against rather than just a minimum percent clear. 

 Made map catalogs remember the selected elevation units for vector files included in the 

map catalog. 

 Updated batch conversion 'Use Quad Names' option to work for any type and to use the 

layer description if a quad name is not available. 

 Added option to export slope values as percent rather than degrees when exporting Float 

Grid files. 

 Added access to an additional zoom layer of OpenStreetMap.org tiles so you can zoom in 

far enough to see things like house numbers now. 



 Added option to combine terrain layers using a multiplication operation. 

 Added new option to convert area features with separate islands into a single parent area 

with all of the islands connected through a single vertex list with "stock arcs". This is 

useful for software that cannot handle areas with islands. The option is in the Advanced 

Feature Creation submenu of the right-click menu of the Digitizer Tool when at least one 

area with islands is selected. 

 Added option to split DTED exports into folders by the western longitude of the exported 

tiles. For example, a tile having a southwest corner of W90 and N35 would be stored in 

your selected path plus \W090\N35.dt0. 

 Added new blend mode, ‘Color to Grayscale’, that allows viewing any color raster 

/imagery layer in grayscale. 

 Added support for displaying information about clicked features from loaded WMS 

servers using the Feature Info tool. 

 Increased the number of remembered recently used files from 6 to 9. 

 Added option to select areas that are only partially contained within an area when using 

the Advanced Feature Selection submenu option to Select Areas that are Contained 

Within Other Areas using the Digitizer Tool. 

 Updated CSV export to maintain the original attribute order if all features being exported 

have the same set of attributes in the same order. 

 Updated CSV export to include options controlling whether or not the LAYER and 

SYMBOL fields are exported for each point. 

 Added new right-click menu option to the Digitizer Tool to allow counting the line and 

point features contained with selected area features and adding those counts as attributes 

(LINE_COUNT and POINT_COUNT) to the selected area features. 

 Updated creation of range rings from selected point features to copy the attribute list of 

the points that the range rings is centered on to the created range ring feature. 

 Made the 'I' column from .xyzi files automatically come in as an INTENSITY attribute 

when loading them with the File->Open Generic ASCII Data File menu command. 

 Make splitting lines with per-vertex timestamps keep the timestamps. 

 Added option to generate world files for tiles exported during Google Maps or Bing 

Maps exports. This can be useful when debugging the exports as you can then easily pull 

the exported image tiles back into Global Mapper (or other software). 

 Allowed sorting of the columns in the control points list for the rectification dialog. This 

is handy for sorting by the error column. 

 Added option to the Advanced section of the General tab of the Configuration dialog to 

allow reversing the direction of zooming down for the Page Up/Down keys and zooming 

with the mouse wheel. 

 Added option when exporting new GPX files to encode text using UTF-8 rather than 

ISO-8859-1. This allows non Western-European text to be encoded properly. 

 Added option to only re-order the selected layers in the Control Center when selecting the 

option to re-order layers (by name, position, etc.) in the Control Center. 

 Made the toolbar hide/show state be remembered for all toolbars. 

 Fixed some errors creating buffers areas area/line features. 

 Made batch conversion to DWG files use the DWG version last selected on the DWG 

export dialog. 



 Made the last selected elevation units on the custom shader dialog be remembered. 

 Made cropping to a selected area work for CSV exports. 

 Updated the CSV export to use the selected Position Display Format settings for lat/lon 

values exported to CSV files rather than always using decimal degrees. 

 Updated the GeoPDF import to recognize multiple map areas and bring them in as 

separate layers at the correct location and already cropped 

 Updated the PNG export to remember the state of the "Save Vector Data if Displayed" 

option. 

 Fixed problems loading encrypted PDF files. 

 Corrected loading of BIL files with unsigned 16-bit elevation values. 

 Don't add CLOSED attribute from loaded ASCII files if it was just used to mark a feature 

as an area or line. 

 Fixed issue from v11.02 with the alpha channel from ECW files not being used. 

 Updated creating lines from areas to not copy over any default attribute values from the 

area to the line. 

 When copying features to the clipboard from the search results dialog, maintain the order 

of the sort when pasting those features. 

 Fixed loss of measurement attributes when changing the classification of newly created 

features with the Digitizer Tool. 

 Added new "Range Ring Center" point type. 

 Added option to reorder maps in the Control Center by their type (i.e. elevation layers 

first, then raster layers, and finally vector layers). 

 Updated Anuga Mesh import to use geo-referencing from file to properly position 

coordinates. 

 Improved results of auto-interpolation during raster exports, particularly way 

undersampled or web-based exports. 

 Updated creation of range rings and arc areas of a fixed radius to start the feature relative 

to magnetic north rather than true north if that option is selected in the Measure Tool. 

 Added option to rotate feature dialog to allow rotating around the center of each 

individual feature center rather than around the center of the total bounding box of all 

features. 

 Fixed issues with files rotated 90, 180, and 270 degrees with a world file. 

 Made 'Restore Default Settings' button on General tab of the Configuration dialog also 

restore all elevation shader options. 

 When editing the symbol multiple points with rotation or scaling applied, maintain the 

original rotation and scaling for each point unless those values are explicitly changed. 

 When editing strike-and-dip points, don't change the default strike-and-dip symbol for 

when new strike-and-dip points are being created. 

 Added button to feature vertices dialog to allow updating the existing per-vertex 

elevation values based on loaded terrain data. 

 Fixed bug exporting Lowrance LCM maps that caused many point types to come out as 

cities rather than the proper type (like a navaid). 

 Updated GPX to look for a URL attribute from a feature and include it as a <url> value 

for points exported to the new GPX file. 

 Added option to the Advanced section of the General tab of the Configuration dialog to 



specify that exported PRJ files should append the .prj to the entire filename (like 

test.ecw.prj for test.ecw) rather than replacing the existing file extension with .prj). 

 Added new 'Box Average 7x7' resampling method. 

 Added new empty square custom point symbol. 

 Allowed setting the 'Center Label on Line' setting when editing individual line feature 

styles. 

 Improved support for SEGP1 files with only easting and northing coordinates. 

 Updated MrSID Lidar Decode SDK to v1.1 for faster MrSID MG4 Lidar decoding. 

 Added option to load EMF files as vector or raster (the current default). 

 Fixed problems with missing data from some Tobin .bas format files. 

 Added option when applying elevation from loaded terrain data to selected point features 

to control whether or not the unit label (like 'ft' or 'm') is appended to the elevation. 

 Made layer metadata dialog close when the Escape key is pressed. 

 When the advanced option to always display lat/lon values as WGS84 is checked, display 

the lat/lon values as WGS84 in the Feature Information dialog for point features in 

addition to on the status bar. 

 Fixed error exporting named points with no symbol to DWG files. 

 Fixed problems getting data from some secure (HTTPS) WMS servers. 

 Added 'Automatic' setting for orientation of PDF exports to allow automatically selecting 

landscape or portrait orientation based on the aspect ratio of the exported data. 

 Fixed bug with left margin setting in map layout being set to right margin when saving a 

re-opening a workspace or Global Mapper. 

 Updated creation of a new feature classification/type from the feature edit dialog to use 

the currently selected style as the default style. 

 Made the shift/offset feature dialog display the bounds of the selected feature. 

 Fixed issues loading some PDS format files. 

 Fixed problem with duplicate attributes when splitting line and area features on a change 

in a particular column when importing ASCII data. 

 Made the automatic delimiter check during generic ASCII imports check for the pipe (|) 

symbol. 

 Made multi-page TIFF files load as separate layers in the Control Center. 

 Made last used contour simplification threshold be remembered. 

 When moving items in the Control Center, ensure that the item being moved remains 

visible if possible. 

 Fixed bug where rotating or scaling 3D area or line features would cause any per-vertex 

elevations to be lost. 

 Updated map catalog files to save any calculated raster statistics for a layer so they don't 

have to be recalculated multiple times as a map is loaded and unloaded. 

 Updated the sub-path text display on the profile dialog to include the slope as % grade (in 

addition to degrees slope). 

 Updated the area and line elevation statistics calculation to include the slope as percent 

grade in addition to degrees. 

 Updated the line elevation statistics calculation to include the maximum slope both up 

and down and well as the total elevation gain and loss along the line. These things are 

useful for evaluating hiking and biking trails. 



 Added item to right-click menu for scale bar to zoom to a user-specified scale. 

 Made more print settings, like header, scale, etc., be remembered between runs. 

 When batch converting files that are loaded in the current workspace, copy any color 

grade or resampling settings from the loaded layers. 

 Made the contour generation checkbox options be remembered between runs. 

 Fixed import of per-vertex elevations when breaking on the change in a particular field 

during generic ASCII text file import. 

 Added support for some additional non-comforming SEGP1 formats with only easting 

and northing values. 

 Fixed positioning of PDF files with rotated orientations and embedded world file 

coordinates. 

 Fixed issue with Bing Maps exports with just a single level of data not displaying in the 

web browser. 

 Made vector search dialog not automatically redo search when an item label or attribute 

is changed. This allows faster editing in-place, you just have to trigger the re-search 

yourself. 

 Added support for adding a point feature's latitude and longitude to the description string 

for the point in a KML file by using the %<Longitude>% and %<Latitude>% entries in 

the custom HTML text for the point description. 

 Updated search-and-replace of road name text to automatically detect iconized road 

names. 

 Added support for decoding Transverse Mercator projections from BSB files. 

 Improved type mapping when exporting MP files (or any features with a MP_TYPE 

attribute) to the OSM XML format. 

 When splitting area features at selected vertices, create the new areas in the same layer as 

the original. 

 Corrected point record size written out to exported Lidar LAS files (this was incorrect in 

v11.02). 

 Improved display of some TEXT entities loaded from DXF files to have the correct 

orientation and color. 

 Fixed incorrect export of 3D area features to DXF files. 

 Added option to control whether or not LAYER attribute is added to exported MapInfo 

files when doing a batch conversion. 

 Added support for grades as a bearing measurement unit in the Measure Tool. 

 Added 'Yes to All' and 'No to All' option for loading files where a projection is guessed 

based on the filename and the user is asked to confirm. 

 Fixed export of non-closed 3D areas to vector KML/KMZ files. 

 Added shortcut key (Shift+C) for File->Capture Screen Contents to Image menu item. 

 Append the classification name of a feature to the text displayed in the status bar when 

the cursor is over the feature if it is different than the description. 

 Updated Full View (Home) to use the cropped rather than full bounds of loaded layers. 

 Fixed custom band setup for Erdas Imagine and NITF image formats. 

 Fixed problems loading area features from some SOSI format files. 

 When creating point features from selected line and area features with the Digitizer Tool, 

copy the attribute values from the selected features to the new points. 



 Fixed dark display of some GIF files. 

 Fixed problems saving named views from v11.02. 

 Fixed export of header and footer text to PDF files when no top or bottom margins are 

used. 

 Updated the hill shading when a non-zero maximum shadow darkness is used to scale the 

shadows between the maximum brightness and darkness rather than clamping any 

shadows to the max darkness value. This allows for more contrast in the darkly shadowed 

areas. 

 Added support for loading SWIR and TIR data sets from ASTER L1B HDF files. 

 Added new right-click option to the Measure Tool to enable display of extra digits of 

precision for measurement values. 

 Updated SEGP1 exports to have an option (enabled by default) to write out easting and 

northing columns with an implied digit of decimal precision if possible. 

 Fixed view shed calculation for checking beam visibility for negative transmission 

angles. 

 When saving a line of sight to a KML file from the Path Profile dialog, save extra points 

along the line of sight rather than just the endpoints so that it displays properly in Google 

Earth. 

 Added time of fix to GPS Information dialog. 

 Updated WMS import to not default to EPSG:4326 (Lat/Lon WGS84) if the WMS server 

does not explicitly specify that EPSG:4326 is supported and there is another recognized 

projection available. 

 Fixed issues loading some DGN files, particularly in the 64-bit version. 

 Make sure that point features created from area centroids are always inside the area 

feature that they are created from. 

 Updated package export to store elevation values with centimeter rather than decimeter 

precision. This results in slightly larger GMP files but higher precision. 

 Updated Shapefile export to not mark fields with all empty values as numeric by default, 

but instead as character fields (unless the field came from a loaded layer that explicitly 

marked the field as numeric). 

 Updated vector KML/KMZ export to allow loading an HTML description from a file. 

 Fixed problems with holes in areas not always coming in properly from MapInfo 

MIF/MID files. 

 Fixed issues loading directories of files from non-Windows servers, like SUSE. 

 Fixed export of elevation values to DXF files for 3D TIN face area features. 

 Corrected PDF export to scale when using margin units of centimeters. 

 Fixed issue with labels not exporting to MapInfo MIF/MID or TAB/MAP files. 

 Fixed issues with PDF files losing or having incorrect rectification when reloaded from a 

workspace. 

 Made gridding vector exports to selected areas support cropping the export to the actual 

boundary of each selected area rather than just to the bounding box of the area. 

 Made creation of distance/bearing/COGO lines create segments that much more exactly 

match the requested bearing (previously there could be errors of a few tenths of a degree). 

 Added option to specify the export bounds for terrain/gridded elevation exports as “pixel 

is area” rather than “pixel is point”. This option is available under the Advanced section 



of the General tab of the Configuration dialog. 

 Updated Google Maps export HTML file to prevent zooming in beyond where the data 

would be displayed. 

 Fixed rare crash loading some improperly formatted Shapefiles. 

 Made attributes for S-57/S-63 files include both the raw value and the associated text for 

that value (if known), rather than just the associated text if known. 

 Fixed extremely slow loading and searching of some Tiger Shapefiles. 

 Fixed usage of grid tightness and ‘fill to bounds’ settings when loading and gridding 

multiple Lidar LAS files at a time. Previously those settings would only be used on the 

first file, then the default settings would be used for the rest. 

 Added support for getting per-vertex elevations from <gpxx:Depth> fields for tracks in 

GPX files even if no <ele> tags are available. 

 Made adjusting the elevation units for map catalog layers work. 

 Added support for getting roughness values for areas on export to Wasp .map files from 

attributes named ‘ROUGHNESS’ or ‘ROUGH’. 

 When combining range rings, create an area feature rather than a line if the boundary if a 

valid area in the current projection. 

 Added support for world files using comma rather than decimal points as decimal 

delimiters. 

 Added support for exporting elevation GeoTIFF files at a particular scale and with a DPI 

stored in them. 

 Fixed loading of multi-patch Shapefiles with multi-part triangle fan features. 

 Added support for directly loading .bag.gz files. 

 Fixed problem with shifted layers not showing up if shifted outside of the previous 

loaded data bounds until something else is loaded or unloaded. 

 Don't prompt users to rectify images from KMZ files that aren't positioned as ground 

overlays in the KML files in the KMZ. 

 Added support for loading style information from KML/KMZ files where the style 

definitions are at the end of the file rather than the beginning. 

 Fixed slow response to clicks in some tools (like Digitizer) when ECW or MrSID files 

were loaded. 

 Added support for loading Float/Grid files larger than 4GB in size. 

 Added ability to change the color used for a view shed layer by right-clicking on it in the 

Control Center and selecting the option to change the color. 

 

WHAT'S NEW IN Global Mapper v11.02 

 

 Significant New Features 

o Added support to the Map Layout tool for automatically generating a map legend, 

either from the collection of loaded map features display styles or from a user-

specified color palette. 

o Added 'Area Styles' tab to Options dialog for vector layers with area features 

allowing users to setup the styling of areas in a layer. Now users can use the 

default type-based styling, apply a single style to all area features in a layer, setup 

an attribute-based styling system that styles the areas based on the value of an 



attribute value or the display label, or randomly assign colors to the areas in a 

layer. 

o Added 'Line Styles' tab to Options dialog for vector layers with line features 

allowing users to setup the styling of lines in a layer. Now users can use the 

default type-based styling, apply a single style to all line features in a layer, setup 

an attribute-based styling system that styles the lines based on the value of an 

attribute value or the display label, or randomly assign colors to the lines in a 

layer. 

o Added support for resampling raster and elevation layers using bicubic 

interpolation or a box average of size 3x3, 4x4, or 5x5, in addition to the 

previously available options of nearest neighbor and bilinear interpolation. The 

"anti-alias" option on the Raster Options dialog has been replaced with one for 

selecting the sampling method to use. 

o Updated the option to crop lines to areas in the Digitizer Tool to allow splitting 

lines (i.e. keeping parts both inside and outside the crop areas). 

o Updated the option to add areas as islands in another area in the Digitizer Tool to 

allow removing overlapping but not enclosed areas from another area. The option 

was renamed to 'Cut Selected Area(s) from Another Area (Add Islands)' to reflect 

the new functionality. 

o Updated creation of buffer areas to allow combining overlapping buffer areas into 

a single combined buffer area. 

o Added option to create buffers some distance inside an area feature by specifying 

a negative buffer distance. 

o Updated area combine functionality in the Digitizer Tool to allow combining 

multiple groups of non-intersecting areas into as many combinations as are 

possible. 

o Added option to export GeoTIFF files to a particular scale. 

o Added new option when creating/flattening terrain from areas to taper the edges. 

This provides for easy simulation of non-flat areas like a sand bunker or hill while 

just providing a single elevation value for the area. 

o Added support for batch-converting to multi-band GeoTIFF imagery files. 

 New Supported Formats 

o Added support for loading S-63 (encrypted S-57 charts) format files. Use File-

>Create S-63 User Permit menu command to generate a user permit file to 

provide to S-63 data provider to obtain S-63 files encrypted for use with your 

Global Mapper installation. 

o Added support for loading NV Verlag encrypted marine charts (EAB/BSB 

format). 

o Added support for loading TOBIN .bas (TDRBM II) files. 

o Added support for loading OziExplorer OZFx2 and OZFx3 files. 

o Added support for importing GRIB I and II format data, a format commonly used 

for meteorological data. 

o Added support for loading COLLADA 3D models (like model.dae files 

referenced from KML/KMZ files). 

o Added support for loading ATS (Alberta Township System) v4.1 files. 



o Added support for GeoDXF and GeoDWG files (DXF/DWG positioned with 

WLD file). 

o Added support for using Adobe Color Table (.act) files for palettes. 

o Added support for TIFF files with 12-bit per sample JPEG-in-TIFF encoding. 

o Added support for 16-bit TIFF files with palettes. 

o Added support for MrSID files encoded using CMYK colors. 

o Added support for LIDAR LAS files using point format 2 or 3. This allows for 

coloring Lidar data sets using the RGB color specified in the LAS file rather than 

the elevation-based color. 

o Added support for loading Anuga Triangulated Mesh format files. 

o Renamed Platte River export to reflect that it is the same as the 

Whitestar/Geographix Township/Range format export. 

 Projection/Datum Changes 

o Added support for providing custom datums with the conversion to WGS84 based 

on a set of control points from a text file. This allows you to easily create your 

own datum conversions when you just know a collection of lat/lon values in the 

source projection and the corresponding WGS84 lat/lon location. 

o Added support for getting projection information from ESRI .aux.xml files. 

o Added the La Canoa (Venezuela), PSD93 (Oman), and North Sahara 1959 (Hassi 

Messaoud) datums as a built-in datums. 

o Updated PRJ files saved in WKT format to use names expected by ESRI products 

that in general don't conform to OGC standards. 

o Made Wisconsin County Projections write out correctly to GeoTIFF files. 

o Added support for decoding Irish Grid projections from Ozi .map files. 

o Added support for Dutch Grid projections in ECW files. 

o Fixed bug selecting UTM zones in the Southern Hemisphere in the 64-bit version. 

o Added EPSG codes for Corregre Alegre and Nord Sahara 1959 UTM projections. 

o Corrected latitude for Japanese Grid Zone IV projection. 

o Added support for EPSG code 2056 (Swiss Grid CH1903/LV95). 

o Fixed bug in v11.01 that caused custom datum transformation parameters to be 

lost in some cases. 

o Fixed positioning of GeoPDF files using Southern UTM zones. 

 Updated ECW and JPEG2000 access to be much faster when sub-sampling for export or 

rectifying either of those types. 

 Updated option that calculates and adds elevation attributes for selected areas to also 

calculate and add MAX_SLOPE, AVG_SLOPE, and MODE_ELEV attributes for 

selected line features. 

 Made selecting a feature with a GM_LINK attribute with the Feature Info tool open the 

file referenced by the attribute value in the current Global Mapper instance. 

 Added option for users to choose which DWG version to create when exporting a new 

DWG format file. 

 Allow specifying a prefix and suffix for labels when setting up labeling using multiple 

attributes for a layer. 

 Added support for modifying the folder that user data is stored in by adding a registry key 



value with the desired path at 'HKEY_CURRENT_USER\Software\Global 

Mapper\SettingsFilePath'. 

 Added option to generate 8-bit GeoTIFF files with no compression via a new 

compression selection list on the GeoTIFF export dialog. 

 Removed separate JPG-in-TIFF GeoTIFF export option as you can now achieve the same 

results with a 24-bit RGB export and the JPEG compression option selected. 

 Added option to online data source dialog to load WMS data sources from an external 

text file. This provides an easy way to share your list of WMS sources with other users. 

 Updated 3D view to rotate around the center of the current view rather than the center of 

the entire data set currently in the 3D view. 

 Updated LIDAR point clouds to display in color in the 3D view. 

 Made most point symbols display in the 3D view rather than just a dot for each point. 

 Added option to KML/KMZ export to highlight areas in Google Earth when you mouse-

over them. 

 Updated automatic loading of image links from attributes to support image filename 

values relative to the path of the data file containing the feature with the attributes. 

 When exporting Shapefiles, provide more options for splitting the data into separate files 

so that you can now choose to split based on the type/classification of each feature (same 

as the current option) or based on the feature description/layer. 

 Added support for cropping to selected area features when creating an elevation grid 

from loaded vector layers. 

 Updated the rectification dialog so that if you press 'Enter' with the focus in the one of the 

coordinate windows then focus will advance to the next coordinate field. Pressing 'Enter' 

with focus in the Y/northing/latitude field will just add the control point. 

 Added new right-click option to the Control Center allowing you to scale a selected layer 

based on a user-specified length of a selected line feature in that layer. This is useful if 

you know the actual length of a line feature in a vector layer and want to scale the layer 

so that the line length is correct without caring about where on the earth the layer is 

placed. 

 Added new right-click option to the Control Center to allow opening Windows Explorer 

to the folder that a selected map file is in. 

 Added new Combine Terrain operations to filter and keep the first layer value when it is 

greater than the second layer value and also less than the second layer value. 

 When selecting two vertices of a single line feature with the Digitizer Tool, the status bar 

will list the length of the line between the two selected vertices. 

 Made creating areas from line features maintain the per-vertex elevations of the 

connected lines (if there were any). 

 Fixed behavior of water level controls on the 3D view options dialog. 

 Restored old 3D view behavior of going behind main window and having separate button 

on Windows start bar. 

 Fixed flicker of main view when moving your cursor over a 3D path profile. 

 Improved accuracy of affine and triangulated rectification operations. 

 Significantly increased speed of contour generation. 

 Automatically treat signed 16-bit samples from imagery TIFF files with values of -32767 

as void areas. 



 Fixed problems reading projection information from some newer MrSID files. 

 Added display of the target compression ratio used when creating a MrSID file to the 

metadata display for that layer. 

 Allowed cropping to selected areas when batch converting to vector formats. 

 Added support for controlling multi-band GeoTIFF exports from scripts using a new 

BAND_EXPORT_SETUP parameter for the EXPORT_RASTER command. 

 Added support for exporting a new raster with the same color/palette type as the file 

being exported using the EXPORT_RASTER command by using the 

PALETTE=KEEP_SOURCE parameter. 

 Corrected creation/flattening of terrain from 3D area features with islands. 

 Made Lidar files share the elevation shader with all loaded elevation and Lidar layers, 

making them consistently color across multiple layers. 

 Fixed problems with missing data from Italian TAF that have invalid records. 

 Made scaling of built-in custom shape symbols work properly. 

 Fixed handling of multi-line text in map layouts when saved to a workspace. 

 Fixed problem with map layout text becoming upper-case when loaded from a 

workspace. 

 Improved detection of datums from P190 files. 

 Corrected display of elevations on real-time cursor display for path profile display when 

doing a line-of-sight analysis with earth curvature enabled. 

 Changed shortcut key to toggle all vector layers on and off to Ctrl+Shift+V from just 'V' 

since the 'V' shortcut key was already used to enable snapping only to vertices. 

 Fixed range of elevation legend display and shader colors when the min/max elevation 

values are overridden for a loaded terrain layer. 

 Allowed non-integer starting number values when creating new point features spaced 

along selected line or area features using the Digitizer Tool. 

 Allowed naming of points sequentially or based on distance when creating new point 

feature spaced by distance along selected line or area features using the Digitizer Tool. 

 Made "display elevation legend on right" toggle work properly. 

 Fixed bug in PDF export that caused labels for lines with a Null drawing style to not be 

exported. 

 Fixed bug with road icons assigned to existing line features not being maintained when 

saving and restoring a workspace. 

 Corrected progress bar behavior during Vertical Mapper export. 

 Updated creation of terrain when flattening areas to flatten based on drawing order, so the 

top-most drawn area that is flattened will be the flattened part in the terrain (useful for 

nested 3D areas, like for a building). 

 Fixed crash when closing a layer that a search is active on in the vector search dialog. 

 Fixed problems in v11.xx loading some ASRP/USRP data sets. 

 Added support for additional HDF data sets. 

 Added recognition of .190 as a P-190 file extension. 

 Added option to Measure Tool to allow calculating grid distance rather than great circle 

distance for distance calculations. 

 Fixed DTED export sizes near latitude change boundaries in the Southern Hemisphere. 

 Fixed bug loading points from some MapInfo TAB/MAP or MIF/MID files. 



 Added option when finding features with duplicate attribute values to delete the 

duplicates. 

 Fixed half-pixel shift of Vertical Mapper grids from v11.01 release (v11.00 was ok). 

 Added options to the Advanced Section of the General tab of the Configuration dialog to 

disable the automatic interpolation of reprojected or resampled raster layers on export and 

when zoomed way out on a layer. 

 Fixed problem with HATCH entity pattern name being saved as display label when 

loading DXF files. 

 Fixed added of extension to files when gridding to selected areas and the name used for 

an export file already has a period in it. 

 Fixed incorrect interpretation of 4th color band as an alpha channel for some ECW files. 

 Fixed display of bearings relative to magnetic north. 

 Fixed problems accessing WMS through secure (https) connections. 

 Added progress reporting to potentially lengthy transfers of features to a new layer or 

simplification of multiple line/area features. 

 Added support for customizing the pixel radius used when snapping to existing features 

using the DWORD registry key 'HKEY_CURRENT_USER\Software\Global 

Mapper\SnapToPixelRadius'. The default value is 10 pixels. 

 Significantly sped up the deletion of large numbers of vertices from the vertex dialog. 

 Added option to the Advanced section of the General tab of the Configuration dialog to 

'Disable Display of Pan Arrows on Map Edge', allowing one to disable the map-edge pan 

arrows displayed in most tools. 

 When using the File->Rectify Imagery menu command to rectify and export images, 

maintain the DPI (if available) of the original image and create GeoTIFF files with an 

alpha channel if the source image has transparency. 

 Improved handling of layer translucency when exporting Global Mapper package files. 

 Fixed bug decoding custom point symbol names with multi-part names, like 

DOT_EMPTY, VERT_BAR, DIAG_CROSS, etc. 

 Updated display of most error messages to include the build version and to also copy the 

error text to the Windows clipboard for easy pasting. 

 Updated import of 3D face features from DXF files to automatically mark them as Tin 

Face areas so they will export by default as 3D Face features to new DXF files. 

 Added options to control whether or not LAYER and ELEVATION attributes are added 

to MapInfo MIF/MID and TAB/MAP exports. 

 Fixed option to default to exporting screen bounds work even if you don't activate the 

Export Bounds tab during an export. 

 Sped up the load of MrSID LIDAR files when loaded in preview mode. 

 Added support for specifying area border widths as a fixed width in meters. 

 Made export of 3D area Shapefiles using loaded elevation layers work when done using 

the EXPORT_VECTOR command in a script file. 

 Added vertex elevation (if available) to ZMap+ XYSegID format export. 

 Made the image rectification dialog display the errors in the X and Y direction for each 

pixel in addition to the total error. 

 Added support for customizing the number of decimal digits written out for the X and Y 

coordinates for a Simple ASCII Text export through the use of a DWORD registry key 



'HKEY_CURRENT_USER\Software\Global Mapper\ASCIIExportCoordPrecision'. For 

example, set this value to 6 to get 6 decimal digits for each X and Y coordinate. 

 Made the print header and footer font selections be remembered. 

 Made Ctrl+Left Click on a photo point from an EXIF JPG file in the Feature Info tool 

bring up the normal Feature Info dialog rather than the image. 

 Added ELEVATION and TIMESTAMP attribute to EXIF JPG picture points if the EXIF 

data contains an elevation value or creation timestamp for when the picture was taken. 

 Made  loading a workspace file with the File->Open Data File menu command correctly 

restore the zoom bounds of the workspace file. 

 Updated the 3D Shapefile and Simple ASCII Text export to obey the export elevation 

units selection on the Vertical Options tab of the Configuration dialog. 

 Made DGN exports that have other DGN files as the source data maintain the level 

numbers and names on export to the new DGN file if possible. 

 Made the Control Center remember its size between runs. 

 Added support for Idrisi Raster files with a .img extension. 

 Fixed half-pixel shift when scaling or rotating symbols. 

 Fixed issue with "always on top" fixed screen layers displaying twice in exported PDF 

files with non-zero margin values. 

 Fixed issue with labels marked not to display still showing up in exported PDF files. 

 Fixed issue with the scaling of the header/footer text in exported PDF files, particularly at 

low DPI values. 

 Fixed issues with the placement of right-aligned and centered text in exported PDF files. 

 Fixed error loading some raster KMZ files from workspace files. 

 Fixed problem with area labels not moving with the area if it is moved. 

 Fixed error loading some multi-band PDS files. 

 Changed batch conversion to Arc ASCII Grid files to use .asc extension instead of .agr. 

 Added PLAY_SOUND script command to allow playing a sound file from a script. 

 Fixed out of memory errors when working with very large numbers of JPG files. 

 Fixed issues loading DXF files with lines 256 characters in length. 

 Added new option to the Advanced section of the General tab of the Configuration dialog 

to "Auto-Fake Location of Unpositioned Rasters". 

 Allowed Arc ASCII Grid files that are too large to load into memory still be loadable. 

 Made the option to 'Crop Right and Bottom to Export Bounds' on the Gridding tab of 

Export dialogs work when gridding to fixed pixel size tiles. 

 Significantly increased display and export speed for some very large CIB/CADRG/RPF 

data sets. 

 Put GPX <time> field for <wpt> features directly after <ele> field so that Garmin's 

MapSource can read those GPX files. 

 Fixed matching on empty name/attribute values when using the ASSIGN_TYPES script 

command. 

 Allowed for placement of fixed screen layers and map layout items (like scale bar and 

elevation legend) in centimeters (in addition to inches, degrees, and percent). 

 Made grayscale export option work properly Optimi Clutter export. 

 Sped up marking large numbers of features as deleted using the Digitizer Tool. 



 Made right-click when drawing a new line in trace mode with the Digitizer Tool cancel 

the operation. 

 Changed shortcut key for toggling vector layers on and off from Ctrl+Shift+V (which 

was already assigned for the special paste-and-keep function) to Ctrl+Alt+Shift+V. 

 Updated the 3D viewer so that extruded areas only extend to the terrain surface instead of 

well below it. 

 Fixed problems loading GXF files with lots of comments. 

 Made PDF exports maintain the proper paper size in Acrobat and other PDF readers. 

 Added support for pulling additional <Placemark> tags from KML files and using them 

as attributes for the created features, like <address> and <snippet> tags. 

 Added support for creating new area and line types with line widths that are specified as a 

fixed width in meters. 

 Fixed assignment of point attributes to areas when the projection of the point and area 

features was not the same. 

 When exporting Lidar LAS files from vector point data, use the value of an INTENSITY 

attribute for the intensity value exported to the LAS file. 

 Fixed export of tiled GeoTIFF elevation files. 

 Updated GPX file to use type name for <desc> element when the description is unknown. 

 Updated TerraServer-USA links to point to MSRMaps.com as Microsoft changed the 

name and URL. 

 

WHAT'S NEW IN Global Mapper v11.01 

 

 3D Viewer Improvements 

o The 3D Viewer now supports displaying 3D vector features in space above or 

below the terrain surface. You can also extrude 3D area features to create 

building-like displays. 

o You can now save 3D screenshots of much higher resolution. 

o You can now get descriptive text (tooltips) about the 3D toolbar buttons by 

hovering your mouse over them. 

o Added new button to toolbar to toggle wireframe display on and off. 

 Other Significant New Features 

o Added new GPS menu option to send any loaded data map directly to a 

compatible Garmin GPS device, such as a Colorado or Oregon handheld, for 

display as a raster map on the unit. This allows display of anything, including 

imagery, on compatible Garmin GPS devices! 

o Added support for creating buffer areas some fixed distance around selected area 

and line features. This option is available from the Advanced Feature Creation 

submenu of the right-click menu in the Digitizer Tool. 

o Allowing sorting search results by any attribute rather than just the name. 

o Added support for controlling at what zoom levels a map layer will appear, 

similar to the functionality available with a map catalog. You can configure this 

by right-clicking on a layer in the Control Center and selecting the new option to 

setup what zoom levels a map will display at. 

o Added support for generating multi-band GeoTIFF files with 1 and 2 bands as 



well as 32-bit floating point samples. 

o Added support for generating 8-bit (256-color) GeoTIFF files with transparency. 

o Added support for importing BIL and GeoTIFF imagery files with 32-bit floating 

point samples. 

o Fixed major performance issue from v11.00 with triangulating and gridding 3D 

vector data. It should now be 5-10 times as fast as in v11.00. 

o Added support for generating tiled GeoTIFF files. 

o Added new Search menu option to allow finding and editing loaded vector 

features with the same attribute values. This is useful for enforcing things like an 

attribute that needs to be unique. 

o Made elevation statistics calculated for area features include slope statistics. 

o Added font/label scaling option when exporting (Geo)PDF files, allowing you to 

easily grow or shrink labels written to the PDF file. 

o Added ability to export to a fixed scale when exporting (Geo)PDF files. 

o Added support for generating MapInfo TAB files for most raster format exports. 

o Changed behavior of drawing lines using the trace mode of the Digitizer Tool to 

work while the mouse button is depressed and complete when you release it. This 

makes the trace mode work much better with digitizing tablets. Also, if your 

drawn feature is nearly closed, you will be prompted whether to create an area or 

a line feature. 

o Improved the labeling of areas so that the area label will always be inside the area. 

o Updated KML export to allow displaying point features above the terrain surface. 

o Updated KML vector export to have option to use symbols displayed in Global 

Mapper for point features rather than default push-pin. 

o Added new Lidar import option to pull in data in "preview" mode, which just 

pulls in every 10th point for quick load and display. You can now also choose to 

only pull in ground-shot points during a Lidar point cloud import. 

o Added option to Control Center to create a layer with a point feature at the center 

of each gridded elevation layer cell center. This provides a handy way to edit 

elevation layers as you can easily edit the elevation values of the created points or 

remove problem points, then create a new elevation grid from the edit points. 

o When displaying a 3D path profile of a 3D line feature, show the 3D line feature 

as well as the elevation profile. 

o Allow selection of the text font to use when displaying a 3D path profile rather 

than just the color of the text to display. 

o Updated printing to a file to allow the full resolution of the selected printer always 

be available, regardless of paper size. 

o Added new option to range ring creation to allow creating rectangles of the 

specified range rather than rings. 

o Added LOAD_STYLE_FILE script command to allow loading .gm_style files 

saved from the Styles tab of the Configuration dialog from scripts and also 

created new custom types from scripts. 

o Updated Shapefile exports to maintain the field type and length values (if 

possible) from the source data files if they are Shapefiles or DBF files. 

 New Supported Formats 



o Added support for reading Idrisi Vector (VCT) format files. 

o Added support for reading side-scan sonar data from XTF (eXtended Triton 

Format) files. 

o Added support for reading Italian CML (Cadastral Markup Language) format 

files. 

o Added support for reading Italian TAF (Confidence) format files. 

o Added support for reading DWG 2010 format files. 

 Map Layout Changes 

o Allow map scale to be displayed at a fixed percentage of the output device width. 

o Updated map layout to support adding text anywhere on the map. 

 Projection/Datum Changes 

o Added built-in support for Bessel 1841 Ellipsoid, IGN72 Grande Terre (New 

Caledonia), and RGNC91-93 (New Caledonia) datums. 

o Added support for creating custom datums that use a prime meridian other than 

Greenwich. 

o Fixed problems loading Touratech TTQV.cal files that use commas for decimal 

delimiters rather than periods. 

o Updated Robinson projection to properly crop to world edges by default. 

o Added the text NADCON to any datums that use NADCON datum 

transformation tables. 

o Corrected definition of EPSG code 3057 (ISN93 / Lambert93). 

o Corrected Swiss Grid definition (azimuth should be 90 instead of 0). 

o Made longitude/meridian parameters be displayed and entered relative to the 

prime meridian associated with the selected datum rather than always relative to 

Greenwich. 

 Allowed cropping DWG, DXF, and several other exports to a selected crop area. 

 Added right-click option to 3D path profile dialog to create a new point feature at the 

current cursor location. 

 Made 3D path profile CSV export include slope value for each segment. 

 Added Vertices button to feature edit dialog when editing an existing line or area 

allowing you to edit the vertices for that feature. 

 Greatly improved appearance of most loaded EMF files by making them come is as a 

raster layer rather than a vectorized one. 

 Added new button to the view shed options dialog to allow having ground-relative 

transmitter and receiver heights calculated based on just a subset of the loaded elevation 

layers. This is useful if for example you have a layer with the bare ground elevations, 

then another gridded elevation layer that includes buildings that you want to use for line-

of-sight purposes. With this new option you can choose to have the transmitter and 

receiver heights relative to the bare ground layer. 

 Added display of calculated scatter angle for the active line of sight when showing path 

details for the path profile/LOS. 

 When moving one or more line and/or area features with the Digitizer Tool and a single 

vertex on those features is selected, made snapping work so that selected vertex will snap 

to other existing features. 

 Greatly improved initial display of OS Mastermap data from GML files. Most areas will 



now automatically be displayed using the OSGB-recommended colors. 

 Made fill of small gaps during raster export work even at 'T' intersections of no data lines. 

The average of colors across the diagonals will be used at those intersections if available. 

 When gridding exports to selected area features and not cropping to the area boundaries, 

use the full bounding box of the area for each export rather than the intersection of the 

area bounding box with the specified export bounding box. 

 Made custom shader dialog resizable. 

 Added new option when batch converting to Simple ASCII Text files to control whether 

or not a blank line is used to separate features. 

 Added new option when batch converting the CSV files to allow using a space separator 

rather than a comma. 

 Fixed problems loading TIF files created by AutoCAD Raster Design that specify they 

both have strips and tiles (they really have tiles). 

 When digitizing a line with the stream mode, delay any simplification until the feature 

completes and also don't remove quite as many vertices when simplifying. 

 Added new keyboard shortcut (Shift+T) to go into line trace mode in the Digitizer Tool. 

 Added new ASCII import option to skip a fixed number of lines at the start of a file. 

 Fixed problem saving new measure areas and lines to new layers. 

 Fixed problem with small red rectangle displaying for new point features using the 'No 

Symbol' symbol type. 

 Improved loading of Shapefiles with overlapping island areas within a parent. 

 Fixed bug cropping to selected areas during batch conversion. This bug was introduced in 

the v11.00 release. 

 Drastically reduced memory requirement for Surfer Grid exports, allowing basically 

unlimited size exports. 

 Made generated contour lines be oriented such that the higher elevations are to the left of 

the line. 

 Fixed error saving workspace files with a PDF loaded. 

 Updated the ETA reporting on progress dialogs to add a completion date if the operation 

is estimated to take more than 12 hours. 

 Fixed problem getting DigitalGlobe imagery in some locations. 

 Added option to PDF export to control whether or not fonts are embedded. 

 Fixed problem with background values stored for exporting multi-band GeoTIFF files. 

 Added option to BIL export to allow exporting shorter ESRI/Arc format .hdr file. 

 Improved import of HATCH entities from DXF files to maintain islands/holes inside 

areas. 

 Reduced simplification threshold used when saving active GPS tracklogs from 1.5 m to 

0.5 m so more detail will be kept from recorded track logs. 

 Added new GPS menu option allowing you to disable the simplification of track logs. 

 Fixed crash loading some large Erdas Imagine .img files. 

 Added support for import and exporting DGN v8 files in 64-bit builds. 

 Added support for interrupting the draw of a large raster layer by pressing the ESC key. 

 Updated KML "super overlay" export to work better with transparent layers. 

 Removed warnings about unknown attributes during S-57 imports. 



 Fixed problem importing some S-57 files resulting in crossing lines and lines with gaps. 

 Fixed problems in v11.00 connecting to online data sources through some proxy servers. 

 Made map catalog loads report any files that cannot be found. 

 Updated Lowrance LCM export to include water label points for any labeled water areas. 

 Updated the ECW 64-bit export to multiply your target compression ratio by 0.6 so that 

the end results are comparable to the 32-bit ECW export with the same target 

compression ratio. 

 Fixed one half sample spacing shift of raster/elevation layers when exporting them to a 

new raster format with vector data included. 

 Fixed error when doing Lowrance USR export (this started with v11.00 release). 

 Made workspace and script files show up in the normal File->Open Data File dialog. 

 Made "Select From" checkbox options on the Vector Display tab of the Configuration 

dialog always reset to checked when you start a new instance of Global Mapper rather 

than being remembered. 

 Added new option to Google Maps and Bing Maps (Virtual Earth) exports to allow 

skipping empty tiles. 

 Added option to map catalog dialog to allow using a non-default drawing style. 

 Added option to DigitalGlobe export to allow using premium un-watermarked access 

only when exporting and just browsing using free watermarked imagery. 

 When creating a new line with distance/bearing/COGO input, display a bullseye at the 

line start location. 

 When creating a new line with distance/bearing/COGO input and a single point feature of 

line/area vertex is selected, give the user the option to start the line at the selected 

point/vertex. 

 Fixed problem with creation of distance/bearing/COGO line by right-clicking in the 

Feature Info dialog not working. 

 Made elevation display units setting from Vertical Options tab of the Configuration 

dialog be remembered between runs. 

 Fixed bug in Lidar LAS export with the wrong sentinel value being written for variable 

length records used to store projection information. 

 Fixed problems loading 3D polyface meshes from DXF files. 

 Added support for transparency (i.e. alpha channel) from tiled TIFF files and TIFF files 

with something other than 3 bands of data. 

 Made 3D path profile remember sample count setting if changed. 

 Added new option to not get elevation values from any attribute on the vector type 

options dialog. This will allow elevation requests on export to fall through to underlying 

elevation data for data sets that already have elevation attributes. 

 Fixed error in calculating cut-and-fill volumes along a line feature. 

 Added 'V' shortcut key to toggle the display of vector layers on and off. 

 Updated 'Save Workspace As' option to default the filename to the existing workspace 

filename. 

 Fixed bug with auto-cropping of collars from some file types when those files are 

displayed from a map catalog. 

 Improved recognition of elevation values from generic ASCII import. Now values 

without a space between the elevation value and units will be allowed for an elevation 



column. 

 Make sure improperly formatted <time> values are not exported to GPX files. 

 Fixed blending of online layers (i.e. TerraServer-USA, WMS layers, etc.) with 

underlying DigitalGlobe layers. 

 Fixed error loading OCAD files with bad offsets in their header. 

 Fixed problems loading some MapTech PCX charts. 

 Added support for reading annotation and traffic line features from S-57 (ENC) files. 

 Added 'nautical miles' as an available distance unit when creating 

distance/bearing/COGO lines. 

 Added new option to allow disabling the automatic snapping behavior of the Digitizer 

Tool. This option is in the general option list on the Vector Display tab of the 

Configuration dialog. 

 Updated creation of point features sampled along a line or area boundary with a fixed 

distance between samples to allow a start label to be used and to label with the distance 

rather than an incremented number. 

 Updated the Digitizer Tool option to assign area attributes to lines in those areas to not 

replace existing values in the line attribute list but only add new attributes. 

 Added support for creating 24-bit TIFF files when batch converting to raster KMZ files. 

 Made double-clicking on a line type on the Line Styles tab of the Configuration dialog 

bring up the default attribute list for that type. 

 Made double-clicking on an attribute on the default attribute list dialog for a type 

automatically bring up the edit dialog for the selected attribute. 

 When creating point features from selected line vertices and the line has per-vertex 

timestamp values, add a TIMESTAMP attribute to each new point. 

 Allowed selection of only vertices from already selected line or area features by holding 

down the 'S' key when left-clicking or dragging a box in the Digitizer Tool. 

 Write more precision for sample sizes in exported Gravsoft Grid files to prevent 

problems with large files exported with degree units. 

 Made Configuration dialog remember the tab it was on when last closed. 

 Fixed bug in placement of TerraScan LIDAR files with non-default origin or units. 

 Made import of marine features from MP files using extended type notation 

(0x01XXXX) correctly have MARINE=Y attribute added. 

 Fixed smoothing of area features to behave the same as smoothing a line feature with the 

same boundary. 

 Added support for specifying prefix text when creating points spaced along a selected 

line or area feature with the Digitizer Tool. 

 Added support for tracking NMEA GPS devices that don't separate the NMEA sentences 

with newline characters. 

 Made area features created from lines in the Digitizer Tool automatically have measure 

attributes added to them. 

 Fixed error from v11.00 with some polynomial (4-point) image rectifications. 

 Corrected DXF imports and exports to treat color index 0 as black, not white. 

 Added option to disable the alpha channel for raster layers on the Band Setup tab of the 

Options dialog for the layer. This is useful for layers with bad alpha channel values. 

 Added support for loading KML files with multiple alternate names for the <Placemark> 



tag. 

 Added support for disabling automatic export of BigTIFF formatted files when exporting 

to very large GeoTIFF files from a script by adding a DISABLE_GEOTIFF=YES 

parameter. 

 Added support for 16-bit Vertical Mapper clutter (.grc) files. 

 Fixed problem with text size on elevation legend and distance scale saved to PDF files. 

 When creating view sheds from selected point features, made the attributes of those 

selected point features be copied over to the new tower point that is created. 

  

WHAT'S NEW IN Global Mapper v11.00 

 

 Significant New Features 

o Created native 64-bit version of Global Mapper, allowing users of 64-bit versions 

Windows to work with much larger data sets. 

o Added support for exporting loaded data directly to geo-enabled PDF files. This 

includes keeping all vector features as separate entities rather than rasterizing 

them. 

o Added support for directly loading PDF/GeoPDF® format files. 

o Added support for exporting loading vector data to DWG format files. 

o Built-in DigitalGlobe imagery access was updated to have much better worldwide 

coverage. 

o Added free built-in access to global street-level maps from OpenStreetMap.org 

via the File->Download Online Imagery menu command. 

o Added support for exporting GeoTIFF files with 3 or more bands of data and 16 

bits per band, thus allowing multi-spectral input files to be output without losing 

any information. 

o Added new Map Layout option under the Tools menu and on some right-click 

menus to allow more control over the display of the elevation legend and distance 

scale, as well as new support for adding margins and a north arrow to your map 

display/exports. 

o Added real-time display of current cursor information (location, distance, 

elevation) to 3D Path Profile dialog. In addition, you can now also click to define 

a sub-path on the 3D Path Profile dialog and get information about that sub-path 

displayed. 

o Added ability to easily create symbols from common shapes like dots, squares, 

diamonds, and stars of a user-selected size and color anywhere that a point 

symbol can be selected. 

o Added ability to add custom point symbols from PNG, GIF, and JPG images (in 

addition to the current support for BMP and ICO files). This includes support for 

translucent symbols by using PNG files with an alpha channel for transparency. 

o Added ability to add custom point symbols from vector format files, including 

EMF, DXF, and Global Mapper symbol (.gm_sym) files, which are just ASCII 

XYZ files. 

o Added support for scaling point symbols, allowing you to change of existing point 

symbols either by some fixed percentage or to make them a fixed number of 



meters in height on the display. 

o Updated vector exports that are cropped to a selected area to actually crop the line 

and area features being exported to the selected area. 

o Added new option to display a whitened highlight area in terrain areas that are 

getting direct sunlight. The amount of whitening can be controlled on the Vertical 

Options tab of the Configuration dialog. 

o Added new option to vector KML/KMZ export to generate an index KML file. 

This can help manage large collections of vector KML files that would otherwise 

overwhelm Google Earth. 

o Added support for averaging your GPS position to create a more accurate 

waypoint when tracking a connected GPS device. 

o Added new Search->Search and Replace menu option to allow easily searching 

for a particular text item and replacing that with a new value, including appending 

or pre-pending text to existing values. 

o Prompt users for location of missing files when loading workspaces rather than 

just skipping the load of those files. 

o Added estimated completion time to progress dialog for operation that take longer 

than 30 seconds. 

o Added support for named views that are saved to a workspace file rather than 

globally shared, thus allowing you to easily share views view workspace files. 

o Added support for adding area and line features to a running instance of Global 

Mapper using the External Control API interface. 

 Digitizer/Edit Tool Enhancements 

o Added toolbar for Digitizer/Edit Tool to make it easier to perform many 

commonly used operations. 

o Added ability to create new line features by tracing them without clicking at each 

vertex with the Digitizer/Edit Tool. 

o Added ability to rotate and scale features. 

o Added ability to combine arbitrary area features. 

o Added ability to find the intersection of two area features. 

o Added ability to crop selected line features to a selected area feature. 

o Added ability to apply attributes to selected line features from selected area 

features that the lines are completely enclosed within. 

o Added a new feature to the Digitizer/Edit tool allowing you to select one or more 

points, then right click and assign attributes to those points based on the top-most 

area feature with attributes that each point is contained in. 

o Added a new feature to the Digitizer/Edit tool allowing you to create labeled point 

features at a regularly spaced interval along selected area and line features. This is 

in the Advanced Feature Creation right-click menu. 

o Added a new feature to the Digitizer/Edit tool allowing you to resample selected 

area and line features at a regularly spaced interval along selected area and line 

features. This is in the Advanced Feature Creation right-click menu. 

o Added a new feature to the Digitizer/Edit tool allowing you to simplify (reduce 

the vertex count) of selected line and area features by removing vertices that do 

not significantly contribute to the shape of the feature. 



o Added a new feature to the Digitizer/Edit tool allowing you to smooth selected 

line and area features by moving existing vertices to create a smoother 

appearance. 

o Added option to split selected line features into separate line features for each 

segment under the Advanced Feature Creation sub-menu in the Digitizer Tool. 

o Added option to calculate view sheds at each point feature selected with the 

Digitizer Tool rather than just at the clicked location. 

o Allow generation of 3D path profiles from selected area features using the 

Digitizer Tool (previously only lines were supported). 

 New Supported Formats 

o Added support for loading from and exporting to PDF/GeoPDF® format files. 

o Added support for exporting loaded vector data to DWG format files. 

o Added support for exporting loaded data to Window bitmap (BMP) format files. 

o Added support for loading MrSID MG4 Lidar files. 

o Added support for loading Vertical Mapper (MapInfo) Grid/Clutter format files. 

o Added support for loading QCT (Quick Chart) and QED format files. 

o Added support for loading Google SketchUp (.skp) format files. 

o Added support for exporting loaded vector data to OSM XML 

(OpenStreetMap.org) format files. 

o Added support for loading HTF (Hydrographic Transfer Format) files. 

o Added support for loading SPS (Shell Processing Support) format files. 

o Added support for loading MapMaker Drawing (DRA) format files. 

o Added support for loading LMN (Spectra Line Management Node) files. 

o Added support for loading GSD (Swedish DEM Grid) format files. 

o Added support for loading BAG (Bathymetric Attributed Grid) files. 

o Added support for loading FCC ASR (Antenna Registration System) data files. 

o Added support for loading Japanese DEMs in LEM/CSV format. 

o Added support for loading Garmin TCX (Training Center Database) files. 

o Added support for loading CXF (Italian Cadastral Format) files. 

o Added support for exporting loaded point and line data to UKOOA P1/90 format 

files. 

o Added support for exporting loaded vector data to Lowrance LCM format files for 

display on Lowrance GPS devices. 

o Added support for exporting loaded elevation data to Vertical Mapper (MapInfo) 

Grid format files. 

o Added support for exporting loaded data to tiles for displaying on the web with 

Zoomify (use File->Export Web Formats->Export Zoomify menu command). 

o Added option to import features from ASCII text files using the Well-Known-

Text (WKT) format for storing feature geometry. 

 Image Rectification Enhancements 

o Added checkboxes to allow easily turning individual control points on and off to 

see how it affects the rectification. 

o Added an optional crosshair display traversing the entire zoomed and reference 

image views. 



o Added dynamic cursor location display for reference image view. 

o Added display of the selected rectification method to the dialog title bar. 

o Added support for using a Helmert (similarity) transformation when rectifying 

imagery and vector data layers. 

o Made polynomial rectification with 6 or more control points use a 2nd degree 

(N=2) equation. 

o Made Ctrl+Left Click in the Zoomed View automatically fill in the projected 

coordinates and also zoom the Reference View to the same approximate location 

and zoom scale if possible. 

o Made Ctrl+Left Click in the Reference View automatically fill in the pixel 

coordinates and also zoom the Zoomed View to the same approximate location 

and zoom scale if possible. 

o Added option under the Options menu to automatically save the control points 

(GCPs) to a GCP file when closing the dialog. 

o Made the control point list resize when the dialog is resized. 

 Projection/Datum Changes 

o Added built-in support for the Japanese Projection System (zones I - XIX), the 

Philippines Grid projection (zones 1-5), and the Sinusoidal (Integerized) 

projection. 

o Added built-in support for Clarke 1866 Authalic Sphere, ED50 (North Sea), 

ED50 (Norway Offshore N62), ED50 (Norway Offshore S62), JGD2000 (Japan), 

LKS92 (Latvia 1992), NAD83 (South Carolina HPGN), Naparima 1972, Rome 

1940 [Monte Mario] (w/ Rome meridian), SIRGAS 2000 (Brazil), South 

American 1969 (Brazil), Wisconsin - Burnett County, Wisconsin - Douglas 

County,  and special MODIS spheroid-based datums. 

o Added support for a Central Longitude parameter for the Geographic (Lat/Lon) 

projection to allow re-centering a lat/lon display on a longitude other than 0. This 

allows for easily wrapping maps near the anti-meridian. 

o Added built-in support for Mars 2000 sphere and polar sphere datums and 

ellipsoids. 

o Added support for Maine CS2000 State Plane zones. 

o Updated the built-in Lambert-93 projection to now be a zoned projection 

supporting the base Lambert-93 definition as well as the CC-42 through CC-50 

zones 

o Renamed 'Central Meridian Scale Factor' in projection selection dialog to just 

'Scale Factor' so that it would fit on the screen better. 

o When writing out State Plane projections to PRJ files, save the name of the State 

Plane zone in the projection name at the start of the PRJ file. 

o Added support for modifying the location relative to which the extra scale factor 

is applied to State Plane projections. This is for advanced users with some very 

unusual modifications to State Plane projections. 

o Corrected EPSG codes and added new ones for many State Plane projections. 

o Fixed problem with an extra scale factor being applied to some State Plane zones 

extracted from ECW files (this bug was introduced in v10.01). 

o Corrected transformation for Kertau 1948, PRS92, and Timbalai 1948 datums 



(incorrect since v10.01). 

o Improved accuracy of NTF France datum conversions (they now agree with the 

official results to within 1 centimeter). 

o Improved accuracy of ROME 1940 and WGS72 datum transformations. 

o Updated Robinson projection to use newer PROJ4 library definition rather than 

older GCTPC library definition that does not seem to be consistent with any other 

applications. 

o Added support for using inches as a linear unit with projections. 

o Increased valid range for scale factor parameters from [-2,2] to [-10,+10]. 

o Allowed use of WGS84 with Austrian Grid, Belge1972, and Dutch Grid 

projections. 

o Updated MrSID imports to treat false easting/northing values embedded in the 

SID file as GeoTIFF tags as always being provided in meters as that seems to be 

how the MrSID library treats them. 

 Scripting Language Changes 

o Added new LOAD_TYPE_FILTER script command for loading area, line, and 

point filters from GMF (Global Mapper Filter) files. 

o Added new EXPORT_PACKAGE script command to allow exporting loaded 

data to Global Mapper Package files. 

o Added new GENERATE_REPORT script command to allow creating a text 

report about the loaded vector layers, including feature counts, combined line 

length, and total covered area, broken down by feature name, type, or attribute 

value. 

o Added new GENERATE_LAYER_BOUNDS script command to allowing 

generating a layer with bounding areas for the loaded data from a script. 

o Added support for splitting a vector export into a separate file for each group of 

features with the same attribute values using the SPLIT_BY_ATTR=YES 

parameter. The new FILENAME_ATTR_LIST and 

FILENAME_INCLUDE_ATTR_NAME parameters can be used to control the 

file naming when splitting an export using this new functionality. 

o Modified specification of vertical exaggeration for VRML exports to allow 

manual number entry rather than using a slider to allow for a greater range of 

values and a more intuitive experience. The VERT_EXAG value used for the 

EXPORT_ELEVATION script command also now uses a normal value rather 

than a strange scaled value. 

o Made GEN_WORLD_FILE parameter work for all export formats with 

EXPORT_ELEVATION and EXPORT_RASTER script commands. 

o Updated default SIMPLIFICATION parameter value for 

GENERATE_CONTOURS command to match what is used in the user interface. 

 Added new collar cropping option to allow manually specifying a degree boundary to 

crop each side of a loaded layer to. For example you might specify that the crop boundary 

for a layer is at even degree boundaries. 

 Added new option to Search->Search by Attributes dialog to allow searching on a value 

in any attribute, rather than just a single selected attribute. 

 Automatically use bilinear interpolation when exporting reprojected or resampled raster 



layers that are not palette-based. 

 Added ability to label features based on the feature type, description, and/or source 

filename as well as attributes when setting up feature labeling for a vector layer via the 

Options dialog for the layer from the Control Center. 

 Added support for exporting loaded area data to multi-patch Shapefiles. 

 Dramatically increased speed of raster and elevation exports cropped to areas with a large 

number of vertices. 

 Updated to save user settings in Application Data area of Windows rather than in 

Program Files folder. This is more in line with the requirements of newer Windows 

versions like Vista and Windows 7. The location of your user data folder will now also be 

displayed on the Help->About dialog. 

 Allowed modifying the options for multiple selected vector layers and the User Created 

Features layer from the Control Center. 

 Added new option to vector KML/KMZ export to allow specifying that the feature 

description be based on custom HTML text that can include attribute values and other 

feature information in whatever manner the user deems appropriate. 

 Added new option to vector KML/KMZ export to allow specifying the character 

encoding to specify in the header. This is useful if you are exporting things like UTF-8 

text to KML files. 

 Added much better looking 24-bit color toolbar buttons (thanks to Bruno Bellazzi for 

these). You can switch back to using the older higher-contrast toolbar buttons using an 

option under the View->Toolbars menu. 

 Added toolbar button to restore the last drawn view. 

 Added new right-click option to the Control Center to allow ordering the loaded layers by 

resolution or by the bounding box of the layers. 

 Added button to copy the contents of the Feature Vertices to the clipboard as text. 

 Added reporting of DPI to metadata for (Geo)TIFF files. 

 When batch converting from TIFF files to new TIFF or JPG files, maintain the DPI value 

specified in the original file (if there was one). 

 Made GPX exports write out <time> attributes for <wpt> elements if TIMESTAMP, 

TIME, or UTCDATE and UTCTIME attributes are available for the point being 

exported. 

 Made the preview window on the feature edit dialog for points and the create strike-and-

dip dialog display the portion of the map under the point location so that you can see 

exactly how the symbol will look on the map when you create it. 

 Added new option specify that any raster layers should automatically have anti-aliasing 

(interpolate) enabled when loaded to the Advanced section of the General tab of the 

Configuration dialog. 

 Added support for loading text associated with features from USGS DLG-O files. 

 Added support for loading compressed GXF files. 

 Made FONT_HEIGHT_METERS attribute actually be used when importing point 

features. 

 Changed FONT_HEIGHT_METERS to FONT_HT_M when writing out style 

information via attributes so that it would fit inside the 10 character attribute length limit 

for DBF/Shapefiles. 



 Added a new option to the Advanced section on the General tab of the Configuration 

dialog to specify that lat/lon values in the status should be displayed in WGS84 rather 

than the current datum selected on the Projection tab of the Configuration dialog. 

 Sped up gridding of Lidar LAS files when using the option to remove ground shot points 

during the gridding operation. 

 Allowed use of up to 20 zoom levels (instead of 19) when generating tiles for display in 

Virtual Earth. 

 Fixed problem with specified sample spacing not being maintained when gridding to a 

fixed width in ground units during export and also applying overlap. This bug was 

introduced in the v10.02 release. 

 Updated custom shader creation to allow initializing values between currently specified 

min/max values when using the 'Evenly Space Elevations' option rather than just 

replacing the existing number of values. 

 Added support for loading rotated MrSID format files. 

 Added support for loading additional MODIS data sets from HDF format files. 

 Added support for loading data from netCDF format files with multiple plottable data 

sets in them. 

 Fixed problem with duplicate points being exported to SEGP1 files when points are in 

both line and point form. 

 Updated KMZ vector exports to copy any files referenced by "link" attributes to the 

output file. 

 Added support for loading gzipped text files using the File->Open Generic ASCII Data 

File menu command. 

 Updated 3D path distance reported in path profile to work correctly for multi-segment 

lines. 

 Added support for using styling information from KML/KMZ files that use 'StyleMap' 

tags. 

 Updated the TomTom OV2 export to generate a BMP file with the same name as the 

OV2 file with the first symbol found in the points being exported. 

 Allow creating/flattening terrain from areas with per-vertex elevations rather than just a 

single elevation attribute. 

 When calculating view sheds and using area features as obstructions, added option to 

control whether or not the top of the area features are allowed to be marked as visible or 

not. 

 Added support for modifying the intervals used for designating minor and major contours 

during contour generation via registry keys. To change the minor interval, create a 

DWORD value  

'HKEY_CURRENT_USER\Software\GlobalMapper\ContourInterval_Minor' and set it to 

the desired multiplier (5 is the default).  To change the major interval, create a DWORD 

value  'HKEY_CURRENT_USER\Software\GlobalMapper\ContourInterval_Major' and 

set it to the desired multiplier (10 is the default). 

 Corrected issues loading BIL/BIP/BSQ images with signed 16-bit samples rather than 

unsigned 16-bit samples. 

 Added support for gridding Terragen exports. 

 Fixed problem in v10.02 release with rotated symbols being mirrored in the X direction. 



 Reduced default simplification applied during contour generation to improve appearance 

of contours generated with default settings (at the expense of the default settings now 

resulting in contours with more vertices). 

 Added new options to the right-click menu in the Measure Tool allowing you to set the 

bearing format to degrees (the previous display format), the two-directional format used 

in surveying, or mils. In addition you can also choose whether to display bearings relative 

to True North, Magnetic North, or Grid North. 

 Increased precision of decimal bearings displayed when measuring and also provided a 

registry key to control this at 'HKEY_CURRENT_USER\Software\Global 

Mapper\BrgPrecision'. 

 Fixed problems exporting MapInfo MIF/MID and TAB/MAP files with US Survey Feet 

coordinates. 

 Added a new shortcut key (Ctrl+Shift+L) to copy the cursor location and the elevation at 

the cursor location to the clipboard. 

 Updated elevation legend display when a Slope Shader is used to be restricted to the 

min/max slope range setup for the Slope Shader. 

 Fixed problems with missing time-stamps when tracking some connected NMEA GPS 

devices. 

 Added support for additional colors when export to and importing from DXF files. 

 Allow selection of any color for label font display rather than just a pre-selected list of 

colors. 

 Fixed issues with some data not importing from OSGB GML files. 

 Added support for loading PNG files embedded in KMZ files. 

 Increased precision of elevation values written to Arc ASCII Grid files (now will be up to 

3 digits of precision in nearly all cases). 

 Changed PNG and BMP world file extensions for screen captures to .pgw and .bpw 

respectively, rather than .pngw and .bmpw. 

 Improved performance exporting from some WMS data sources. 

 Allowed GPS-triggered redraw to happen up to 3 times per second rather than just once 

per second. 

 Added support for rods and varas as a unit of measure when using 

distance/bearing/COGO input. 

 Added support for using bearings relative to the current projection/grid system rather than 

true north when using distance/bearing/COGO input. 

 Fixed problems with cropping to rectangles or polygons during draw not working for 

online sources, like DigitalGlobe, Terraserver-USA, or WMS sources. 

 Added support for loading ellipse/circle and rectangle features from EMF files. 

 Added support for saving elevation values from multi-point Z Shapefiles. 

 Added option to combine all vector layers into a single layer when exporting a Global 

Mapper Package file. 

 Significantly sped up access to the SRTM and NED data sources using the File-

>Download Online Imagery menu command. 

 Updated the Feature Info dialog so that if you double-click on an attribute with a 

filename as the value, that file will be opened with the associated Windows application. 

 Sped up display or rotated or rectified ECW and JPEG2000 files. 



 Added support for associating a text or web file to display when loading a workspace 

with a particular file. This association is set via the right-click menu on the Control Panel. 

 Fixed rare positioning problem with some Arc Binary Grid (ADF) files. 

 Sped up Global Mapper Grid exports from large collections of files (like map catalogs). 

 Added option to batch convert vector files to the InRoads ASCII format. 

 Fixed problem exporting areas with duplicate islands/holes when the export boundary 

passes through one or more duplicate islands/holes. 

 Updated KML import to use feature names for type assignment if type assignment based 

on folder names doesn't find a matching type. 

 Added support for specifying the Image ID to use when exporting a Polish MP file. 

 Updated Polish MP exports to use 'EndLevel' rather than 'Levels' and [POLYLINE] and 

[POLYGON] sections rather than [RGN40] and [RGN80]. 

 Made Polish MP export report any literal types that are exported which may cause 

problems in cGPSMapper. 

 Added area and line vertex count to metadata for layers. 

 Added support for gpxx:Depth and gpxx:Temperature attributes when importing GPX 

files. 

 Significantly sped up exports to extremely large ECW (multi-GB) files that had 

previously slowed to a crawl in some cases. 

 Updated behavior of path profile generation along multi-segment paths to not always stop 

at vertices when generating a path with a user-specified fixed interval. Now that interval 

will be obeyed so the user will get the exact spacing that they requested. 

 Added option to generate 24-bit PNG files when exporting to WorldWind tiles. 

 Made fat road line styles and zoom-level based type filtering work properly when 

exporting to formats with multiple zoom resolutions, like Google Maps. 

 Made the Add New Attribute option when editing one or more features remember the last 

added attribute to simplify adding the same attribute to lots of features. 

 Added display of bounding box for area and line features to the Geometry section of the 

Feature Info dialog for those features when selected. 

 When adding a new WMS data source, if an existing WMS data source is selected 

initialize the server URL to that of the selected WMS source. 

 Updated CSV export to include all available attributes, even if the values for all of them 

are empty. 

 Added support for Yards as a unit for specifying the radius of range rings. 

 Corrected problem with the default font being written to style files saved from the * 

Styles tabs of the Configuration dialog rather than the font assigned to a type. 

 Updated the Path Profile/Line of Sight tool to draw using the 'Measurement' line style, so 

you can now customize the appearance of that line. 

 Added support for loading data that is in .zip files contained within .zip files, like the new 

Tiger 2008 data is typically distributed. 

 When measuring cut-and-fill volume from the Path Profile or Digitizer Tools, initialize 

the cut elevation for each vertex to that of the input path if possible. 

 Added ability to save your 3D cut line to a CSV file on the Volume Calculation dialog. 

 When splitting Shapefiles by layer on export, use the type name rather than the 

description string for anything other than unknown types. 



 Corrected positioning of some OSGB TIFF tiles. 

 Added support for loading arc (BUE and BUEP) features from SOSI format files. 

 Fixed problem loading area features with holes from SOSI format files. 

 Added Location button to Feature Info dialog displayed for point features allowing 

display and editing of point feature location from there. 

 Renamed Virtual Earth export to Bing Maps to reflect new naming by Microsoft. 

 Added support for positioning raster files with SOSI .sos files. 

 Updated saving of Surfer CLR shader files to allow saving the actual elevation values 

rather than the standard elevation percentage values that Surfer uses. This makes it easier 

to save and restore shader settings within Global Mapper. 

 Reduced size of built-in bullseye symbol to make it less obtrusive. 

 Added option to use space separator rather than comma when batch converting to Simple 

ASCII Text and XYZ grid files. 

 When using the File->Rectify Imagery menu command, make the export option be 

unchecked by default. 

 When exporting to a raster (image) format, check the 'Save Vector Data if Displayed' 

option by default if any vector data is loaded. 

 Made SEGP1 import just ask the user to confirm the datum as the projection is already 

known. 

 Corrected application of color intensity when feather blending. 

 Improved bearing calculations in Global Mapper to use the Vincenty formula. 

 Made attribute values with multiple leading zeroes be treated as text fields rather than 

numeric when exported to DBF/Shapefiles. 

 Made Global Mapper Package exports maintain the names for palette entries if they exist. 

 Fixed problem with slow terrain draws from the last release. 

 Added progress reporting when loading an archive (.zip or .tar.gz) file with multiple files 

to load inside it. 

 Fixed bug with changes on the Palette tab of the Options tab for TIFF files not being 

applied to overview layers (i.e. it only worked when zoomed in on the layer). 

 Dramatically improved performance of exports from large numbers of MrSID files. 

 Updated GeoTIFF exports to write out the ellipsoid parameters. 

 Updated TIN generation when flattening areas to automatically delete any triangles 

outside the area feature(s) being flattened. 

 Reversed the order of colors in the HSV shader. 

 Made CSV exports include non-default symbol names as well as an IMAGE_LINK 

attribute for EXIF point features. 

 Added support for additional HDF-formatted data sets. 

 When loading .gm_style files via the * Styles tabs of the Configuration dialog, prompt 

the user to add any types that aren't found on the system. 

 Added support for controlling the accuracy and collection system values stored in 

exported DTED files through the 'HKEY_CURRENT_USER\Software\Global 

Mapper\DTEDAccuracy' and 'HKEY_CURRENT_USER\Software\Global 

Mapper\DTEDCollectionSystem' string registry keys. 

 Added new option on the Vector Display tab of the Configuration dialog to disable the 

automatic add of measurement attributes to newly created area and line features. 



 Added new option on the Vector Display tab of the Configuration dialog to treat 

duplicate vertices in area borders as 'Pen Up' or 'Pen Down' commands, thus allowing for 

having some segments of an area border be not drawn. 

 Made export of generated TIN polygons to DXF files generated 3D face features rather 

than 3D polylines. 

 

WHAT'S NEW IN Global Mapper v10.02 

 

 Significant New Features 

o Added ability to easily create strike-and-dip points by right-clicking in the 

Digitizer Tool. You can now place your strike-and-dip points and specify the dip 

value, azimuth angle, and symbol to use and get the appropriate symbology 

displayed on the map. 

o Added support for adding custom area fill styles from image files. New fill styles 

can be added on the Area Styles tab of the Configuration dialog. 

o Added support for rotating point symbols by a user-specified angle. This option is 

on the Point Styles tab of the Configuration dialog as well as on the edit dialogs 

for point features. 

o Added option to the Digitizer Tool to calculate the minimum, maximum, and 

average elevation values within selected area features. 

o Added support for specifying that lines should draw a particular number of meters 

in width. Line width selections on the Line Styles tab of the Configuration dialog 

and anywhere else that you setup a line drawing style now include an option to 

specify a fixed width in meters for the line. 

o Added new input option to distance/bearing/COGO input for lines to allow one-

handed-input using the number pad with either quadrant/bearing/distance input or 

distance/bearing input. Also added support for entering DM or DMS bearings as 

decimal values, like 40.3020 for 40 degrees, 30 minutes, and 20 seconds. 

o Added new right-click options to the Area Styles, Line Styles, and Point Styles 

tabs of the Configuration dialog to allow saving the current style settings to a file 

and restoring style settings from a file. 

o Added new ASSIGN_TYPE command to the scripting language to allow 

classifying loaded vector features based on one or more attribute/display label 

value queries. 

o Added support for loading SOSI format files (commonly used in Norway). 

o Added ability to easily shift loaded data by some fixed distance by right clicking 

on them in the Control Center and selecting a new option to shift the selected 

layer(s). 

o Made batch conversion remember the last used import and export formats as well 

as the last used settings for a previously used import/export format combination. 

o Made GPX files with links pointing to local image files behave just like JPG files 

with EXIF positioning data and show the image when you click on the point with 

the Feature Info tool. The linked images will also export to KMZ files. 

o Added new Slope Direction shader to allow coloring loaded terrain files by the 

direction that the slope faces (the coloring can be setup on the Shader Options tab 



of the Configuration dialog). You can also now export slope direction values to 

Float/Grid files. 

o Added option to batch converter to add a watermark image. 

o Added new option to only display area labels when the label is completely 

contained within the parent area to the Vector Display tab of the Configuration 

dialog. 

o Made the option to display selected feature measurements (including combined 

values) in the Digitizer/Edit Tool work even if only line features are selected. 

o Added ability to display any custom "elevation" units string that you want on the 

elevation legend by right-clicking on the legend and selecting the option to 

specify a custom unit string. 

o Added support for exporting to DeLorme track and waypoint formats. 

o Added support for exporting loaded area and line features to ZMap+ XYSegId 

text files. 

o Added option when generating Global Mapper Package files to store each layer in 

its native projection rather than in the current view projection or in 

lat/lon/WGS84. 

o Added new option to the Vector Display tab of the Configuration dialog to always 

show vertices for features selected with the Digitizer/Edit Tool. This makes it 

easier to edit the vertices of area and line features without being overwhelmed by 

displaying all feature vertices. 

o Allowed rasterization of vector data to any size to exported image file (previously 

you were limited by the largest bitmap that could be allocated on your system). 

 Projection/Datum-Related Additions and Changes 

o Added built-in support for the Wisconsin County coordinate systems. 

o Added built-in support for Deir Ez Sor, Egypt Gulf of Suez S-650 TL, Estonia 

1997, FD 1958, Herat North, ISN93, Jordan, Korean 1985, Korean 1995,  

Ocotepeque (Costa Rica), Reykjavik 1900, and Trinidad 1903 datums. 

o Added built-in support for the Clarke 1858, Danish 1876 and  Clarke 1880 (IGN) 

ellipsoids. 

o Added built-in support for linear units of Clarke Feet. 

o Added EPSG codes for KGD (Korean Geodetic Datum) and Mercator projection 

used in Google Maps and Virtual Earth (code 3785). 

o Fixed problem with Dutch (RD) datum transformations in the v10.01 release. 

o Added support for decoding Bonne projections from OziExplorer .map files. 

o Added support for decoding projection names from ECW files stored as 

EPSG:<epsg_code> in the projection name and also encode unknown projections 

that way in exported ECW files. 

o Improved accuracy of KKJ datum conversions and added KKJ projection EPSG 

codes. 

 Added option to Path Profile/Line of Sight dialog when matching the elevation scale to 

the draw scale to allow users to enter a vertical exaggeration to apply. 

 Added new batch conversion option to skip existing output files. 

 Added new batch conversion option to disable anti-aliasing (interpolation) in all cases, 

even when it is automatically applied for reprojection or resampling. 



 Added new batch conversion option to minimize the main window while the conversion 

is running. 

 Updated batch conversion to not report any errors in the conversion until all conversions 

have been completed. This prevents a batch conversion operation from stalling in the 

middle waiting for a user to clear an error message. 

 Updated the set position dialog to have an elevation field when editing the location of a 

single vertex from a 3D line or area feature using the Digitizer Tool. 

 Added options when gridding exports to break each row (or column if naming is 

reversed) into its own folder as well as an option to not place an underscore between each 

piece of the export filename. 

 Improved decoding of waypoints from GPS TrackMaker .gtm files. An appropriate 

symbol should now be assigned if possible and the correct naming is now used. 

 Don't use EXIF information from JPG files if you open the files with the File->Rectify 

Imagery menu command to force rectification. 

 Fixed crash when loading Terrascan .bin files from v10.01 release. 

 Added new Ctrl+Shift+D shortcut key to toggle the display of deleted features. 

 Allow initialization of custom shaders from other custom shaders in addition to the 

Global Shader and also added option to re-base and offset the elevation values used in a 

shader. 

 Fixed problems with labels for very short lines not showing when zoomed way out on 

them. 

 Reduced memory requirements for loading Helava DEM format files. 

 Fixed color problems with CMYK-encoded JPG files from Adobe Photoshop. 

 Fixed problem generating iso-height contour areas in some rare situations. 

 Added a new option when batch converting to Float/Grid format files to export slope 

values rather than elevations. 

 Updated the DXF export to use the Elevation Display/Export Units setting on the Vertical 

Options tab of the Configuration dialog to determine whether to export feet or meters for 

elevation values derived from loaded terrain data during export. 

 Updated Google Maps exports to use a separate folder for each row in a particular zoom 

level to avoid overloading a single Windows folder with more files than it can efficiently 

handle. 

 Fixed problem with incorrect slope values of 0 being written out to Float/Grid format 

files in some cases. 

 Fixed bug with slope values written out to Float/Grid files being slightly smaller than 

they should be, especially in very steep areas. 

 Fixed problem with KML_ZOOM_SCALE_FACTOR script parameter not working. 

 Added support for overriding the default naming convention for Lidar class names using 

a lidar_classes.txt file enumerating Lidar classes and the new name to use for those 

classifications. 

 Fixed problems with some features being missing when loading some ESRI personal 

geodatabase (.mdb) files, like those from the NHD. 

 Updated KML import to support color specified for icons. 

 When batch converting files that are loaded in the main map view with contrast 

adjustment enabled, use the contrast adjustment settings of the loaded files during the 



conversion. 

 Added support for loading clutter and height files similar to MSI Planet but with .cl or .he 

extensions and a List file rather than a Index file. 

 Added new option to Google Maps and Virtual Earth exports to allow skipping existing 

tiles. This provides a mechanism for restarting cancelled exports or just updating part of a 

data set. 

 Improved compression ratio achieved in LZW-compressed GeoTIFF files. 

 Fixed problem exporting Shapefiles split by layer/description when the layer/description 

includes special characters like '<' or '>'. 

 Allow the Control Center dialog to be resized to be more narrow. 

 Added option when batch converting from USGS DRG files with accompanying FGD 

metadata files to use the quad name from the FGD filename as the output filename. 

 Drastically sped up the loading of Canada3D files. 

 Updated distance/bearing input dialog to allow bearings to be specified with formats 

other than decimal degrees (like DMS, DM, etc.). 

 Added new option to the Options menu on the Path Profile/LOS dialog to allow 

modifying the start distance for the distance scale in the path profile graph. 

 When gridding during export and using a letter to name rows and/or columns, keep the 

letter as lower case if it was originally specified that way. 

 Fixed problem with default line simplification not being applied during contour 

generation unless you actually click on the Simplification tab. 

 When gridding to selected area features, allow the overlap setting to be applied if you are 

just cropping to the bounds of each area feature. 

 Corrected half-pixel shift in the placement of loaded GXF files. 

 Fixed problem reading palette color labels with spaces in them from .pal files. 

 Made the shot point number field in exported SEG-P1 files be right-justified. 

 Increased the number of recently opened files that are remembered on the File menu from 

4 to 6. 

 Made the Search->Search by Attributes dialog always display the current number of 

selected items. 

 Added option to feather blend to the outside of a polygonal boundary rather than to the 

inside. 

 Added option to generate ERS files when doing elevation-format BIL exports. 

 Allowed cropping a raster layer to multiple selected polygons when using the Cropping 

tab on the options dialog for the layer. 

 Fixed error reading some MapInfo MIF/MID format files. 

 Added support for .jgwx as a JPG world file extension. 

 Made the dialog displayed when editing multiple features at the same time be resizable. 

 Updated the create/flatten terrain from areas option of the Digitizer Tool when treating 

the area elevations as relative to the ground perform the relative adjustment of the terrain 

at each sample location within the area rather than picking a single representative 

elevation for the entire area. This is useful for adjust all elevation values within an area 

feature by some amount. 

 When loading files that have contrast adjustment automatically applied, make them use a 

shared contrast adjustment by default. This makes loading multiple high color (i.e. 16-bit 



per color channel) files adjust them consistently automatically rather than doing a 

separate adjustment for each image. 

 Added new right-click option to the Control Center to allow easily setting the current 

view/export projection to the native projection of the layer that is right-clicked on. 

 Corrected placement of text points from DGN v8 files. 

 Added support for rotated text from DGN v8 files. 

 Added GPS toolbar with buttons for marking waypoints and showing GPS information. 

 Fixed problem with the placement of area centroids/labels for fully closed areas. 

 Added support for loading GeoTIFF files with a *.gtif extension. 

 

WHAT'S NEW IN Global Mapper v10.01 

 

 Added support for loading JPG files with embedded EXIF GPS position data. These files 

will be loaded as point features with picture icons. When you select one of these with the 

Feature Info Tool, the JPG image will be displayed. 

 Added support for tracking and managing multiple GPS devices via an input GPS data 

stream including $PRAVE sentences. With a compatible receiver, you can now use 

Global Mapper for fleet management. There is a new Manage GPS Devices option under 

the GPS menu that provides extensive functionality for managing the collection of GPS 

devices being tracked. 

 Added new Color Grade tab to raster options dialog to allow complex manipulation of 

color channel values and saturation for loaded raster files. This allows 'grading' each 

color channel from a specified input range for a color channel to a specified output range. 

 Added support for exporting loaded data to NITF format files. 

 Added support for exporting an alpha channel to ECW and JPG2000 format files, thus 

allowing creating of files in those formats with transparency built-in. 

 Added button to the toolbar for the Search->Search by Attributes menu command. 

 Added option to add X and Y coordinate attributes to selected point features via the right-

click menu in the Digitizer Tool. 

 Added new option to the distance/bearing/COGO input to close a path using the 'compass 

rule' and to edit the start location. 

 Added ability to right click on a point in the Search by Attributes dialog and start a new 

distance/bearing/COGO line from that point. 

 Added new batch conversion option to "Make a Single Color Transparent". This will 

allow you to choose a color to make transparent when batch converting raster format 

files. 

 Added support for loading PDS/Vicar format data, which is commonly used by NASA 

for planetary data sets. 

 Added new item to the right-click menu in the Digitizer Tool when area features are 

selected to populate the attributes of those areas from the attribute tables of a single point 

contained within those area features. 

 Added new Advanced Creation Options sub-menu to the right-click menu in the Digitizer 

Tool when area and/or line features are selected. This menu now contains the options to 

create lines from area, create areas from lines, create terrain from areas, as well as a 

couple of new options (see below). 



 Added option to the Advanced Creation Options menu of the Digitizer Tool to create new 

point features at the centroid of selected area features. 

 Added option to the Advanced Creation Options menu of the Digitizer Tool to create new 

point features from the vertices of selected area and line features. 

 Added new options to the right-click menu option of the Digitizer Tool for creating 

rectangular/square area and line features by manually entering the rectangle coordinates. 

 Added new built-in point types for LIDAR point types to make it easier to filter out 

different LIDAR points loaded from LAS and Terrascan LIDAR files. 

 Sped up export to GeoTIFF files when a large number of input files are being exported. 

 Added support for adding multiple custom symbols at once when adding custom symbols 

on the Point Styles tab of the Configuration dialog. 

 Added automatic positioning of OSGB 10K grid cells in TIFF format. 

 Improved generation of image-optimized palettes in cases where over 16.7 million pixels 

with the same color are involved in the export. 

 Added ability to select which layers to load from an ESRI personal geodatabase (MDB) 

file. 

 Added new palette option during batch conversion to use the same settings as the source 

file. This allows you to convert a mixture of RGB and palette-based files and maintain 

their original settings. 

 Added built-in support for the Double Stereographic and System 1965 (Uklad 1965) 

projection systems. 

 Added built-in support for IRENET95, Malongo 1987, PRS92 (Philippines Reference 

System 1992), and SWEREF99 datums and associated EPSG projection codes. 

 Added new EPSG codes for Swedish Grid (3021 and 2400). 

 Added built-in datums for each of the custom Minnesota county ellipsoids as well as for 

Sheboygan County, Wisconsin. 

 Added more accurate 7-parameter datum transformations for Kertau 1948 and Timbalai 

datums. 

 Allowed use of linear units other than meters (i.e. feet) for New Zealand projections. 

 Corrected definition of Guam State Plane zone. 

 Added option when shifting selected features with the Digitizer Tool and selected control 

points when rectifying imagery to shift based on a distance and bearing as well as fixed X 

and Y offset distances. 

 Added Speed and Bearing display for each leg in the Feature Vertices dialog when a 

time-stamp is present for each vertex (i.e. such as GPS tracklogs). 

 Added support for getting positioning information for raster files (like JPG, etc) from a 

greater variety of KML files. 

 Sped up display of dense point data sets with labels. This was slower in v10 due to new 

automatic label placement feature. 

 Added new right-click option to the Search by Attributes dialog to allow zooming to the 

selected feature(s). 

 Increased the size of the displayed elevation and lat/lon position on the GPS Information 

dialog. 

 No longer generate transparent PNG or TIFF files for KML raster exports using the super 

overlay feature if vector data is being exported. This is to prevent problems with the 



multiple layers of images showing through in Google Earth when zoom in on transparent 

areas which are prevalent in vector exports. 

 Made filename parameters for script commands referencing loaded files (like 

COMBINE_TERRAIN, UNLOAD_LAYER, etc.) also match against the description of 

loaded layers in case no matching filenames are found. This allows matching against 

created layers that are not backed by a filename, like the results of a previous 

COMBINE_TERRAIN or GENERATE_CONTOURS command. 

 Allowed use of PROJ_EPSG_CODE parameter with LOAD_PROJECTION script 

command. 

 Fixed problem decoding projections from MapInfo files with units other than meters and 

specified false easting/northing values. 

 Added option to view shed generation to specify a receiver height above the terrain 

surface to check for visibility at when use a beam with restricted transmission angles. 

 Improved export of 3D line and area features to PLS-CADD XYZ files. 

 Update PLS-CADD export to write out a sequential ID number in the first field for point 

features with no POINT_DESC attribute value. 

 Fixed problem loading some WMS data sets. 

 Added new option to the Global Mapper Package export dialog to specify that the full 

style for all features should always be saved to the generated file, even if a feature is 

using the default style for a type. This makes it easier to save data sets with the same 

styling for sharing between users. 

 Made Feature Edit dialog resizable. 

 Made types that are disabled in the type filter on the Vector Display tab of the 

Configuration dialog not show up in the Feature Edit dialog. 

 Updated raster/elevation export plugin architecture to add a new flag 

(EP_Flags_ElevAndColor) that allows an elevation format to also have the color callback 

function called for each exported sample for formats that store both elevation and color 

information. 

 Added display of current data download speed to export progress dialogs that are 

exporting data coming from online sources, like WMS or DigitalGlobe imagery. 

 Fixed bug in v10.00 that prevented export to some formats from a script file. 

 Fixed bug with incorrect Z value being written out to new 3D DGN files for 3D points 

that have no display label. 

 Added new File menu command to the Path Profile/LOS dialog to allow saving the path 

profile results to a CSV file with X, Y, elevation, and distance (both segment and 

cumulative) values. 

 Added support for loading JPEG2000 files from associated .TAB files. 

 Added display of target compression ratio to metadata display for ECW and JP2 format 

images. 

 Added support for tracking NMEA GPS devices that use $IN* sentences rather than 

$GP* sentences. 

 Corrected zone number used for GeoTIFF files for the Mississippi West State Plane zone. 

 Greatly sped up export to large ECW files from map catalogs. 

 Updated date fields imported from DBF files to use 4 digit years. 

 Updated Lidar LAS export from vector data to use feet for the elevation units if the 



'Elevation Display/Export Units' setting on the Vertical Options tab of the Configuration 

dialog is set to 'Statute (ft)'. 

 Fixed problem batch-converting to GeoTIFF files using a min-is-black or min-is-white 

palette. 

 Added options to Erdas Imagine export to control the block size, whether or not 

compression is used, and whether or not to add overview (pyramid) layers. 

 Added progress bar for lengthy area volume calculations. 

 Made Surfer BLN files be automatically detected and imported with no user intervention. 

 Made Delft 3D .ldb files be automatically detected and imported with no user 

intervention. 

 Added support for reading place point features from OpenStreetMap (OSM) files. 

 Fixed problem with attribute display in Search by Attributes dialog when loading new 

files with the dialog open. 

 Added new line drawing style, "Solid with Black Edges". 

 Fixed bug in v10.00 which caused vector features to not be selectable if any fixed screen 

position layers that are set to always draw on top are loaded. 

 Modified the bearing display in Global Mapper to be based on the Position Display 

Format selection on the General tab of the Configuration dialog. So if you have that set to 

DMS, your bearings should show up that way as well. 

 Added support for MPR/MPH files larger than 2GB. 

 Reduce memory requirements for loading large ENVI DEM format files. 

 Fixed problem in v10.00 release with users being prompted to confirm projection for 

NAD83-based projections from old-style PRJ files or prj.adf files. 

 Added support for loading truncated Lidar LAS files. 

 Added support for loading very large 16-bit BMP files. 

 Corrected color display in the status bar as you move the cursor around the map over 

loaded TIFF files. 

 Added support for user-specified tile size when generating KML super overlays. 

 Made the last palette selection be remembered for batch conversions. 

 Added support for additional flavors of MODIS data in HDF format, like the SST (sea 

surface temperature) data. 

 Fixed problem with some new line styles from v10.00 not drawing properly when used as 

area borders. 

 Corrected rotation of text labels from some DXF files. 

 Fixed problem with multiple consecutive spaces being reduced to a single space when 

reading in attributes from ASCII text files. 

 Made the text '\n' be interpreted as a newline character in attribute values read from 

ASCII text files. 

 Added LEVEL_DESC attribute to features imported from DGN v8 and later files if the 

file contains a text description for the level of the feature. 

 Fixed problem with translucency setting not always working with TIFF files in map 

catalogs. 

 Added ability to use custom palettes when exporting GeoTIFF, PNG, or Erdas Imagine 

files from scripts by providing the palette filename as the value of the PALETTE 

parameter, like PALETTE="C:\my_palette.pal". 



 Greatly sped up the addition of JPG files to map catalogs. 

 Made NAME and LABEL fields be preferred for labeling over fields that just start with 

NAME or LABEL when loading Shapefiles. 

 Added support for addition font style information from attributes using FONT_STYLE, 

FONT_WEIGHT, and FONT_PLACEMENT attributes. 

 Changed name of automatic MODIFIED_DATE attribute to MOD_DATE to avoid 

attribute name length issues with Shapefiles. 

 Fixed problem when geo-coding to loaded data from a file that contains the address 

number and street name in the same field. 

 

WHAT'S NEW IN Global Mapper v10.00 

 

 Significant New Features 

o Added support for importing ESRI personal geodatabase (MDB) files. 

o Added support for importing and exporting BigTIFF files, which allows working 

with (Geo)TIFF files larger than 4GB. 

o Added support for generating super overlays in raster KML/KMZ exports to 

allow for the viewing of massive quantities of data in Google Earth. The existing 

option to automatically grid data on the KML/KMZ raster export options dialog 

enables this behavior. 

o Added support for selecting/changing the layer that features are in when editing 

existing features and creating new ones with the Digitizer Tool. 

o Added ability to generate raster KML/KMZ files using the EXPORT_RASTER 

script command. 

o Added new Coordinate Convertor option under the Tools menu to allow easily 

converting a coordinate between any two supported projections/datums/units. 

o Added ability to Search Vector Data dialog to limit your search to the existing 

search results. This effectively allows you to query on multiple attributes/values. 

o Added support for creating new feature coordinates based on distance/bearing 

and/or COGO values from a start location using the Digitizer Tool. 

o Added more control over placement of labels for point features. Now when 

choosing the font to use for point features, you can also choose where to place the 

label for the point relative to the point location. An automatic setting will try 

different locations to try and make the label fit. 

o Added a large collection of new available line styles to use when rendering line 

features or area feature borders. 

o Added option to crop a loaded raster layer to the currently selected area feature to 

the Cropping tab of the Raster Options dialog accessible from the Overlay Control 

Center. 

o Added support for exporting loaded vector data to the MapInfo TAB/MAP 

format. 

o Added support for exporting loaded 3D line and point data to the SEGP1 format. 

o Added support for exporting loaded area features to the DeLorme Polygon Text 

format that some DeLorme products can import. 

o Added support for loading IKT track files generated by MagicMaps software. 



o Added support for loading Gravsoft Grid format files. 

o Added option on the Gridding tab for exports to grid to the currently selected area 

features. This will create a separate export file for each selected area feature. 

Naming can be done using the display labels or an attribute of the selected area 

feature(s). 

o Added support for generating 3D DXF and Shapefiles (including using any 

loaded elevation data as a source) when batch converting to those formats. 

o Made automatic collar cropping work for BSB charts. 

o Added arrow buttons to the Overlay Control Center to make it easier to change 

the overlay draw order. 

o Added support for loading files from web URLs using the IMPORT command in 

a script file. Just pass the URL with the FILENAME parameter. 

o Alphabetized the area, line, and point type lists on the * Styles tabs of the 

Configuration dialog and on the vector type options dialog. 

o Added new 'Pseudo Natural Color' blend mode to combine the color channels in a 

layer using a common algorithm for generating natural color imagery from CIR 

imagery. 

o Added option to the Digitizer Tool to select multiple area features and right click 

and display measure information about each feature and the combination of 

features on a dialog. 

o Added options when editing multiple features to rename attributes and also to 

copy the values of one attribute to a different attribute. 

o Added new option when combining terrains to filter one terrain layer based on 

another by keeping the values in one terrain layer only when the other terrain 

layer also has a valid value. 

o Added options to the View menu to save the current view with a name and then 

restore named views from a list of the saved views with names. 

o Added option to the View menu to restore the last drawn view. This allows you to 

back up through up to the last 20 drawn views. 

o Added option to the View menu to zoom the view to a particular sample spacing 

(pixel size). 

o Added support for extracting positioning information for image files from KML 

files. This allows you to load KMZ files that contain embedded raster images. 

o Added option when creating an elevation grid when loading Lidar data formats 

(like LAS and Terrascan files) for the user to specify options such as the grid 

tightness, whether or not to fill to the entire bounds of the data, and whether or not 

to only consider ground-shot points in the gridding process. 

o Added new option to initialize custom elevation shaders from a palette file. 

o Made the distance scale displayed on the main map view and on the path profile 

dialog use the currently selected distance measure units. This allows display of 

nautical and other units on the scale. 

o Added option for fixed screen layers to force them to always be drawn on top of 

other layers (including grid lines and user created features) regardless of the layer 

order in the Control Center. This is useful for forcing things like legends to 

always be display on top of other data. 



o Added new option when pasting features from the clipboard to not clear the 

clipboard after pasting the features (shortcut key is Ctrl+Shift+V). 

o Added option when printing to select the area to print rather than just always 

using what is on screen. 

o Significantly improved the speed and reliability of accessing the Landsat7 Global 

Imagery Mosaic data layer through the File->Download Online Imagery menu 

command. 

o Added built-in access to several new aviation chart (GNC, ONC, TPC, and JNC) 

layers through the File->Download Online Imagery menu command. 

o Made rotated line labels be exported to DXF files when exporting line labels to 

DXF files 'Include Display Labels as Separate Text Layer' option. 

o Added new option to the Font selection dialog to control the label fill background 

mode. Now you can force the background to be transparent, which allows labels 

centered on line features to be drawn with no filler behind them if you want. 

 Projection/Datum Changes 

o Added built-in support for the MSTM (Mississippi Transverse Mercator) and 

New Brunswick Double Stereographic projections as well as a configurable RSO 

(Rectified Skew Orthomorphic) projection. 

o Added built-in support for the ED87, JAD69 (Jamaica 1969) and JAD2001 

(Jamaica 2001) datums. 

o Improved accuracy of datum conversions involving the Tananarive datum by 

using improved conversion parameters from IGN. 

o Fixed accuracy problem with ED50 (Spain and Portugal) and OSGB36 datum 

conversions very close to and just east of the prime meridian. 

o Improved accuracy of datum conversions involving the Bogota Observatory 

(Bogota 1975) datum. 

o Allow the Azimuthal Equidistant projection to cover the entire world rather than 

just half the world around the projection center. 

o Added support for users to add their own EPSG codes definitions or modify the 

existing ones by modifying the epsg_codes.txt file in the Global Mapper 

installation folder. 

o Added recognition of additional EPSG codes for projections (like MGI/Balkans). 

o Updated EPSG projection definitions for State Plane Illinois zones (FIPS 1201 

and 1202). New codes 3435 and 3436 are for these zones using feet units and 

existing codes 26971 and 26972 now use meters as units. 

o Added support for two extra false easting/northing attributes to the State Plane 

projection system to support users that use a State Plane projection system with an 

extra scale factor (such as for ground vs. grid coordinates) and then apply an XY 

offset to the coordinates after that. 

o Added zones 6-9 for Gauss Krueger Germany (3-degree zones) projection. 

o Added additional S-42 (Pulkovo 1942) datum specializations and made the base 

S-42 (Pulkovo 1942) datum automatically select an appropriate specialization to 

use. 

 Added support for easy creation of multi-line text for area and point features by adding 

the text '\n' to display labels for points when creating/editing them with the Digitizer 



Tool. 

 Allowed the label for area features to be rotated. 

 Automatically combine address ranges for Tiger 2007 line segments that have multiple 

address ranges to make address searching more effective. 

 Added support for additional MTFCC (feature type) codes from Tiger 2007 data so that 

features like state and county boundaries can be automatically classified on import. 

 Added new selection mode to the Digitizer Tool. If you hold down the 'I' key when 

dragging a box, only features that are completely contained within the box will be 

selected. This is useful for things like selecting a point feature on top of a line or area 

feature. 

 Corrected ERS header export to be correct when exporting BIL files or files with export 

units of arc degrees. 

 Fixed bug when exporting raster KML/KMZ files to a filename with a special character 

not allowed in XML files, like an ampersand. 

 Fixed problem with per-vertex time-stamp values being lost in some cases when 

graphically moving or deleting vertices with the Digitizer Tool. 

 Added new built-in point type 'Address Label'. You can disable this type to turn off the 

center address labels automatically applied to downloaded online sources, like 

TerraServer-USA and DigitalGlobe. 

 Added new built-in area type 'County Subdivision'. 

 Added option to maintain the map location under the cursor position when using the 

mouse wheel to zoom. You can do this either by checking the option on the Advanced list 

on the General tab of the Configuration dialog or holding down the Ctrl key when 

scrolling the mouse wheel. 

 Added new options to Google Maps export to allow easily adding additional controls to 

the map displayed by the default HTML file that is generated, such as a map type 

selected. Also made double-click zooming be enabled by default. 

 Added transparency slider to the Google Maps and Virtual Earth export dialogs to allow 

setting the default transparency level for the exported maps. 

 When importing generic ASCII text files, make the default attribute list for the type being 

assigned to a feature automatically be applied to the attribute list for that feature. 

 Added automatic type and style assignment from attribute values when loading DBF 

point files. 

 Updated the 'Find by Name' dialog to allow recentering on a feature without showing the 

bullseye icon if you hold down the ALT key when double-clicking on an item. 

 Added new Ctrl+Alt+L shortcut key for automatically copying the current point/cursor 

coordinates to the clipboard in the current selected projection with a tab separated the X 

and Y coordinate values. 

 Corrected placement of ECW/JPEG2000 files that use a projection code of 

TMNEWYEM. They were previously very slightly shifted. 

 Made the COMBINE_TERRAIN script command by default use the intersection of the 

bounding box of the two layers being combined rather than the union of the layer 

bounding boxes. 

 Fixed problem with elevations sometimes not being saved when recording a tracklog for 

a connected GPS device. 



 Made saved CSV export options be remembered during a run of Global Mapper. 

 Fixed problems loading LAS, Terrascan, and DMDF files from workspace files. 

 Added support for loading latest GNIS (USGS Geographic Names) database from 

http://geonames.usgs.gov/domestic/download_data.htm. 

 Added option when capturing the screen contents to an image to save a text file 

containing metadata about the file, like the bounds, pixel size, etc. 

 Increased precision of lat/lon coordinates displayed on the status bar. 

 Improved automatic detection of alpha channels and non-standard color channels when 

loading ECW and JPEG2000 (JP2) format files. 

 Changed font used for elevation legend and distance scale display text so that it can 

display correctly on all systems, regardless of language. 

 Fixed problems loading 24-bit RGB MPR/MPH files. 

 Fixed error when trying to load DBF files greater than 2GB in size. 

 Made gridded elevation grid generation from loaded vector data automatically overlap 

the edges during generation to generate a smooth, non-overlapped output. 

 Fixed problem when gridding elevation grid generation and manually specifying the 

sample spacing to use. 

 Fixed problem loading SID files with corrupt world files accompanying them. 

 Fixed problem with features being exported to the non-populated upper layer(s) of MP 

files in some cases. 

 Made files loaded at a fixed screen position be maintained as fixed screen location files 

when saved to Global Mapper Package (GMP) files. 

 When loading generic ASCII text/CSV files, keep a name/label column as both an 

attribute value and the display label if multiple attributes exist to allow easily changing 

what attribute(s) to display as the label. 

 When exporting to the Arc Ungenerate formats, write out coordinates in the projection 

selected on the Projection tab of the Configuration dialog rather than just lat/lon values. 

 Added automatic detection of grid cell registration type (i.e. pixel-is-point or pixel-is-

area) for netCDF grids like those created using GMT. 

 When generating Simple ASCII Text files from a script using the EXPORT_VECTOR 

command, allow specification of attribute export except for style attributes by using the 

parameter EXPORT_ATTRS=NO_STYLE. 

 When importing files from a script/workspace, warn the user if a file does not exist. 

 Improved detection of invalid (void) values for elevation GeoTIFF files that use very 

large negative numbers for invalid values and the files do not contain any valid data. 

 Added support for loading palettes from Idrisi SMP files. 

 Added option to make background pixels transparent when batch converting to raster 

KMZ files. 

 Added option to generate 8-bit palette-based PNG files when batch converting to raster 

KMZ files. 

 Added automatic detection and correction of incorrect State Plane zone encodings in 

some .aux files, such as those produced by a New York imagery site. 

 Fixed problem reading the timestamp for tracklog points from GPX files that are on the 

31st day of a month. 

 Fixed problem with TriangulationLib.dll files sometimes not being installed by auto-



downloading them if needed. 

 Fixed rare error loading some DNC data sets. 

 When importing ASCII data files, automatically detect lines with a series of 999.0 values 

and allow the user to treat these as feature separator lines rather than coordinates. 

 Sped up import of GML files, particularly when importing lines or areas with a lot of 

vertices. 

 Drastically improved speed when displaying some NAIP 2008 JPEG2000 imagery. 

 Added support for using TFWX files as world files for TIFF files. 

 Added display of the number of grid cells being exported when doing a gridded raster or 

elevation export. 

 Added display of the area covered by the screen to the View->Properties dialog. 

 Fixed crash when doing more than one export to a web-based format (like Virtual Earth, 

Google Maps, etc.) from a single Global Mapper session. 

 Fixed HTML file created for Virtual Earth export when using the JPG format. 

 Added option to Download Online Imagery menu command to delete the caches for the 

various sources. 

 Added Alt+R as a shortcut key to save the current view. 

 Improved decoding of block labels and attributes from some DXF files. 

 Added support for 2 additional resolution level exports for Google Maps exports, 

allowing up to 2 cm resolution imagery to be accurately represented. 

 Allowed for the specification of negative grid cell width and/or height values when 

exporting and using the Gridding tab. When a negative value is specified the grid cells 

will be snapped to the right and/or bottom of the export bounds rather than the left and/or 

top as is normal. 

 When assigning areas to be islands in other areas with the Digitizer Tool, allow the user 

to add areas as islands even if they are not completely contained within the topmost area 

at the clicked location. 

 Changed the cursor used when selecting features with the Digitizer Tool to a crosshair 

from a pointer. 

 Added new Ctrl+Shift+M shortcut key to the Digitizer Tool to activate move mode. 

 Allow 2 line features that do not share a common endpoint to be combined by 

automatically adding a line segment connecting the 2 closest ends of the line when using 

the Combine Selected Line Features command in the Digitizer Tool. 

 Added display of some projection information on the Metadata tab of the metadata dialog 

for layers and also in the output of the EXPORT_METADATA script command. 

 Added option to the batch conversion dialog when converting raster files to disable the 

automatic use of contrast adjustment. This is useful when you have files with more than 8 

bits per color channel that look better with no contrast adjustment applied. 

 Added new PROMPT_IF_TYPE_UNKNOWN parameter for the IMPORT script 

command to allow disabling the type prompt when importing files for which the type 

could not automatically be determined. 

 Added new option to the NASA World Wind export to allow manual specification of the 

level 0 tile size to use. 

 Allowed use of the Delete key to delete ground control points from the rectification 

dialog. 



 Fixed problem loading some MapTech BSB charts with unusual projections (like 

Polyconic). 

 Fixed problem with image rectification that would occasionally cause polynomial 

rectification to be used instead of triangulated even if triangulated (piecewise-affine) 

should have been used. 

 Corrected half-pixel shift when loading SRTM30 and SRTM30+ files. 

 Added Ctrl+S as a shortcut key to the image rectifier dialog to save the GCP list to a file. 

 When loading a GCP file in the image rectifier dialog, prompt the user to remove all of 

the current control points if there are any. 

 Added option to the advanced section of the General tab of the Configuration dialog to 

specify that when cropping to an area feature on export that any cell that has any part in 

the crop area should be kept rather than just those for which the center of the cell is inside 

the crop area. 

 When cropping to selected area features during batch conversion, prompt the user to see 

whether they want the export files to have the bounds of the file being converted or the 

selected area features. 

 Made the screen capture dialog remember the last format used and select it by default 

within a single run of Global Mapper. 

 Improved display of some BSB charts that cross the anti-meridian. 

 Fixed error loading some NITF imagery data sets that use JPG2000 compression. 

 Improved positioning of NITF imagery that uses RPC (polynomial-based) positioning. 

 Prompt the user to specify whether 16-bit JPEG2000 and ECW files are elevation or 

imagery files rather than just assuming they are elevation. 

 Fixed problem with view background color not being in generated image optimized 

palettes in all cases. 

 Made script exports automatically create the destination directory for the new file being 

created if it doesn't already exist. 

 Added new GRID_NAMING_PREPEND_ZEROES parameter to the script export 

commands to allow controlling whether or not zeroes are prepended to named grid tiles 

during export. 

 Added new GRID_NAMING_SEPARATOR parameter to the script export commands to 

allow users to control what separator character is used between pieces of a grid name. 

The default is an underscore. 

 Added support for appending column names before row names when gridding on export 

from a script by using the GRID_NAMING=SEPARATE_COLS_FIRST parameter. 

 Improved resizing of main map window so that the map data is not constantly redrawn as 

you drag the window to a new size. 

 Increased the size of the displayed elevation on the GPS Information dialog. 

 Added option when batch converting vector data to KML/KMZ files to allow the 

inclusion of displayed text labels for exported area and line features with labels. 

 Fixed problems reading some TIFF files larger than 2GB in size. 

 Added new shortcut key (Ctrl+1) to zoom the map to the full detail for the 

raster/elevation map at the center of the screen. 

 Fixed error when trying to export vector-only data to a raster BIL file. 

 When exporting Polish MP files using an image ID from a template file and also gridding 



the export into multiple pieces, automatically increment the image ID of the output files 

to prevent duplicate image ID values. 

 Added new option to always display line labels on the center of the longest segment of 

the line to the Vector Display tab of the Configuration dialog. This prevents line labels 

from jumping around as you zoom and pan around. 

 Added new option to only snap to area and line vertices by default when drawing new 

features to the Vector Display tab of the Configuration dialog. Holding the 'V' key when 

drawing the new features will toggle this behavior. 

 Enable snapping to existing features when inserting vertices into existing area and line 

features using the Digitizer Tool. The shortcut key to stay in "insert vertex" mode was 

changed to the 'I' key from ALT since the ALT key is used to disable snapping behavior. 

 Added option to crop Shapefile exports to selected area features. This will only include 

point features inside the selected area features and line and area features that intersect the 

bounding box of the selected area features. 

 Updated GeoTIFF export to always write out all projection information and parameters 

even when an EPSG code is matched and written. 

 Added support for additional parameters for recommended route (0x0108) and marine 

contour (0x0105) lines when exporting vector data to Polish MP files. 

 Fixed memory leak when running a script file with EXPORT_RASTER commands that 

includes vector data from the command line. 

 

WHAT'S NEW IN Global Mapper v9.03 

 

 Significant New Features 

o Added support for loading Tiger 2007 Shapefiles with full attribution and 

automatic styling and type assignment from 

http://www.census.gov/geo/www/tiger/tgrshp2007/tgrshp2007.html. 

o Added support for loading Vulcan3D triangulation files. 

o Added support for exported loaded gridded elevation data to Vulcan 3D 

triangulation (.00t) files. 

o Added support for loading OpenStreetMap (OSM) format vector maps. 

o Added support for loading NITF data sets using JPEG2000 compression. 

o Added option to directly export the results of the triangulation and gridding of 

loaded vector layers from the Overlay Control Center to Global Mapper Grid files 

rather than loading them in the main map view, thus allowing larger areas to be 

triangulated and gridded at once without memory issues. 

o Added ability to add per-vertex elevations to features that don't already have 

them. 

o Made the vertex display dialog automatically highlight all vertices that are 

selected in the dialog on the map. 

o Made the Search by Attributes/Name dialog automatically highlight all of the 

result features that are selected on the map. 

o Added support for exporting loaded point features to TomTom OV2 format files 

for creating new point databases for loading onto TomTom GPS devices. 

o Added support for exporting loading vector data to Delft 3D (.ldb) format files. 



o Added option to KML/KMZ vector export to make labels for line and area 

features display on the map in Google Earth. 

o Added option when generating elevation grids from vector data to ignore zero 

elevation values. 

o Added automatic recognition of potentially iconized road names when editing 

road features. This allows you to do things like enter a road name of 'I-35' and 

have it automatically be recognized as an interstate highway iconized road name. 

o Added new option to the File menu of the rectification dialog to allow easily 

saving a world file that represents (if possible) the transformation defined by the 

currently provided control points. 

o Added option to the vector filter dialogs to save and restore a filter to a file. 

o Added yards and chains as available units of measure when using the Measure 

Tool. 

 Projection/Datum Changes 

o Added built-in support for the MGA (Map Grid of Australia) projection. 

o Added built-in support for the Aratu and Camacupa datums. 

o Improved accuracy of OSGB36 datum conversions by using the OSTN02 tables. 

o Made Bonne projection work properly when the origin latitude is in the Southern 

Hemisphere. 

o Added support for decoding Albers Conic projections from Ozi .map files. 

o Added support for correcting the projection of multiple raster files at once (only if 

all of the raster files being corrected have the same projection to start with). 

o Fixed problem with displaying the equator grid line when using the Van der 

Grinten projection. 

o Fixed problems encoding and decoding Lambert Cylindrical Equal Area 

projection to/from GeoTIFF files. 

 Added option to the Shader Options tab of the Configuration dialog to reverse the color 

order of the selected shader (previously only the HSV shader was reversible). 

 Added support for reading the track style information written to GPX files by the 

ExpertGPS software application. 

 Added new right-click option to the Feature Info dialog to allowing easily zooming to the 

extents of the selected feature. 

 When an elevation legend is displayed, make selecting the View->Full View menu 

command zoom the map so that the elevation legend does not obscure any of the loaded 

data. 

 When editing existing elevation values on the custom shader dialog, edit the value in the 

selected elevation units rather than always in meters. 

 When digitizing new point features, display the distance from the last digitized point to 

the current cursor position in the status bar. 

 Added option to the Vector Display tab of the Configuration dialog to allow drawing dots 

at line endpoint locations (this is a subset of the existing option to display all area and 

line vertices). 

 Fixed problem that prevented the description of the 'User Created Features' layer from 

being modified in some situations. 

 Fixed bug with enabling transparent colors for gridded elevation maps that made them 



disappear in some cases. 

 Added support for parsing coordinate values that use commas rather than periods for the 

decimal separator character. 

 When exporting new Polish MP format files, check the default attribute list for the type 

of a feature if the feature does not have a particular attribute in its own attribute list (this 

was already being done for the MP_TYPE attribute, but has now been extended to all 

supported MP attributes, like PERIOD for light points). 

 Fixed problem with icon symbols not being correctly exported to Polish MP files if the 

export was based on a MP template file using a LBLCoding value other than 9. 

 Sped up exports to ECW and JPEG2000 files from map catalogs. 

 Fixed snapping to existing line and area feature boundaries when the data being snapped 

to is in a different projection than the current view projection. 

 Made the display label for selected area features be displayed if the option to only 

highlight the border of selected areas is selected. 

 Improved default elevation unit selection when loading multiple files so that it doesn't 

always default back to meters. 

 Fixed problem with some grid line labels being drawn at strange angles. 

 Added new SPLIT_BY_LAYER parameter to the EXPORT_VECTOR command in the 

scripting language to allow splitting Shapefile exports into files based on the layer/type of 

each feature. 

 When drawing new line and area features with the Digitizer Tool, render the vertices if 

we are displaying the vertices for other line and area features. 

 Made the Feature Info dialog display the enclosed area in addition to the length in the 

Geometry field for closed line features. 

 Allowed band selection for NITF imagery with 3 or more bands of data. 

 Made the bit depth be displayed in the metadata list for MrSID and NITF imagery. 

 Added support for WMS servers using secure HTTP (i.e. https:// addresses). 

 Improved accuracy of area calculations when using the Mercator projection. 

 Updated WASP .map area export to support roughness values in a RV attribute in 

addition to ROUGH_L and ROUGH_R. 

 Write out "LOCAL" as the projection name when exporting ECW files using a projection 

that is not recognized for storage in ECW files. 

 Added support for per-vertex elevations for area features from Shapefiles in all cases 

(previously only simple areas with no holes were supported). 

 Made the calculated error at each control point in a rectification be saved in a GCP file 

saved through the File menu on the rectification dialog. It will be the last column for each 

control point. 

 Improved great circle distance calculations by using the more accurate Vincenty 

algorithm. 

 Fixed remaining problems loading portions of some Erdas Imagine .img grid files with 

floating point samples. 

 Fixed bug with image-optimized palette selection generating 24-bit RGB PNG and Erdas 

Imagine files when batch converting to those formats. 

 Fixed problem with gap showing up between lines that end at the same location. 

 Added built-in point types for bank and restaurant. 



 Added built-in line type for invisible boundaries (such as those commonly found in 

Tiger/Line files). 

 Fixed rare problem with very long vector lines or large area features not printing 

correctly. 

 When loading KML/KMZ files, use the folder names from the files to automatically 

assign Global Mapper types if possible (i.e. if a matching type name exists). 

 Added ability to specify water level in feet in addition to meters in the 3D viewer. 

 Fixed problems loading some complex entities from DXF and DWG files. 

 Fixed problems adding package files with multiple layers to map catalogs. 

 Made default attribute lists be applied when changing the feature classification of 

multiple features at a time. 

 Corrected placement of image files positioned using world files with rotation.  

 

WHAT'S NEW IN Global Mapper v9.02 

 

 Significant New Features 

o Added support for exporting any loaded data into tiles for use in Microsoft Virtual 

Earth. In addition, an HTML file will also be created allowing immediate viewing 

of the maps. The menu option for creating the tiles is under the new File->Export 

to Web Formats menu. 

o Moved web mapping formats, like Google Maps, World Wind, etc., to a new File-

>Export to Web Formats menu from existing export menus. 

o Added ability to batch convert to DTED and raster KMZ formats. 

o Added Vertices button to the Feature Info dialog to allow displaying and editing 

the location and per-vertex elevations for line and area features and displaying 

per-vertex time stamps for line features. 

o Added ability to apply elevation values from loaded terrain data to point features 

using a right-click option in the Digitizer/Edit tool. 

o Added new right-click menu option in the Digitizer Tool to allow easily shifting 

(offsetting) selecting features by some distance. 

o Added ability to combine multiple attribute values into the display label for 

features on the vector layer options dialog available from the Overlay Control 

Center. 

o Added new external control interface to allow external applications to control the 

view of Global Mapper and also display point features on the map loaded in 

Global Mapper. See the Developers page at http://www.globalmapper.com for 

details. 

o Added option to the path profile/line of sight dialog to allow matching the 

elevation scale to the distance scale. 

o Added support for selecting multiple colors as transparent for palette-based raster 

files. 

o Added new Palette tab to Options dialog for raster layers with palettes to allow 

easy display and modification of the palette used for loaded raster layers. 

o Added support for loading PCI Geomatics RAW files with AUX headers. 

o Added support for loading German Topo map files in MPR/MPH format. 



o Added support for loading block polygon ASCII data files from the Minerals 

Management Service department of the US Department of Interior (DOI). 

o Added support for loading TMC Location Database files from (point.dat and 

poffset.dat files). 

o Added support for loading Lowrance USR v3 files with depth data. 

o Added support for automatic detection and loading of PLS-CADD XYZ files. 

o Made the dialog for drawing a box around the area to export be resizable and also 

allow zooming and panning the map. 

o Added support for having lines a fixed width in meters based on attribute values 

named WIDTH_M or LINE_WIDTH_METERS. 

o Added new GENERATE_ELEV_GRID script command to allow generating an 

elevation grid from loaded 3D vector data. 

o Made time stamps for each vertex in a GPS tracklog be saved if available when 

tracking a connected GPS device or when loading a tracklog from a GPX file. 

o Made tracklogs exported to GPX files contain time stamps if the tracklog had 

time information for each vertex. 

o Added new options to hide all offscreen layers and close all hidden layers to the 

right-click popup menu in the Overlay Control Center. 

 Projection/Datum Changes 

o Added built-in support for the Belge 1972 (Belgian Lambert 1972) grid system, 

Laborde (Madagascar) projection, and Transverse Mercator (South-Orientated) 

projection. 

o Added built-in support for the NGO 1948 datum based on the Oslo prime 

meridian vs. Greenwich. 

o Added built-in support for the Tananarive 1925 datum based on the Paris prime 

meridian vs. Greenwich. 

o Added decoding support for some Polar Stereographic, Austrian Grid, and 

Norwegian grid EPSG projection codes. 

o Fixed Oblique Stereographic and Dutch Grid projections (they were broken in 

v9.00). 

o Fixed Lambert Azimuthal Equal Area projection to work properly with all 

datums. This fixes problems with the CORINE land cover data not lining up 

properly. 

o Fixed problems using New Zealand Map Grid with any datum other than 

NZGDA49. 

o Renamed some datums (i.e. ED50 and OSGB36) to make them shorter and reflect 

their more common usage. 

o Fixed problem loading new format (WKT) PRJ files with a datum using a 

meridian other than Greenwich (i.e. the NTF Paris datum). 

o Added support for decoding Vertical Near-Sided Perspective projections from 

OziExplorer .map files. 

o Fixed bug using the Aitoff-Wagner projection. 

o Added centifeet (hundredths of feet) as an elevation unit for export. 

 Made further improvements to triangulation and gridding to allow even larger data sets to 

be gridded. 



 When gridding 3D point data sets using the File->Open Generic ASCII Data File menu 

command, made the elevation specific options (like tightness threshold and grid spacing) 

appear on a separate dialog after selecting the ASCII options. 

 Added option to make specified export bounds be exactly maintained at the expense of 

the specified sample spacing (the reverse is the default) to the Advanced section of the 

General tab of the Configuration dialog. 

 Allowed map catalog files to be added to existing map catalog files. In these cases, all 

files referenced in the map catalog being added will simply be added to the map catalog 

they are being added to. 

 Added "Save As" button on the map catalog options dialog to allow changing the 

filename associated with a map catalog. 

 Added new 'SPOT Natural Color' blend mode to combine the color channels in a layer 

using the common algorithm for generating natural color imagery from the SPOT HRV 

multi-spectral sensor. 

  Fixed bug writing out 3D area features to DGN files. 

 Made the 'Copy to Clipboard' button on the Feature Info dialog copy the actual feature to 

the clipboard for pasting into Global Mapper in addition to copying the text attribution 

for the feature to the Windows clipboard for pasting in a text application. 

 Added new option to the Vector Display tab of the Configuration dialog to allow auto-

iconizing road feature names on import if they are recognizable icon names (like I-70, 

US63, etc.). 

 Made holding down the 'P' key when left clicking with the Feature Info tool only select 

area features (i.e. nearby lines and points will be ignored). 

 Fixed problem generating image-optimized palettes during export when the input files are 

all palette-based files whose combined palette has over 256 colors. 

 Allowed for the generation of .tab files for ECW and JPEG2000 when batch converting. 

 Made results on Search by Attributes dialog not include features in hidden layers or 

features with the types disabled for display. 

 Allowed splitting of selected area features at selected vertices with the Digitizer Tool 

when more than one feature is selected. 

 Added option to several raster export formats (like ECW, JPG, JPEG2000) to fill small 

gaps between valid data samples. 

 Fixed problems loading some projections from ECW and JPEG2000 files. 

 Made additional speed-ups to ECW and JPEG2000 exports when exporting from large 

numbers of loaded files. 

 Added option to feathering to just crop to the specified feather boundary rather than 

actually feather-blending. 

 Added option to palette-based exports to use a custom palette from a .pal file (such as one 

saved from the transparency dialog in Global Mapper). 

 Added new Option menu command on the rectification dialog to allow displaying the 

transformation equations used for the specified control points. 

 Added new option to the Advanced Selection menu in the Digitizer Tool for easily 

selecting all of the island areas associated with a parent area and deselecting the parent. 

 Prompt for the type of 16-bit Erdas Imagine .img files (i.e. are they elevation data or 

imagery). 



 Improved loading of HATCH entities from DXF files. 

 Improved loading of text from MTEXT entities in DXF files. 

 Added option to Google Maps export to select the default Google Maps background layer 

that is displayed (i.e. street maps, imagery, or terrain). 

 Made the last searched address be remembered on the Find Data Online and Find 

Address dialogs. 

 Made point classification and intensity be available for Lidar points from Terrascan 

format files. 

 Made the Search by Name and Search by Attributes dialogs show a bullseye on the map 

when you double click on a search result. 

 Made running script files that make changes to the main view automatically update the 

main view window when they complete in all cases. 

 Made the 'Run in Context of the Main Map View' setting on the Run Script dialog be 

remembered between runs. 

 Allow selection of elevation units when batch converting to the Lidar LAS format. 

 Fixed bug with color intensity values not being used in some cases for some raster files. 

 Added option to the elevation grid generation dialog to allow the user to specify that they 

want the generated elevation grid to fill the entire bounding box of the input data rather 

than stopping at the convex hull of the data set. This should really only be used for data 

sets that very nearly fill the bounding box but have corners cut off or something. 

 Added support for reading raster layout information from .glcf data files. 

 Fixed problems loading portions of some Erdas Imagine .img grid files with floating 

point samples. 

 Added support for auto-detecting connected NMEA GPS devices running at 9600 baud 

(in addition to the standard 4800 baud). 

 Fixed error exporting vector data to SHP file if there are more than 100 attributes with the 

same name to 10 characters associated with a single feature. 

 Added support for getting positioning information for JPG files from JGC files. 

 Fixed problems loading CDF files where the pen goes up and down within a single string 

of coordinates. 

 Added new RP_RenderStarted and RP_RenderFinished functions to raster/elevation 

import plugin API to allow plugin DLLs to be notified of raster begin and end operations 

with the bounding box being rendered. 

 Significantly sped up the loading of line and area features with a lot of vertices from 

KML/KMZ files. 

 Fixed problems loading some new MicroDEM DEM format files. 

 Fixed problems converting some Erdas Imagine elevation files with void areas to Arc 

ASCII Grid format files. 

 Made elevation values from loaded terrain data be used when batch converting to Simple 

ASCII Text files and selecting to include elevation data. 

 Ignore duplicate point features in DXF BLOCK sections. 

 Fixed error in some cases when generating view sheds while checking Fresnel zone 

clearance. 

 Made cut-and-fill volume calculation operations for areas report the 3D surface area of 

the calculation area in addition to the 2D surface area. 



 Slightly increased the precision reported for some measurements. 

 Added option to the right-click menu on the Overlay Control Center to allow disabling 

selection of vector features from a layer. 

 Added support for using a MP_BIT_LEVEL attribute value to specify the maximum 

zoom bit level that a particular feature (or feature type for default attribute lists) should 

be visible at in exported Polish MP files. 

 Added new area fill styles (black cross and black dot on white backgrounds). 

 

WHAT'S NEW IN Global Mapper v9.01 

 

 Significant New Features 

o Added support for exporting any loaded data into tiles for use in Google Maps. In 

addition, an HTML file will also be created allowing immediate viewing of the 

maps. 

o Made significant improvements to the triangulation and gridding of 3D point, 

line, and area data. Not only is the process now MUCH faster (especially for large 

triangulations), but it also now supports treating lines as constraints (i.e. 

breaklines), saving the generated triangulation as a separate vector layer, and 

making elevations for source vector features be relative to the elevation from 

loaded terrain data. You now also grid a much larger number of points at once 

(well over 10 million points have been tested with no problems). 

o Added option to Shapefile export to split the export into separate files by layer. 

This allows you to easily break your data up into separate Shapefiles based on the 

layer/description of the features being exported. The layer name for each file will 

be appended to the end of the selected export filename. 

o Added fuzzy transparency support to allow for transparency for a raster layer to 

be set up so that all colors near a selected transparent color can be marked as 

transparent. This is useful for removing collars from lossy formats, like JPG, 

ECW, and MrSID.  

o Allowed 3D area features to be created in Shapefile export. 

o Added support for loading RIK (Swedish Topo) format raster files. 

o Added support for loading OCAD format files. 

o Added support for loading MapTech PCX charts. Load these from the MapTech 

.hdr file in the ChartHdr folder. 

o Added support for loading OziExplorer .rte format files. 

o Added support for loading Garmin PCX5 .rte format files. 

o Added support for loading UKOOA format post plot data files. They are listed 

under the format SEGP1/UKOOA. 

o Added support for loading HF2/HFZ format elevation grid files. 

o Added support for exporting loaded gridded elevation data to HF2/HFZ format 

files. 

o Added new item to the Options menu on the Path Profile/Line of Sight dialog to 

allow specification of how many sample points (either by number or by a spacing 

distance) to use when generating the path profile. 

o Allowed feather blending to use multiple polygons. 



o Added several new built-in symbols for different well types used in the petroleum 

industry. 

 Made minor improvements to Polish MP export, including option to keep ID value from 

[IMG ID] section during templated exports, to copy the [FILES] and [MAP] sections 

from template files, to allow Text attributes longer than 80 characters, and to 

automatically remove the labels from marine spot depth and height points. 

 Added new option to JPG export to allow specification of a DPI value to store in the 

exported JPG file. 

 Added DXF vector export option to use the filename for the input feature as the layer 

name in addition to the default of the feature description or the feature label. 

 Scripting Language Changes 

o Added new COMBINE_TERRAIN command to the scripting language to allow 

combining terrain layers to generate a new layer using a script file. 

o Added new ADD_MEASURE_ATTRS command to the scripting language to 

allow adding measure attributes to loaded vector layers from a script. 

o Made the OVERWRITE_EXISTING=NO parameter work properly when 

gridding an export from a script. 

o Added new PIXEL_SIZE parameter for use with the EXPORT_RASTER script 

command. This parameter allows you to specify the desired pixel size of your 

export result. The format is PIXEL_SIZE="<width>x<height>", or 

PIXEL_SIZE="1024x768" as an example. 

o Made the value of the INC_VECTOR_DATA parameter default to YES with the 

EXPORT_RASTER command if only vector data is loaded. 

o Allowed use of SPATIAL_RES parameter with the IMPORT_ASCII script 

command to manually specify the grid resolution to use when generating a 

gridded elevation layer. 

o Added new LAYER_BOUNDS_EXPAND parameter to script commands taking 

a bounding box so allow using an expanded version of a bounding box obtained 

using a LAYER_BOUNDS parameter. 

o Added new DGN_GLOBAL_ORIGIN_LL, DGN_REPLACE_DARK_COLORS, 

and DGN_UNIT_RESOLUTION parameters to the EXPORT_VECTOR script 

command to allow specifying additional options for DGN export. 

o Made GEN_WORLD_FILE parameter work for ECW and JPEG2000 exports 

from script files. 

o Added new PROJ_EPSG_CODE parameter to IMPORT commands to allow 

specifying the projection by EPSG code. 

 Allowed easy movement of view sheds by moving the transmitter point feature at the 

center of the view shed using the Digitizer/Edit Tool. When this is done, the user will 

now be prompted to recalculate the view shed at the new location if they want. 

 Added option to lock the current active workspace file while you are working with it to 

prevent other users from opening and using that same workspace file. This is useful in 

network environments where you don't want one persons work to accidentally overwrite 

another's. This option is in the Advanced section of the General Options tab of the 

Configuration dialog. 

 Added option to have cells from DGN v8 and later files to be imported as point features 



at the cell's origin rather than be exploded into the features referenced by the cell. This 

option is in the Advanced section of the General Options tab of the Configuration dialog. 

 Added option to have the color number for lines from DGN v8 and later files to be add to 

the feature description text in addition to the level number. This option is in the 

Advanced section of the General Options tab of the Configuration dialog. 

 Added option to generate world files and PRJ files during Terragen terrain export. 

 Added support for getting depth values from a connected GPS device that embeds 

$STDBT or $IIDBT NMEA sentences containing the depth values. For GPS devices that 

provide depth, the depth will be used as the Z coordinate for track logs rather than the 

elevation value. 

 Added option to Options menu on rectification dialog to automatically add control points 

at the image corners. 

 Fixed creation of attribute list when marking new waypoints from a connected GPS 

device. Previously the elevation and time stamp attributes were no longer being saved. 

 Fixed problem with elevation units other than meters not being usable for Lidar LAS and 

Terrascan files loaded as point cloud data sets. 

 When loading TIFF files with 4 color channels and the 4th color channel is of unspecified 

type, prompt the user to see if this should be treated as an alpha channel or an additional 

data channel (like infrared). This allows TIFF files created with Photoshop with an 

incorrectly marked alpha channel to be loaded and displayed properly. 

 Added new option to the Advanced section of the General Options tab of the 

Configuration dialog to automatically save backup copies of the current workspace every 

so often. These backup copies will be created in the same folder as the workspace file and 

have the suffix "auto_backupX", where X is a number from 0 to 9. 

 When generating new area features from the bounds of layers in the Overlay Control 

Center, make those new areas have an attribute list consisting of the metadata from the 

layer. 

 Made the last selected file type be remembered between sessions on the GeoTIFF export 

dialog. 

 Made the last selected export target compression ratio be remembered between sessions 

on the ECW and JPG2000 export dialogs. 

 Made the last selected quality setting be remembered between session on the JPG export 

dialogs. 

 Projection/Datum Changes 

o Added the Winkel Tripel projection as a built-in projection. 

o Added built-in support for the BD72 (Belgium 1972), M'Poraloko (Gabon) and 

Google Maps datums. 

o Improved the accuracy of the ED50 - Spain and Portugal datum transformation by 

having it use a NTv2 transformation file. 

o Improved the accuracy of the MGI Austria and Potsdam (DHDN) datum 

transformations. 

o Added Indian Yard as an available unit for projections. 

o Allowed EPSG datum codes to be used to specify a datum on the projection 

selection dialog using the 'Init From EPSG' button. 

o Added support for decoding Polyconic (American) projections from OziExplorer 



.map files. 

 Made the map/chart type for CADRG maps (i.e. TPC, ONC, etc.) be included in the layer 

description and metadata for those maps. 

 Fixed problem with elevation override data not being applied to elevation WMS layers 

(like SRTM and NED) loaded from a script or workspace file. 

 Made the Vertical Units control actually work when combining terrain layers. 

 Made the addition operation work when combining terrain layers in areas where only one 

of the two input layers has a valid elevation. 

 Made Surfer CLR files saved from the custom shader dialog actually be compatible with 

Surfer. 

 Added support for correctly importing line and point features in Polish MP format files 

that have multiple Data0 coordinate records. 

 Added option to PNG export options dialog to easily specify the sample spacing in units 

other than the current export projection units. 

 Improved performance of raster exports from map catalogs when one or more files 

referenced by the map catalog are missing. 

 Added support for automatically cropping the collar of Canadian topographic maps with 

CanMatrix XML metadata files. 

 When exporting filled area features to DXF files, write out the fill color of the area to the 

DXF file. 

 When exporting raster layers to Global Mapper Package files, make those layers support 

transparency so that they will overlay properly on other layers when re-loaded. 

 Made feather-blended elevation layers visually feather blend better in to underlying 

layers rather than just smoothly blending the elevation values. 

 When loading files from workspace, script, and map catalog files, if the file exists at the 

full path specified, don't check for a new location relative to the metafile location. 

 When rectifying imagery, allowed new control point values to be entered as lat/lon 

coordinates regardless of the native projection of the layer. 

 Fixed problem with manually specified grid spacing being ignored when flattening areas 

using the Digitizer Tool. 

 Added option to World Wind export to allow generating the filenames required by the 

Java edition of World Wind. 

 Updated area calculations to be done in the native units for a layer rather than always be 

done in lat/lon coordinates. This can make area calculations from Global Mapper for 

large areas more consistent with what you see in other applications. 

 Fixed bug with fill style not being read from generic ASCII files properly. 

 Fixed errors rendering ECW and JPEG2000 files to monitors with extremely high 

resolutions (typically multi-monitor setups). 

 Added option to Help menu to disable the automatic check for updates at application 

startup. 

 Made it possible to batch convert from ASCII text files (like XYZ) to gridded elevation 

formats. 

 Fixed bug in batch conversion that caused the horizontal extents of raster or gridded 

elevation data exported using a custom spacing to be incorrect in some situations. Also 

fixed problem with an extra column and or row being exported when the custom spacing 



option was used. 

 Added attributes for database linkages to loaded DGN files. 

 Improved the handling of break lines imported from DMDF format files. 

 Fixed problems loading some Garmin PCX5 files. 

 Added new File menu commands to the rectification dialog to allow loading control 

points and projection information from CompeGPS .imp and Touratech TTQV .cal files. 

 Added option to specify offset and scale values to apply to coordinates loaded from EMF 

format files. 

 No longer save the 'Render Areas', 'Render Lines', 'Render Points', and 'Render Area and 

Line Vertices' options from the Vector Display tab of the Configuration dialog between 

runs as this tends to cause confusion. The first three will always be enabled by default 

when you start Global Mapper and the vertex display will now always be disabled by 

default. 

 Corrected positioning of ENVI files that don't use the top left coordinate as their 

reference point. 

 Fixed problems exporting attributes with special characters like # and - in their name to 

MapInfo MIF/MID format files. 

 Added support for loading ERS files with missing cell sizes. These are apparently defined 

as having a cell size of 1.0. 

 Made the last exported bounds be available between runs of Global Mapper. 

 Added an option to the Advanced section of the General tab of the Configuration dialog 

to make the full path to files be displayed in the Overlay Control Center for layers that do 

not have any description other than the filename. 

 Allowed selection of which bands are used from multi-spectral FAST-L7A Landsat 

imagery layers. 

 Added support for loading 16-color (4-bit per pixel) PCX files. 

 Made holding down the 'P' key when selecting a new location in the Reference View of 

the rectification dialog or when using the Measure or Digitizer Tools, cause the new 

location to be snapped to the nearby point features. 

 Made the default attribute list for a feature type be applied when changing the 

classification of an existing feature through the single feature edit dialog. 

 Fixed problem with missing start row and column of DTED tiles in some cases when 

exporting to DTED format. 

 When cropping to selected area features during a batch conversion operation, made the 

bounds of the exported data also be cropped to the selected area features. 

 Added support for loading Ozi .map files with grid coordinates in multiple UTM zones. 

 Significantly sped up export of large number of files to ECW and JPEG2000 format files. 

 Added support for modifying the default projection used when rectifying imagery by 

supplying a default_rectification.prj file in the Global Mapper installation folder 

containing the desired default projection. 

 Added Ctrl+R as shortcut key to restore last saved view. 

 Made the compression type used for TIFF files be displayed in the metadata for the file 

available from the Overlay Control Center. 

 Made the image collar specified in the "MainPolygonBitmap" section of CompeGPS IMP 

files be used when automatically cropping the collar of imagery loaded with positioning 



information from the IMP file. 

 Fixed problem with the 'Update GCP' button on the rectification dialog causing the name 

of the control point being updated to be lost. 

 Added ability to automatically add/update a MODIFIED_DATE parameter to vector 

features when they are modified. This option is found in the options list at the bottom of 

the Vector Display tab of the Configuration dialog. 

 Added control of the JPEG-in-TIFF quality setting with a new DWORD registry setting 

at "HKEY_CURRENT_USER\Software\Global Mapper\JpegInTiffQuality" to control 

the JPEG-n-TIFF quality. The default value is 75. 

 Added control of the default search string used in the Search by Attributes dialog with a 

new string registry setting at "HKEY_CURRENT_USER\Software\Global 

Mapper\DefaultVectorSearchStr". The default value is '*'. 

 Made it possible to batch rectify ECW and JPEG2000 format files using the File-

>Rectify Imagery menu command. 

 Made LiDAR LAS export write out the point count for each number of returns in the 

header. 

 Made LiDAR LAS support reading and writing projection information. 

 Added an 'Invert Selection' option to the popup menu when you right click on the search 

results list on the Search by Attributes dialog. 

 Made the Add/Update Feature Measures option in the Digitizer Tool report the combined 

length of all selected line features and the combined enclosed area of all selected area 

features at the end of the operation. 

 Added new 'Deleted Line' and 'Selected Line' line classifications so that users could 

modify the drawing style used for deleted and selected line features. 

 Fixed saving of Lambert Conformal Conic projections to MapInfo MIF/MID files (this 

was broken in v9.00). 

 Updated elevation legend to only display the valid range for visible gridded elevation 

files. 

 

WHAT'S NEW IN Global Mapper v9.00 

 

 Significant New Features 

o Added direct access to high resolution Digital Globe, GlobeXplorer, and 

AirPhotoUSA imagery for the entire world through the File->Download Online 

Imagery menu command. Free access is provided to watermarked imagery for 

reference only, with access to un-watermarked imagery that can be exported to 

new files can be purchased. 

o Added support for exporting ECW files of unlimited size. Previously there was a 

limit of 500 MB of uncompressed data for ECW exports. 

o Added support for exporting loaded data to JPEG2000 format files. 

o Added support for exporting loaded raster/elevation data to KML/KMZ file for 

display in Google Earth (use File->Export Raster and Elevation Data->Export 

KML/KMZ menu command). 

o Added support for exporting loaded gridded elevation data to DTED format files. 

o Added support for exporting loaded gridded elevation data and 3D vector data 



(including LIDAR point clouds) to LIDAR .LAS format files. 

o Added ability to make area features partially transparent. Everywhere that you can 

edit an area style now has a transparency slider allowing you to adjust how 

translucent a solid filled area will be. 

o Added new File->Combine Terrains menu command to allow combining loaded 

terrain layers with a variety of operations, including differencing terrains, 

averaging terrains, and using the min and/or max elevations from two terrains. 

o Added new option to the Color/Contrast Adjust option dialog for raster layers to 

allow specification that the contrast adjustment should be shared between multiple 

layers. This allows a consistent contrast adjustment to be applied to all images 

with that option checked. 

o Added option to view shed calculation to generate area features for the covered 

areas. These generated area features could then be exported to vector formats like 

Shapefiles. 

o Added support for feather-blending elevation layers in order to smoothly blend 

the elevation values of one layer with an underlying one near some edge (either a 

polygon or the rectangular edges of the top file). 

o Added support for loading DMDF (Digital Map Data Format) files, such as those 

used for Alberta DEM files. 

o Added support for loading vector data from EMF (Windows Enhanced Metafile) 

files. 

o Added support for loading Erdas .LAN format files. 

o Added support for loading PCX format image files. 

o Added support for loading point Arc Vector Coverage files (lab.adf). 

o Added option to the Vector Options dialog to allow selecting the attribute to use 

for elevation values for vector features. This is useful if you want to get elevation 

values from something other than the default elevation field for a layer. 

o Added option to the Digitizer Tool to split an area feature into 2 pieces along the 

segment connecting 2 selected vertices. 

o Made the Search->Search by Attributes/Name/Desc dialog be "modeless" so that 

you can interact with the map underneath the dialog without closing the dialog. 

 Added new "Select All" option under the Edit menu to allow easily selecting all loaded 

vector features. 

 Added support for loading files in a fixed location relative to the screen with the position 

of the file being specified in width or height percentage values or relative to an absolute 

latitude/longitude value in addition to the previously available inches from edge values. 

 When specify custom crop bounds for a raster layer, allow control of which sides will be 

cropped through check boxes activating which edges to actually crop. The default is all 

edges. 

 Added a new "Hill Shading Shadow Darkness" control to the Vertical Options tab of the 

Configuration dialog. This control allows you to control the maximum darkness of 

shadows (the default is black). With this setting you can cause the shadowing to be 

capped in high relief areas, thus allowing the use of other controls to better bring out 

detail in low-relief areas. 

 Added support for drawing the location for a connected GPS device as a circle or 



transparent triangle with a dot at the center for the GPS location. This support is provided 

by the new GPS->Vessel Shape submenu. 

 Added option to DXF vector export to allow elevation values from loaded elevation 

layers to be used as the Z coordinate for exported vertices if available. 

 Added option to DXF vector export to allow coordinate values to be written out as ECEF 

(earth-centered earth-fixed) coordinates rather than in the current selected projection. 

 Added support for performing batch geocode operations from data files using currently 

loaded road data. Previously batch geocoding was limited to the US using an online 

geocoder. With this new feature, geocoding can be done using load and properly 

attributed road data along with input address data split into appropriate fields. 

 Allowed drawing of rectangle, square, circle, and ellipse shapes anchored at the top left 

rather than center with the Digitizer Tool by holding down the 'T' key when left clicking 

to start the shape. 

 Projection/Datum Changes 

o Added option to the projection selection dialog to allow a projection to be 

initialized from an EPSG projection system code. 

o Made the parameters used for most grid system and zoned projections, like British 

Grid and UTM, be displayed in the attribute section of the projection selection 

dialog (which will be disabled for those projections). 

o Added support for the India Zoned Grid, Korean Grid, Krovak, Lambert (Marta), 

Lambert (NOAA), Marta Satellite, and Winkel I projections. 

o Added built-in support for the Dealul Piscului 1970, Ireland 1965 (with 1975 

Adjustment), Korean Geodetic (KGD), Lisbon (DLx), S-JTSK, Solomon 1968 

(GUX1 Astro) datums as well as a generic GRS80 ellipsoid datum. 

o Improved accuracy of the Beijing 1954, Hungarian Datum 1972 (HD72), 

NGO1948, and Portugese 1973 (Datum 73) datums. 

o Added Bessel (Modified) as a new built-in ellipsoid. 

o Added support for adding new ellipsoids to create custom datums from on the 

custom datums dialog. 

o Fixed crash when exporting to some formats with the Old Israel Grid or New 

Israel Grid projections selected. 

o Made the extra scale factor for State Plane projections be applied AFTER any 

false easting and northing values for the underlying projection for the State Plane 

zone, rather than before the false easting/northing values as before. 

 Scripting Language Changes 

o Allowed exports cropped to a polygon from a file be cropped to multiple 

polygons with the new POLYGON_CROP_USE_ALL parameter for the export 

commands. 

o Added CLIP_COLLAR_FLAGS parameter to IMPORT script command to allow 

saving of per-edge collar cropping flags. 

o Added COLOR_INTENSITY_FULL parameter to IMPORT script command to 

allow specification of higher resolution color intensity for raster layers (from 0 to 

512 rather than 0 to 20). 

o Allowed the polygon to use when feather blending to be specified from a file 

using a FEATHER_BLEND_POLY_FILE parameter with an IMPORT command 



in a script file. 

o When using the EXPORT_RASTER script command in conjunction with a 

polygon crop file, only use the bounds of the crop polygon for the export as the 

export bounds if the export bounds are not explicitly specified. In addition, for 

gridded exports with a crop polygon, don't export grid cells that are completely 

outside of the crop polygon. 

o Fix error with some layers not showing up in the output when using the 

EXPORT_RASTER script command in conjunction with gridding. 

o Added new parameters to the EXPORT_* script commands to allow specifying 

how gridded tiles should be named.  

o Allowed FEATURE_SEP values for exporting simple ASCII text files with the 

EXPORT_VECTOR script command to specify feature separators other than just 

none or a blank line. 

o Fixed problem using SET_BG_COLOR in scripts called from the command line. 

 Made the area covered by the bounding box of a layer be reported as part of the metadata 

for that layer. 

 For BIL and Erdas Imagine elevation exports, if all of the input files use the same 

NODATA value use that rather than the default of -9999.0 for the NODATA value for 

the export. 

 Fixed problem loading complex shapes from older (pre-v8) DGN files. This problem was 

introduced in the v7.04 release. 

 Improved decoding and encoding of some Lambert-based projections with default units 

of feet with ECW files. 

 Fixed garbled display of some rare ASRP/ADRG/USRP format maps. 

 Fixed problem with features being duplicating when copying and pasting selected 

features from multiple data layers at a time. 

 Made blending and translucency between layers within a map catalog work properly. 

 Fixed display of selected features when dragging a map to pan. 

 Made nearby point locations be snapped to when selecting the transmitter location for 

view shed analysis. 

 Fixed problem with scale bar being cut off when printing to scale with a footer string. 

 Fixed problem in v8.03 with some features in the a User Created Features layer not 

responding to the show/hide checkbox in the Overlay Control Center. 

 Fixed problems loading area and line features with more than about 200,000 vertices 

from Polish MP format files. 

 Increased precision of angular coordinates (like arc degrees) written to text file formats, 

like Simple ASCII Text export, to support approximately the same level of ground truth 

precision as linear coordinates (like meters). 

 Fixed problem with offscreen islands not being exported when exporting simple ASCII 

text format files. 

 Fixed problems loading uncompressed CIB imagery. 

 Fixed problems with edited labels for Shapefile features not being saved to workspaces. 

 Split line features with more than 5,000 vertices into multiple pieces on export to DGN 

files as some applications (like Microstation) do not support lines with more than 5,000 

vertices. 



 Added option to DGN export for converting dark line colors (like black) to white. This is 

useful as many DGN viewers automatically use black as the background color, making 

dark colors very difficult to see. 

 Added option to the GPS Status dialog to copy the current GPS location to the clipboard. 

 Added support for loading polyface mesh features from DXF files. 

 Added support for loading DXF files with nested BLOCK references. 

 Fixed problems handling some SPLINE entities in DXF files. 

 Added new View->Properties menu command to allow displaying properties about the 

current view, including bounds, scale, and resolution. 

 Made ERS files be used for positioning information if needed for additional formats, like 

JPG, ECW, TIFF, and PNG. 

 Increased the resolution of the color intensity slider on the raster options dialog and also 

made the current intensity value be displayed. 

 Made filenames in the Overlay Control Center be displayed with the same casing as they 

have on disk rather than always being all upper case. 

 Added new option to the Advanced section of the General tab of the Configuration dialog 

to allow users to specify that the default export folder should be the folder of the first 

loaded file rather than the last exported-to folder. 

 Added new option to the Advanced section of the General tab of the Configuration dialog 

to specify that lines in generated world files should be separated with CR/LF (carriage 

return and line feed) characters rather than just a LF (line feed) character. 

 Updated GNIS files to use the NAD83 datum as the USGS switched to that in 2005. In 

addition, GNIS files that use meters for elevation values will also handle those correctly 

and less error messages will be shown for GNIS files. 

 Allowed clearances greater than 100% of the first Fresnel zone to be checked when 

performing line of sight and view shed analysis. 

 Made the minimum clearance display for line-of-sight analysis display in the currently 

selected 'Position Display Format' if the From and To locations are also displayed using 

it. 

 Fixed problem with the per-vertex elevation list for 3D area and line features not being 

maintained when copying and pasting those features. 

 Fixed problems with loaded data from some VPF data sets with only one tile of data, 

namely UVMAP3 data. 

 Fixed memory leak when generating an elevation grid from some loaded 3D vector data 

sets. This problem was introduced in the v8.02 release. 

 Added a new right-click option to the Overlay Control Center to allow you to save a 

workspace file containing just the selected layers and their settings. 

 Changed export of transparent areas to new 24-bit RGB PNG files to use an alpha 

channel rather than a single color transparency as some applications only support the 

alpha channel method. 

 Fixed error loading some RPF (i.e. CADRG/CIB) data sets. 

 Fixed file size error loading some Geosoft Grid files. 

 Made Global Mapper workspace (.gmw) files be loaded from archive files (.zip, .tar.gz, 

etc.). If any .gmw files are encountered and loaded from a workspace file, no other data 

files will be loaded from the archive file. 



 Made it possible to rectify MrSID files with the File->Rectify Imagery menu command. 

 Fixed error loading some DGN v7 or older files with tags in them. 

 When digitizing new area, line, and point features, notify the user if their features will not 

be displayed immediately after creating it due to vector display settings. 

 Make the default attribute list for the default classification be properly initialized when 

digitizing new features. 

 Make sure that the user wants to switch away from the Digitizer Tool if doing so would 

result in the loss of a significant number of digitized points. 

 Display progress while saving workspace files. 

 Added support for reading vector features from KML files that use multiple Schema 

directives to change the name of Placemarks. 

 Fixed rare problem with a handful of iso-height areas not generating properly during 

contour generation. 

 No longer break lines over 256 vertices into smaller pieces on export to the Polish MP 

format as cGPSMapper can now properly handle lines of any length. 

 Made double-clicking on layers in the Overlay Control Center bring up the Options 

dialog for that layer. If you hold down the 'M' key when double-clicking the Metadata 

dialog will appear instead. 

 Added support for the Swiss Grid projection in ECW files. 

 Fixed problems batch converting Lidar LAS format files to some other formats, like 

Shapefiles. 

 Made automatic DRG-style collar cropping work for high latitude Canadian topo maps. 

 Added support for loading MSI Planet files with a .dat extension. 

 Made GML files from the UK Ordnance Survey load. 

 Allowed border and line widths up to 30 pixels wide (up from 10) to be selected. 

 Updated raster/elevation import plugin API to allow the plugin DLL to notify Global 

Mapper that the data in a layer has changed and needs to be redrawn, thus allowing for 

dynamically updating layers. 

 Updated raster/elevation export plugin API to add an EP_ExportEvent function that is 

called whenever an entire export operation is started and ends. 

 Reduced memory requirements for loading and displaying CMYK TIFF files. 

 Dramatically sped up the process of moving overlays to the top and bottom of the draw 

order when there are a lot of layers loaded. 

 Don't attempt to load DBF files from archive (.zip, etc.) files if they don't have obvious 

positioning fields in them. 

 In the location selection dialog, made the Latitude and Longitude fields initialize with the 

coordinates formatted according to the currently selected position display format. Also 

swapped the fields so that the Latitude is on top. 

 Made the elevation readout on the status bar display up to 3 digits beyond the decimal 

rather than just 1. 

 Made DEM files exported with the Geographic (Lat/Lon) projection write out full 

elevation profiles for every column, even if there are invalid data values at the beginning 

and/or end of the profile. This is to ensure compatibility with other software. 

 Added support for the user providing an explicit format and/or projection to use in the 

service name string when adding a new WMS data source. For example, if a data source 



is available in both JPG and PNG formats and you want to get the JPG data, use a service 

name of 'WMS&format=image/jpeg' when adding the data source. Use the SRS 

parameter to explicitly select a projection to use. 

 Added support for specifying extra WMS parameters (like map=) in the Server URL 

when creating a new WMS source. This allows you to now have parameters after a 

question mark be used rather than ignored. 

 Added new right-click option to the Measure Tool to specify that no unit labels (like 'm' 

or 'ft') should be appended to the measure attributes added to new line and area features. 

 Fixed half-pixel shift of GeoTIFF files that were forcefully positioned using a world file 

rather than embedded positioning information. 

 Added new advanced selection option to the Digitizer Tool to allow selecting all line 

features contained within a selected area feature. 

 Made the false easting/northing values for UTM projections in units other than meters be 

stored correctly when saved to WKT format PRJ files. 

 Made the list of user-provided web-based ECW links be stored in a text format in the 

user_web_files.wfl file rather than a hard to edit binary format. 

  

WHAT'S NEW IN Global Mapper v8.03 

 

 Added support for loading GML format files. 

 Modified the Overlay Control Center to display a checkbox next to each layer for 

controlling the displayed state of the layer. This replace the previous text of 

"(Displayed)" and "(Hidden)" used for each layer and also provides an additional 

mechanism to turn the layer on and off. 

 Added new option on the "Select Online Data Source to Download" dialog to specify the 

download location as a lat/lon and a radius. 

 Added option when batch converting and exporting most raster formats to generate an 

ERS file for use with ERMapper. 

 Added new menu commands to the Options menu on the Path Profile/Line of Sight 

dialog to allow users to manually specify the range of elevation values displayed. This 

options allows for consistent results between multiple profiles if desired. 

 Added option when drawing line or area arcs to have the arcs be a fixed radius rather than 

drawing them. 

 Added option to use a template file when batch converting to new Polish MP format files. 

 Added option to the Generic ASCII Import dialog to allow the specification of a column 

to break area/line features on when the value of that column changes. This allows 

importing formats like the Landmark polygon format that runs all of its features together 

but changes a feature index in a particular column to indicate a new feature. 

 Allowed batch conversion to raster/elevation export formats added via plugin. 

 Added a new line type ("Digitizer Tool Line") that controls the drawing style used when 

digitizing new line and area features with the Digitizer (Edit) Tool. 

 Added option to the transparent color picker dialog for palette-based files to save the 

palette to a .pal file. 

 Added built-in support for the Tananarive Observatory 1925 and Yacare datums. 

 Corrected datum conversions involving the Hermannskogel datum. 



 Fixed export to ECW format when export units are not arc degrees, meters, or US survey 

feet. 

 Fixed errors during lengthy exports to ECW files when data from online sources was 

loaded. 

 Fixed problems with not being able to change the label attribute used for Shapefile 

features that have a 'LABEL' attribute associated with them. 

 Fixed reading of altitude values for waypoints in somee Garmin PCX5 .WPT format 

files. 

 Fixed rendering of TIFF files with overview layers when raster display options are 

changed from the defaults. This problem was introduced in v8.02. 

 Allow color band setup for TIFF files with just 3 color bands. 

 Fixed slowdown in rendering/exporting TIFF files. This was introduced in v8.02. 

 When batch converting ADRG/ASRP files to new raster formats, use the name of the 

internal .IMG file for the export results rather than the TRANSH01.THF file which is too 

generic. 

 Made most of the metadata for SDTS vector layers be available on the main metadata tab 

for that layer to allow easy copying to the clipboard. 

 Fixed problems with translucency, blending, and feathering over the top of TerraServer-

USA data layers. 

 Fixed vertical flip of some GMT grids in netCDF format. 

 Added Projection tab to the Options dialog for raster and gridded elevation layers to 

allow easily changing the native projection interpretation of the coordinates for that layer. 

This allows you to easily correct files that have the wrong projection/datum used for them 

at load time. 

 Made the vertices of holes/islands in areas be displayed when displaying area and line 

vertices. 

 Fixed rare problem decoding some sections of Arc Binary Grid format files. 

 Fixed error when exporting vector data to Erdas Imagine .IMG files. 

 Made online data display more responsive to canceling the render with the ESC key. 

 Improved exporting of data to palette-based images with multiple colors in the export 

palette being very near each other. 

 Added BANDROWBYTES, TOTALROWBYTES, BANDGAPBYTES, and NODATA 

fields to the .hdr file exported for elevation BIL format exports. 

 Added support for reading <MultiGeometry> features from KML files. 

 Fixed problems when adding loaded map files to a map catalog when the loaded files 

were loaded from an archive file, like a .zip or .tar.gz. 

 Added support for loading some additional Moss/Genio format files and made *.inp be a 

recognized file mask for that type of file. 

 Fixed crash when generating contour lines at only the 0 height contour. 

 Fixed problems with the global projection being reset when using the 

VECTOR_ONLY=YES parameter for the UNLOAD_ALL script command. 

 Allowed .clr palette files for BIL/BIP/BSQ format files to be delimited with commas, 

tabs, or semi-colons in addition to spaces. 

 Added support for additional NITF format imagery files, such as those using JPG 

compression. 



 Added support for reading vector features from KML files that use a Schema directive to 

change the name of Placemarks. 

 Improved the name displayed for Arc Vector Coverage layers in the Overlay Control 

Center. 

 Make default export elevation units for DEM and Global Mapper Grid exports be 

decimeters if metric units are the default so that the full precision of nearly all data sets 

will be preserved by default. 

 Added option to save custom shaders to Surfer CLR format files when editing them. 

When coupled with the current ability to initialize a shader from a Surfer CLR file this 

provides an easy way to makes copies of custom shaders. 

 Added support for loading new tab-delimited GNIS format files. 

 Fixed problems exporting attributes as tags to DGN format files (this problem was 

introduced in v8.02). 

 Made graphic group codes for 2D lines and points from DGN v7 files be used as 

elevation values. 

 Made the 'z' scan range value for 2D lines and points from DGN v8 files be used as 

elevation values. 

 Added new GRID_KEEP_CELL_SIZE parameter to the scripting language to allow 

specification that grid cell size should be maintained at the expense of sample spacing. 

 Added support for reading 8-bit palette and grayscale Intergraph COT format files. 

  

WHAT'S NEW IN Global Mapper v8.02 

 

 Added the ability to load layers (like graphic images) to be displayed at a fixed location 

on the screen rather than tied to earth coordinates. This allows you to add things like 

headers and watermarks very easily. There is a new File menu command called "Open 

Data File at Fixed Screen Location" that allows this. 

 Added ability to export any loaded data to tiled images for use in NASA's World Wind 

application. The new World Wind export option under the File->Export Raster and 

Elevation Data menu will correctly break your data up into tiles at various zoom levels 

and also create the necessary XML file to view your data in World Wind. 

 Added the ability to copy features selected with the Digitizer Tool to the clipboard and 

then paste that copied data into any running instance of Global Mapper by using the new 

Edit menu options. 

 Added new right-click option to the Search->Search by Attributes dialog to allowing 

copying the selected features to the clipboard. Those features can then be pasted into any 

running instance of Global Mapper by pressing Ctrl+V. 

 When triangulating and gridding 3D vector data, like LIDAR and XYZ data, made all 

sample locations outside of the bounding polygon of the input data to be discarded to 

avoid the spurious data outside of the bounds. 

 When triangulating and gridding 3D vector data that includes area features with height 

values, make any regions inside an area feature be flattened rather than just treating the 

area features as 3D lines. This allows making good elevation grids from things like 

buildings as well as allows easily flattening an area like a lake. 

 Added option to smooth generated contour lines to improve their appearance. This option 



is enabled by default. 

 Added option when generating contour lines to directly export them to Global Mapper 

Package (GMP) files rather than displaying them on the main map. This allows very large 

areas to be contoured when used in conjunction with the Gridding option during contour 

generation. 

 Added ability for users to add support for additional raster and elevation export formats 

through a DLL-plugin architecture. See the Developers/SDK page at 

http://www.globalmapper.com for more details. 

 Allowed Global Mapper to use up to 4GB of RAM on 64-bit Windows. On 32-bit 

Windows Global Mapper (like all applications) is limited to 2GB of RAM. 

 Added option to rotate point labels when selecting the font to use for points of a 

particular type. 

 Digitizer Tool Changes 

o Added option to the Digitizer Tool to create/flatten terrain within any selected 

area features that have an elevation value associated with them. 

o Allowed quick insertion of multiple vertices in selected features with the Digitizer 

Tool by holding down the ALT key when adding vertices. This will cause you to 

stay in insert vertex mode rather than reverting back to the default mode. 

o Allowed modification of insert vertex behavior to insert vertices on the existing 

selected line feature if the SHIFT key is held down when adding vertices. This 

allows you to emulate the behavior of releases earlier than v8.01 if you prefer 

things to work that way. 

o Allowed quick deletion of selected vertices with the Digitizer Tool. Simply use 

the CTRL+DELETE hotkey to delete selected vertices. This saves having to right-

click and select the delete vertices option from the popup menu. 

o Added new right-click option to the Search by Attributes dialog to allow selecting 

all of the selected search results with the Digitizer Tool to allow further editing 

after closing the dialog. 

o When reversing the order of line vertices also reverse any left or right type 

attributes like addressing attributes. 

o Added option to add address attributes to selected point features using addressing 

information from the nearest line feature to those selected point features. 

 Scripting Changes 

o Added new IMPORT_DIR_TREE command to allow importing all files in a 

directory tree that match a list of filename masks. This is the same functionality 

offered by the File->Open All Files in Directory Tree menu command. 

o Allowed the user of files with multiple polygons when using the 

POLYGON_CROP_FILE parameter for any of the EXPORT_* commands. If 

multiple polygons are found in the specified file the polygon with the largest 

overlap over the loaded data will be used as the crop polygon. 

o Added ability to specify template file to use for MP export when scripting 

(TEMPLATE_FILENAME parameter for EXPORT_VECTOR command). 

o Added ability to specify an image id to use for MP export when scripting 

(MP_IMAGE_ID parameter for EXPORT_VECTOR command). 

o Made User Created Features layers be exportable via scripts run in the context of 



the main view window. 

o Added new SAVE_CURRENT_VIEW and RESTORE_LAST_SAVED_VIEW 

script commands to allow saving a restoring views from within script files. 

o Added OVERWRITE_EXISTING parameter for EXPORT_ELEVATION, 

EXPORT_RASTER, and EXPORT_VECTOR script commands to allow user to 

specify that they want to skip existing files. 

o Made passing a filename of ‘USER CREATED FEATURES’ to the 

UNLOAD_LAYER script command of a script being run in the context of the 

main map view unload any user-created features. 

o Added new parameter (VECTOR_ONLY) to the UNLOAD_ALL script 

command to allow easily unloading all of the vector layers but leaving the other 

layers loaded. 

o Fixed handling of export bounds and spacing when exporting DXF 3D Face, DXF 

Mesh, STL, and VRML files with the EXPORT_ELEVATION command. 

o Added SMOOTH_CONTOURS parameter to the GENERATE_CONTOURS 

script command to allow the user to control whether or not generated contour 

lines are smoothed to improve their appearance. 

o Added REQUIRE_WORKSPACE parameter to the 

GLOBAL_MAPPER_SCRIPT command to allow specification that a 

script/workspace file can only be run if another workspace file is already loaded. 

o Added ENABLE_PROGRESS parameter to the GLOBAL_MAPPER_SCRIPT 

command to allow specification that  no progress reporting dialogs should be 

displayed while running a script. Use ENABLE_PROGRESS=NO to disable the 

display of progress. 

 Projection/Datum Changes 

o Added the Cassini Malaysia (state zones), Hungarian National Grid (EOV), 

Lambert Cylindrical Equal-Area, RSO East Malaysia (Borneo), RSO West 

Malaysia (Peninsular), and Two Point Equidistant projections. 

o Added the ATS77 (Nova Scotia), Hungarian 1972 (HD72), and Indian (Nepal) 

datums. 

o Added the ATS77, Everest 1830 (1967 Definition), and Everest 1956 ellipsoids. 

o Added support for supplying an extra scale factor to State Plane projections. This 

allows for using things like grid vs. ground coordinates. 

o Modified the Timbalai 1948 datum to use the Everest 1830 (1967 definition) 

ellipsoid internally. 

o Fixed problem with Hotine Oblique Mercator A projection acting exactly like a 

Mercator projection. 

o Corrected false northing value for Lambert IV Corse projection. 

o Corrected central meridian for the Quebec MTM Zone 2 projection. 

o Added ability to specify a scale factor for Mercator projections. 

o Improved handling of some Lambert France projections in GeoTIFF files. 

o Fixed decoding of Ireland 1965 datum from TAB files. 

o Fixed problem from v8.00 release that caused some PRJ files to not be loadable. 

o Fixed problems with northing values for a handful of State Plane zones, like the 

NM East zone with the NAD27 datum. 



o Fixed problems with saving and restoring the Hotine Oblique Mercator B and the 

derived Michigan Georef projections to/from PRJ files. 

o Fixed problems saving projections using a "longitude of pole" or a "true scale 

latitude" parameter to new format PRJ files. 

 Made the current view scale be display on the status bar. 

 When running the cursor over line features with recognized addressing attributes the 

address under the cursor will be displayed on the status bar. 

 Added support for points to have dot or square symbols of any size and color when 

loaded from a file. Symbol attributes now support symbol names of 

DOT_CUSTOM_<SIZE>_<RED>_<GREEN>_<BLUE> and 

SQUARE_CUSTOM_<SIZE>_<RED>_<GREEN>_<BLUE> where the <SIZE> value 

is the radius in pixels of the dot or square, and the <RED>, <GREEN>, and <BLUE> 

values represent the color to use. 

 Made any text rotation and size be obeyed when loading DXF files. 

 Made fixed size text and text rotation angles be saved to exported DXF files.  

 Added 'inches' as a supported elevation unit. 

 Made township, range, section, and meridian values be recognized from additional 

attribute values when exporting to Platte River Survey files. 

 Made batch converting from LIDAR and TerraScan formats to gridded elevation formats 

work. 

 Added support for additional NTF grid formats, like the LandRanger DTMs. 

 Added new right-click option to the Measure Tool to save the current measure text to the 

Windows clipboard. 

 Added option to show pixel coordinates of the current mouse location in the topmost 

raster layer in the status bar. This option is in the Advanced Options section on the 

General tab of the Configuration dialog. 

 Added new option to the Advanced Options section on the General tab of the 

Configuration dialog to specify that default display label fonts should use the OEM 

character set (code page 437) rather than the ANSI character set (code page 1252). This 

option can be helpful if you are having problem with accented characters not displaying 

correctly from some data sets (those data sets encoded in code page 437 rather than 

1252). 

 Added support for cropping Polish MP exports to a selected area feature. Note that this 

will only crop point features to the selected area feature. Exported area and line features 

will only be cropped to the bounding box of the selected area. 

 Fixed storage of contour line elevations to Polish MP files when a template file with 

elevation units of meters is used. 

 Made Polish MP exports using template files be done in the datum specified in the 

template file if the datum name is known. 

 Fixed automatic map ID generator for Polish MP exports so that valid map IDs will 

always be generated. 

 Made the Z-level value for custom area types be stored in the custom_area_types.txt file. 

This allows the user to customize the Z-ordering of custom area types to get them to draw 

where they want. Currently this requires editing the custom_area_types.txt file and 

editing the value in the 7th column. A value of 0 will cause the type to draw below all 



other area features. 

 Fixed problems loading text from some DGN v8 files. 

 Fixed error when loading some DGN v8 files with raster data in them. 

 Made the last selected type be remembered on the Area Styles, Line Styles, and Point 

Styles tabs of the Configuration dialog. 

 Made the 'Restore Default Settings' button on the General tab of the Configuration dialog 

also restore the vertical display settings to their default values. 

 Made alpha channels from ECW files be used. 

 Fixed conversion of offset and min/max elevation values in feet units on Alter Elevations 

tab of the raster Options dialog when pressing the Apply button. 

 Fixed export bug when using blend modes and transparency at the same time. 

 When rectifying, made holding down the CTRL key and right-clicking in either the 

zoomed or reference map views zoom the clicked view out to the full extents of the 

available data. 

 When rectifying, made holding down the SHIFT key when left-clicking in the reference 

map view with a lat/lon projection in arc degrees clamp to the nearest 30 second interval 

rather than the nearest 1 minute interval. 

 Fixed error in polyline flags for 3D area features exported to DXF files. 

 Made the correct elevation for 3D point features imported from DXF block entities be 

used. 

 Made HATCH and SOLID entities be loaded from DXF files. 

 Allowed loading of RPF (i.e. CADRG, CIB, etc.) files with absolute file paths. 

 Added support for using positioning and projection information from Fugawi JPR files. 

 Added support for loading multi-patch Shapefiles. 

 Added support for providing offset and scale values for STL export. 

 Added option when printing to specify an extra margin. This is useful when printing to 

things like a PDF file that do not have any natural margins. 

 Fixed problem with label settings not being saved toworkspace files when changing the 

label attribute of Shapefiles to '<No Name Field>'. 

 Removed error about bad OziExplorer .map format when loading MapInfo .tab files from 

which the projection cannot be automatically determined. 

 Added ability to directly load Ozi .map files to load the referenced imagery. 

 Made the last used State Plane zone be remembered in the projection selection dialog. 

 Added a new option ("Mark Sides of Roads with Addressing Information") to the option 

list at the bottom of the Vector Display tab of the Configuration dialog. If checked, any 

roads that are recognized to have addressing information available on one or both sides 

will have "hair" drawn on the side(s) of the line where that address information is 

available. This option can be useful for determining the coverage of your addressing data. 

 Made the default face name used by labels in Global Mapper be stored in the registry and 

editable there. The 'HKEY_CURRENT_USER\Software\Global 

Mapper\DefaultFaceName'registry key now holds that value and can be edited via 

regedit to change the default face name for all labels. 

 Added support for loading some additional Moss/Genio format files. 

 When using the File->Rectify Imagery menu command, made the control point list for 

each file automatically be initialized to the control points found in any associated .gcp 



file. 

 When using the File->Rectify Imagery menu command, added an option to control 

whether or not rectified imagery is displayed in the reference view when rectifying 

multiple images. Unchecking this can speed up the process when rectifying lots of 

imagery. 

 Fixed problems selecting some line features at some zoom levels. 

 Added option to generate a PRJ file when exporting vector data to Simple ASCII Text 

files. 

 Made information about the feature/location under the cursor be displayed in the status 

bar regardless of what the active tool is. For tools like the Digitizer/Edit tool the feature 

information will be displayed after any instructions. 

 Made the 'Feature Type' value for selected features be displayed in the Feature Info 

dialog. The 'Description' value will only be displayed if it is different from the 'Feature 

Type' value. 

 In the vector Search dialog, replaced the '<Feature Description>' searchable field with the 

more useful '<Feature Type>' field that always reflects the type of the feature. 

 Fixed error introduced in v8.01 when exporting grayscale MrSID imagery to new files. 

 When exporting to a Float/Grid file, write a 'cellsize' value to the .hdr file rather than 

'xdim' and 'ydim' values if the X and Y sample spacing are equal. This should fix errors 

loading creating Float/Grid files into Arc/Info. 

 Added support for loading Erdas Imagine .img files directly from archives (.zip, .tar.gz, 

etc.) files. 

 Made additional SEGP1 format layouts be supported. 

 Added an option to map catalogs to control whether or not the map bounding boxes are 

displayed when a map itself is not displayed. 

 Added option to the Path Profile/Line of Sight dialog File menu to save the path profile to 

a BMP file and display it in a fixed location on the main map view. This is useful for 

easily getting the path profile graphic displayed along with the main map for presentation 

purposes. 

 Fixed problems with features with HTML in their names or descriptions being exported 

to GPX files. 

 Added band selection support for BIL, BIP, and BSQ files and their derivatives. 

 Added support for additional band setups for GeoTIFF files (i.e. 5 band 8 bit-per-sample 

files, etc.). 

 Fixed access violation with 16-bit tiled elevation TIFF files. 

 Allowed custom lat/lon grid spacing to be specified in DD MM.MMMM and DD MM 

SS.SSSS format in addition to DDD.DDDDD. 

 Make sure area features exported to KML files are closed (i.e. first and last vertex equal) 

so that they will draw correctly in Google Earth when extruded. 

 Improved accuracy of distance calculations. 

 Made area features exported to MatLab format files be cropped to the selected export 

bounds rather than just including all area features that overlap the export bounds. 

 Fixed positioning problems when batch converting files in a State Plane projection and 

using the datum override setting on the batch conversion dialog to change the datum. 

 Allowed layers that have been rectified to be properly stored in map catalog files. 



 Made the custom color palette on the color selection dialog for the View->Set 

Background Color menu command be remembered between runs. 

 Made county and state boundary lines automatically be classified when imported from 

Tiger/Line files. 

 Added option to the Vector Display tab of the Configuration dialog to "Hide Labels that 

are Partially Offscreen". This makes sure that you always get complete labels and is very 

useful if you are gridding vector data being exported to a raster format to ensure that you 

get a seamless set of tiles. 

 

WHAT'S NEW IN Global Mapper v8.01 

 

 Added new tab to the Options dialog for some multi-spectral raster files (currently only 

GeoTIFF files with more than 3 bands of data and Erdas IMAGINE, ECW, JPEG2000, 

and MrSID imagery with 3 or more bands of data) to allow controlling which bands are 

used for the red, green, and blue color channels during display. 

 Added support to check for new releases of Global Mapper, both automatically and 

manually using a new Help menu option. 

 Added support for feather blending raster data to a polygonal boundary rather than just 

along selected edges. This makes it much easier to feather blend the border of a large 

collection of adjacent files. 

 Added option to associate a list of default attribute/value pairs with each area, line, and 

point classification on the * Styles tabs of the Configuration dialog. If a default attribute 

list is provided for a type any new features created with that type using the Digitizer Tool 

will automatically add those default attribute/value pairs. 

 New Import/Export Formats 

o Added support for loading DWG files. 

o Added support for importing data from WAsP .map format files. 

o Added support for exporting lines with elevation and/or roughness values to be 

exported to WAsP .map format files for use in the WAsP wind analysis 

application. 

o Added option to export survey section (i.e. section/township/range) area features 

to Platte River ASCII Digitizer format files. 

o Added support for exporting gridded elevation data to PGM format grayscale grid 

files. 

o Added support for loading NTF-format contour files as supplied by the UK 

Ordnance Survey. 

o Added support for loading KINGDOM planimetric polygon files like those used 

by SMT (Seismic Micro-Technology) software. 

 Image Rectifier Changes 

o Added option to shift all of the control points for a file when rectifying imagery or 

vector data. This effectively provides an easy way to shift a file by a given 

distance. 

o Added Apply button to the image rectification dialog to allow the results of 

repositioning a layer to be immediately seen in the reference map window. 

 Digitizer Tool Changes 



o Added option to the Digitizer Tool to automatically create vertices at the 

intersections of selected line features. 

o Improved behavior of vertex insertion into area and line features so that the new 

vertex is inserted at the clicked location rather than the nearest point on the 

feature to the clicked location. 

o When inserting new vertices in selected line and area features with the Digitizer 

Tool, automatically select the newly added vertices to allow easy moving and 

joining of them. 

o Added option when creating range rings with the Digitizer Tool to create a 

“multi-ring” by combining the outer rings of multiple range rings into a single 

combined boundary. 

o When adding range rings and point features are selected, added option to add the 

new range rings at the selected point locations. 

o Changed behavior of moving features and vertices with the Digitizer Tool so that 

the move operation is terminated once the feature(s)/vertices are moved. This is to 

prevent inadvertently moving the features again. 

o Fixed problems in Digitizer Tool with horizontal and vertical snapping not 

working properly for the last vertex added to line and area features. 

o Changed “point-in-polygon” selection hot key from ALT to the ‘P’ key. Now if 

you hold down the ‘P’ key when left clicking to select with the Digitizer Tool, the 

top-most area feature containing the clicked location will be selected. 

o Made holding down the ALT key when selecting features and/or vertices 

automatically put you in Move mode after the selection, thus providing a quick 

way to manually reshape or move features. 

 Polish MP (cGPSMapper) Support Changes 

o Added option to the Polish MP export to allow the use of a template MP file for 

getting the map settings to save in the newly created MP file. 

o Made addressing and routing attributes for line features be written to Polish MP 

files on export if they exist in the data being exported. 

o Made all point features except for known cities be written out to Polish MP files 

as RGN10 features rather than RGN20 features. 

o Made features in Polish MP files that do not have data at level 0 still be loaded. 

 Scripting Changes 

o Added new EXPORT_METADATA command to the scripting language to allow 

exporting of text metadata for loaded layers to a file. 

o Added ability to grid exports from script files when using the 

EXPORT_ELEVATION, EXPORT_RASTER, and EXPORT_VECTOR script 

commands. 

o Added SAVE_DIST_Z_FILE parameter for GENERATE_PATH_PROFILE 

script command to allow specification that a file containing distance and elevation 

values should be saved rather than one with the XYZ coordinates of the path 

profile line. 

o Corrected behavior of POINT_SPACING parameter for 

GENERATE_PATH_PROFILE script command. It was generating one less 

sample point than needed. 



o Added new DEFINE_SHAPE script command. This is currently used for defining 

a polygonal feather blend boundary. 

o Added ability to export CDF format files from a script. 

o Allowed POLYGON_CROP_FILE to be used for EXPORT_VECTOR command. 

For now all line and area features will just be cropped to the bounding box of the 

specified polygon. Point features for some formats will actually be cropped to the 

polygon. 

 WMS Changes 

o Fixed problems exporting WMS data layers to Global Mapper Package files. Now 

the full detail of the data layer will always be exported. 

o Removed limit on the length of WMS server URLs added through the “Select 

WMS Data Source to Load” dialog. 

o Added support for adding custom WMS sources with a question mark at the end 

of the server URL. 

o Added support for adding custom WMS sources with a service name other than 

WMS (this was not working properly before). 

 Added option to 24-bit RGB and JPG-in-TIFF GeoTIFF exports to have any 

background/no data pixels marked as transparent. This works by adding an alpha channel 

to the file. This might not be supported by all applications. 

 Added support for loading the Z coordinates for 3D area features from most 3D 

shapefiles. 

 Added option to the Simple ASCII Text export to write out the Y (latitude) coordinates 

before the X (longitude) coordinates if desired. 

 Added support for cropping Simple ASCII Text exports to a selected area feature. Note 

that this will only crop point features to the selected area feature. Exported area and line 

features will only be cropped to the bounding box of the selected area. 

 When exporting vector data to Simple ASCII Text files, made area features that extend 

outside of the export bounds be cropped to the export bounds. 

 Added option on the File menu of the Path Profile/LOS dialog to save the sight line and 

the Fresnel zone line (if applicable) to a KML format file for display in Google Earth. 

 Made overwrite of existing workspace files fail-safe by not writing out the workspace to 

the existing file until the workspace save is complete and error-free. This prevents any 

errors during a workspace save from wiping out an existing workspace file that was being 

overwritten. 

 Added additional progress reporting when batch converting files. 

 Dramatically sped up the loading of map catalog files with lots of files in different 

projections. 

 Fixed problem with scale being slightly changed when printing to scale with a header 

and/or footer. 

 Made State Plane projections with NAD83 HARN/HPGN datums be properly saved and 

loaded from PRJ files. 

 Added support for loading ECW and JPG2000 files with more than 8 bits per color 

channel, including elevation-based files. 

 Made the TIFFTAG_SAMPLEFORMAT value be written out for 16-bit elevation TIFF 

files so that ESRI products can properly read them when negative values are present. 



 Added option to skip files for which the projection cannot be automatically be 

determined when batch converting files. 

 Added support for decoding some additional NITF imagery formats, in particular 2-band 

16-bit per band imagery. 

 Added POSGAR94 (Argentina) datum. 

 Fixed bug in gridding while exporting with an overlap percentage specified that caused 

the overlap to not be applied to the right or bottom sides of some files when splitting up 

the export to a fixed ground size. 

 Added support for loading MrSID imagery with more than 8 bits per color channel. 

 Fixed display of ADRG/ASRP/USRP data sets with 4-bit count RLE compression. 

 Added option to the Vector Display tab of the Configuration dialog to have only the 

border of selected area features highlighted. 

 Added additional Lambert France projections to handle the newer projections with larger 

false northings. Made the attributes used for each of these Lambert projections be listed 

on the Projection selection dialog as well. 

 Added support for decoding and encoding Lambert France projection codes from 

GeoTIFF files. 

 Added support for automatically decoding projection and datum information from text 

metadata files accompanying Mexican topo maps. 

 Fixed rare problems loading some NOS/GEO format files. 

 Fixed bug cropping reprojected area features on export to MapInfo MIF/MID format 

files. The bug caused those areas to not be exported. 

 Improved behavior of near-white colors when exporting to image-optimized palettes. 

 When exporting 3D point features to DXF files, export the elevation information after the 

coordinate information rather than before. 

 Fixed problems loading positioning information from Touratech (TTQV) .cal files where 

the first pixel control point is at (0,0). Also added support for automatically decoding 

Swiss Grid projections from those files. 

 Fixed application of Fresnel zone analysis to view sheds. It had nearly no effect in the 

v8.00 release for view sheds (it did work properly for line of sight analysis however). 

 Expanded support for FAST-format Landsat imagery to allow the direct loading of 

panchromatic, VNIR/SWIR, and thermal imagery without needing a _MTL.FST header 

file. 

 Fixed problem with line vertices showing up slightly offset from the line when zoomed 

way in on line features that are also being reprojected. 

 Improved display of 4-band Digital Globe QuickBird imagery with 8 bits per color band. 

 Removed special TIFF and GeoTIFF metadata pages and placed all of the information on 

the main metadata page so that the information could be easily copied to the clipboard. 

 Improved decoding of diacritic text from NIMA GNS point data files. The UTF-8 

encoded text is now converted to the current system codepage for improved display of 

diacritic and other extended characters. 

 Fixed very slow display of some large tiled TIFF files. 

 Dramatically sped up export of TerraServer-USA data when it is being exported in a 

projection other than Geographic. 

 Added JPEG2000 .jp2, BSB chart .kap, and Polish .MP files to the list of “Supported 



Commonly Used Types” list on the file selection dialog. 

 Added option to CSV export to include LATITUDE and LONGITUDE columns even if 

the projection is not Geographic. 

 Drastically reduced memory requirements when exporting vector data to Global Mapper 

Package files and saving generated vector features (like contour lines) to workspace files. 

This should eliminate all error messages when exporting package files and most when 

exporting workspace files. 

 Added version to title bar. 

 When exporting a VRML file, made the lowest vertical exaggeration setting on the slider 

correspond to no vertical exaggeration at all. 

 Fixed bounds of exported VRML files so that they will tile properly. In addition, 

additional comments were added VRML file headers to describe the ground location of 

the data and additional digits of elevation precision were also written out in most cases. 

 When using the ‘Add Loaded Files’ or ‘Add Onscreen Files’ batch conversion dialog 

buttons, allow the user to add files of types other than the specified input file type. 

 Allowed for entry of azimuth and altitude light angle values at greater than integer 

precision on the Vertical Options tab of the Configuration dialog. 

 Moved the Configuration button on the toolbar to be next to the Overlay Control Center 

button as that is a more logical grouping. 

 Changed the globe button on the toolbar to launch the online TerraServer-USA/WMS 

data access dialog rather than going to the Find Data Online page at 

<http://www.globalmapper.com>. 

 When marking a waypoint from a tracked GPS location, automatically add elevation (if 

available) and timestamp attributes. 

 Fixed error message and lockup on Search->Search by Name dialog when searching on 

the last start letter (like ‘Z’) and having non-alphanumeric characters starting some of the 

strings. 

 Made State Plane projections be recognized from ECW files rather than using the base 

projection (like Lambert Conformal Conic). 

 Updated Surfer BLN export to use new comma-delimited format. 

 Sped up some raster/elevation exports from map catalogs (exports that span many maps 

from the catalog in a single export row). 

 Made elevation units for most gridded elevation exports default to the elevation units of 

the loaded data or, if the vertical display units are manually set to metric or statute on the 

Vertical Display tab of the Configuration dialog, to meters or feet respectively. 

 Added option when gridding on export and naming the rows or columns with numbers to 

specify a step value by which to increment the row or column numbers rather than just 1. 

 Made the default projection system displayed for files for which the projection cannot 

automatically be determined be configurable. This default projection system can be set by 

saving a default.prj file in the Global Mapper installation folder. 

 

WHAT'S NEW IN Global Mapper v8.00 

 

 Added support for loading data from OpenGC WMS servers. This is done through the 

new File->Download Online Imagery/Topo Maps menu command (formerly the 



Download TerraServer menu command). Several sources are built-in, providing easy 

access to gridded elevation data for the US (NED) and the world (SRTM) as well as color 

imagery for the entire world. Users can easily add their own WMS data sources as well. 

 Added support for exporting loaded vector data to the Polish MP format for use with the 

cGPSMapper application (www.cgpsmapper.com <http://www.cgpsmapper.com>) which 

allows the creation of new maps for Garmin GPS units. 

 Added support for loading Polish MP format files like those used by the cGPSMapper 

application. 

 Added support for loading vector data from KML/KMZ format files. 

 Added support for loading NITF (National Imagery Transmission Format) format 

imagery. 

 Added support for loading Geodas Grid (GRD98) format elevation files. 

 Added support for loading some Intergraph COT format files. 

 Added support for loading CDF (GES Cartographic Data Format) files. 

 Greatly improved the raster layer options by adding support for color balancing 

(individual red, green, and blue adjustment), linear min/max contrast stretch, setting 

transparency for multiple layers at a time, feather blending (see below) and cropping to 

native bounds or by a given number of pixels. 

 Added feather blending support for raster layers to the Options available from the 

Overlay Control Center. This is an extremely powerful feature that allows smoothly 

blending raster layers with underlying layers. For example, you might have high 

resolution imagery on top of lower resolution imagery. With feather blending, you can 

smooth the sharp edge and make the transition at the border seamless. 

 Added support for checking clearances with respect to the first Fresnel zone when 

calculating view sheds and performing line of sight analysis. This allows for a more 

accurate visibility calculation depending on the wavelength being transmitted. 

 Added support for having labels be displayed at a fixed height in meters rather than at the 

same size at each zoom level. This option is on the bottom of the font selection dialog 

when either selecting a font for a classification on one of the * Styles tabs on the 

Configuration dialog or when selecting a font for a feature when editing it. 

 Added option to always display the label for a particular feature or classification if labels 

are displayed. This option is on the bottom of the font selection dialog when either 

selecting a font for a classification on one of the * Styles tabs on the Configuration dialog 

or when selecting a font for a feature when editing it. 

 Digitizer Tool Changes 

o Added an undo option when digitizing new features with the Digitizer Tool or 

drawing new measurements with the Measure Tool. Simply press Ctrl+Z and the 

last vertex added to the feature/measurement being drawn will be removed. 

o Changed the snapping behavior in the Digitizer Tool so that snapping is disabled 

using the ALT key (rather than CTRL) and that snapping to vertices only is 

enabled by holding down the ‘V’ key (rather than SHIFT). 

o When digitizing new features or moving existing feature or vertices using the 

Digitizer Tool, made holding down the CTRL key make the new location be 

snapped vertically, holding down the SHIFT key make the new location be 

snapped horizontally, and holding down both the CTRL and SHIFT keys snap the 



location diagonally. 

o Added a new advanced selection option popup menu to the right-click popup 

menu for the Digitizer Tool when one or more area features is selected. This new 

menu has options for selecting all point and area features within the selected 

area(s), making it easy to select and edit features within a particular area. 

o Added option to the Digitizer Tool to allow creating new line features from the 

boundaries of selected area features.  

o Added option to the Digitizer Tool to allow creating new line features from the 

boundaries of selected area features.  

o When placing new range ring features with the Digitizer Tool, make the range 

ring center snap to existing features just like line, area, and point features do when 

drawing them. You can hold down Ctrl when placing the range ring to disable 

snapping. 

o When adding areas as islands to existing features with the Digitizer Tool, prompt 

the user for whether or not the original areas should be marked as deleted. 

Previously the original areas were always marked as deleted, but this is not 

always desired. 

 Export Changes 

o Greatly sped up exports to numerous binary formats, including Shapefiles, Global 

Mapper Grid files, and Surfer Grid files, especially when exporting to a network 

drive. 

o Added option when gridding data on export to have the column name be first and 

then the row name in the generated filename, rather than the default of row name 

first, then column name. 

o Added option when gridding data on export to turn off the prepending of zeroes to 

numeric column or row names in order to make them all the same length. 

o Added option to save a gridded file of slope values rather than elevations when 

exporting to a Float/Grid format. 

o Corrected text encoding recorded in exported KML/KMZ files to ISO-8859-1 

rather than UTF-8. 

o Added option when exporting to KML/KMZ format files to fake an elevation for 

2D area features in order to get the same draw order in Google Earth as you see in 

Global Mapper. 

o When gridding an export that is also cropped to a selected area feature, don’t 

create files to any grid cells that don’t intersect the selected area feature. 

o When exporting Shapefiles, remove any duplicate vertices from the exported 

lines. 

o Added option when exporting GeoTIFF files to generate PRJ files for the 

GeoTIFF files. 

o Added option when exporting 3D DXF Face files to generate the coordinates as 

ECEF (earth-centered earth-fixed) rather than in whatever projection system is 

selected (use EXPORT_ECEF=YES parameter for EXPORT_ELEVATION 

command in scripting language to script this behavior). 

o Added option when batch converting to DGN format to control whether or not 3D 

DGN files are created. 



o Fixed problems saving some Lambert Conformal Conic based projections to 

ECW files. In the v7.04 release a bug was introduced which would cause some 

projections to not have a projection string written to a newly created ECW file. 

o Made transparency when exporting PNG files work when including either loaded 

vector data or the displayed scale, legend, and/or grid. 

o When exporting Simple ASCII text files, make the GM_TYPE attribute be 

exported when necessary if either attribute export option is enabled rather than 

only when the style attributes export option is enabled. 

 Rectification Changes 

o When rectifying imagery, made snapping to nearby vector data in the Reference 

Map view be turned off by holding the Alt key when left clicking rather than 

holding down the Ctrl key. This allows both snapping and zooming to a clicked 

location to be done by holding down the Ctrl key. 

o When rectifying imagery, made left-clicking in the Zoomed Image and Reference 

Image views drop a small red dot to visually indicate the click location. 

o In the image rectification dialog, made holding down the Ctrl key increase the pan 

size to a half screen when panning with the edge arrow on any of the map views. 

 Projection/Datum Changes 

o Made PRJ files be saved if possible in the newer PRJ well-known-text (WKT) 

format rather than the older ESRI-originated format that is no longer supported by 

ESRI products. There is an option to use the older PRJ format if desired on the 

General tab of the Configuration dialog. 

o Added support for the Bipolar Oblique Conic Western Hemisphere, Times, Old 

Israeli Grid, and New Israeli Grid projections. 

o Added Corrego Alegra, NID (New Israeli Datum), OID (Old Israeli Datum) and 

QND95 (Qatar) as built-in datums. 

o Added Clarke 1880 (Palestine), Clarke 1880 (RGS) and Sphere Radius 6371000 

m as built-in ellipsoids available for use with custom datums. 

o Fixed problems using and saving the Quebec MTM projection for which support 

was added in the last release. 

o Made the names of state-plane zones listed on the projection selection dialog 

include the FIPS zone number of the zone. 

o Allowed the use of the NAD83 HARN/HPGN datums with State Plane 

projections. 

o Fixed problems decoding the Lambert France projections from old format PRJ 

files and workspaces. 

o Increased accuracy of OSGB36 datum conversions. 

o Made central meridian scale factor for Lambert Conformal Conic projections only 

be used in the 1SP (both first and second standard parallels the same) case since it 

can only be unity (1.0) in the 2SP case.  

o Fixed decoding of UTM zones in the Southern hemisphere from some new format 

PRJ files. 

o Fixed Transverse Mercator projections when used with datums based on perfect 

spheres (these would only have been custom datums based on a spherical 

ellipsoid). 



 Added option to custom shader dialog to allow initialization of a custom shader from a 

Surfer CLR shader palette file. 

 When creating or editing a map catalog and using the “Add Loaded Files” or “Add 

Onscreen Files” buttons, made files from other loaded map catalogs be added as well if 

they are not already in the map catalog being worked with. 

 When saving a workspace with any gridded elevation data loaded, made the current 

shader and other vertical display settings be written to the workspace so that the view will 

be the same when the data is reloaded. 

 Added new advanced options list to the General tab of the Configuration dialog to allow 

selecting advanced options like treating DXF INSERT entities as points, automatically 

adding custom types for DXF layers, exporting old format PRJ files, preferring world file 

coordinates over embedded coordinates for GeoTIFF files, and prompting for whether or 

not 16-bit BIL data is imagery or elevation data. 

 Added SAVE_SCALE_AND_LEGEND parameter to the EXPORT_RASTER script 

command to allow saving the distance scale and/or elevation legend to generated raster 

format files. 

 Added POINT_SPACING parameter to the GENERATE_PATH_PROFILE script 

command to allow specifying the spacing between sample locations along a path profile 

rather than the number of points. 

 Fixed reading of Shapefiles with PolygonZ and PolygonM shape types which don't have 

Z or M values for all features. 

 Allowed specification of the default elevation units to use for vector data with elevations 

from the Options button of the Overlay Control Center. This elevation units value will be 

used for any elevation values associated with vector features in that layer that do not 

explicitly contain a unit identifier (i.e. “ft” or “m”). 

 When saving/updating feature measure information for polygon features that have 

islands/holes, include the area of the island features as a separate ISLAND_AREA 

attribute. Also subtract the area of those islands away from the total polygon area stored 

in the ENCLOSED_AREA attribute to give a true representation of the actual area 

covered by the polygon. 

 Greatly improved the load speed and reduced the memory requirements for most BMP 

format files. 

 Improved auto-assignment of type names based on feature descriptions when loading 

DXF files to handle type names with spaces or underscores in them. 

 Fixed error when saving a workspace file containing a map catalog with auto-collar 

cropping enabled. 

 Fixed problems decoding NMEA GPS streams where the only valid sentence is the 

$GPRMC sentence. 

 Fixed problem with the label background for labels set to display with filled backgrounds 

being white rather than the current view background color in some instances when raster 

or gridded elevation data is also being displayed. 

 Made the size of the vector search dialog be remembered between runs. 

 Allowed ECW and MrSID files without embedded positioning information to use 

positioning information from additional sources, like world files. 

 Replace underscores with spaces in waypoint names loaded from CompeGPS format 



files. 

 Made symbols for waypoints from CompeGPS files be automatically set if the symbol 

name for the waypoint matches a Global Mapper symbol name. 

 Fixed restoring of default drawing styles for area and line features from the tabs of the 

Configuration dialog. This has been broken since the v6.08 release. 

 Added support for reading coordinates from world files where the coordinates are 

separated with tabs rather than being on separate lines. 

 Made the list of layers in the Overlay Control Center be scrollable with the mouse wheel. 

 Corrected image registration via CompeGPS IMP files with control points in multiple 

UTM zones or in a UTM zone in the Southern hemisphere. 

 Improved decoding of CompeGPS IMP files using Lambert Conformal Conic 

projections. 

 Sped up the import of large DTED files. 

 Made symbol and type lookups by name work properly for types and symbols with 

accented characters. 

 Don’t allow multiple custom shaders with the same name to be used. 

 Fixed loading of Arc ASCII Grid files with lines over 256 KB in length (up to a max of 

2MB per line). 

 Fixed bug with display of raster layers texture mapped over loaded elevation layers that 

do not use the shared default shader. 

 Fixed bug in the encoding of area features in DLG-O files and allowed correct reading of 

incorrectly encoded DLG-O files with area features. 

 Fixed display of tiled 16-bit grayscale TIFF imagery. 

 Fixed recording of GPS tracklog when attached GPS device always reports an elevation 

of 0. 

 Fixed auto-contrast adjustment for some large images with 16 bits per color channel. 

 Made rotation values from BLW files used to position BIL files be used. 

 Added option to Vector Display tab of the Configuration dialog to allow hiding any extra 

text displayed below road icons, like alternate names for the road. 

 Added option to the General tab of the Configuration dialog to control whether or not 

grid lines should extend beyond the edge of loaded data. 

 Added support for dragging Global Mapper Script (GMS) files onto a running instance of 

Global Mapper and have them be run. 

 Added support for 16-bit per color channel separated (Geo)TIFF files with more than 3 

bands of data. 

 Improved rendering of some lat/lon data that crosses the anti-meridian (180 E/W), such 

as range rings. 

 Added option to the Measure Tool to have measured lines and areas be drawn along great 

circles rather than on straight lines (all measurements are always along great circles). 

 Fixed rare problem with min and max values being treated as invalid from some Surfer 

Grid files. 

 Made national wilderness and wildlife areas in 100K SDTS DLG files be detected and 

automatically classified as “National Park (Other)”. 

 Improved positioning of imagery using Ozi .map files that reference the Swiss Grid 

projection. 



 Corrected positioning of imagery using Ozi .map files that specify a “map scale factor” 

(MSF) value other than 1. 

 Added support for reading text from MTEXT entities in DXF files. 

 Made link elements in GPX files be saved as attributes in the created features. 

 Fixed very rare lockup when creating an elevation grid from 3D vector point features or 

during ASCII file import. 

 Fixed problem with attribute tags in exported DGN files not being recognized by 

MicroStation. 

 Added Gridding tab when generating contours to allow breaking up the contour 

generation into multiple smaller pieces. 

 Improved the visual appearance of gridded elevation data along the edges of the data 

when interpolating (the visible seem is reduced or disappears altogether in some cases). 

 

WHAT'S NEW IN Global Mapper v7.04 

 

 Added KML/KMZ export function. This allows any loaded vector data to be exported to 

a KML/KMZ format file for use in Google Earth. 

 Fixed problem on some systems that would cause the application to disappear or crash 

when attempting to select a new file for loading or saving. This problem occurred on 

Windows XP SP2 systems which also had Adobe Acrobat Reader v7 installed. 

Apparently the installation of Acrobat Reader changed some built-in Windows behavior 

in a way that broke Global Mapper (and several other applications). 

 DGN Import/Export Changes 

o Allowed batch conversion of vector data to DGN format files. 

o Allowed export of DGN format files from Global Mapper scripts using the 

EXPORT_VECTOR command. 

o Made tag values be read in from DGN files and stored as attributes. 

o Made point features stored as 0-dimensional lines in DGN v7 files load correctly. 

o When exporting DGN files, made the current view background color be saved as 

the DGN background color. 

o When exporting DGN files, made the correct unit conversion and type values be 

used rather than reporting all units as meters. 

o When exporting DGN files, made the level number used for exported features that 

originally came from a DGN file be maintained. 

o When exporting DGN files, made text features be exported for line and area 

features that have labels. 

o When exporting DGN files, made text labels be sized proportionally to the font 

size used for the label in Global Mapper. The export options dialog also has an 

option to scale the text to make it larger or smaller and still maintain the 

proportionality. 

o When exporting DGN files, made generation of a 3D DGN file optional. 

o When exporting DGN files, added an option to also generate a PRJ file containing 

the native projection of the coordinates in the DGN file. 

o When exporting DGN files, added an option to specify the unit resolution to use, 

such as 100 to use centimeters when the export ground units are meters. 



 Allowed saving of the 3D view to images of a size other than the 3D view window size 

on systems that support this operation. Many older or underpowered video cards will not 

support this operation, but newer video cards with the latest drivers should be ok. 

 Added support for loading Japanese DEM (JDEM) .mem files. 

 Added support for loading SEGP1 seismic shotpoint format data files. 

 Added support for loading CompeGPS RTE, TRK, and WPT format files. 

 Added option when batch converting to a zoned projection, like UTM or Gauss Krueger, 

to “Automatically Select the Best Zone” for each file being converted, allowing easy 

conversion of files that span multiple zones. The auto-selection option will be at the top 

of the zone list for those zones where it is available. 

 Export Gridding Changes 

o Added option when gridding data on export into adjacent tiles to make those tiles 

overlap by some percentage of the tile size. This is to allow more easily 

overlaying the data in other non-mapping applications, like Photoshop. 

o Added option when gridding data on export and separately naming tile rows and 

columns to specify the start number or letter for the rows and/or columns rather 

than just using 1 and ‘A’. 

o Added option when gridding data on export into a specified number of rows and 

columns to crop the right and bottom grid cells to the specified export bounds. 

This may make the grid cells not all have the same size, but will prevent 

extraneous data from appearing on the right and bottom edges. 

o Changed naming of numeric rows/columns when gridding data on export to make 

the numeric name for every tile be padded with 0’s to the maximum length of the 

numeric label for any row/column. For example, if 100 columns of tiles were 

being exported, the columns names would go 001, 002, …, 100 rather than 1, 2, 

… 100. 

o Made most settings on the Gridding tab of exports be remembered between runs. 

o Added option when gridding data on export to not export grid tiles where the 

destination file already exists. This is useful for continuing a canceled export, or 

re-exporting just some tiles that you want different data in. Simply delete the tiles 

that you want to re-export, then do the export again with the option to skip 

existing files checked. 

o Added option when gridding data on export to specify a prefix to apply to the 

column and row names when separately naming rows and columns. 

 When loading Shapefile, MapInfo, and DXF format files, use the layer name/attributes to 

try and auto-classify features. 

 When exporting Shapefile and MapInfo MIF/MID features and including the description 

as an attribute, also include the classification as a GM_TYPE attribute if the description 

for any of the feature being exported is not the default of the classification name. 

 Added built-in support for the Quebec MTM projection. 

 Added support for western hemisphere zones when using the Gauss Krueger 6-degree 

zone projection. 

 Added built-in support for the LUREF (Luxembourg) datum. 

 Improved accuracy of the Dutch Grid projection and the Dutch (RD) datum. 

 When performing cut-and-fill volume calculations, also calculate and display the surface 



area that needs cut and filled respectively. 

 Made the “Path Details” dialog for a 3D path profile display the along-ground distance 

(i.e. distance with elevation changes taken into account) as well as the minimum and 

maximum elevation values along the path. 

 Added support for loading USRP data sets (ASRP data with UTM coordinates). 

 Made all appropriate border pixels be marked as transparent in ADRG, ASRP, and USRP 

data sets. 

 Added option to Simple ASCII Export to make style attribute export be controlled 

separately from data attribute export. 

 Added button to the custom shader edit dialog allowing the elevation value for an 

existing elevation/color range be changed. 

 Added option to the Digitizer Tool when multiple point features are selected to identify 

any point features that are within a user-specified distance of other selected point 

features. This is helpful for finding duplicate points. 

 Display the height of any gridded elevation data in the status bar as you move the cursor 

around, even if the cursor is near vector data (the height will be appended to the nearest 

vector feature description). 

 When placing new point/text features or moving a single point/text feature with the 

Digitizer Tool, make the point snap to existing features just like line and area features do 

when drawing them. You can hold down Ctrl when placing the point to disable snapping. 

 Made CSV files created by the Lowrance SonarViewer software be automatically 

detected and loaded rather than prompting the user for input parameters. 

 Added option to CDF export to allow exporting coordinates in either the current 

projection system or lat/lon. 

 Allowed DTED files with invalid column numbers in the data record to be loaded. 

 Added support for loading Geosoft Grid files with right-handed vector orientation. 

 Added automatic detection of world files that have an extra .txt appended to the filename. 

 Improved loading of ATTRIB values from DXF values. 

 Improved export of point/text features to DXF files. 

 Fixed loading of 3D LINE entities from DXF files where the start and end points had 

different elevations. 

 Made 3DFACE entities be loaded from DXF files. 

 Added option to use the display label as the layer name when exporting to DXF files 

rather than the description/type if a layer name is available for a feature. 

 Allowed “Crop to Selected Area Feature” option to be used when generating contours. 

 Added option when generating contours to control whether or not unit indicator suffixes 

should be appended to labels for the generated contour features. 

 Added INC_UNIT_SUFFIX parameter to the GENERATE_CONTOURS script 

command to allow specification of whether unit indicator suffixes should be appended to 

the labels for the generated contour features. 

 Added Sphere Radius 6371204 m as an available ellipsoid for adding custom datums. 

 Fixed problem with custom datums created by the user being written out to new files, like 

GeoTIFFs, as the Adindan datum. 

 Fixed incorrect loading of some MSI Planet format height files (they would appear 

garbled). 



 Fixed errors loading some GPX files with extremely long text strings in them. 

 Fixed problem with missing lat/lon grid lines in some projections where the lat/lon grid is 

not valid over the entire data bounding box. 

 Fixed automatic removal of collars for files with very curved lat/lon boundaries, such as 

the Antarctica DRGs. 

 Fixed loading of attributes from MIF/MID files when one of the attribute names starts 

with “Index”. 

 Fixed errors trying to batch convert raster data with both the “Use Other Source Files As 

Filler” and “Auto Adjust Contrast” options enabled. 

 Improved rectification based on an OziExplorer .map file when that .map file has a UTM 

grid and each control point has both lat/long and grid coordinates or the .map file has 

control points that are marked as excluded. 

 Allowed ground control points specified for rectification with the IMPORT script 

command to be specified in a projection other than the specified projection for the file 

being rectified. The use of either the GCP_PROJ_NAME or GCP_PROJ_FILENAME 

parameters will cause the control points to be projected automatically to the file 

projection before rectification occurs. 

 When loading LIDAR LAS data, save the class of each sample point as an attribute. 

 When batch converting from LIDAR LAS data to other vector formats, add an option to 

only include sample points classified as “ground shot points” in the output. 

 Don’t display POLYLINE entities from DXF files that are marked as 3D polygon meshes 

or polyface meshes. 

 When loading generic ASCII files with quoted fields, make sure the quoted fields are 

properly treated as a single field and that the quotes are removed for all fields. Also treat 

back-to-back double quotes as a single quote mark in the text that doesn’t act as a field 

delimeter. 

 When loading generic ASCII text files and using column names from the first line of the 

file as attribute names, don’t include attributes from non-coordinates lines. 

 Fixed problem introduced in v7.02 release with saving Transverse Mercator projections 

to ECW files (the projection name was not being saved for some users). 

 Allowed view shed calculations to have a radius as small as one thousandth or a mile or 

kilometer rather than the previous minimum of one tenth of a mile or kilometer. 

 Fixed some printing issues and improved printing performance when printing to large 

paper sizes. 

 Added a registry key to allow specifying that positioning information from TIFF world 

files, if available, should be preferred over the positioning data stored within TIFF file 

headers. If you create a 

HKEY_CURRENT_USER\Software\GlobalMapper\TIFFPreferTFW DWORD value 

with the value set to 1, then the world file positions will be preferred. 

 Added support for reading and writing oblique stereographic projections from/to 

GeoTIFF files. 

 Added support for reading and writing Gauss Krueger (6-degree zones) projections using 

the Pulkovo 1942 datum from/to GeoTIFF files. 

 Added support for reading and writing the Potsdam/DHDN datum from/to GeoTIFF files 

as well as Gauss Krueger Germany (3 degree zones) projections with that datum. 



 Added checkbox to the ASCII import file to allow using the same configuration for all 

files during that load or batch convert operation. 

 Allowed positioning data from Ozi .map and CompeGPS .imp files to be used to position 

ECW files that do not contain embedded positioning information. 

 Corrected positioning of some non-WGS84 MapTech maps. In some cases the wrong 

datum would be used. Now if there is any doubt the user is prompted to select the correct 

projection. 

 Made user-defined projections be automatically decoded from MrSID files. 

 Fixed export of NAD83 datums to Erdas Imagine format files. 

 Made French Lambert projections be decoded and encoded from/to ECW files 

automatically. 

 Improved positioning of NOS/GEO format charts by positioning them using the specified 

native chart projection if recognized. 

 When using the GENERATING_CONTOURS script command, allowed negative 

intervals to be specified if the SINGLE_LEVEL_ONLY=YES parameter is specified. 

 Fixed half pixel shift and other positioning problems when exporting to new Float/Grid 

format files. 

 Fixed errors loading text from some single-precision E00 files. 

 Dramatically sped up the calculation of auto-contrast statistics for large MrSID files. 

 When loading MapInfo MIF/MID format files, don’t set any numeric fields to have a 

value of 0 when their value is actually empty. 

 Fixed bug from v7.03 release that could cause discontinuities in rectified imagery that 

used the triangulated rectification method. 

 When displaying feature information for polygon features that have islands/holes, include 

the area of the island features as a separate item in the Geometry section of the Feature 

Info dialog. Also subtract the area of those islands away from the total polygon area to 

give a true representation of the actual area covered by the polygon. 

 Improved compression of 24-bit RGB GeoTIFF files created by Global Mapper that are 

created with the LZW compression option. 

 Improved consistency of multiple view sheds calculated from the same center point with 

the same sample spacing but different radii when the specified sample spacing is much 

larger than the spacing of the elevation files that are used. 

 Sped up calculation of view sheds when the elevation data being used comes from a map 

catalog or Global Mapper Grid files. 

 Sped up contour generation when the elevation data being used comes from a map 

catalog or Global Mapper Grid files. 

 Added support for specifying a scale factor for Lambert Conformal Conic and 

Stereographic projections. 

 Significantly sped up export to any raster format using a palette, such as palette-based 

GeoTIFF or PNG exports. 

 Added option to do case-sensitive searches with the Search->Search by Attributes menu 

command. 

 Made map catalogs be exportable to Global Mapper Package files. 

 Fixed orientation of GPS heading arrow when the display projection is one in which 

north is not necessarily straight up. 



 Reduced memory usage for E00 files with lots of attribute values. 

 Fixed calculation of PERIMETER and ENCLOSED_AREA values for some range rings 

that had incorrect values stored. 

 Fixed decoding of UTM zone 60 projections from NASA LandSat .met files. 

 When rectifying data with vector data displayed in the Reference pane, made clicking 

near a vector feature automatically “snap” to that feature to assure exact matches. 

 Made statistics (STX) files be generated for elevation BIL file exports. 

 Added SHOW_3D_VIEW command to the scripting language to allow scripts and 

workspaces to bring up the 3D view window. 

 Added option to generate XYZ grid files in row-major order. 

 Added option to anti-alias pixels (interpolate) when batch converting between raster 

formats. 

 Fixed rare problems loading some portions of Arc Binary Grid format files (technically, 

some 32-bit RLE encoded tiles with very large values were incorrectly decoded). 

 Fixed problem with labeled areas exported to Landmark Graphics ASCII format files 

have two TEXT labels exported. 

 Made image-optimized palettes always contain white and/or black if those colors are in 

the image being exported. This makes collars stay the color they are supposed to be. 

 Made tracking of Garmin USB GPS devices work for newer devices, like the SP2720, 

that send some extra information when first connected. 

 Added warning to exports when a large amount of TerraServer data would be exported to 

explain that it could be very slow and give the user a chance to cancel the operation. 

 

WHAT'S NEW IN Global Mapper v7.03 

 

 New Import Formats 

o Added support for loading DGN v8 and later format files. 

o Added support for loading MapTech format files, including encrypted BSB files 

and other MapTech topo maps and aerial navigation maps. 

o Added support for loading Idrisi format raster and elevation files. 

 New Export Formats 

o Added support for exporting loaded vector data to DGN format files. 

o Added support for exporting loaded data to Erdas Imagine IMG format files. 

o Added support for exporting loaded data Idrisi format files. 

o Added support for exporting 8-bit and RGB GeoTIFF files with LZW 

compression. LZW compression typically results in much better compression that 

the default methods, but may not be supported by all software applications. 

 Drawing Changes 

o Significantly improved the display of raster and gridded elevation data at 

intermediate zoom levels by always anti-aliasing the display when not zoomed 

into the pixel level of the data and not zoomed out so far that it doesn’t matter 

much. There will be a slight performance hit for this, but the improvement in 

display quality seems worth it. 

o Made pressing the ESC key during a draw abort the draw as soon as possible. 

 Projection/Datum Changes 



o Improved accuracy of the NAD27 (Canada), AGD66, AGD84, and NZGD49 

datums by using the NTv2 grid shift method for sub-meter datum transformation 

accuracy. 

o Added generic NAD27 datum that will automatically use the most accurate local 

datum conversion based on the location being converted. 

o Added support for the Miller Oblated Stereographic projection. 

o Allowed use of the NZGD2000 datum with the New Zealand Map Grid 

projection. 

o Made additional datum codes, like those for the NTF datums, be recognized for 

GeoTIFF files. 

o Made ETRS89 datum be recognized in additional spellings from PRJ files. 

o Corrected small error when transforming the Rome 1940 datum to other datums. 

o Added Clarke 1880 (Benoit) as an available ellipsoid for adding custom datums. 

 View Shed Changes 

o Added option to the view shed tool to find a view shed of just where a beam will 

hit the terrain. A start and end transmission angle are specified in addition to the 

transmitter height in order to find the beam intersection points. 

o Added option to the view shed tool to specify a minimum distance from the 

transmitter to perform the view shed analysis. 

 Improved loading of DXF files that have features in the BLOCKS section of the file. 

 Prompt users to unload all loaded data when loading workspace files rather than 

automatically unloading all loaded data. 

 Added option to batch geocode addresses from a file from the Search->Find Address 

menu command. 

 Added support for gridding the export of Simple ASCII Text, VRML, and Zmap Plus 

Grid files. 

 Added support for reversing the order in which rows and columns are named when 

gridding files on export. 

 Made the path profile/line of sight dialog maintain its size between showings, preventing 

the user from having to continually resize it to get the size they want for different path 

profiles. 

 Added option to the Vector Display tab of the Configuration dialog to allow an arrow to 

be drawn along line features in the direction that they travel. 

 Fixed scaling problem when exporting vector data to a raster file using the 

EXPORT_RASTER command from a script file. 

 Made custom symbols from .ico files draw in their actual size instead of always using the 

default system size of 32x32. 

 Added new built-in point symbol, “Dot - Yellow”. 

 Fixed problems loading some GPS TrackMaker files that have no waypoints in them. 

 Made degree symbols display correctly on Asian versions of Windows that weren’t fixed 

in the earlier update. 

 Fixed problems with render progress on status bar not working properly with map catalog 

files. 

 Fixed problems with some maps that result in multiple layers, like ADRG files, in map 

catalogs. 



 Allowed custom per-layer shaders to work properly with map catalogs containing 

elevation data. 

 Fixed problems with some iso-height area contours not being generated in some rare 

cases when generating contours. 

 Fixed loading of package files containing elevation data from workspaces. 

 Fixed occasional problems with missing outer row and/or column of data when exporting 

a raster or elevation file and cropping to a selected, rectangular area feature. 

 Fixed problems with elevation shading and display of the elevation legend when negative 

scaling factors are used on the Alter Elevations dialog. 

 Made up to 3 decimal digits of precision be used when saving elevation values to many 

ASCII formats. 

 Added option to remove archive files (like .zip and .tar.gz) from the list of files to batch 

convert/reproject by right-clicking on the batch convert file list and selecting the 

appropriate option. 

 Added option to add files to the list of files to batch convert/reproject from a text file 

containing a list of full paths to files. To access this option, simply right click on the file 

list in the Batch Convert/Reproject dialog and select the appropriate option. 

 Added option to add files to a map catalog from a text file containing a list of full paths to 

files. To access this option, simply right click on the map list in the Map Catalog dialog 

and select the appropriate option. 

 Corrected half-pixel offset in placement of MrSID files with embedded coordinate 

information. 

 When exporting Shapefiles, do not export line features that are at a point (all vertices 

coincident) or area features that are a point or a 2-vertex line. 

 When exporting Shapefiles, make sure that lines that get cropped to the export bounds 

maintain their original direction. 

 Made attributes for which none of the features being exported have a non-empty value 

still be exported to DBF files that are created with Shapefiles. 

 Allowed confirmation prompt when closing loaded overlays from the Overlay Control 

Center to be disabled so that it won’t be shown again. 

 Fixed out of memory errors when zoomed in really far on some MrSID files. 

 Fixed loading of E00 files with empty annotations. 

 Made deleted holes in area features not be exported to DLG-O format files. 

 Added support for tracking NMEA GPS devices that use $EC* sentences rather than 

$GP* sentences. 

 Fixed determination of State Plane projection from Erdas Imagine .img files that use a 

negative zone number in the header. 

 Fixed problem with STL, 3D DXF mesh, and 3D DXF mesh exports that would cause a 

one sample gap between gridded files when exported. 

 Added right-click option to the Search by Attributes dialog to allow selecting all search 

results. 

 Made files opened by dragging them onto Global Mapper be added to the list of recently 

used files under the File menu. 

 When dragging multiple files onto Global Mapper to load them, make the “Use Selected 

Projection for All” checkbox option work if the user is asked for a projection. 



 Added a registry key to allow overriding where temporary files, like extracted archive 

contents and downloaded TerraServer tiles, are stored. If you create a 

HKEY_CURRENT_USER\Software\GlobalMapper\TempDir string value with the 

folder that you want the temporary files to be based in, that folder will be used the next 

time that you run Global Mapper. 

 Added option to save the elevation legend in the main view to a BMP file by right-

clicking on it and selecting the appropriate option. 

 Added option to control whether or not unit labels (e.g. “m” or “ft”) are displayed on the 

elevation legend. This setting can be changed by right-clicking on it and selecting the 

appropriate option. 

 Fixed problem with grid line labels being cropped at the bottom when footer strings were 

used during printing. 

 Made new Explorer-style dialogs be used for all file selection. 

 Fixed crash when displaying metadata for map catalogs that contain elevation layers. 

 Fixed errors loading some tiled TIFF files with separated color channels. 

 Made dot symbols look better when printed. 

 Made the filling in of small gaps work when exporting DEM files with arc degrees as the 

current view/export units on the Projection tab of the Configuration dialog. 

 When creating area features from selected line features with the Digitizer Tool, only 

prompt for name, attribute, and style information once, then use that information for all 

remaining areas created from the selected lines if no other information is available from 

the lines making up the area. 

 Made the count of selected features appear in the status bar when the Digitizer Tool is 

active and you are not actively working with the selected features. 

 Corrected decoding of New Zealand Map Grid projections from ECW files. They were 

being decoded as a closely-approximated Transverse Mercator projection. 

 Fixed loading of some ASRP-format data files. 

 Fixed errors loading DLG-O files with area features and non-contiguous element IDs for 

lines (these are very rare). 

 When exporting DXF format files, made area features be fully cropped to the specified 

export bounds rather than just exporting in whole any area that intersects the export 

bounds. 

 Fixed ordering of data written to GPX files to make sure that really picky applications, 

like Garmin’s MapSource, can always read them. 

 Fixed problem when doing multiple line connection operations from the Search by 

Attributes dialog that would result in extra long lines (they would loop over themselves) 

after the first line connection operation. 

 Made “Longitude of Pole” attributes for Polar Stereographic projections be saved and 

read from PRJ files. 

 Added support for a BOTTOM_UP parameter in BIL file headers to specify that the data 

starts at the lower-left rather than the top-left. Just add a line with the text 

“BOTTOM_UP Y” to the .hdr file to flip the data vertically. 

 Added a LAYER_DESC parameter to the GENERATE_CONTOURS script command to 

allow the name of the generated contour layer to be changed from the default. 

 Fixed problem with point features getting the wrong attributes from some E00 files. 



 Made holes in area features maintain the descriptions of their parents when exported to 

ASCII text files. 

 Allowed minus signs, dollar signs, and underscores to be used at the start of labels when 

exporting to DXF format files. Previously those characters were removed from the start 

of lines to prevent errors. Now a space is just inserted before those characters to get rid of 

the errors. 

 Added support for a LABEL_ON_LINE parameter in ASCII text files for specifying that 

labels for a line feature should be centered on the line. 

 

WHAT'S NEW IN Global Mapper v7.02 

 

 Added option on Vector Display tab of the Configuration dialog to allow more control 

over the order that vector features are drawn in. You can now select to have the layer 

order in the Overlay Control Center take top priority for vector data, allowing vector 

layers to be drawn under raster layers and also allowing explicit forcing of vector layer 

draw order. 

 Added support for searching on address in the US under the Search menu. 

 Added option to download TerraServer data near an address. 

 Made transparency and translucency in PNG files be used. 

 Added support for creating transparent PNG files (this is now the default). 

 Digitizer Tool Changes 

o Improved ease of digitizing lots of area, line, and point features by making the 

Digitizer Tool stay in the creation mode after creating a feature rather than forcing 

you to re-select the feature type to create each time. You still just need to right-

click to cancel the current operation. 

o Added display of the number of points digitized so far when drawing a new line 

or area feature with the Digitizer Tool. 

o Added option to reverse the order of the vertices in selected line features using the 

Digitizer Tool. 

o Added option to find unconnected endpoints in selected lines with the Digitizer 

Tool. This provides an easy method of identifying connectivity problems in 

loaded data. 

o Fixed creation of duplicate attributes when editing multiple features at a time with 

the Digitizer Tool and adding a new attribute which already exists in some of the 

features being edited. 

o Added option to measure cut-and-fill volumes to the right-click menu when a 

single line or area feature is selected. 

 New Supported Import/Export Formats 

o Added support for exporting loaded vector data to Lowrance USR format files for 

use in Lowrance GPS devices. 

o Added support for loading LIDAR data from TerraScan .bin and .ts format files. 

o Added option to print to (Geo)TIFF format files. 

o Added ability to batch convert to Global Mapper Package files. 

o Added support for exporting loaded elevation data to Optimi Terrain format files. 

 Projection/Datum/Unit Changes 



o Vastly improved accuracy of RT90 (Sweden) datum transformations. 

o Added Indonesia 1974 and Bukit Rimpah datums. 

o Added support for using the French angular unit “grades” with the Geographic 

projection. 

o Fixed rare problems projecting between a State Plane projection and a Lambert 

Conformal Conic projection. 

o Fixed loading of Erdas Imagine .img files with embedded projection information. 

This was broken in the v7.01 release. 

o Added support for loading and saving Southern Transverse Mercator projections 

in ECW files. 

o Added support for using projection and positioning information from .TAB files 

for ECW files. 

o Added support for decoding New Zealand Map Grid projections from .TAB files. 

o Added option to write an invalid datum code to DEM files when exporting with a 

view/export datum set to one that is not supported by the DEM format. 

o Do not allow modifying the Origin Latitude for Mercator projections since it is 

not used (the latitude origin is always the equator for Mercator). 

o Fixed saving of some projections to MapInfo TAB files. Some projections either 

could not be written at all or if they had a central meridian scale factor parameter 

it would always be set to 1.0. 

o Made projection information from supplemental files (like .prj files) be used if 

available for GeoTIFF files that do not contain projection information internally 

rather than always asking the user to select the projection in that case. 

o Added GRS 1967 (Indonesia 1974), Sphere Radius 6378388 Meters , and War 

Office (McCaw 1924) as available ellipsoids for adding custom datums. 

o Fixed name of the “Everest 1830” ellipsoid in the custom datum dialog. It was 

being incorrectly listed as “Everest 1930”. 

 Made Ctrl+Right Click in the Zoom Tool restore the last zoom scale. 

 Made the name of the map that a vector feature is in always be displayed in the Feature 

Info dialog for the feature. 

 Added button on the General tab of the Configuration dialog to allow restoring all 

settings to their default values. 

 Added support for tracking GPS devices on COM ports up to COM64 (previously the 

highest support serial port was COM16). 

 Made the COM port and baud rate settings for serial GPS devices be properly 

remembered between sessions. 

 Added shortcut key (Ctrl+T) for starting and stopping the tracking of a connected GPS 

device. 

 Made font information about labeled features be saved in Simple ASCII Text files 

exported with the “include attributes” option set. 

 Added support for using new font attributes when reading generic ASCII text files. See 

the User’s Manual section for that menu command for details on the new supported 

attributes. 

 Added ability to combine line features in the Search by Attributes dialog. Just select the 

lines to combine, then right click on them in the list and select the combine option that 



appears. 

 Fixed errors loading label points from some .e00 files. 

 Added support for rectifying ECW and JPG2000 files. 

 Added support for loading TAB-referenced raster files which do not have the same base 

name as the TAB file. You must select the TAB file to load for this to work. 

 If a color palette is specified in a TIFF header for files with a grayscale photometric 

interpretation, use the color palette rather than creating a grayscale one. Apparently some 

products, like ArcGIS, will create TIFF files in this way for some reason. 

 Made TEXT feature labels from MIF/MID files be read in and used. 

 Made saving a path profile to a BMP file save a bottom-up rather than a top-down bitmap 

since some applications (including Global Mapper) can’t read top-down bitmaps. 

 Fixed problems batch converting to Shapefile format and exporting to the “source file” 

folder when the input files are either archives (e.g. .zip or .tar.gz files) or the output is 

being gridded. 

 When using the “Add Loaded Files” or “Add Onscreen Files” buttons in the batch 

conversion dialog and map catalog files are loaded, made the maps referenced by the map 

catalog be added to the convert list if they are of the right type. 

 Fixed loading of attributes from some DBF files that had padding bytes after the DBF 

header. 

 Added support for decoding DMS lat/lon values which use a hyphen as the separator. 

 Sped up the export of raster and elevation files when only a subset of a large number of 

files is being exported. 

 Fixed really slow drawing of some rotated BSB files. 

 Fixed vertical flip of NTF-format grid files. 

 When exporting MapInfo MIF/MID format files, made area features be fully cropped to 

the specified export bounds rather than just exporting in whole any area that intersects the 

export bounds. 

 Made line and area border widths be stored correctly in MapInfo MIF/MID files. 

 When using area features with elevations as obstructions for view shed calculations, 

make the tested receiver heights inside area features just be based on the terrain and only 

use the area heights as obstructions. This makes it easier to simulate things like wooded 

areas blocking reception within those areas and not just beyond them. 

 Added Landsat True Color links from resmap.com to the File->Open ECW File from the 

Web menu dialog. 

 Added support for reading in 3D DXF line features and saving the separate elevations for 

each vertex rather than using the elevation of the first vertex for the entire line. 

 Added ability to create regularly spaced tiles of elevation grids from 3D vector data when 

right-clicking on vector layers in the Overlay Control Center and selecting the option to 

create an elevation grid from the data. This makes it easier to deal with very large data 

sets that cannot be gridded all at once without running out of memory. 

 Added support for Global Mapper Package files larger than 2GB in size. 

 

WHAT'S NEW IN Global Mapper v7.01 

 

 Made the middle mouse button drag the map in all of the tools and not just the Zoom 



tool. 

 Added option to use an elevation shader other than the shared elevation shader selected 

on the toolbar for rendering an elevation layer. This option is available from the Options 

button in the Overlay Control Center. 

 Added option to grid (i.e. tile) data during batch conversion. 

 Made decimal digit fields exported to Shapefiles display as decimal numbers by default 

when loaded into other applications rather than displaying just as whole numbers. 

 Added and/or improved metadata display from the Overlay Control Center for most file 

types. The improved metadata display allows copying the metadata to the clipboard and 

easy viewing of projection information. 

 Projection/Datum/Unit Changes 

o Added support for the NAD83 HARN/HPGN datums. 

o Improved accuracy of NAD27 Alaska, Old Hawaiian Mean, and Puerto Rico 

datums by adding support for using the NADCON datum conversion methods for 

those datums. 

o Improved accuracy of NTF France datums by adding support for using variable 

grid shifts depending on the location within France. 

o Added support for creating custom datums that use the 7-parameter Bursa-Wolfe 

datum transformation method (previously only the 3-parameter Molodensky 

method was supported). 

o Added built-in support for the Irish Grid projection. 

o Added support for yards as a linear unit. 

o Added support for millimeters as an elevation unit. 

o Corrected detection of UTM zones in the Southern Hemisphere from old-format 

ESRI PRJ files. 

o Improved decoding of some projections from OziExplorer .map files. 

 New Supported Formats 

o Added support for loading NTF-format grid files, such as those used for elevation 

data in Great Britain. 

o Added support for loading some FAST format imagery files, such as those used 

for L7A Landsat data in some parts of the world. 

 Digitizer Tool Changes 

o Made holding the X and Y keys when moving vertices or features with the 

Digitizer Tool, clamp the move horizontally or vertically. 

o When creating new line or area features with the Digitizer Tool, the length and 

enclosed area (if applicable) will be displayed in the status bar as the new feature 

is drawn. 

o When moving or joining vertices of line or area features with the Digitizer Tool, 

the length and enclosed area (if applicable) will be displayed in the status bar as 

the vertices are moved. 

 Measure Tool Changes 

o When creating a new line feature from a measurement in the Measure Tool, set 

the length of the measurement to also be the default display label. 

o When displaying length and other measurement strings, such as with the Measure 

Tool, remove any trailing zeroes from the length to make it more compact. 



 Image Rectification Changes 

o Added new hotkeys to the image rectification dialog. Now Alt+R will act like 

pressing the “Update Selected GCP” button, Alt+Q will move the GCP list 

selection up, and Alt+Z will move the GCP list selection down. 

o Improved the crosshair cursor used in the Zoomed and Reference views of the 

Image Rectification dialog. 

o Improved the symbols used in the image rectification dialog for displaying ground 

control points to make it easier to see the data behind the control point. 

 Map Catalog Changes 

o Added the ability to display metadata about maps in a map catalog by right-

clicking on the map in the map list in the Map Catalog dialog and selecting a 

popup menu option to display metadata about them. 

o Added the ability to have map catalogs be displayed within a range of map scales. 

o Fixed problems using files with Oblique Mercator projections in map catalogs. 

o Fixed problems with some files, particular packages with multiple data layer, 

being included in map catalogs. 

 Corrected placement of Erdas Imagine .img files with a UTM projection in the Southern 

Hemisphere. 

 Added support for getting projection information for MrSID files from .aux files. 

 Added option to generate world files when exporting to BIL/BIP/BSQ format files. While 

the information in the world files is also in the .HDR file generated, some software only 

checks for a world file. By default, both will be generated. 

 Added support for loading JPG files directly from .zip and .tar.gz archives. 

 Fixed loading of some Raster Product Format (RPF) data, like CADRG/CIB data, that 

had odd security descriptor values in the frame files. 

 Display a progress dialog when printing to show the progress of generating the high-

resolution image to send to the printer. 

 Drastically sped up the export of BMP files when capturing the screen to one or printing 

to one. 

 Made zooming the main map view with the mouse wheel only zoom half as far as the 

zoom buttons on the toolbar. 

 Fixed problems introduced in the v7.00 release with calculating view sheds when the 

global projection units are either arc seconds or radians. 

 Made the feature type lists on the Generic ASCII Import dialog be sorted alphabetically. 

 If the datum can not be determined from a GeoTIFF file, ask the user to confirm it if we 

can't determine the datum from some other source rather than just assuming the datum is 

WGS84. 

 Added ability to generate black-and-white GeoTIFF files that use black for the minimum 

value rather than white. To do this, select the Grayscale - Min Is Black palette option 

when exporting a black-and-white GeoTIFF file. 

 Made auto-collar cropping work correctly for 1:63K scale Alaska DRGs. 

 Improved dialog that appears when TerraServer connections fail. 

 Made point features with labels be exported as TEXT entities to DXF files rather than 

either being split up into separate POINT and TEXT entities or being created as a POINT 

entity with attributes. 



 Improved display of elevation lines in the path profile dialog when the elevation range is 

small. 

 Fixed problems with the wrong font being displayed when editing custom area, line, and 

point types from the Configuration dialog. 

 Corrected datum used for VPF (e.g. VMAP, DNC) data. NAD83 was being used when it 

should have been WGS84. There was no position error however as those datums are the 

same positionally. 

 Fixed problem with the zoom scale changing after a print preview. 

 Fixed problem with grid lines not being saved to raster files or printed if no other vector 

data is loaded. 

 Allowed correct loading of elevation TIFF files that don’t correctly specify their min/max 

elevation range. 

 Added option to clamp values outside the valid elevation range to the specified elevation 

range when modifying the valid elevation range of a layer from the Options button in the 

Overlay Control Center. 

 Added support for loading large TIFF files with YCBCR-encoding (usually JPEG-in-

TIFF files). 

 When loading ECW and JPEG2000 files with apparently flipped Y coordinates, made it 

optional to flip the image vertically since it some cases that is not correct. 

 Added new red and yellow diagonal crosshair symbols. 

 When saving PRJ and world file names (e.g. .tfw, .jgw), use lower case to make it easier 

to use these files on platforms that are case-sensitive, like Linux. 

 Made true 3D DXF polylines be generated when exported 3D line features (such as those 

from XYZ files) to DXF files. 

 Made features from Tiger/Line files include the CFCC (census feature class code) as an 

attribute of the feature if available. 

 Improved generation of range rings to always use a great-circle distance method if 

possible, even if the current projection is not Geographic. 

 Added support for automatically positioning imagery using ASTER browse .meta files. 

 

WHAT'S NEW IN Global Mapper v7.00 

 

 Added support for grouping collections of map files together into a “map catalog”. Map 

catalogs allow you to easily load, view, and manage large collections of data without 

using too much system memory. 

 Added support for tracking real-time GPS locations from Garmin USB GPS devices. 

 Added option under the Search menu to allow searching loaded vector data on the name, 

description, or attribute values. The searching allows both text and numeric comparisons 

in the search criteria. Features can be edited and deleted directly from the search results. 

 Added “Gridding” tab to most exports to allow splitting up the data into regularly spaced 

tiles on export if desired rather than just exporting a single file. 

 Measure Tool Changes 

o Added support for calculating “cut-and-fill” volumes within area measurements 

and along linear measurements using the Measure Tool (right click to see the 

Calculate Volumes option). 



o Made the bearing from the start to the end of line features be added when creating 

new lines using either the Measure tool or the Digitizer tool. 

o Changed the cursor used in the Measure Tool to make it easier to perform precise 

measurements. 

 Digitizer Tool Changes 

o Added ability to easily create rectangular, square, circular, elliptical, circular arc, 

and elliptical arc area and line feature using the Digitizer Tool. There are 

additional items on the right click popup menu for drawing these shapes. 

o Added option to create concentric range rings (i.e. circles of a given radius) on the 

right-click menu in the Digitizer Tool. 

o Added an option when editing vector features with the Digitizer Tool to add file 

link attributes by selecting files rather than manually typing the file names. 

o Made area features selected with the Digitizer Tool be drawn in their normal style 

during exports cropped to the selected area feature(s). 

o Made point feature labels be displayed even if the points are selected with the 

Digitizer Tool. 

 3D Path Profile/Line of Sight Tool Changes 

o Added support for calculating “cut-and-fill” volumes along a path profile using 

the 3D Path Profile/Line of Sight Tool. 

o Added additional menus to the 3D Path Profile dialog to provide easier access to 

some of the options. Also made the path details be copied to the clipboard when 

displayed. 

o Added additional options to the 3D Path Profile dialog for controlling the from/to 

position display format and the coloring and style of the profile elements. 

o Fixed problems with the path profile tool when the loaded data is not correctly 

projected (i.e. the lat/lon readout in the status bar reads that the coordinates could 

not be determined). 

o Made elevation values saved to XYZ files from the path profile dialog have 2 

digits after the decimal place rather than 1. 

 3D Viewer Changes 

o In the 3D viewer, allow the vertical exaggeration to be increased all the way to a 

factor of 100.0 rather than just 20.0. 

o In the 3D viewer, made the Panorama/Walk mode toolbar button act as a mode 

just like the Rotate, Move, and Zoom buttons since that is how it behaves. 

o In the 3D viewer, added an option to the Properties dialog to allow the 

background color to be changed. 

o In the 3D viewer, added an option to the Properties dialog to allow the height used 

in the Panorama/Walk mode to be manually set and to also specify whether the 

height should be a constant height relative to the ground or a constant height 

relative to sea level. 

o In the 3D viewer, made the vertical exaggeration and background color settings 

be remembered between instances of running the software. 

 Batch Convert/Reproject Changes 

o Added option to the Batch Convert/Reproject dialog to allow the specification of 

an additional string to append to the names of the files created during the batch 



convert process. 

o Added option to the Batch Convert/Reproject dialog to allow some files to only 

be used as filler for other files. To mark files this way, simply right click on them 

in the source files list and select the option to just use them as filler files. 

o Added option to create 1-bit black-and-white GeoTIFF files with the Batch 

Converter. 

o Reduced memory requirements during batch conversion when using all loaded 

files as filler data and there are lots of files being converted. 

 Image Rectification Changes 

o When shift-clicking in the Reference pane of the image rectification dialog, made 

the selected coordinates be rounded to the nearest minute for lat/lon values and 

the nearest 1000 units for other projections. 

o Made the image rectification dialog start out maximized if the dialog was 

maximized the last time the user closed the dialog. 

o Made the Latitude and Longitude coordinate values in the ground control point 

list of the image rectification dialog be displayed using the current Position 

Display Format selection in the Configuration dialog. 

o When double clicking on a control point in the control point list in the image 

rectification dialog and the rectify coordinates are lat/lon values, format the 

projected X and Y coordinate fields using the current Position Display Format 

from the Configuration dialog. 

o While Shift-clicking in the Zoomed view in the image rectification dialog, 

automatically add the control point to the control point list use the clicked 

location. 

o When Ctrl clicking in the Entire Image view in the image rectification dialog, 

automatically recenter the Reference view if there are enough control points 

entered to convert the clicked coordinates to a ground coordinate. 

o Make layers that are hidden in the Overlay Control Center still be rendered in the 

rectify window when re-positioning that layer. 

o Default to use triangulated rectification when rectifying imagery any time that 5 

or more control points are entered and the “Automatic” rectification method is 

selected (previously this happened at 8 control points). 

 Added support for using the bounds of a loaded layer when exporting or performing other 

operations that require bounds in a script file. The LAYER_BOUNDS parameter has 

been added to several script commands to support this. 

 Added ONLY_GENERATE_METADATA parameter to the EXPORT_RASTER script 

command to allow scripts to just create the metadata files like world files and TAB files 

when exporting GeoTIFF, JPG, and PNG files rather than doing a full export. 

 Made workspace files support relative filenames, allowing data referenced by workspace 

files to be moved so long as the workspace file is moved as well. 

 Added option to Terragen .ter file export to allow the creating of non-square terrain files. 

This files should work with Terragen 0.9.x and later. 

 Added option to create area features from the bounds of the selected layer in the Overlay 

Control Center by selecting and then right-clicking on the layers that you want to create 

the bounds from. 



 Added support for loading data in the GPS TrackMaker (.gtm) format. 

 Added support for the Bonne and Cassini-Soldner projections. 

 Added support for non-zero central meridians when using the Gall Stereographic 

projection. 

 Added support for the Hartbeesthoek94 datum. 

 Added support for loading DTED files that have HDR and/or VOL records at the 

beginning. 

 Added support for loading ASTER HDF files with .hdf0 and .hdf1 extensions as well as 

additional variations of ASTER SWIR data. 

 Fixed export of high-color (24-bit and above) and 8-bit grayscale TIFF files to image-

optimized palette-based TIFF and PNG formats when the TIFF file incorrectly specifies 

that it is grayscale and not RGB. 

 Sped up display of TerraServer data that crosses UTM zone boundaries. 

 Added support for finding world files with a .wld extension when loading most imagery 

formats (i.e. BMP, JPG, TIFF, GIF, and PNG). 

 Corrected placement of Hawaiian data loaded from Tiger files (the NAD83 datum was 

being used rather than Old Hawaiian Mean). 

 Made the size of the feature info dialog be saved between sessions. 

 Fixed decoding of State Plane projections from new format PRJ files. The problem was 

introduced in the v6.09 release and made some PRJ files with State Plane projections 

decode the projection into the core projection rather than keeping it as State Plane. This 

should not have affected any coordinates. 

 Corrected incorrect interpretation of “Foot” string from new format PRJ files. Previously 

this was interpreted as US Survey Feet when it should have been interpreted as 

International Feet. 

 Fixed application crash loading some slightly odd .zip files. 

 Made additional digits of precision be stored for settings like custom grid spacing. 

 Manually compute the min/max sample values for USGS DEMs that have a non-unity Z 

resolution since they are often stored incorrectly, resulting in odd shading in Global 

Mapper. This will apply to things like decimeter and centimeter DEMs. 

 Made full extents of polar data reprojected from a polar stereographic projection to 

another projection be displayed whenever possible (previously the part nearest the pole 

and near the anti-meridian could get clipped off). 

 Increased the maximum number of grid lines that could be displayed when using the 

custom grid spacing setting. 

 Made TIFF files that use a transformation matrix for position information be 

automatically positioned rather than requiring rectification. 

 Made degree symbols display correctly on Asian versions of Windows. 

 Corrected drawing and zooming in on ECW and JPEG2000 files that have flipped Y 

coordinate values in the header. 

 Added option to contour generation to control whether or not small gaps in the data are 

filled (previously they always were). 

 Improved the speed of exporting downloaded TerraServer data to new raster files. 

 Corrected display of zone numbers for Gauss Krueger Germany projection. 

 Only show the warning message about user-defined datums in GeoTIFF files being 



interpreted as WGS84 once each session. 

 When changing the current view projection, maintain the current view window if possible 

rather than zooming out to all loaded data. 

 Added option to initialize sample spacing values to the current screen sample spacing 

from the dialog allowing specification of sample spacing in units other than the current 

projection units when performing raster and elevation exports. 

 Added red, blue, green, and white dot symbols. 
 


